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Before You Begin
This section introduces you to standard warranty provisions, safety
precautions, warnings and cautions, document formatting conventions,
and sources of additional product information. A documentation roadmap
is also provided to guide you in finding the appropriate information.

Warranty Information
To receive a copy of the standard warranty provision for this product, con-
tact your local Intermec support services organization. In the U.S. call
1-800-755-5505, and in Canada call 1-800-668-7043. If you live outside
of the U.S. or Canada, you can find your local Intermec support services
organization on the Intermec Web site at www.intermec.com.

Note: Opening this product may void the warranty. The internal workings
of this product can only be accessed by Intermec service personnel. Radio
replacements and upgrades require Intermec service personnel.

Safety Summary
Your safety is extremely important. Follow these guidelines:

S Read and follow all warnings and cautions in this book before handling
and operating Intermec equipment. You can be seriously injured, and
equipment and data can be damaged if you do no follow the safety
warnings and cautions.

S Do not repair or adjust energized equipment alone under any circum-
stances. Someone capable of providing first aid must always be present
for your safety.

S Always obtain first aid or medical attention immediately after an injury.
Never neglect an injury, no matter how slight it seems.

S Begin resuscitation immediately if someone is injured and stops breath-
ing. Any delay could result in death. To work on or near high voltage,
you should be familiar with approved industrial first aid methods.

S Never work on energized equipment unless authorized by a responsible
authority. Energized electrical equipment is dangerous. Electrical shock
from energized equipment can cause death. If you must perform autho-
rized emergency work on energized equipment, be sure that you comply
strictly with approved safety regulations.
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Warnings, Cautions, and Notes
The warnings, cautions, and notes in this manual use this format:

A warning alerts you of an operating procedure, practice, condition, or
statement that must be strictly observed to avoid death or serious injury
to the persons working on the equipment.

Attention Danger: Un avertissement vous avertit d’une procédure de
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit être
strictement respecté pour éviter l’occurrence de mort ou de blessures
graves aux personnes manupulant l’équipement.

A caution alerts you to an operating procedure, practice, condition, or
statement that must be strictly observed to prevent equipment damage or
destruction, or corruption or loss of data.

Attention: Une précaution vous avertit d’une procédure de
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit être
strictement respecté pour empêcher l’endommagement ou la destruction
de l’équipement, ou l’altération ou la perte de données.

Note: Notes are statements that either provide extra information about a
topic or contain special instructions for handling a particular condition or
set of circumstances.

About This Manual
The 700 Series Color Mobile Computer User’ s Manual provides you with
information about the features of the 700 Series Color Mobile Computer
and how to configure, troubleshoot, and support it. You must be familiar
with your host PC, your network, and your other Intermec equipment.

S Chapter 1 — Introduction
Introduces the 700 Series Color Mobile Computer.

S Chapter 2 — Pocket PC 2002
Introduces the Pocket PC 2002 operating system from Microsoft Cor-
poration, and explains how to use its Outlook, ActiveSync, Internet Ex-
plorer, and other companion programs.

S Chapter 3 — Installing Applications
Provides methods to install applications and CAB files, also covers ap-
plication migration.

S Chapter 4 — Network Support
Introduces the CORE application, network adapters such as Ethernet,
802.11b radios, GSM/GPRS or CDMA/1xRTT embedded radio mod-
ules, and wireless printing equipped with a Bluetooth module, SNMP
configuration, and Network Selection APIs.

S Chapter 5 — Printer Support
Provides information on printing ASCII to either a port or to a generic
serial port, and on working with IrDA, NPCP, and O’ Neil printer driv-
ers.
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S Chapter 6 — Scanner Support
Provides Automatic Data Collection COM and IImage interfaces and
lists settings via Data Collection parameters.

S Chapter 7 — Programming
Programming information that includes creating CAB files, the FTP
Server, Full Screen, Kernel I/O Control Functions, Reboot Functions,
and remapping the keypad.

S Appendix A — Control Panel Applets
Contains detailed information about the Data Collection, SNMP, and
Unit Information control panel applets.

S Appendix B — Unit Manager
Describes how to configure some parameters via the Unit Manager ap-
plication and includes reader commands.

S Appendix C — Bar Codes
Describes some of the more common bar code symbologies and includes
bar code labels that can be scanned to configure your 700 Series Com-
puter.

Format Conventions for Input From a Keyboard or Keypad
This table describes the formatting conventions for input from PC or host
computer keyboards and device keypads.

Format Conventions

Convention Description

Special text Shows the command as you should enter it into the device.

Italic text Indicates a variable that you must replace the parameter with a value.

Bold text Indicates the keys you must press on a PC or host computer key-
board. For example, “press Enter” means you press the key labeled
“Enter” on the PC or host computer keyboard.

where This word introduces a list of parameters and explains the values you
can specify for them.



Before You Begin

xviii 700 Series Color Mobile Computer User’s Manual

Related Publications
To order printed versions of the Intermec manuals, contact your local In-
termec representative or distributor. Following are related Intermec
manuals, CD-ROMs, and part numbers (P/N). For other versions and
languages, consult your Intermec sales representative.
S 700 Series Color Mobile Computer Quick Start Guide

(P/N: 962-054-053)

S 700 Color Recovery CD PPC 2002 Professional Edition WWE
(P/N: 235-100-001 Kit)

S 700 Color Recovery CD PPC 2002 Premium Edition WWE
(P/N: 235-101-001 Kit)

S 700 Series Color Software Tools CD (P/N: 235-099-001)

S Windows 95 and Windows CE Configuration Utilities Reference Manual
(P/N: 978-054-010)

Global Services and Support
Select any of the following services available from Intermec Technologies
Corporation:

S Factory Repair and On-site Repair
To request a return authorization number for one of our authorized ser-
vice centers, or to request an on-site repair technician, call
1-800-755-5505, then select option 1.

S Technical Support
For technical support on your Intermec product, call 1-800-755-5505,
then select option 2.

S Service Contract Status
To inquire about an existing contract, or to renew a contract, call
1-800-755-5505, then select option 3.

S Schedule Site Surveys or Installations
To schedule a site survey, or to request a product or system installation,
call 1-800-755-5505, then select option 4.

Web Support
Visit our Web site at http://www.intermec.com to download many of our
current manuals in PDF format.

Visit our technical knowledge base (Knowledge Central) at
http://intermec.custhelp.com to review technical information or to request
technical help for all Intermec products.
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Introduction1

This chapter introduces the 700 Series Color (700C) Mobile Computer,
developed by Intermec Technologies Corporation to enhance wireless con-
nectivity needs.
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About the 700 Series Color Mobile Computer

Audio System

Speaker
A speaker capable of variable volume levels is located on the back of the
computer. This speaker has a transducer volume of 85 dB min at 10 CM
and a frequency range of 1-8 KHz.

Internal Microphone
The internal microphone is located on the bottom of the unit to the left of
the hirose connector.

External Headset Jack
The external headset jack connects a mono headset to your mobile com-
puter for use in noisy environments. The jack is a 2.5 mm, three-conduc-
tor jack, with autosensing of the headset jack insertion which disables the
internal speaker and microphone. The external headset jack is located on
the bottom of the mobile computer to the right of the hirose connector.

Battery
The 700 Series Computer comes equipped with a nominal 14.4
Watt-hour, 7.2V (two 2000 mAh cells), replaceable Lithium-Ion (LiIon)
battery. To view the status of this battery from the 700 Series Computer,
tap Start → Settings → the System tab → the Power icon to view the
current status of both the main battery and the backup battery. Tap ok to
exit this information.
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Note: The Unit Information control panel applet is only available in the
700 Series Computer if Intermec Content is enabled, the Plus region is
enabled and installed, and a laser scanner is installed.

You can also view the battery status for the 700 Series Computer by
accessing the Unit Information control panel applet. Tap the Unit
Information icon, then tap the Battery Status tab to view the current
status. Tap ok to exit this information.

Low Battery Shutdown
If your computer shuts down because of low battery conditions, your com-
puter will not operate. This is done to ensure that data is protected. Al-
though the battery will protect the data against loss for several hours, you
should connect your computer to a power source when you first detect a
low battery condition.

Your computer contains an internal super capacitor, a temporary power
storage device, that protects data for up to ten minutes. This is to give you
time to replace the main battery pack before that data is lost. Be sure to put
the computer in a suspend mode before doing so.

The battery power fail level is set so that after the system shuts down in a
low battery condition, there is still sufficient charge to allow the unit to
remain configured, keep proper time, and maintain DRAM (Dynamic
Random Access Memory) for at least 72 hours at room temperature if the
main battery remains in the mobile computer. The configuration and time
are lost if:

S The battery discharges beyond this level.

S The battery is removed when the computer is not in suspend mode.

S A cold reset is performed on the computer.
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System Status Maintained
System status is maintained in “suspend” when the main battery is re-
moved:

S 10 minutes for 64 MB low-power chips

S 5 minutes for 128 MB low-power chips

CAB Files Within 700C Software Tools CD
If you leave the default destination while you install the “\700 Color
Mgmt Tools” directory onto your desktop PC, then “C:\Intermec\Inter-
mec 700 Color Mgmt Tools\Cab Files” will be the default directory. There
are folders within the “\Cab Files” directory that contain demos and pro-
gram files. See the 700 Series Color Software Tools CD User’ s Manual for
more information about these files.

Modem Support
Modem PC Cards are not supported by the 700 Series Computer. Howev-
er, modem options do include the following:

S Switchable dock that includes a built-in modem and a serial port be-
tween which an application can switch.

S Mini-Landline Modem that can be tethered to the port on the bottom
of the 700 Series Computer.

S Other external modems that may be connected to the bottom of the
700 Series Computer or to the dock.

Network Support
Radio CompactFlash Cards cannot be installed by a user. The 700 Series
Computer must be serviced to install or replace radios. See Chapter 4,
“Network Support” for more information.

S 802.11b radio

S Integrated GSM/GPRS radio

S CDPM/1xRTT radio

S Wireless printing equipped with a Bluetooth qualified module by Socket
Communications
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Removeable Card Support
To access either the CompactFlash (CF) or SecureDigital (SD) card slot,
locate the access door at the top of the 700 Series Computer, remove its
two screws, then remove the door.

CompactFlash Cards
Support is limited to one CompactFlash (CF) Storage Card in the 700 Se-
ries Computer, either for storage or for the 802.11b radio.

SecureDigital Cards
Support is limited to one SecureDigital (SD) Storage Card in the 700 Se-
ries Computer for storage.

MultiMediaCards
MultiMediaCards (MMCs) are not supported in the 700 Series Comput-
ers because current technology shows that SD cards will quickly surpass
MMC cards in storage capacity.

Software Build Version
To check to see if your 700 Series Computer has the latest build, select
Start → Internet Explorer → the Intermec logo.

The latest software build version is displayed beneath the Patent Informa-
tion title. This information will be useful should you need customer assis-
tance.

Note: The Unit Information control panel applet is only available in the
700 Series Computer if Intermec Content is enabled, the Plus region is
enabled and installed, and a laser scanner is installed.
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You can also view the latest software build version on your 700 Series
Computer by accessing the Unit Information control panel applet. Select
Start → Settings → the System tab → the Unit Information icon → the
Versions tab to view the current build version on your 700 Series
Computer.

What’ s New
The newest functionality is available in software build versions 1.30 or
greater. The following changes have occurred since the last release of this
manual:

S Applied new publications standards to this manual.

S Adapted instructions using Ethernet connections to fit Intermec require-
ments in Chapter 2, “Pocket PC 2002.”

S Moved “Updating System Software” and “EFlash” information to the Re-
covery CD User’ s Manual from Chapter 3, “Installing Applications.”

S Removed several 802.11 APIs not related to the 700 Series Color Com-
puter from Chapter 4, “Network Support.”

S Added the Siemens MC45 radio module to Chapter 4, “Network Sup-
port.”

S Added tethered scanner information to Chapter 6, “Scanner Support.”

S Added CAB extraction information and FTP Server parameters to
Chapter 7, “Programming.”

S Added imager option information via the Data Collection control panel
applet to Appendix A, “Control Panel Applets.” Note that this is for 700
Series Computers using an imager.
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Pocket PC 20022

This chapter introduces the Pocket PC 2002 operating system from
Microsoft Corporation.
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Introduction
Congratulations on purchasing a Pocket PC. Due to the size and capabili-
ties of this 700 Series Color Mobile Computer, you can keep your most
important business and personal information up-to-date and close at hand.
Microsoft ActiveSync increases the power of your 700 Series Computer by
allowing you to synchronize the information on your desktop or laptop
computer with your 700 Series Computer. Picture yourself in the follow-
ing situations:

S A Calendar reminder alerts you that it is time to catch the bus. You grab
your 700 Color Pocket PC Mobile Computer and catch the bus just in
time. Because ActiveSync keeps the information on your 700 Series
Computer up-to-date, you leisurely review your task list, make notes
about the new books and CDs you want to buy, and read and respond
to e-mail messages. When you get back to the office, ActiveSync trans-
fers any task changes you made, your notes, and your e-mail message
responses to your desktop computer. For more information on Active-
Sync, see “Microsoft ActiveSync” on page 29.

S While walking with a colleague, your 700 Color Pocket PC Mobile
Computer rings. You look at the caller ID and see it is your manager
who is calling. She asks if you two are free this afternoon for an emer-
gency meeting. While your colleague fumbles through his paper orga-
nizer, you press a button on your 700 Series Computer and instantly see
a list of today’ s appointments and meetings. You are quickly able to tell
your manager your available times, and make a note of the new meeting
while on the call. You hang up, send an e-mail with a schedule request
for the three of you at the desired location. For more information on
scheduling appointments and meetings, see “Microsoft Pocket Outlook”
on page 31.

S You are meeting your friends tonight for dinner and a movie. You
download the latest movie information from the Internet to your desk-
top computer and then synchronize it with your 700 Series Computer.
At dinner, you pull out your 700 Color Pocket PC Mobile Computer
and review your movie options with your friends. For more information
on downloading Web pages to your 700 Series Computer, see “Pocket
Internet Explorer” on page 62.

Premium versus Professional Editions
Your 700 Series Computer will have either the Premium Edition or the
Professional Edition of Pocket PC 2002. Do the following to determine
which edition of Pocket PC 2002 is on your unit.

1 Select Start → Internet Explorer → the Intermec logo.
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2 Note the “Software Build” information displayed beneath the Version
Information title.

Note: If you have an older software build, your unit may say either
“PREM” (which indicates the Premium Edition) or “PRO” (which indicates
the Professional Edition).

3 Tap the Close icon in the top right corner to exit the Internet Explorer.

Below is a list of components for each edition of Pocket PC 2002:

Component
Premium
Edition

Professional
Edition

Microsoft ActiveSync Client (page 29) X X

Microsoft Pocket Outlook (page 31) X X

Pocket Word (page 47) X X

Pocket Excel (page 52) X X

MSN Messenger (page 53) X

Windows Media Player for Pocket PC (page 57) X RAM

Microsoft Reader (page 58) X RAM

Pocket Internet Explorer (page 62) X X

Note: Components marked with “RAM” are provided on a Companion
CD for download into RAM rather than burned into Flash ROM.
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Where to Find Information
This chapter describes your 700 Series Computer hardware, provides an
overview of the programs on your 700 Series Computer, and explains how
to connect your 700 Series Computer to a desktop computer, a network,
or the Internet. For instructions on setting up your 700 Series Computer
and installing ActiveSync, see the Quick Start Card. The following is a
guide to more information to assist you use your 700 Series Computer.

For information on: See this source:

Programs on your mobile computer. This chapter and mobile computer Help. To view Help,
tap Start → Help.

Additional programs that can be installed on the mobile
computer.

The Pocket PC Companion CD.

Connecting to and synchronizing with a desktop com-
puter.

The Quick Start Card or AutoSync Help on your desktop
computer. To view Help, click Help → Microsoft Acti-
veSync Help.

Last-minute updates and detailed technical information. The Read Me files, located in the Microsoft ActiveSync
folder on the desktop computer and on the Pocket PC
Companion CD.

Up-to-date information on your Pocket PC. http://www.microsoft.com/mobile/pocketpc

Pocket PC and many of the technologies supported by the 700 Series
Computer are not from Intermec Technologies. Many of the utilities and
features on a Pocket PC device come directly from Microsoft without any
modification from Intermec Technologies. There may be certain Micro-
soft-specific issues that Intermec Technologies would not be able to sup-
port, so you will have to contact Microsoft Corporation. Use these URLs
to determine your Microsoft support options:

S http://msdn.microsoft.com/support/

S http://support.microsoft.com/

S news://news.microsoft.com (a free support option)
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Basic Skills
Learning to use your 700 Series Computer is easy. This describes the basic
concepts of using and customizing your 700 Series Computer.

Buttons and Stylus
Your 700 Series Computer has hardware buttons that control actions and
scroll functions, and a stylus for selecting items and entering information.
On the 700 Series Computer, the stylus replaces the mouse.
S Tap:

Touch the screen once with the stylus to open items and select options.
S Drag:

Hold the stylus on the screen and drag across the screen to select text
and images. Drag in a list to select multiple items.

S Tap and hold:
Tap and hold the stylus on an item to see a list of actions available for
that item. On the pop-up menu that appears, tap the action to be per-
formed.

Today Screen
When you turn on your 700 Series Computer for the first time each day
(or after four hours of inactivity), you will see the Today screen. You can
also display it by tapping the Start flag (shown left) and then Today. On
the Today screen, you can see at a glance important information for the
day.
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Following are some of the status icons you may see:

Status Icon Meaning:

Turns all sounds on and off.

Backup battery is low.

Main batteries are charging.

Main batteries are low.

Main batteries are very low.

Main batteries are full.

Connection is active.

Synchronization is beginning or ending.

Synchronization is occurring.

Notification or one or more instant messages received.

Notification of one or more e-mail messages received.

If more notification icons need to be displayed than there is
room to display them, the Notification icon (shown left) will
display. Tap the icon to view all notification icons.
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Programs
You can switch from one program to another by selecting it from the Start
menu. (You can customize which programs you see on this menu. For
information, see “Adjusting Settings” on page 26.) To access some
programs, tap Start → Programs, and then the program name.

You can also switch to some programs by pressing a program button. Your
700 Series Computer has one or more program buttons located on the
front or side of the computer. The icons on the buttons identify the pro-
grams to which they switch.

Note: Some programs have abbreviated labels for check boxes and drop-
down menus. To see the full spelling of an abbreviated label, tap and hold
the stylus on the label. Drag the stylus off the label so that the command is
not carried out.

The following is a partial list of programs that are on your 700 Series
Computer. Look on the Pocket PC Companion CD for additional pro-
grams that you can install onto your 700 Series Computer.

ActiveSync
Synchronize information between your 700 Series Computer and desktop
computer.

Calendar
Keep track of your appointments and create meeting requests.

Contacts
Keep track of your friends and colleagues.

Inbox
Send and receive e-mail messages.

Pocket Internet Explorer
Browse Web and WAP (Wireless Application Protocol) sites, and download
new programs and files from the Internet.

Notes
Create handwritten or typed notes, drawings, and recordings.

Tasks
Keep track of your tasks.

Pocket Excel
Create new workbooks or view and edit Excel workbooks created on your
desktop computer.

MSN Messenger
Send and receive instant messages with your MSN Messenger contacts.

Pocket Word
Create new documents or view and edit Word documents created on your
desktop computer.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active
program and current time, and allows you to switch to programs and close
screens.

Use the command bar at the bottom of the screen to perform tasks in pro-
grams. The command bar includes menu names, buttons, and the Input
Panel button. To create a new item in the current program, tap New. To
see the name of a button, tap and hold the stylus on the button. Drag the
stylus off the button so that the command is not carried out.
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Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For
example, you can use the pop-up menu in the contact list to quickly delete
a contact, make a copy of a contact, or send an e-mail message to a con-
tact. The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item name that you
want to perform the action on. When the menu appears, lift the stylus,
and tap the action you want to perform. Or tap anywhere outside the
menu to close the menu without performing an action.

Notifications

Your 700 Series Computer reminds you in a variety of ways when you
have something to do. For example, if you have set up an appointment in
Calendar, a task with a due date in Tasks, or an alarm in Clock, you will be
notified in any of the following ways:

S A message box appears on the screen.

S A sound, which you can specify, is played.

S A light flashes on your 700 Series Computer.

S A vibrator resonates from the 700 Series Computer.

To choose reminder types and sounds for your 700 Series Computer, tap
Start → Settings → the Personal tab → Sounds & Notifications. The
options you choose here apply throughout the 700 Series Computer.
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Enter Information on Your 700 Series Computer
You have several options for entering new information:

S Use the input panel to enter typed text, either by using the soft key-
board or other input method.

S Write directly on the screen.

S Draw pictures on the screen.

S Speak into your 700 Series Computer microphone to record a message.

S Use Microsoft ActiveSync to synchronize or copy information from
your desktop computer to your 700 Series Computer. For more infor-
mation on ActiveSync, see ActiveSync Help on your desktop computer.

Use the input panel to enter information in any program on your 700
Series Computer. You can either type using the soft keyboard or write
using Block Recognizer, Letter Recognizer, or Transcriber. In either case,
the characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the
arrow next to the Input Panel button to see your choices.
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When you use the input panel, your 700 Series Computer anticipates the
word you are typing or writing and displays it above the input panel.
When you tap the displayed word, it is inserted into your text at the
insertion point. The more you use your 700 Series Computer, the more
words it learns to anticipate.

Note: To change word suggestion options, such as the number of words
suggested at one time, tap Start → Settings → the Personal tab → Input
→ the Word Completion tab.

Typing With the Soft Keyboard
1 Tap the arrow next to the Input Panel button, and then Keyboard.

2 On the soft keyboard that is displayed, tap the keys with your stylus.

Using Block Recognizer
With Block Recognizer, you can input character strokes using the stylus
that are similar to those used on other 700 Series Computers.

1 Tap the arrow next to the Input Panel button, then Block Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Block Recognizer, with Block
Recognizer open, tap the question mark next to the writing area.
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Using Letter Recognizer
With Letter Recognizer, you can write letters using the stylus just as you
would on paper.

1 Tap the arrow next to the Input Panel button, then Letter Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Letter Recognizer, with Letter
Recognizer open, tap the question mark next to the writing area.

Using Transcriber
With Transcriber, you can write anywhere on the screen using the stylus
just as you would on paper. Unlike Letter Recognizer and Block Recogniz-
er, you can write a sentence or more of information. Then, pause and let
Transcriber change the written characters to typed characters.

1 Tap the arrow next to the Input Panel button, and then Transcriber.

2 Write anywhere on the screen.

For specific instructions on using Transcriber, with Transcriber open, tap
the question mark in the lower right hand corner of the screen.

Selecting Typed Text
If you want to edit or format typed text, you must select it first.

S Drag the stylus across the text you want to select.

You can cut, copy, and paste text by tapping and holding the selected
words and then tapping an editing command on the pop-up menu, or by
tapping the command on the Edit menu.
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Writing on the Screen
In any program that accepts writing, such as the Notes program, and in
the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to
write directly on the screen. Write the way you do on paper. You can edit
and format what you have written and convert the information to text at a
later time.

S Tap the Pen button to switch to writing mode. This action displays lines
on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button.
See the documentation for that program to find out how to switch to writ-
ing mode.

Selecting the Writing
If you want to edit or format writing, you must select it first.

1 Tap and hold the stylus next to the text you want to select until the in-
sertion point appears.

2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools → Undo and try again.
You can also select text by tapping the Pen button to deselect it and then
dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with
typed text: tap and hold the selected words and then tap an editing com-
mand on the pop-up menu, or tap the command on the Edit menu.
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Converting Writing to Text
S Tap Tools → Recognize.

If you want to convert only certain words, select them before tapping Rec-
ognize on the Tools menu (or tap and hold the selected words and then tap
Recognize on the pop-up menu). If a word is not recognized, it is left as
writing.
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing. To do so, tap and hold the in-
correct word (tap one word at a time). On the pop-up menu, tap Alterna-
tes. A menu with a list of alternate words appears. Tap the word you want
to use, or tap the writing at the top of the menu to return to the original
writing.

Tips for getting good recognition:

S Write neatly.

S Write on the lines and draw descenders below the line. Write the cross
of the “t” and apostrophes below the top line so that they are not con-
fused with the word above. Write periods and commas above the line.

S For better recognition, try increasing the zoom level to 300% using the
Tools menu.

S Write the letters of a word closely and leave big gaps between words so
that the 700 Series Computer can easily tell where words begin and end.

S Hyphenated words, foreign words that use special characters such as ac-
cents, and some punctuation cannot be converted.

S If you add writing to a word to change it (such as changing a “3” to an
“8”) after you attempt to recognize the word, the writing you add will
not be included if you attempt to recognize the writing again.
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Drawing on the Screen
You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you se-
lect items and how they can be edited. For example, selected drawings can
be resized, while writing cannot.

Creating a Drawing
S Cross three ruled lines on your first stroke. A drawing box appears. Sub-

sequent strokes in or touching the drawing box become part of the dra-
wing. Drawings that do not cross three ruled lines will be treated as
writing.

Note: You may want to change the zoom level so that you can more easily
work on or view your drawing. Tap Tools and then a zoom level.

Selecting a Drawing
If you want to edit or format a drawing, you must select it first.

S Tap and hold the stylus on the drawing until the selection handle ap-
pears. To select multiple drawings, deselect the Pen button and then
drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the
selected drawing and then tapping an editing command on the pop-up
menu, or by tapping the command on the Edit menu. To resize a drawing,
make sure the Pen button is not selected, and drag a selection handle.
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Recording a Message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording in
the Notes tab. In the Notes program, you can create a stand-alone record-
ing or include a recording in a written note. If you want to include the re-
cording in a note, open the note first. In the Inbox program, you can add a
recording to an e-mail message.

Creating a Recording
1 Hold your computer’ s microphone near your mouth or source of

sound.

2 Press and hold the Record hardware button on your 700 Series Com-
puter until you hear a beep.

3 While holding down the Record button, make your recording.

4 To stop recording, release the Record button. Two beeps will sound.
The new recording appears in the note list or as an embedded icon.

Note: You can also make a recording by tapping the Record button on the
Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert pre-
set or frequently used messages into the text entry area. To insert a mes-
sage, tap My Text and tap a message.

Note: You can add text after inserting a My Text message before sending
it.

To edit a My Text message, in the Tools menu, tap Edit → My Text Mes-
sages. Select the message you wish to edit and make desired changes.
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Finding and Organizing Information
The Find feature on your 700 Series Computer helps you quickly locate
information.

Tap Start → Find. Enter the text you want to find, select a data type, and
then tap Go to initiate the search.

Note: To quickly find information that is taking up storage space on your
700 Series Computer, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your 700 Series Comput-
er and to organize these files into folders. Tap Start → Programs → File
Explorer.

Note: You can move files in File Explorer by tapping and holding the item
you want to move, and then tapping Cut or Copy and Paste on the pop-
up menu.
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Customizing Your 700 Series Computer
You can customize your 700 Series Computer by adjusting settings and
installing additional software.

Adjusting Settings
You can adjust settings to suit the way you work. To see available options,
tap Start → Settings → either the Personal tab or the System tab located at
the bottom of the screen. You might want to adjust the following:
S Clock:

To change the time or to set alarms.
S Menus:

To customize what appears on the Start menu, and to enable a pop-up
menu from the New button.

S Owner Information:
To enter your contact information.

S Password:
To limit access to your 700 Series Computer.

S Power:
To maximize battery life.

S Today:
To customize the look and information displayed on the Today screen.

Adding or Removing Programs
Programs added to your 700 Series Computer at the factory are stored in
ROM (Read Only Memory). You cannot remove this software, and you
will never accidentally lose ROM contents. ROM programs can be up-
dated using special installation programs with a *.XIP extension. All other
programs and data files added to your 700 Series Computer after factory
installation are stored in RAM (Random Access Memory).
You can install any program created for your 700 Series Computer, as long
as your 700 Series Computer has enough memory. The most popular place
to find software for your 700 Series Computer is on the Pocket PC Web
site (http://www.microsoft.com/mobile/pocketpc).

Adding Programs Using ActiveSync
You will need to install the appropriate software for your 700 Series Com-
puter on your desktop computer before installing it on your 700 Series
Computer.
1 Determine your 700 Series Computer and processor type so that you

know which version of the software to install. Tap Start → Settings →
the System tab → About → the Version tab, then make a note of the
information in Processor.

2 Download the program to your desktop computer (or insert the CD or
disk that contains the program into your desktop computer). You may
see a single *.XIP, *.EXE, or *.ZIP file, a SETUP.EXE file, or several
versions of files for different 700 Series Computer types and processors.
Be sure to select the program designed for the Pocket PC and your 700
Series Computer processor type.
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3 Read any installation instructions, Read Me files, or documentation that
comes with the program. Many programs provide special installation
instructions.

4 Connect your 700 Series Computer and desktop computer.

5 Double-click the *.EXE file.

S If the file is an installer, the installation wizard will begin. Follow the
directions on the screen. Once the software has been installed on your
desktop computer, the installer will automatically transfer the soft-
ware to your 700 Series Computer.

S If the file is not an installer, you will see an error message stating that
the program is valid but it is designed for a different type of comput-
er. You will need to move this file to your 700 Series Computer. If
you cannot find any installation instructions for the program in the
Read Me file or documentation, use ActiveSync Explore to copy the
program file to the Program Files folder on your 700 Series Comput-
er. For more information on copying files using ActiveSync, see Acti-
veSync Help.

Once installation is complete, tap Start → Programs, and then the pro-
gram icon to switch to it.

Adding a Program Directly from the Internet
1 Determine your 700 Series Computer and processor type so that you

know which version of the software to install. Tap Start → Settings →
the System tab → About → the Version tab, then make a note of the
information in Processor.

2 Download the program to your 700 Series Computer straight from the
Internet using Pocket Internet Explorer. You may see a single *.XIP,
*.EXE, or *.ZIP file, a SETUP.EXE file, or several versions of files for
different 700 Series Computer types and processors. Be sure to select the
program designed for the Pocket PC and your 700 Series Computer
processor type.

3 Read any installation instructions, Read Me files, or documentation that
comes with the program. Many programs provide installation instruc-
tions.

4 Tap the file, such as a *.XIP or *.EXE file. The installation wizard will
begin. Follow the directions on the screen.
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Adding a Program to the Start Menu
Tap Start → Settings → Menus → the Start Menu tab, and then the check
box for the program. If you do not see the program listed, you can either
use File Explorer on the 700 Series Computer to move the program to the
Start Menu folder, or use ActiveSync on the desktop computer to create a
shortcut to the program and place the shortcut in the Start Menu folder.

S Using File Explorer on the 700 Series Computer:
Tap Start → Programs → File Explorer, and locate the program (tap the
folder list, labeled My Documents by default, and then My Device to
see a list of all folders on the 700 Series Computer). Tap and hold the
program and tap Cut on the pop-up menu. Open the Start Menu fold-
er located in the Windows folder, tap and hold a blank area of the win-
dow, and tap Paste on the pop-up menu. The program will now appear
on the Start menu. For more information on using File Explorer, see
“Finding and Organizing Information” on page 25.

S Using ActiveSync on the desktop computer:
Use the Explorer in ActiveSync to explore your 700 Series Computer
files and locate the program. Right-click the program, and then click
Create Shortcut. Move the shortcut to the Start Menu folder in the
Windows folder. The shortcut now appears on the Start menu. For
more information, see ActiveSync Help.

Removing Programs
S Tap Start → Settings → the System tab → Remove Programs.

If the program does not appear in the list of installed programs, use File
Explorer on your 700 Series Computer to locate the program, tap and hold
the program, and then tap Delete on the pop-up menu.
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Microsoft ActiveSync
Visit the following Microsoft Web site for the latest in updates, technical
information, and samples:

S http://www.microsoft.com/mobile/pocketpc/downloads/activesync.asp

Using Microsoft ActiveSync, you can synchronize the information on your
desktop computer with the information on your 700 Series Computer.
Synchronization compares the data on your 700 Series Computer with
your desktop computer and updates both computers with the most recent
information. For example:

S Keep Pocket Outlook data up-to-date by synchronizing your 700 Series
Computer with Microsoft Outlook data on your desktop computer.

S Synchronize Microsoft Word and Microsoft Excel files between your
700 Series Computer and desktop computer. Your files are automatically
converted to the correct format

Note: By default, ActiveSync does not automatically synchronize all types
of information. Use ActiveSync options to turn synchronization on and off
for specific information types.

With ActiveSync, you can also:

S Back up and restore your 700 Series Computer data.

S Copy (rather than synchronize) files between your 700 Series Computer
and desktop computer.

S Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose the synchronize com-
mand.

S Select which information types are synchronized and control how much
data is synchronized. For example, you can choose how many weeks of
past appointments you want synchronized.

Before you begin synchronization, install ActiveSync on your desktop
computer from the Pocket PC Companion CD. For more information on
installing ActiveSync, see your Quick Start card. ActiveSync is already
installed on your 700 Series Computer.

After installation is complete, the ActiveSync Setup Wizard helps you con-
nect your 700 Series Computer to your desktop computer, set up a part-
nership so you can synchronize information between your 700 Series
Computer and your desktop computer, and customize your synchroniza-
tion settings. Your first synchronization process will automatically begin
when you finish using the wizard.

After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your 700 Series Computer. You will notice that information you
have stored in Microsoft Outlook on your desktop computer has been
copied to your 700 Series Computer, and you did not have to type a word.
Disconnect your 700 Series Computer from your computer and you are
ready to go!
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Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your 700 Series Computer.
To switch to ActiveSync on your 700 Series Computer, tap Start →
ActiveSync. Note that if you have a wireless LAN card, you can
synchronize remotely from your 700 Series Computer.

For information about using ActiveSync on your desktop computer, start
ActiveSync on your desktop computer, and then see ActiveSync Help.

For more information about ActiveSync on your 700 Series Computer,
switch to ActiveSync, then tap Start → Help.



Pocket PC 2002—Chapter 2

31700 Series Color Mobile Computer User’s Manual

Microsoft Pocket Outlook
Note: The Professional Edition of Microsoft Pocket Outlook does not in-
clude a spell checker.

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
e-mail addresses stored in Contacts can be used to address e-mail messages
in Inbox.

Using ActiveSync, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your 700 Series
Computer. You can also synchronize this information directly with a
Microsoft Exchange server. Each time you synchronize, ActiveSync
compares the changes you made on your 700 Series Computer and desk-
top computer or server and updates both computers with the latest in-
formation. For information on using ActiveSync, see ActiveSync Help on
the desktop computer.

You can switch to any of these programs by tapping them on the Start
menu.

Calendar: Scheduling Appointments and Meetings
Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views (Agenda,
Day, Week, Month, and Year) and easily switch views by using the View
menu.



Pocket PC 2002Chapter —2

32 700 Series Color Mobile Computer User’s Manual

Note: You can customize the Calendar display, such as changing the first
day of the week, by tapping Options on the Tools menu.

Creating an Appointment
1 If you are in Day or Week view, tap the desired date and time for the

appointment.

2 Tap New.

3 Using the input panel, enter a description and a location. Tap first to
select the field.

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the input panel
to see all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” on page 40.

7 When finished, tap OK to return to the calendar.

Note: If you select Remind me in an appointment, your 700 Series Com-
puter will remind you according to the options set in Start → Settings →
the Personal tab → Sounds & Reminders.
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed.
To change the appointment, tap Edit.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting request will be created automatically and sent either
when you synchronize Inbox or when you connect to your e-mail server.
Indicate how you want meeting requests sent by tapping Tools →
Options. If you send and receive e-mail messages through ActiveSync,
select ActiveSync.

Scheduling a Meeting
1 Create an appointment.

2 In the appointment details, hide the input panel, and then tap
Attendees.

3 From the list of e-mail addresses you have entered in Contacts, select the
meeting attendees.

The meeting notice is created automatically and placed in the Outbox
folder.

For more information on sending and receiving meeting requests, see Cal-
endar Help and Inbox Help on the 700 Series Computer.
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Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can
easily find the information you are looking for, whether you are at home
or on the road. Using the 700 Series Computer infrared (IR) port, you can
quickly share Contacts information with other 700 Series Computer users.

Note: To change the way information is displayed in the list, tap Tools →
Options.

Creating a Contact
1 Tap New.

2 Using the input panel, enter a name and other contact information. You
will need to scroll down to see all available fields.

3 To assign the contact to a category, scroll to and tap Categories and se-
lect a category from the list. In the contact list, you can display contacts
by category.

4 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” on page 40.
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5 When finished, tap OK to return to the contact list.

Finding a Contact
There are four ways to find a contact:

S In the contact list, enter a contact name in the box under the navigation
bar. To show all contacts again, clear text from the box or tap the button
to the right of the box.

S In the contact list, tap the category list (labeled All Contacts by default)
and select the type of contact that you want displayed. To show all con-
tacts again, select All Contacts. To view a contact not assigned to a cate-
gory, select None.

S To view the names of companies your contacts work for, in the contact
list, tap View → By Company. The number of contacts that work for
that company will be displayed to the right of the company name.

S Tap Start → Find, enter the contact name, select Contacts for the type,
and then tap Go.
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.
To change the contact information, tap Edit.
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Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do.

Note: To change the way information is displayed in the list, tap Tools →
Options.
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Creating a Task
1 Tap New.

2 Using the input panel, enter a description.

3 You can enter a start date and due date or enter other information by
first tapping the field. If the input panel is open, you will need to hide it
to see all available fields.

4 To assign the task to a category, tap Categories and select a category
from the list. In the task list, you can display tasks by category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes: Capturing
Thoughts and Ideas” on page 40.

6 When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the
Tools menu. Then, tap Tap here to add a new task and enter your task
information.
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To
change the task, tap Edit.
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Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers
with Notes. You can create a written note or a recording. You can also in-
clude a recording in a note. If a note is open when you create the record-
ing, it will be included in the note as an icon. If the note list is displayed, it
will be created as a stand-alone recording.
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Creating a Note
1 Tap New.

2 Create your note by writing, drawing, typing, and recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see “Basic Skills” on page 11.
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Inbox: Sending and Receiving E-mail Messages
Use Inbox to send and receive e-mail messages in either of these ways:

S Synchronize e-mail messages with Microsoft Exchange or Microsoft
Outlook on your desktop computer.

S Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet Service Provider (ISP) or a network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization
process. You will need to enable Inbox synchronization in ActiveSync. For
information on enabling Inbox synchronization, see ActiveSync Help on the
desktop computer. During synchronization:

S Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your 700
Series Computer. By default, you will receive messages from the past
three days only, the first 100 lines of each message, and file attachments
of less than 100 KB in size.

S E-mail messages in the Outbox folder on your 700 Series Computer are
transferred to Exchange or Outlook, and then sent from those pro-
grams.

S E-mail messages in subfolders must be selected in ActiveSync on your
desktop computer in order to be transferred.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail server
using a modem or network card connected to your 700 Series Computer.
You will need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see “Getting Con-
nected” on page 67.

When you connect to the e-mail server, new messages are downloaded to
the 700 Series Computer Inbox folder, messages in the 700 Series Com-
puter Outbox folder are sent, and messages that have been deleted on the
e-mail server are removed from the 700 Series Computer Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a mes-
sage on your 700 Series Computer, it is also deleted from the e-mail server
the next time you connect based on the settings selected in ActiveSync.

You can work online or offline. When working online, you read and re-
spond to messages while connected to the e-mail server. Messages are sent
as soon as you tap Send, which saves space on your 700 Series Computer.

When working offline, once you have downloaded new message headers or
partial messages, you can disconnect from the e-mail server and then de-
cide which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval and
sends the messages you have composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most
recently received messages are displayed first in the list.
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When you receive a message, tap it to open it. Unread messages are dis-
played in bold.

When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new message, and file attachments of less
than 100 KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You specify your downloading preferences when you set up the service or
select your synchronization options. You can change them at any time:

S Change options for Inbox synchronization using ActiveSync options.
For more information, see ActiveSync Help.

S Change options for direct e-mail server connections in Inbox on your
700 Series Computer. Tap Tools → Options → the Service tab, then
tap the service you want to change. Tap and hold the service and select
Delete to remove a service.
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Composing Messages
To compose a message:

1 Tap New.

2 In the To field, enter an e-mail or SMS address of one or more recipi-
ents, separating them with a semicolon, or select a name from the con-
tact list by tapping the Address Book button. All e-mail addresses en-
tered in the e-mail fields in Contacts appear in the Address Book.

3 Compose your message. To enter preset or frequently used messages, tap
My Text and select a message.

4 Tap Send when you have finished the message. If you are working of-
fline, the message is moved to the Outbox folder and will be sent the
next time you connect.

If you are sending an SMS message and want to know if it was received,
tap Edit → Options → Request SMS text message delivery notification
before sending the message.
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Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service
you have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items.
The Deleted Items folder contains messages that have been deleted on the
700 Series Computer. The behavior of the Deleted and Sent Items folders
depends on the options you have chosen. In the message list, tap Tools →
Options → the Message tab, then select your options.

If you want to organize messages into additional folders, tap Tools →
Manage Folders to create new folders. To move a message to another fold-
er, in the message list, tap and hold the message and then tap Move to on
the pop-up menu.

Folder Behavior With a Direct Connection to an E-mail Server
The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

S If you use ActiveSync:
E-mail messages in the Inbox folder in Outlook will automatically be
synchronized with your 700 Series Computer. You can select to syn-
chronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox fold-
er to a folder named Family, and you have designated Family for syn-
chronization, the server creates a copy of the Family folder and copies
the messages into that folder. You can then read the messages while away
from your desktop computer.

S If you use SMS:
Messages are stored in the Inbox folder.

S If you use POP3:
and you move e-mail messages to a folder you created, the link is broken
between the messages on the 700 Series Computer and their copies on
the mail server. The next time you connect, the mail server will see that
the messages are missing from the 700 Series Computer Inbox and de-
lete them from the server. This prevents you from having duplicate cop-
ies of a message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
700 Series Computer.

S If you use IMAP4:
The folders you create and the e-mail messages you move are mirrored
on the server. Therefore, messages are available to you anytime you con-
nect to your mail server, whether it is from your 700 Series Computer
or desktop computer. This synchronization of folders occurs whenever
you connect to your mail server, create new folders, or rename/delete
folders when connected.
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Companion Programs
The companion programs consist of Microsoft Pocket Word, Microsoft
Pocket Excel, Windows Media Player for Pocket PC, and Microsoft
Reader. To switch to a companion program on your 700 Series Computer,
tap Start → Programs, then tap the program name.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to
give you easy access to copies of your documents. You can create new doc-
uments on your 700 Series Computer, or you can copy documents from
your desktop computer to your 700 Series Computer. Synchronize docu-
ments between your desktop computer and your 700 Series Computer so
that you have the most up-to-date content in both locations.

Creating a Document
Use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports. To create a new file, tap Start → Programs → Pocket
Word → New. A blank document appears. Or, if you have selected a tem-
plate for new documents in the Options dialog box, that template appears
with appropriate text and formatting already provided. You can open only
one document at a time; when you open a second document, you will be
asked to save the first. You can save a document you create or edit in a va-
riety of formats, including Word (.DOC), Pocket Word (.PSW), Rich Text
Format (.RTF), and Plain Text (.TXT).



Pocket PC 2002Chapter —2

48 700 Series Color Mobile Computer User’s Manual

Pocket Word contains a list of the files stored on your 700 Series Comput-
er. Tap a file in the list to open it. To delete, make copies of, and send files,
tap and hold a file in the list. Then, select the appropriate action on the
pop-up menu.

You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, and recording), which are displayed on the View menu.
Each mode has its own toolbar, which you can show and hide by tapping
the Show/Hide Toolbar button on the command bar.

Note: You can change the zoom magnification by tapping View → Zoom,
then select the percentage you want. Select a higher percentage to enter
text and a lower one to see more of your document.

If you are opening a Word document created on a desktop computer, select
Wrap to Window on the View menu so that you can see the entire
document.
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Typing Mode
Using the input panel, enter typed text into the document. For more infor-
mation on entering typed text, see “Basic Skills” on page 11.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit → Find/Replace.
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled
lines are displayed as a guide, and the zoom magnification is greater than
in typing mode to allow you to write more easily. For more information on
writing and selecting writing, see “Basic Skills” on page 11.

Note: If you cross three ruled lines in a single stylus stroke, the writing
becomes a drawing, and can be edited and manipulated as described in
“Drawing Mode” on the next page.

Written words are converted to graphics (metafiles) when a Pocket Word
document is converted to a Word document on your desktop computer.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Grid lines appear
as a guide. When you lift your stylus off the screen after the first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
“Basic Skills” on page 11.

Recording Mode
In recording mode, embed a recording into your document. Recordings are
saved as .WAV files. For more information on recording, see “Basic Skills”
on page 11.

For more information on using Pocket Word, tap Start → Help.
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to
give you easy access to copies of your workbooks. You can create new
workbooks on your 700 Series Computer, or you can copy workbooks
from your desktop computer to your 700 Series Computer. Synchronize
workbooks between your desktop computer and your 700 Series Comput-
er so that you have the most up-to-date content in both locations.

Creating a Workbook
Use Pocket Excel to create workbooks, such as expense reports and mileage
logs. To create a new file, tap Start → Programs → Pocket Excel → New.
A blank workbook appears. Or, if you have selected a template for new
workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only one
workbook at a time; when you open a second workbook, you will be asked
to save the first. You can save a workbook you create or edit in a variety of
formats, including Pocket Excel (.PXL) and Excel (.XLS).

Pocket Excel contains a list of the files stored on your 700 Series Comput-
er. Tap a file in the list to open it. To delete, make copies of, and send files,
tap and hold a file in the list. Then select the appropriate action from the
pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View →
Toolbar.
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Note: If your workbook contains sensitive information, you can protect it
with a password. To do so, open the workbook, tap Edit → Password. Ev-
ery time you open the workbook, you will need to enter the password, so
choose one that is easy for you to remember but hard for others to guess.

Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

S View in full-screen mode to see as much of your worksheet as possible.
Tap View → Full Screen. To exit full-screen mode, tap Restore.

S Show and hide window elements. Tap View and then tap the elements
you want to show or hide.

S Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View → Freeze Panes. You might want to freeze the
top and leftmost panes in a worksheet to keep row and column labels
visible as you scroll through a sheet.

S Split panes to view different areas of a large worksheet. Tap View →
Split. Then drag the split bar to where you want it. To remove the split,
tap View → Remove Split.

S Show and hide rows and columns. To hide a hidden row or column, se-
lect a cell in the row or column you want to hide. Then tap Format ,
Row or Column → Hide. To show a hidden row or column, tap Tools
→ Go To, and then type a reference that is in the hidden row or co-
lumn. Then tap Format → Row or Column → Unhide.

For more information on using Pocket Excel, tap Start → Help.

MSN Messenger
Note: MSN Messenger is only available on the Premium Edition of Pocket
PC 2002.

MSN Messenger on your 700 Series Computer is an instant messaging
program that lets you:

S See who is online.

S Send and receive instant messages.

S Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport account or a
Microsoft Exchange e-mail account. You must have a Passport to use MSN
Messenger Service. If you have a Hotmail or MSN account, you already
have a Passport. Once you have obtained either a Microsoft Passport or a
Microsoft Exchange account, you are ready to set up your account.

S Sign up for a Microsoft Passport account at http://www.passport.com.

S Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To switch to MSN Messenger, tap Start → Programs → MSN Messenger.
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Setting Up
Before you can connect, you must enter Passport or Exchange account in-
formation. To set up an account and sign in:

1 In the Tools menu, tap Options.

2 In the Accounts tab, enter your Passport or Exchange account informa-
tion.

3 To sign in, tap the sign-in screen and enter your e-mail address and pass-
word.

Note: If you already use MSN Messenger on your desktop computer, your
contacts will show up on your 700 Series Computer without being added
again.

Working with Contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send e-mail, block the contact from chat-
ting with you, or delete contacts from your list using the pop-up menu.

Note: To see others online without being seen, in the Tools menu, tap My
Status → Appear Offline.

If you block a contact, you will appear offline but will remain on the
blocked contact’ s list. To unblock a contact, tap and hold the contact, then
tap Unblock on the pop-up menu.
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Chatting with Contacts
Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, and tap Send. To invite another contact to a multi-user chat, in
the Tools menu, tap Invite and tap the contact you want to invite.

Note: To switch back to the main window without closing a chat, tap the
Contacts button. To revert back to your chat window, tap Chats and select
the person whom you were chatting with.
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To know if the contact you are chatting with is responding, look for the
message under the text entry area.

For more information on using MSN Messenger, tap Start → Help.
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Windows Media Player for Pocket PC
Use Microsoft Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your 700 Series Computer or on a net-
work. To switch to Windows Media Player for Pocket PC, tap Start →
Programs → Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video files to your Pocket PC. You can play Windows
Media and MP3 files on your Pocket PC.

For more information about using Windows Media Player for Pocket PC,
tap Start → Help.
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Microsoft Reader
Use Microsoft Reader to read eBooks on your 700 Series Computer.
Download books to your desktop computer from your favorite eBook Web
site. Then, use ActiveSync to copy the book files to your activated 700 Se-
ries Computer. The books appear in the Reader Library, where you can tap
them in the list to open them. Each book consists of a cover page, an op-
tional table of contents, and the pages of the book. You can:

S Page through the book by using the Up/Down control on your 700 Se-
ries Computer or by tapping the page number on each page.

S Annotate the book with highlighting, bookmarks, notes, and drawings.

S Search for text and look up definitions for words.

The Guidebook contains all the information you will need to use the soft-
ware. To open the Guidebook, tap Help on the Reader command bar. Or,
on a book page, tap and hold on the book title, and then tap Help on the
pop-up menu. To switch to Microsoft Reader, tap Start → Programs →
Microsoft Reader.

Getting Books on Your 700 Series Computer
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary are also included in the MSReader folder in
the Extras folder on the Pocket PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your
activated mobile computer as described in the Read Me file in the
MSReader folder.
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Using the Library
The Library is your Reader home page; it displays a list of all books stored
on your 700 Series Computer or storage card. To open the Library:

1 On the Reader command bar, tap Library.

2 On a book page, tap the book title, then tap Library on the pop-up
menu.

3 To open a book, tap its title in the Library list.
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Reading a Book
Each book consists of a cover page, an optional table of contents, and the
pages of the book. Navigation options are listed in the bottom portion of
the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open the book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and book
title.

You can also page through a book by using the Up/Down control on your
700 Series Computer.
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Using Reader Features
Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on
the pop-up menu, as described here:

S Searching for Text
Find text in a book by tapping Find on the pop-up menu. Enter the
word you want to search for, and tap the desired Find option. Reader
highlights found text on the page. To close Find, tap outside the box.
To return to your original page, tap the title and then tap Return on the
pop-up menu.

S Copying Text
You can copy text from books that support this feature into any pro-
gram that accepts text. On a book page, select the text you want to copy.
Then, tap Copy Text on the pop-up menu. The text can be pasted into
the program of your choice.

S Adding Bookmarks
When you add a bookmark to a book, a color-coded bookmark icon
appears in the right margin. You can add multiple bookmarks to a book.
Then, from anywhere in the book, tap the bookmark icon to go to the
bookmarked page.

S Highlighting Text
When you highlight text, it appears with a colored background.

S Attaching Notes to Text
When you attach a note to text, you enter the text in a notepad that ap-
pears on top of the book page. A Note icon will display in the left mar-
gin. To show or hide the note, tap the icon.

S Adding Drawings
When you add a drawing, a Drawing icon appears in the bottom-left
corner of the page, and drawing tools appear across the bottom of the
page. Draw by dragging your stylus.

S Annotations Index
To see a list of a book’ s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’ s cover
page. You can tap an entry in the list to go to the annotated page.

Removing a Book
When you finish reading a book, you can delete it to conserve space on
your 700 Series Computer. If a copy of the book is stored on your desktop
computer, you can download it again at any time.

To remove a book from your 700 Series Computer, tap and hold the title
in the Library list, and then tap Delete on the pop-up menu.
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Pocket Internet Explorer
Note: The Professional Edition of Pocket Internet Explorer does not sup-
port WAP pages.

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in ei-
ther of these ways:

S During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile Favor-
ites subfolder in Internet Explorer on the desktop computer.

S Connect to an ISP or network and browse the Web. To do this, you will
need to create the connection first, as described in “Getting Connected”
on page 67.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap Start → Internet Explorer.

The Mobile Favorites Folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder
in Internet Explorer on your desktop computer will be synchronized with
your 700 Series Computer. This folder was created automatically when
you installed ActiveSync.

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet Ex-
plorer on your 700 Series Computer. Both computers are updated with
changes made to either list each time you synchronize. Unless you mark
the favorite link as a mobile favorite, only the link will be downloaded to
your 700 Series Computer, and you will need to connect to your ISP or
network to view the content. For more information on synchronization,
see ActiveSync Help on the desktop computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your 700 Series Comput-
er. Synchronizing mobile favorites downloads Web content to your 700
Series Computer so that you can view pages while you are disconnected
from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mo-
bile favorites quickly. To create a mobile favorite:

1 In Internet Explorer on your desktop computer, click Tools → Create
Mobile Favorite.

2 To change the link name, enter a new name in the Name box.

3 Optionally, in Update, select a desired update schedule.
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4 Click OK. Internet Explorer downloads the latest version of the page to
your desktop computer.

5 If you want to download the pages that are linked to the mobile favorite
you just created, in Internet Explorer on the desktop computer,
right-click the mobile favorite just created and then click Properties. In
the Download tab, specify the number of links deep you want to
download. To conserve 700 Series Computer memory, go only one level
deep.

6 Synchronize your 700 Series Computer and desktop computer. Mobile
favorites that are stored in the Mobile Favorites folder in Internet Ex-
plorer are downloaded to your 700 Series Computer.

Note: If you did not specify an update schedule in step 3 above, you will
need to manually download content to keep the information updated on
your desktop computer and 700 Series Computer. Before synchronizing
with your 700 Series Computer, in Internet Explorer on your desktop
computer, click Tools → Synchronize. You will see the last time content
was downloaded to the desktop computer, and you can manually download
content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile
favorites. In Internet Explorer on your desktop computer, click View →
Toolbars → Customize.

Mobile favorites take up storage memory on your 700 Series Computer.
To minimize the amount of memory used:

S In the settings for the Favorites information, type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the 700 Series Computer. For more information, see Ac-
tiveSync Help.

S Limit the number of downloaded linked pages. In Internet Explorer on
the desktop computer, right-click the mobile favorite you want to
change and then Properties. In the Download tab, specify “0” or “1” for
the number of linked pages you want to download.
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Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your 700 Series Computer. Then, you synchronize
your 700 Series Computer and desktop computer, or connect to the Inter-
net to download the content. For more information, visit the AvantGo
Web site. To sign up for AvantGo:

1 In ActiveSync options on the desktop computer, turn on synchroniza-
tion for the AvantGo information type.

2 In Pocket Internet Explorer on your 700 Series Computer, tap the Fa-
vorites button to display your list of favorites.

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your
700 Series Computer with your desktop computer and then tap the My
Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in
your list of favorites to see a few of the most popular channels. To add or
remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and chan-
nels that have been downloaded to your 700 Series Computer without
connecting to the Internet. You can also connect to the Internet through
an ISP or a network connection and browse the Web.
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Viewing Mobile Favorites and Channels
1 Tap the Favorites button to display your list of favorites.

2 Tap the page you want to view.

You will see the page that was downloaded the last time you synchronized
with your desktop computer. If the page is not on your 700 Series Com-
puter, the favorite will be dimmed. You will need to synchronize with your
desktop computer again to download the page to your 700 Series Comput-
er, or connect to the Internet to view the page.

Browsing the Internet
1 Set up a connection to your ISP or corporate network using Connec-

tions, as described in “Getting Connected” on page 67.

2 To connect and start browsing, do one of the following:

S Tap the Favorites button, and then tap the favorite you want to view.

S Tap View → Address Bar. In the address bar that appears at the top
of the screen, enter the Web address you want to visit and then tap
Go. Tap the arrow to choose from previously entered addresses.

Note: To add a favorite link while using the 700 Series Computer, go to
the page you want to add, tap and hold on the page, and tap Add to
Favorites.
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Getting Connected
You can use your 700 Series Computer to exchange information with oth-
er 700 Series Computers as well as your desktop computer, a network, or
the Internet. You have the following connection options:

S Use the infrared (IR) port on your 700 Series Computer to send and
receive files between two 700 Series Computers. If this is the method
you want to use, see “Transferring Items Using Infrared” below.

S Connect to your ISP. Once connected, you can send and receive e-mail
messages by using Inbox and view Web or WAP pages by using Pocket
Internet Explorer. The communication software for creating an ISP con-
nection is already installed on your 700 Series Computer. Your service
provider will provide software needed to install other services, such as
paging and fax services. If this is the method you want to use, see “Con-
necting to an Internet Service Provider” on page 68.

S Connect to the network at your company or organization where you
work. Once connected, you can send and receive e-mail messages by
using Inbox, view Web or WAP pages by using Pocket Internet Explorer,
and synchronize with your desktop computer. If this is the method you
want to use, see “Connecting to Work” on page 70.

S Connect to your desktop computer to synchronize remotely. Once con-
nected, you can synchronize information such as your Pocket Outlook
information. If this is the method you want to use, see ActiveSync Help
on your desktop computer or Connections Help on the 700 Series
Computer.

Transferring Items Using Infrared
Using infrared (IR), you can send and receive information, such as con-
tacts and appointments, between two 700 Series Computers.

Sending Information
1 Switch to the program where you created the item you want to send and

locate the item in the list.

2 Align the IR ports so that they are unobstructed and within a close
range.

3 Tap and hold the item, and tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer. Tap
and hold the item you want to send, and then tap Beam File on the pop-
up menu.

Receiving Information
1 Align the IR ports so that they are unobstructed and within a close

range.

2 Have the owner of the other 700 Series Computer send the information
to you. Your 700 Series Computer will automatically receive it.
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Connecting to an Internet Service Provider
You can connect to your ISP, and use the connection to send and receive
e-mail messages and view Web or WAP pages. You can connect to your
ISP in one of two ways:

S Create a modem connection. If this is the method you want to use, see
“Creating a Modem Connection to an ISP” below.

S Use an Ethernet card and a net tap to connect to the network. If this is
the method you want to use, see “Creating an Ethernet Connection to an
ISP” on page 69.

Creating a Modem Connection to an ISP
1 Obtain the following information from your ISP. Some ISPs require in-

formation in front of the user name, such as MSN/username.

S ISP dial-up access telephone number

S User name

S Password

S TCP/IP settings

2 If your 700 Series Computer does not have a built-in modem, install a
modem card, or use or use a NULL modem cable and appropriate
adapters to connect an external modem to your 700 Series Computer
through the serial port.

3 Tap Start → Settings → the Connections tab → Connections. Under
The Internet settings, select Internet Settings → Modify.

4 In the Modem tab, tap New.

5 Enter a name for the connection, such as “ISP Connection.”

6 In Select a modem list, select your modem type. If your modem type
does not appear, try reinserting the modem card. If you are using an ex-
ternal modem that is connected to your 700 Series Computer with a
cable, select “Hayes Compatible on COM1.”

7 You should not need to change any settings in Advanced. Most ISPs
now use a dynamically-assigned address. If the ISP you are connecting
to does not use a dynamically-assigned address, tap Advanced → the
TCP/IP tab, then enter the address. When finished, tap OK → Next.

8 Enter the access phone number, and tap Next.

9 Select other desired options, and tap Finish.

10 In the Dialing Locations tab, specify your current location and phone
type (most phone lines are tone). These settings will apply to all connec-
tions you create.
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To start the connection, simply start using one of the following programs.
Your 700 Series Computer will automatically begin connecting. Once con-
nected, you can:

S Send and receive e-mail messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the e-mail server. For specific instructions, see “Connecting Directly
to an E-mail Server” on page 72.

S Visit Web and WAP pages by using Pocket Internet Explorer. For more
information, see “Pocket Internet Explorer” on page 62.

S Send and receive instant messages with MSN Messenger. For more in-
formation, see “MSN Messenger” on page 53.

Creating an Ethernet Connection to an ISP
1 You do not need to create a new connection on your 700 Series Com-

puter. Instead, you must purchase a dock to enable on-board Ethernet
or purchase a CompactFlash Ethernet card that is compatible with your
700 Series Computer.

2 Obtain the following information from your ISP:

S User name

S Password

S Domain name

3 Insert the Ethernet card into your 700 Series Computer. For instruc-
tions on inserting and using the Ethernet card, see the owner’ s manual.

If using an on-board Ethernet, place your 700 Series Computer in a dock,
tap Start → Today, then look in the System Tray for the Ethernet icon
(shown left). If not there, then tap the antenna icon for the NDISTRAY
pop-up menu and select Built-in Ethernet from the menu.

4 The first time you insert the card, Network Settings will appear
automatically so that you can configure the Ethernet card. Most
networks use DHCP, so you should not have to change these settings
unless your network administrator instructs you to do so. Tap OK. (If it
does not appear or to change settings later, tap Start → Settings → the
Connections tab → Network, tap the adapter you want to change, and
then tap Properties.)

S If using an on-board Ethernet, then select Start → Settings → the
Connections tab → Network Adapters. Select “NE2000 Compatible
Ethernet Driver” from the list of adapters installed, then tap Proper-
ties to configure the Ethernet driver.
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5 Connect the Ethernet card or dock to the network by using a network
cable. For information, see your owner’ s manual.

6 Tap Start → Settings → the Connections tab → Connections. From
the My network card connects to list, select “Internet.”

To start the connection, simply start using one of the programs listed in
the preceding section. Once connected, you can perform the same activi-
ties as listed in the preceding section.

Connecting to Work
If you have access to a network at work, you can send e-mail messages,
view intranet pages, synchronize your 700 Series Computer, and possibly
access the Internet. You can connect to work in one of two ways:

S Create a modem connection by using a RAS (Remote Access Server) ac-
count. Before you can create this modem connection, your network ad-
ministrator will need to set up a RAS account for you. If this is the
method you want to use, see “Creating a Modem Connection to Work”
below. Your network administrator may also give you VPN settings.

S Use an Ethernet card and a net tap to connect to the network. If this is
the method you want to use, see “Creating an Ethernet Connection to
Work” on page 71.

Creating a Modem Connection to Work
1 Get the following information from your network administrator:

S Dial-up access telephone number

S User name

S Password

S Domain name

S TCP/IP settings

2 If your 700 Series Computer does not have a built-in modem, install a
modem card.

3 Tap Start → Settings → the Connections tab → Connections. Under
The Internet settings, select Internet Settings and tap Modify.

4 In the Modem tab, tap New.

5 Enter a name for the connection, such as “Company Connection.”

6 In the Select a modem list, select your modem type. If your modem
type does not appear, try reinserting the modem card. If you are using
an external modem that is connected to your 700 Series Computer with
a cable, select “Hayes Compatible on COM1.”

7 You should not need to change any settings in Advanced. Most servers
now use a dynamically-assigned address. If the server you are connecting
to does not use a dynamically-assigned address, tap Advanced → the
TCP/IP tab and then enter the address. When finished, tap OK →
Next.



Pocket PC 2002—Chapter 2

71700 Series Color Mobile Computer User’s Manual

8 Enter the access phone number, and tap Next.

9 Select other desired options, and tap Finish.

10 In the Dialing Locations tab, specify your current location and phone
type (most phone lines are tone). These settings will apply to all connec-
tions you create.

To start the connection, start using one of the following programs. Your
700 Series Computer will automatically begin connecting. Once con-
nected, you can:

S Send and receive e-mail messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the e-mail server. For specific instructions, see “Connecting Directly
to an E-mail Server” on page 72.

S Visit Internet or intranet Web or WAP pages via Pocket Internet Explor-
er.

S Send and receive instant messages with MSN Messenger. For more in-
formation, see “MSN Messenger” on page 53.

S Synchronize. For more information, see ActiveSync Help on the desktop
computer.

Creating an Ethernet Connection to Work
1 You do not need to create a new connection on your 700 Series Com-

puter. Instead, you must purchase a dock to enable on-board Ethernet
or purchase a CompactFlash Ethernet card that is compatible with your
700 Series Computer.

2 Obtain the following information from your ISP:

S User name

S Password

S Domain name

3 Insert the Ethernet card into your 700 Series Computer. For instruc-
tions on inserting and using the Ethernet card, see the owner’ s manual.

S If using an on-board Ethernet, place your 700 Series Computer in a
dock, tap Start → Today, then look in the System Tray for the Ether-
net icon (shown left). If not there, then tap the antenna icon for the
NDISTRAY pop-up menu and select Built-in Ethernet from the
menu.
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4 The first time you insert the card, Network Settings will appear
automatically so that you can configure the Ethernet card. Most
networks use DHCP, so you should not have to change these settings
unless your network administrator instructs you to do so. Tap OK. (If it
does not appear or to change settings later, tap Start → Settings → the
Connections tab → Network, tap the adapter you want to change, and
then tap Properties.)

S If using an on-board Ethernet, then select Start → Settings → the
Connections tab → Network Adapters. Select “NE2000 Compatible
Ethernet Driver” from the list of adapters installed, then tap Proper-
ties to configure the Ethernet driver.

5 Connect the Ethernet card or dock to the network by using a network
cable. For information, see your owner’ s manual.

6 To synchronize your 700 Series Computer, tap Start → ActiveSync. In
the Tools menu, tap Options. → the PC tab, select Include PC when
synchronizing remotely and connect to, and select your computer’ s
name. Remote synchronization with a desktop computer will work only
if a partnership is set up with that computer through ActiveSync and
ActiveSync is set to allow remote connections. Other restrictions apply.
For more information, see ActiveSync Help on the desktop computer.

To start the connection, simply start using one of the programs listed in
the preceding section. Once connected, you can perform the same activi-
ties as listed in the preceding section.

Ending a Connection
To disconnect, do one of the following:

S When connected via dial-up or VPN, tap the Connection icon (shown
left) on your navigation bar, and then tap End.

S When connected via cable or cradle, detach your 700 Series Computer
from the cable or cradle.

S When connected via Infrared, move the 700 Series Computer away
from the PC.

S When connected via a network (Ethernet) card, remove the card from
your 700 Series Computer.

Connecting Directly to an E-mail Server
You can set up a connection to an e-mail server so that you can send and
receive e-mail messages by using a modem or network connection and In-
box on your 700 Series Computer.

Note: The ISP or network must use a POP3 or IMAP4 e-mail server and
an SMTP gateway.

You can use multiple e-mail services to receive your messages. For each e-
mail service you intend to use, first set up and name the e-mail service. If
you use the same service to connect to different mailboxes, set up and
name each mailbox connection.
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Setting Up an E-mail Service
S In Inbox on your 700 Series Computer, tap Services → New Service.

Follow the directions in the New Service wizard.

For an explanation of a screen, tap Start → Help. When finished, to con-
nect to your e-mail server, tap Services → Connect. For more information
on using the Inbox program, see “Inbox: Sending and Receiving E-mail Mes-
sages” on page 42.
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Installing Applications3

There are multiple ways to get an application to your 700 Series Color
Mobile Computer; just as there are multiple ways to package the applica-
tion for delivery.
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Packaging an Application
Use any of the following methods to package an application for installa-
tion:

S For very simple applications, the application itself might be the only file
that needs to be delivered.

S It could be a directory structure that contains the application, support-
ing files like ActiveX controls, DLLs, images, sound files, and data files.

S Via a CAB file.

Consider either of the following when choosing a location into which to
store your application:

S In the basic 700 Series Computer, there are no built-in storage options
other than the Object Store. The Object Store is RAM that looks like a
disk. Anything copied here will be deleted when a cold-boot is per-
formed on the 700 Series Computer.

S If the optional SecureDigital or CompactFlash storage card is in the sys-
tem, then consider this card the primary location for placing an applica-
tions install files. The following folders represent either card:

S The SecureDigital storage card creates the “\SDMMC Disk” folder.

S The CompactFlash storage card creates the “\Storage Card” folder.

S Files copied to either of these locations will be safe when a cold-boot is
performed on a 700 Series Computer - providing the AutoRun system is
installed onto the storage card. You can find this system on the Recovery
CD. Copying a CAB file to the “\CABFILES” folder on one of these
cards will automatically extract that CAB file on every cold boot to en-
sure that your system is properly set up. See page 82 for more details on
how this works.

Installing Applications
Consider any of the following options to get the package to the preferred
location on your 700 Series Computer.

S Microsoft ActiveSync

S FTP Server (page 78)

S Application Manager in Unit Manager (page 78)

S SecureDigital or CompactFlash storage card (page 78)
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Using Microsoft ActiveSync
Note: These instructions assume that the 700 Color Management Tools
portion of the 700 Series Color Software Tools CD was installed onto your
desktop.

The Microsoft ActiveSync tool is located on the 700C Companion CD,
which contains Microsoft products, such as Outlook and ActiveSync. See
Chapter 2, “Pocket PC 2002,” for information about this tool as provided
by Microsoft Corporation.

This can be a serial, USB, Ethernet, InfraRed, or 802.11b ActiveSync con-
nection. Files can then be copied using File Explorer on a PC or a laptop
computer. This option is usually only good when updating a few 700 Se-
ries Computers.

These instructions assume that Microsoft ActiveSync had been installed
onto your desktop computer and is up and running. If not, go to Chapter
2, “Pocket PC 2002,” for an URL from which you can download the latest
application.

1 Connect your 700 Series Computer to your desktop computer via an
ActiveSync cable or IrDA.

2 Wait for a “Connected” message to appear in the Microsoft ActiveSync
application to signal a connection to the 700 Series Computer. If neces-
sary, select File → Get Connected to initiate a connection.

3 Click Explore to access the Mobile Device directory on your 700 Series
Computer.
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4 From your desktop, select Start → Windows Explorer, then browse the
applicable path for any of the system files needed for your 700 Series
Computer (listed with their paths). Select to highlight the appropriate
file, right-click the file for a pop-up menu, then select Copy.

S Base operating system files:
“C:\Intermec\Intermec 700 Color Mgmt Tools\Drive Images”

S CAB files:
“C:\Intermec\Intermec 700 Color Mgmt Tools\Cab Files”

5 Within the Mobile Device directory, go to the directory where you want
the files located on the 700 Series Computer, do a right-click for a pop-
up menu, then select Paste.

6 When all of the files are pasted, perform a warm-boot on the 700 Series
Computer. When the computer reboots, wait for the LED on the top
left of your keypad to stop blinking. Tap Start → Programs → File Ex-
plorer to locate the newly copied executable files, then tap these files to
activate their utilities.

Using the FTP Server
The 700 Series Computer has a built-in FTP Server that connects to a net-
work via Ethernet or 802.11b. This “ftp”s to the IP address of the 700 Se-
ries Computer and places files. The benefit of using FTP is that a script
can be created that will automate the process of copying files to the 700
Series Computer. This option is good for when a large number of 700 Se-
ries Computers need to be updated. See Chapter 7, “Programming,” for
more information.

Using the Application Manager in Unit Manager
This requires the 700 Series Computer to connect to the network via
Ethernet or 802.11b. The process is still manual so it would take longer
than the FTP method but it would still be a better option than ActiveSync
where many 700 Series Computers need to be updated. The Unit Manager
applications are available on the 700 Series Color Unit Manager CD-ROM.
For more information, consult your Intermec sales representative.

Using a Storage Card
The following steps pertain to installing an application using a storage
card.

Copying to a CompactFlash Card
Follow the steps below to install your application on the device using a
CompactFlash storage card:

1 Suspend the 700 Series Color Mobile Computer and remove its Com-
pactFlash drive, which holds a SanDisk CompactFlash storage card.

2 Using a CompactFlash Adapter card, place the CompactFlash Drive in
your desktop PC card drive.
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3 Create a subdirectory on the PCMCIA CompactFlash drive in which to
store your application.

4 Add the autorun system to the storage card using the CEImager
application. See the Software Tools User’ s Manual for information about
CEImager.

5 Copy your application, data files, and all required DLLs and drivers to
the subdirectory created on the CompactFlash drive.

6 Add your application to the AUTOUSER.DAT file on the
“\Storage Card\2577” directory that contains the following statement,
where your directory is the directory on the CompactFlash storage card
where the application was installed, and yourapp.exe is the name of your
application. Finish the “RUN=” statement with a carriage return line-
feed combination. There may be multiple run statements in the file.

RUN=\<your directory>\<yourapp.exe>

7 Remove the CompactFlash drive from your desktop computer and rein-
stall it into the 700 Series Computer.

8 Warm-boot the 700 Series Computer to add these files to the Compact-
Flash storage card.

If the AUTOUSER.DAT file is found and the “RUN=” statement is cor-
rect, then the task manager will launch and execute your program on start-
up.

Copying to a SecureDigital Storage Card
Do the same steps as for the CompactFlash storage Card, except replace
the “\Storage Card\2577” directory with the “\SDMMC Disk\2577” direc-
tory.

Updating the System Software
You can use the Recovery CD to reinstall or update the operating system
software on the 700 Series Color Computer. For more information, con-
tact your Intermec sales representative.
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Application Migration
Note: These instructions assume that the 700 Color Management Tools
portion of the 700C Software Tools CD was installed onto your desktop
and that a storage card has been added to the base configuration of the 700
Color Computer.

The following steps are required to ensure that the following will happen
on a cold-boot:

S CAB files can be restored,

S applications will automatically start,

S and the registry will be restored.

Do the following for the cold-boot procedure:

1 From your desktop, double-click the Intermec CE Imager desktop icon
to access the Intermec CEImager application. If this icon is not on your
desktop, then double-click the CEIMAGER.EXE executable from the
“C:\Intermec\Intermec 700 Color Mgmt Tools\Tools\CEImager” folder.

2 Click Default under Components List to activate the components.

3 Click (+) to expand the AutoRun System component, click (+) to ex-
pand the Destination Media option, then select either the Compact-
Flash Card option or the SecureDigital Card option. Do not select both
storage cards, as the AutoRun files copied will work for one storage card, but
not work on the other storage card.



Installing Applications—Chapter 3

81700 Series Color Mobile Computer User’s Manual

4 Click Install to install the AUTORUN files onto the storage card.

5 Create a “\Cabfiles” folder on the storage card. Copy any CAB files that
are to be extracted on every startup into this folder.

6 In the “\2577” directory, add your custom AUTOUSER.DAT file. See
the Recovery Help for more information on how to set up an
AUTOUSER.DAT file.

7 If you are using the RegFlushKey() API, the application must use a spe-
cial API to make sure the registry is written to the appropriate card; or
you can use the Utilities control panel applet, as follows:

a From the 700 Series Computer, tap Start → Settings → the System
tab → the Utilities icon → the Registry Save tab.

b Tap Enable Registry Storage, then tap either of the following:

S SD
To write the registry to the SecureDigital storage card.

S CF
To write the registry to the CompactFlash storage card.

c Tap ok to save your entry and exit the Utilities control panel applet.

Note: If you are using a SecureDigital storage card, you must change any
disk access from “Storage Card” to “SDMMC Disk.”

8 Remove the storage card from the desktop PC and install the card into
the 700 Series Color Computer.

9 Perform a cold-boot on the 700 Series Color Computer. Files will
automatically install from the storage card upon reboot. Any calls to the
RegFlushKey() API will automatically write the registry to the
appropriate location.
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When converting a 700 Series Monochrome Computer application to run
on the 700 Series Color Computer, most APIs should work without chan-
ges. Below are a few exceptions:

S The 700 Series Monochrome Computer used the “\Storage Card” folder
for nonvolatile storage. You may need to change the application to store
data in a volatile location or onto the “SDMMC Disk” if a SecureDigi-
tal storage card is present in the system.

S If the application uses the RegFlushKey() API, it must first verify that
the proper media is available in the system and call the special API men-
tioned in Step 7 on the previous page.

S If the application will be using the 700 Color switchable dock, use the
API to set the proper port on the dock before communications.

S Some WAN radio options have changed. Review the WAN radio section
to determine if any changes will be required in your application.

S The arrow and tab keys are swapped from the way they were on the 700
Series Monochrome Computers. Keyboard remapping is available on
the 700 Series Color Computer if these keys need to be changed. See
page 79 for more details.

S No special SDK is needed to compile applications for the Xscale proces-
sor. Targeting the SA1110 processor will create applications that run on
the 700 Series Color Computer.

Cabinet File Installation
CAB files (short for cabinet files) are like .ZIP files, plus they register DLLs,
create shortcuts, modify registry entries, and run custom set up programs.
Tap a CAB file to extract that file or place the CAB file on one of the ap-
proved storage devices in the “\Cab Files” folder, then perform a warm-
boot on the 700 Series Computer. There are two methods available to ex-
tract a CAB file:

S Tap a CAB file to extract it. When using this method, the CAB file is
automatically deleted when the extraction process is successful, unless
the CAB file is set with the read-only attribute.

S Use the AUTOCAB method where all files are extracted when a cold-
boot is performed on the 700 Series Computer. This AutoCab applica-
tion is on the Recovery CD, see its “Recovery Help” for more informa-
tion.
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Network Support4

The 700 Series Color Mobile Computer can integrate up to three radios in
a single unit, and will automatically install the appropriate software for ra-
dio use when the unit is powered on. The Intermec CORE application
defaults to the most recently used module. If a module has not yet been
used or set, CORE will default to the first module as listed alphabetically.

The following communication options on the 700 Series Computer pro-
vide wired and wireless connectivity:

S Onboard wired Ethernet (standard)

S Wireless Local Area Network (LAN)
This 802.11b radio option provides up to 11 Mb/sec throughput.

S Wireless Wide Area Network (WAN)
Includes support for GSM/GPRS and CDMA/1xRTT radios.

S Wireless Printing
This allows for cable-free communications with peripheral devices, such
as printers, over a ten-meter range. This compatibility is provided via a
Bluetooth qualified module by Socket Communications.
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CORE
The Intermec Common Object Resource Environment (CORE) applica-
tion provides a framework for various modules that let you configure and
manage your Intermec products. These modules are software plug-ins that
can be configuration tools, such as the 802.11b radio configuration mod-
ule, or they can provide information on your environment, such as a bat-
tery life module.

CORE is built into the operating system of every 700 Series Computer.
On the 700 Series Computer, tap Start → Programs → the Intermec
CORE icon to access this application.

CORE modules are collections of specific information. This information is
usually related to a particular radio technology, but not always. Each
module can display general and detailed information. Tap the General and
Details tabs near the bottom to switch between general and detailed
information. Note that not all modules will have detailed information.

To learn more about this application, see its online help. Tap Start →
Help from the menu to see the CORE online help.

Note: Once CORE is running, you can return to it by tapping its icon
from the System Tray via the Today screen. Tap Start → Today → the
Intermec CORE three-ring icon (circled in the following illustration).
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Network Adapters
Your 700 Series Computer can have up to three radios installed. The de-
fault network adapter or radio is dependent on what card is inserted in
your 700 Computer. Below are the the network adapters that exist as of
this publication. See the Developer’s Support web site for the latest infor-
mation on network adapters for your unit.

� Ethernet Communications (LAN9000) - page 86.

� 802.11b Radios (802.11b Wireless LAN driver) - page 87.

� WWAN (Wireless WAN) - page 110.

� Wireless Printing (PAN) - page 120.

Note that the tip of the antenna attached to your 700 Series Computer is
color-coded to identify its radio type. Refer to the following to determine
your radio type:

� Green
802.11b diversity

� Red
CDMA (non-Sprint networks)

� White
GPRS US/Canada and CDMA Sprint networks

� Blue
GPRS International
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Ethernet Communications
Follow the steps below to start Ethernet communications on the 700 Series
Computer. If your system does not contain an 802.11b radio, then
Ethernet networking using DHCP will be selected as the default.

When “Built-in Ethernet” is selected from the NDISTRY pop-up menu,
then the antenna shown to the left will appear in the System Tray. When
“No networking” is selected, then this icon will appear with a red “X”
above it.

From the 700 Series Computer, tap Start → Settings → the Connections
tab → Network Adapters to access the network connections for this unit.
Make the changes necessary for your network, then tap ok when finished.

Note: “LAN9000” is for Ethernet and ”802.11b Wireless LAN” is for
802.11b radios.
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802.11b Communications
The 700 Series Computer can integrate the 802.11b radio module along
with either the GSM/GPRS or the CDMA/1xRTT radio and the Wireless
Printing option. The 802.11b radio module accommodates any Wireless
LAN (WLAN) requirements, such as using WLAN access points for cross-
docking or load-planning applications.

When “Wireless 802.11” is selected via the NDISTRY pop-up menu, then
the antenna shown to the left will appear in the System Tray.

To start 802.11b communications on the 700 Series Computer, tap Start
→ Settings → the System tab → the Wireless Network icon to access the
Profile Wizard for the 802.11b radio module. The Profile Wizard defaults
to the Profiles page.

Profiles
Use the Profiles page to add, edit, or delete multiple networking environ-
ments for this 802.11b radio. To add a profile from this screen, enter up to
32 alphanumeric characters in the Profile field, then tap Add. See “Basic”
on page 89 and “Security” on page 90 for more information.

Leave Use Profile Name for SSID checked for the SSID (or Network
Name) to use this profile name. If this is cleared (check mark removed),
the SSID will default to using the factory-assigned “INTERMEC” net-
work name.
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S To add a profile:
Tap Add, enter up to 32 alphanumeric characters to name this profile if
you have not already entered a description in the Profiles page, configu-
re the basic and security information for this profile, then click Done to
configure its basic and security information.

S Leave Use Profile Name for SSID checked for the SSID to use this as-
signed profile name. If this is cleared (check mark removed), the SSID
will default to using the factory-assigned “INTERMEC” network name.
Go to the next page to continue.

S To edit a profile:
Select an existing profile from the Profile drop-down list, tap Edit,
make the changes needed for this profile (starting in the next para-
graph), then tap OK to return to the Profiles page.

S To delete a profile:
Select a profile from the Profile drop-down list, tap Delete, then tap Yes
to remove the selected profile.
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Basic
Use the Basic page to set the network type and radio channel for this pro-
file. Click OK to return to the Profiles page.

S Network type:
Tap the drop-down list to select either Infrastructure or Ad-hoc.

S SSID (Network Name):
This assumes the profile name when Use Profile Name for SSID is
checked on the previous screen, unless another name is entered in this
field. If you want to connect to the next available network or are not
familiar with the network name, enter “ANY” in this field. Consult your
LAN administrator for network names.

S Channel:
If “Ad-hoc” were selected as the network type, then this is enabled. Tap
the drop-down list to select a channel, from 1-15, through which to
handle connections (default is 3).

S Enable Power Management:
Check this box to conserve battery power (default), or clear this box to
disable this feature.
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Security
Use the Security page to set this profile as read-only or to enable WEP
(Wired Equivalent Privacy) encryption. Click OK to return to the Profiles
page. The following securities are available from the Security Method
drop-down list. Note that the last three methods are available if you have pur-
chased the security package. Contact your Intermec Representative for more in-
formation.

S 802.11 WEP Encryption (next page)

S 802.1x TLS (page 92)

S 802.1x TTLS (page 93)

S LEAP (page 93)
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802.11 WEP Encryption:
WEP keys are only needed if they are expected by your clients. There are
two types available: 64-bit (5-character strings, 12345) (default) and
128-bit (13-character strings, 1234567890123). These can be entered as
either ASCII (12345) or Hex (0x3132333435).

To enter WEP keys, select “802.11 WEP Encryption” from the Security
Method drop-down list. Select a data transmission key from the Data TX
Key drop-down list near the bottom of this screen, then enter the encryp-
tion key for that data transmission in the appropriate Key # field.
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802.1x TLS (Transport Layer Security):
TLS is a protocol that ensures privacy between communicating applica-
tions and their users on the Internet. To use this protocol, select “802.1x
TLS” from the Security Method drop-down list, then enter the following:

S Client Key File:
Enter the file location where the certificate for your identity is stored.

S Password:
Enter the password for the certificate in this field.

S Supplicant ID:
Enter the user ID associated with this certificate.

S Server Cert CN (Certificate Common Name):
Enter the common name of your authentication server.

S CA List (Certificate Authority):
Enter the file location, or path, of the server certificates.
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802.1x TTLS (EAP-Tunneled TLS):
To use this protocol, select “802.1x TTLS” from the Security Method
drop-down list, then enter the following:

S Username:
Enter your user name for this security protocol.

S Password:
Enter your password for this security protocol.

S Supplicant ID:
Enter “anonymous” unless your administrator indicates otherwise.

S Server Cert CN (Certificate Common Name):
Enter the common name of your authentication server.

S CA List:
Enter the file location, or path, of the server certificates.

LEAP (Cisco Wireless EAP (Extensible Authentication Protocol)):
Enter your unique user name and password to use this protocol.
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Advanced
Use this page to secure the configuration for this profile or to make all
fields read-only.

S Make Profile Read-Only:
Check this box, then enter and reenter a password to “lock” or render
“read-only” all configurations for this profile. To reverse this step, clear
the check box, then enter the password assigned with the “read-only”
status.

S Certificates:
If “802.1x TLS,” “802.1x TTLS,” or “LEAP” were enabled via the Se-
curity tab, then this button will appear. Tap this button to configure the
available certificates. See “Certificates” on the next page for more infor-
mation.
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Certificates
Use this page to view, modify, or remove certificates assigned to your
particular security method. Note that you can also access this page by tapping
Start → certificates from the Today screen.

S CA Name/IP:
Enter a valid CA name or IP address assigned to the certificate in ques-
tion. This allows you to enroll the certificate or to browse for its latest
information.

S Enroll File Name:
Enter the file name of the certificate to be enrolled.

S Store Location:
Enter the path where the certificate is to be stored within your 700 Se-
ries Computer.

S Enroll:
Tap this to assign the file entered in Enroll File Name to the location
specified in Store Location.

S CA Vert:
Tap this to view the contents of the certificate via the Internet Explorer.

S View:
Tap this to view information about the certificate, such as to whom this
certificate was issued, who issued the certificate, and the span of time
the certificate is valid.

S Remove:
Select a file from the list, then tap this button to delete that file.
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Import/Export
Use this page to send a profile or to retrieve a profile to or from another
location within your 700 Series Computer.

S To export a profile:
Select to highlight a profile, then tap Export. Select from the drop-down
lists, the folder, type of files, and location within the folder where the
profile is to go, tap OK to export the profile, tap ok to close the con-
firmation screen, then tap OK again to exit the Profile Wizard.
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S To import a profile:
Tap Import to access the Open screen, from the drop-down lists, select a
folder and file type, then tap a profile from the list provided. Tap ok to
close the confirmation screen, then tap OK again to exit the Profile
Wizard.

Scan List
Use this Scan List page to monitor network connections, and if lost, to at-
tempt to reestablish connections with these networks.

Selected Profile
Select this option to use the profile defined in the Profiles page, then tap
OK to exit the Profile Wizard. When connections are lost, attempts will be
made to connect to the specified profile.
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Scan List
Use this option to select a number of profiles with which to establish con-
nections. When connections are lost, attempts will be made to contact each
of the profiles listed, in the order they appear in the list.

1 Tap this option, then tap Edit Scan List.

2 Select profiles from the Available Profiles drop-down list, then tap Add
to include each selection in the Scan List.

3 To arrange the hierarchy of profiles, tap to select a profile, then tap ei-
ther Move Up or Move Down to move each profile. To remove a pro-
file from the list, tap to select that profile, then tap Delete.

4 Click either ok or Close to return to the Scan List page, then click OK
to exit the Profile Wizard.

Network Selection APIs
The Network Selection APIs allow the user to change network adapter
configuration programmatically. Both drivers support the same IOCTL
function numbers for loading and unloading the drivers.

Loading and unloading of the 802.11b driver is performed by the FWV1:
device in the system by performing DeviceIOControl() calls to the driver.

Loading and unloading of the driver for the built-in Ethernet adapter is
performed by the SYI1: device in the system by performing DeviceIO-
Control() calls to the driver.

S For loading an NDIS driver associated with an adapter, the IOCTL is
IOCTL_LOAD_NDIS_MINIPORT.

S For unloading NDIS drivers associated with an adapter the IOCTL is
IOCTL_UNLOAD_NDIS_MINIPORT.
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#include <winioctl.h>
#include “sysio.h”

void DoLoad(int nDevice) {

LPTSTR devs[] = { _T(“SYI1:”), _T(“FWV1:”) };
HANDLE hLoaderDev;

DWORD bytesReturned;

hLoaderDev = CreateFile(devs[nDevice], GENERIC_READ|GENERIC_WRITE, 0,
NULL, OPEN_EXISTING, 0, NULL);

if (hLoaderDev != INVALID_HANDLE_VALUE) {

if (!DeviceIoControl( hLoaderDev, IOCTL_LOAD_NDIS_MINIPORT, NULL, -1, NULL, 0,
&bytesReturned, NULL)){

MessageBox(NULL, TEXT(“SYSIO IoControl Failed”), TEXT(“Network

loader”),MB_ICONHAND);
if (hLoaderDev!=INVALID_HANDLE_VALUE) CloseHandle(hLoaderDev);

hLoaderDev = INVALID_HANDLE_VALUE; // bad handle

}else {
CloseHandle(hLoaderDev);

}

}
}

void DoUnload(int nDevice) {

LPTSTR devs[] = { _T(“SYI1:”), _T(“FWV1:”) };
HANDLE hLoaderDev;

DWORD bytesReturned;

hLoaderDev = CreateFile(devs[nDevice], GENERIC_READ|GENERIC_WRITE, 0,
NULL, OPEN_EXISTING, 0, NULL);

if (hLoaderDev != INVALID_HANDLE_VALUE) {

if (!DeviceIoControl( hLoaderDev, IOCTL_UNLOAD_NDIS_MINIPORT, NULL, -1, NULL, 0,
&bytesReturned, NULL)){

MessageBox(NULL, TEXT(“SYSIO IoControl Failed”),TEXT(“Network
loader”),MB_ICONHAND);

if (hLoaderDev!=INVALID_HANDLE_VALUE) CloseHandle(hLoaderDev);

hLoaderDev = INVALID_HANDLE_VALUE; // bad handle
}else {

CloseHandle(hLoaderDev);

}
}

}
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The API provided by Intermec Technologies exposes a limited set of rou-
tines that allows a programmer to access and affect the 802.11b network
interface card from within their application. The routines provided will
also read/write values to the CE registry that pertain to the 802.11b radio
driver. By using the provided functions, a programmer can alter the
802.11b parameters of Network Name (SSID), WEP Keys, Infrastructure
Modes, Radio Channel, and Power Management Modes. A programmer
can also retrieve network connect status and signal strength indication
from the RF network card.

The API is contained within the 80211API.DLL file that should be pres-
ent in any load that has the 802.11b networking installed.

S NETWLAN.DLL
This file is the 802.11b driver. It will be present in all 700 CE loads that
use the 802.11b network interface card.

S 80211API.DLL
This file is an Intermec authored file that provides the programmer with
a set of API calls to configure or monitor status of the 802.11b network.

S MOD80211.DLL
The CORE module for the 802.11b NIC. It provides the 802.11b sta-
tus information displayed when the CORE application is running.

S 80211CONF.EXE
This is the “Control Panel” for configuring the 802.11b network para-
meters. Note that it is an EXE file and is actually called by
CPL802.CPL (see below). It is also called by the CORE application
when the “Configuration” button is pressed.

S CPL802.CPL
A control panel application that does nothing but call
80211CONF.EXE.

S 80211SCAN.EXE
Internally manages the Scan List activity.

The 80211API.DLL supports an unlimited number of radio configuration
profiles. These profiles are the same as those set by the Wireless Network
control panel applet that runs on the Windows CE unit. You can configure
different 802.11b profiles and switch between them using the 802.11 API.
See the ConfigureProfile() function on page 106 for more information.
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Function Summary
Below are functions available for the 700 Series Color Computer when
enabled with the 802.11b radio module.

RadioConnect()
Connects to the available radio. Use this function if you plan on using a
lot of API calls that talk directly to the radio.

Syntax: UINT RadioConnect( );

Parameters: None.

Returns: ERROR_SUCCESS when successful, otherwise
ERR_CONNECT_FAILED.

RadioDisconnect()
Cleans up the connection from the RadioConnect() function after an ap-
plication closes.

Syntax: UINT RadioDisconnect( );

Parameters: None.

Returns: ERROR_SUCCESS when successful, otherwise
ERR_CONNECT_FAILED.

GetMac()
Gets the radio MAC address.

Syntax: UINT GetMac( TCHAR * );

Parameters: Pointer to a character array, which is populated with MAC addresses.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetBSSID()
Gets the associated access point name, the BSSID.

Syntax: UINT GetBSSID( TCHAR * );

Parameters: Pointer to a character array, which is populated with the current BSSID.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed

GetSSID()
Gets the current SSID (network name).

Syntax: UINT GetSSID( TCHAR * );

Parameters: Pointer to a character array, which is populated with the current SSID.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.
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GetLinkSpeed()
Retrieves the current link speed of the radio connection.

Syntax: UINT GetLinkSpeed( int & );

Parameters: & References an integer.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetNetworkType()
Retrieves the network type.

Syntax: UINT GetNetworkType( ULONG & );

Parameters: & References a ULONG value, populated with one of the following:
NDIS_NET_TYPE_FH Frequency Hopping Radio
NDIS_NET_TYPE_DS Direct Sequence Radio
NDIS_NET_TYPE_UNDEFINED

Unknown or information not available.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetTXPower()
Gets the current TX power of the radio in milliwatts.

Syntax: UINT GetTXPower( ULONG & );

Parameters: & References a ULONG value, populated with one of the following
in milliwatts (mW):

NDIS_POWER_LEVEL_63 63 mW.
NDIS_POWER_LEVEL_30 30 mW.
NDIS_POWER_LEVEL_15 15 mW.
NDIS_POWER_LEVEL_5 5 mW.
NDIS_POWER_LEVEL_1 1 mW.
NDIS_POWER_LEVEL_UNKNOWN

Unknown Value or Error.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.
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GetNetworkMode()
Retrieves the network mode.

Syntax: UINT GetNetworkMode( ULONG & );

Parameters: & References a ULONG value, populated with one of the following:
NDIS_NET_MODE_IBSS 802.11 Ad-Hoc Mode.
NDIS_NET_MODE_ESS 802.11 Infrastructure Mode.
NDIS_NET_MODE_UNKNOWN Unknown Value or Error.
NDIS_NET_AUTO_UNKNOWN

Automatic Selection. Use of this option is not recommended.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

SetNetworkMode()
Sets the radio and updates the CE registry.

Syntax: UINT SetNetworkMode( ULONG & );

Parameters: & References a ULONG value, populated with one of the values defined
in GetNetworkMode().

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

AddWep()
Adds a WEP key to the radio configuration.

Syntax: UINT AddWep( ULONG 1, BOOL 2, TCHAR * 3 );

Parameters: ULONG Pointer that identifies what key to be set.
BOOL Specifies whether the key being set is the default TX key.
TCHAR Pointer that specifies the key data either in hex (string

lengths of 10 or 26) or ASCII (string lengths of 5 or 13).

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetRSSI()
Sets the current RSSI (Received Signal Strength Indication).

Syntax: UINT GetRSSI( ULONG & );

Parameters: & References a ULONG value.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.
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GetAssociationStatus()
Gets the current connection, or association status.

Syntax: UINT GetAssociationStatus( ULONG & );

Parameters: & References a ULONG value, a current connection status as follows:
NDIS_RADIO_ASSOCIATED Radio is associated w/access point.
NDIS_RADIO_SCANNING Radio is scanning for network.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetWepStatus()
Gets the current WEP status.

Syntax: UINT GetWepStatus( ULONG & );

Parameters: & References a ULONG status value which include the following:
NDIS_RADIO_WEP_ENABLED WEP is currently enabled.
NDIS_RADIO_WEP_DISABLED WEP is currently disabled.
NDIS_RADIO_WEP_ABSENT WEP key is absent.
NDIS_RADIO_WEP_NOT_SUPPORTED

WEP is not supported.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetAuthenticationMode()
Gets the current authentication mode.

Syntax: UINT GetAuthenticationMode( ULONG & );

Parameters: & References a ULONG value which include the following current
authentication mode:
NDIS_RADIO_AUTH_MODE_OPEN Open System is in use.
NDIS_RADIO_AUTH_MODE_SHARED Shared Key is in use.
NDIS_RADIO_AUTH_MODE_AUTO Automatic Detection.
NDIS_RADIO_AUTH_MODE_ERROR Unknown value/Error.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

SetAuthenticationMode()
Sets the radio authentication mode with a value defined in the
GetAuthenticationMode() function.

Syntax: UINT SetAuthenticationMode( ULONG );

Parameters: Passes in a ULONG set to one of the values as defined in
GetAuthenticationMode().

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.
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SetChannel()
Sets the radio channel, ranging from 1 to 14.

Syntax: UINT SetChannel( USHORT );

Parameters: USHORT set to a desired channel (1-14).

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

EnableWep()
Enables or disables WEP encryption.

Syntax: UINT EnableWep( BOOL );

Parameters: Set to TRUE (0) to enable WEP encryption or FALSE (1) to disabled
WEP encryption.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

GetPowerMode()
Gets the current power management mode of the radio.

Syntax: UINT GetPowerMode( ULONG & );

Parameters: & References a ULONG value which include the following current radio
power management mode:

NDIS_RADIO_POWER_MODE_CAM
Continuous Access Mode (uses most power).

NDIS_RADIO_POWER_MODE_MAX
Maximum Power Savings.

NDIS_RADIO_POWER_MODE_PSP
Power Saving Mode, best balance of power and performance.

NDIS_RADIO_POWER_UNKNOWN
Unknown mode reported or error.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

SetSSID()
Passes the desired SSID (network name).

Syntax: UINT SetSSID( TCHAR * );

Parameters: Pointer to a character array that contains the desired SSID.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.
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isOrinoco()
Confirms whether the present radio is an ORiNOCO radio.

Syntax: UINT isOrinoco( );

Parameters: None.

Returns: TRUE when an ORiNOCO radio.
FALSE when other than an ORiNOCO radio.

EncryptWepKeyForRegistry()
Encrypts a key for registry storage. Requires TCHAR pointers for a des-
tination and a source.

Syntax: UINT EncryptWepKeyForRegistry( TCHAR * szDest, TCHAR *
szSource );

Parameters: szDest String for the destination.
szSource String for the source.

Returns: ERROR_SUCCESS when successful,
ERR_QUERY_FAILED when the query failed, or
ERR_CONNECT_FAILED if a connection with the radio failed.

SetRTSThreshold()
Sets the radio RTS (Request To Send) threshold.

Syntax: UINT SetRTSThreshold( USHORT & );

Parameters: & References a USHORT value.

Returns: None.

GetRTSThreshold()
Gets the radio RTS threshold.

Syntax: UINT GetRTSThreshold( USHORT & );

Parameters: & References a USHORT value.

Returns: None.

ConfigureProfile()
If using the Intermec 802.11b Profile Management system, you can pro-
gram the API to configure the radio to a specific profile by passing the pro-
file name.

Syntax: UINT ConfigureProfile( TCHAR * );

Parameters: Pointer to a string that contains the name of the profile to be activated.

Returns: None.
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StartScanList()
If a scan list is configured, this will start the API looking for a network on
that scan list and configuring the radio appropriately. This call can take a
long time to process.

Syntax: UINT StartScanList( );

Parameters: None.

Returns: None.

802.11b Radio CORE Module
The 802.11b radio CORE module displays helpful information about the
802.11b radio option built into your 700 Series Computer.

Note that you can configure the 802.11b radio module from this CORE
application. Select Configure → Configure 802.11 CF from the bottom
menu bar to access the Profile Wizard application. Information about this
application starts on page 87.

Select Modules → Intermec 802.11 CF Help for more information on
the contents of this CORE module.

General
Below are descriptions and meanings for each piece of information pro-
vided via the General tab, reading from top to bottom starting on the left.

S ESS 802.11 Station:
This identifies the type of network to which you are attached, either an
ESS (Embedded Security Subsystem) Station, or Ad-hoc.

S Adapter MAC:
This identifies the MAC address for this 802.11b adapter.

S Scanning:
Status of association. When connected to a network, this changes to
“Connected to NET” with NET being the name of the network to
which you are connected.
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S Encryption:
This indicates whether WEP encryption is “Enabled” or “Disabled
(Open).” See page 90 for more information.

S Link:
This indicates the speed at which a connection is made.

S TX Power:
This shows the speed (in milliwatts) at which transmissions are made.

S Signal:
This identifies the radio signal strength (in dBm).

S Antenna:
This identifies the antenna being used with the assigned profile.

S AP Mac:
This identifies the MAC address of the access point to which this 700
Series Computer is connected.

S IP:
This provides the IP address which can be set as either DHCP (Dynam-
ic Host Configuration Protocol) or statically.

S Power:
This indicates the power status of this 700 Series Computer: “Always
On” is the default.

S History:
This bar graph displays an active history of this radio module’ s quality
of connections.

S Friendly Indicator:
If the radio stack is loaded, then all three dots are filled. These dots are
left empty if the stack is not loaded. These dots do vary based on the
CORE application’ s perception of the overall connection quality.
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Details
Below are descriptions and meanings for each piece of information pro-
vided via the Details tab, reading from top to bottom.

S Attach-Roam Cnt:
This includes the number of new associations made during the current
session, including any found roaming.

S Scanlist:
This indicates whether the Scan List option was enabled or disabled. See
page 97 for more information.

S Watchdog Status:
This monitors the activity of the Scan List: “Running” or “Stopped.”

S Supplicant:
This monitors the 802.1x security activity on the client: “Running” or
“Stopped.”
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WWAN Radio Options
The 700 Series Computer can integrate either the GSM/GPRS or the
CDMA/1xRTT radio along with the 802.11b radio and the Wireless
Printing option. The WWAN radio option accommodates any Wireless
WAN requirements, such as taking the 700 Series Computer off the prem-
ises in a delivery vehicle to cover a much larger area.

GSM/GPRS
The GSM (Global System for Mobile communications) and GPRS (Gen-
eral Packet Radio Service) wireless infrastructure increases voice capacity,
enables personalized “user-aware” services, and creates networking efficien-
cies to help wireless service providers drive reduced operating costs.

S GSM is an open, nonproprietary system. One of its great strengths is
the international roaming capability. This provides seamless and same-
standardized same-number contactability world-wide. GSM satellite
roaming has extended service access to areas with unavailable terrestrial
coverage.

S GPRS is the high-speed data evolution of GSM. GPRS supports Inter-
net Protocol (IP), enabling access to Internet and intranet content and
applications from GPRS wireless devices. The anticipated data rate for
GPRS is 115 Kbps and throughput rates of 30-60 Kbps have been
achieved initially. This high speed capability enables vehicle applications
to become real-time and to use the Internet for access to corporate data
or information in the form of traffic or navigation.

CDMA/1xRTT SB555
Code Division Multiple Access (CDMA) is a form of “spread-spectrum,” a
family of digital communication techniques used in military applications
for years. The core principle of spread-spectrum is the use of noise-like
carrier waves, and, as the name implies, bandwidths much wider than that
required for simple point-to-point communication at the same data rate.

S 1XRTT, the first phase of CDMA2000, is designed to support up to
144 KB per second packet data transmission and to double the voice
capacity of current generation CDMA networks.

S SB555 Embedded Module, from Sierra Wireless, provides complete
wireless functionality and integrates easily into the most compact and
slender mobile applications with its small flexible design. The SB555
offers maximum coverage and access to entire CDMA networks.
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WAN Radio CORE Module
The WAN radio CORE module displays helpful information about either
the GSM/GPRS radio or the CDMA/1xRTT radio option built into your
700 Series Computer. The following illustrations are for a GSM/GPRS
GEM350X radio.

General
Below are descriptions and meanings for each piece of information pro-
vided via the General tab, reading from top to bottom starting on the left.
The information applies to both the GSM/GPRS and the CDMA/1xRTT ra-
dio modules unless otherwise indicated.

S Network Type:
This is the network type which would list either “GSM-GPRS” or
“CDMA-1XRTT.” Scatternets are not supported.

S IWS (GSM/GPRS) or Sprint PCS Network (CDMA/1xRTT):
This lists the name of the wireless network provider, such as T-Mobile,
Voicestream, AT&T Wireless, etc. “IWS” is short for the Iowa Wireless
Service carrier.

S Registered on home network:
If the WAN radio module has registered with a service provider net-
work, then one of the following will appear:

S Registered on home network:
The radio module is registered on its “home” network.

S Registered on roamed network:
The radio module is registered on another service provider’ s network.

S Radio Not Registered:
There is no network within range of this radio module.

S Radio ESN:
This displays the Electronic Serial Number (ESN) assigned to this radio
module or lists “Unavailable” if a number cannot be read from the ra-
dio.
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S RSSI:
This displays the Received Signal Strength Indicator (RSSI) frequency or
lists “Unavailable” if there is no signal or the signal cannot be retrieved
from the radio module.

S BER (GSM/GPRS GEM 350X, CDMA/1xRTT):
This shows the Bit Error Rate (BER), the percentage of bits with errors
divided by the total number of bits transmitted, received, or processed
over a given period of time.

S f/w:
This identifies the firmware version, if available.

S h/w:
This identifies the hardware version, if available.

S Serial Status:
This indicates whether serial communications passed (“Serial com OK”)
or failed (“Serial com FAIL”) in its last transaction. A status of “Serial
com FAIL” typically indicates that the 700 Series Computer is unable to
establish communication with the radio module installed within.

S Xircom GEM3503 (GSM/GPRS), Siemens MC45 (GSM/GPRS), or
Sierra Wireless SB555 (CDMA/1xRTT):
This identifies the product name for this radio module.

S Band (GSM/GPRS) or Channel (CDMA/1xRTT):
This identifies the bandwidth or channel available for this radio module,
if any.

S History:
This bar graph displays an active history of this radio module’ s quality
of connections.

S Friendly Indicator:
Usually indicates the signal strength for this radio module. Three filled
dots indicate a high quality or strong signal. Three empty dots indicate
that the signal is out of range or there is no signal detected.
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Details
Below are descriptions and meanings for each piece of information pro-
vided via the Details tab, reading from top to bottom. Most of this is simi-
lar to what is shown under the General tab. The information applies to both
the GSM/GPRS and the CDMA/1xRTT radio modules unless otherwise indi-
cated.

S Serial Status:
This indicates whether serial communications passed (“PASS”) or failed
(“FAIL”) in its last transaction. A status of “FAIL” typically indicates
that the 700 Series Computer is unable to establish communication
with the radio module installed within.

S Manufacturer:
This lists the name of the manufacturer that developed this radio mod-
ule, such as “Xircom, an Intel Corporation,” “Siemens,” or “Sierra Wire-
less.”

S Model:
This identifies the product name for this radio module, such as
“SB555,” “GEM350X,” or “MC45.”

S IMEI # (GSM/GPRS):
This is the IMEI (International Mobile station Equipment Identity) se-
rial number of the GSM/GPRS radio module.

S RSSI:
This displays the RSSI frequency or lists “Unavailable” if there is no sig-
nal or the signal cannot be retrieved from the radio module.

S Operator:
This lists the name of the service providing the network support.

S SIM Status (GSM/GPRS MC45):
Identifies whether a Subscriber Identity Module (SIM) card is installed
in this 700 Series Computer.
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S Band (CDMA/1xRTT):
This identifies the frequency bands used by this radio module.

S IMSI # (GSM/GPRS):
This shows the IMSI (International Mobile Subscriber Identity) number
assigned to the SIM card installed in this 700 Series Computer.

S Radio Temp (CDMA/1xRTT):
This identifies the temperature of the radio module, or lists “Unavail-
able degrees” if there is no information or the temperature cannot be
measured.

S Firmware Rev:
This identifies the firmware version, if available.

S Firmware Date (GSM/GPRS):
This provides the last date when this firmware was updated, if available.

Terminal Application
Tap Terminal App from the Details page to send standard AT commands.
Information about these AT commands are available under “AT Command
Interface” on page 115.

Select an AT command from the drop-down list, then tap Send. The re-
sults of each test appears in the text box. Tap Exit or ok to close this screen
and return to the Details page.
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Phone Application
With the WAN radio module installed in your 700 Series Computer, you
can send and receive telephone calls. Use the speaker on the back of the
computer as your earpiece and use the connector on the bottom of the
computer for your mouthpiece.

Tap Phone App from the Details page to access the application which will
process your phone calls. Tap Exit or ok to close this application and
return to the Details page.

S Tap the numbers for a phone call, using Clear to erase each digit, then
tap Send to initiate the call.

S Tap Answer to receive an incoming call.

S Tap End to disconnect a transaction.

S Tap Vol ^ or Vol v to adjust the speaker volume.

S Tap Mic ^ or Mic v to adjust the microphone sensitivity.

AT Command Interface
This interface specification is based on the following recommendation:

S ETSI GSM 07.05:
European Digital Cellular Telecommunication System (phase 2)
Use of DTE-DCE interface for Short message and cell broadcast service.

S ETSI GSM 07.07:
European Digital Cellular Telecommunication System (phase 2)
AT command set for GSM Mobile Equipment.

S ITU-T Recommendation V.25 ter
Serial asynchronous automatic dialing and control.
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Note: You will need the Adobe Acrobat Reader application to view a PDF
document. Go to “http://www.adobe.com/prodindex/acrobat/readstep.html”
to install or download the latest Adobe Acrobat Reader according to
Adobe’ s instructions.

Command Set for Sierra Wireless SB555
Use the AT command interface from Sierra Wireless to program the
CDMA/1xRTT SB555 radio module. Documentation for this interface is
available via the following URL. Click the “General AT command refer-
ence” link for a PDF document, which is 680 KB in size. Note that this
URL is subject to change.

http://www.sierrawireless.com/ProductsOrdering/embedded_docs.html

Command Set for Xircom/Intel GEM350X
Use the GEM350X AT command list from Intel Corporation to program
the GPRS/GSM GEM350X radio module. The “GEM350X Programmer’ s
Reference” is available either from Intermec Technologies or from Intel
Corporation. Contact either your Intermec representative or the Intel Cor-
poration support personnel at the following URL for more information.
Note that this URL is subject to change.

http://support.intel.com/sites/support/index.htm?iid=intelhome1+support&

Command Set for Siemens MC45
Use the MC45 AT command interface from Siemens AG to program the
GPRS/GSM MC45 radio module. The “MC45 Siemens Cellular Engine
AT Command Set” is available either from Intermec Technologies or from
Siemens AG. Contact either your Intermec representative or the Siemens
AG support personnel at the following URL for more information. Note
that this URL is subject to change.

http://www.siemens-mobile.com/btob/CDA/presentation/ap_btob_cda_presentation_fron
tdoor/0,2950,12,FF.html
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Testing the AT Commands
These commands can be sent to either WAN radio by setting up a dial-up
networking connection to COM4. Do the following to initiate this con-
nection and test these commands to your radio:

1 From the 700 Series Computer, select Start → Settings → the
Connections tab → the Connections icon.

2 Tap Modify beneath the Internet Settings drop-down list.

3 Tap New.. to make a new connection.
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4 Enter a name for the connection, select “WANA on COM4” from the
Select a modem drop-down list, and select “115200” from the Baud
rate drop-down list. Tap Advanced to continue.

5 On the Port Settings tab, check Enter dialing commands manually,
then tap ok, Next, then Finish to return to the Internet Settings screen
with your new connection.
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6 Press and hold the new connection for a pop-up menu, then tap
Connect to initiate the connection. Wait for about ten seconds for the
Network Log On screen, then tap OK. Note: You do not need to enter any
information within the Network Log On screen.

7 Use either the onscreen keyboard, or press the keys to type any of the
AT commands provided by Sierra Wireless. Press or tap Enter to send
each command. The results of each command sent will print onscreen -
see the sample illustration below. Note that each “AT” command must
start with either the “at” or “at+” characters.

S To see what you typed onscreen, type “ate1” to initiate the AT Echo
command, then press Enter.
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Wireless Printing
The 700 Series Computer can integrate the Wireless Printing option
(which is equipped with a Bluetooth qualified module by Socket Communica-
tions) along with either the GSM/GPRS or the CDMA/1xRTT radio and
the 802.11b radio. This option uses the network to print information
stored on the 700 Series Computer.

“Bluetooth” is the name given to a technology standard using short-range
radio links, intended to replace the cables connecting portable and fixed
electronic devices. The standard defines a uniform structure for a wide
range of devices to communicate with each other, with minimal user ef-
fort. Its key features are robustness, low complexity, low power, and low
cost. The technology also offers wireless access to LANs, the mobile phone
network, and the internet for a host of home appliances and portable
hand-held interfaces.

Documentation
Information about additional “Bluetooth” software, including the Blue-
tooth Device Manager and the BTctrl program, can be found within the
Wireless Printing SDK. This is located on the 700C Software Tools CD,
via the directory off the root of the toolkit called “Wireless Printing SDK.”
It also can be found in the Wireless Printing Development Guide, also on the
700C Tools CD.

Bluealps CORE Module
The Bluealps CORE module displays helpful information about this Wire-
less Printing option within your 700 Series Computer. Below are descrip-
tions and meanings for each piece of information provided via the General
tab, reading from top to bottom starting on the left.
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S Bluetooth Point to Point:
This is the network type. “Point to Point” is the type of connection sup-
ported as of this publication. Scatternets are not supported. The only sup-
ported application is wireless printing to Intermec wireless printers, such
as the 781T Belt-Mount Printer.

S Device Address:
This provides the network address, which in this case, will be replaced
by the device address of the Bluetooth compatible module within your
700 Series Computer. Note that this address is universally unique.

S Discoverable:
The following is displayed depending on whether the 700 Series Com-
puter is configured to be discoverable:

“Gen” Generally discoverable
“Lim” Limited discovery
“No” Not discoverable

S Connectable:
This defines whether the 700 Series Computer is able to accept other
devices with Bluetooth compatible modules connecting to it. “Yes” if the
connection is doable, “No” if not.

S Bondable:
This defines the security element of the 700 Series Computer, which is
the bondable setting. If the unit is bondable, then “Yes” is displayed,
otherwise “No” is displayed.

S Module Firmware:
This reflects the firmware (hardware) version of the 700 Series Comput-
er. When the CORE module first installs onto the unit, the firmware
level is unknown, thus “...reading” is displayed. Once the firmware level
is read from the unit, then a three-digit decimal is displayed.

S Stack [Stack Version] [loaded/not loaded]:
[Stack Version] displays the Bluetooth stack version, which appears in the
“1.2.3.4” format. If the stack is loaded, then “loaded” is displayed after
the stack version, otherwise “not loaded” is displayed.

S Device Name:
This displays the device name as assigned to the Bluetooth compatible
module by the end-user. If the configured name is longer than the space
allowed, it will be truncated.

S BTpak Version:
This displays the driver version of additional Bluetooth components
within the 700 Series Computer and is usually presented in the “1.2.3”
format. The version may also contain a letter at either end.

S History:
This bar graph displays an active history of this wireless printer driver’ s
quality of connections.

S Friendly Indicator:
If the Bluetooth stack is loaded, then all three dots are filled. These dots
are left empty if the stack is not loaded. These dots do vary based on the
CORE application’ s perception of the overall connection quality.
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AutoIP/DHCP
Automatic Private IP Addressing (AutoIP) is enabled by default in Pocket
PC 2002. To remain compatible with other Pocket PC devices, this setting
needs to be enabled. You can configure the registry settings in the
following to set the required AutoIP/DHCP behavior:

S For Ethernet: HKEY_LOCAL_MACHINE\Comm\LAN9001\TcpIp

S Fot 802.11b: HKEY_LOCAL_MACHINE\Comm\NETWLAN1\TcpIp

Other registry keys that can modify the behavior of AutoIP are as follows.
You can find the appropriate settings and behavior of each of these keys in
Microsoft Help.

S AutoInterval

S AutoMask

S AutoSubnet

S AutoIP

S AutoSeed

When a TCP/IP client cannot find a DHCP server, it generates an AutoIP
address from the 169.254.xxx.xxx block. The client then tries to check for
a DHCP server every 300 seconds (5 minutes) and if a DHCP server is
found, the client drops the AutoIP address and uses the address from the
DHCP server.

In the MSDN Windows CE documentation, see “Automatic Client Config-
uration” for more information on AutoIP.

To disable AutoIP, set the AutoCfg registry entry to “0.” If a DHCP server
cannot be found, instead of using AutoIP, the system will display the “Un-
able to obtain a server assigned IP address” message.

Note: If AutoIP is defined using CAB files, the EnableDHCP registry key
must also be defined and set to “1” before the system will attempt to ob-
tain a DHCP address.

To extend the number of attempts that a DHCP client makes to get a
DHCP address, use the DhcpRetryDialogue and DhcpMaxRetry registry
settings.

Change the AutoInterval registry key value to make the client retry more
often to obtain a DHCP address.
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SNMP Configuration
Simple Network Management Protocol (SNMP) was developed in the late
1980s to provide a general-purpose internetworking management protocol.
Its primary goal was to be simple so nothing would stand in the way of its
ubiquitous deployment. To this end, it has been very successful as it is cur-
rently deployed in almost every major internetworking product on the
market. However, like many achieved goals, the primary strength can also
become a weakness.

The Focus was “Simple”
An extreme example of simplicity versus power can be realized by compar-
ing SNMP against the Common Management Information Protocol
(CMIP), the ISO entry to the standard management protocol world.
CMIP has a very rich set of primitives and a core set of data elements.
However, to implement CMIP, a subset of the protocol must be selected.
Then, to achieve interoperability, this subset must be agreed upon with
other implementors. As SNMP was specified completely and with no op-
tions, one implemented what was there and interoperability was assured.
Returning to simplicity, SNMP was built simply for a number of reasons
other than time to market: robustness in the face of network failure, low
overhead in the devices running the protocol; and ease of debugging the
protocol itself (the last thing you want to debug is the management protocol
that is supposed to be helping you debug your network). Thus, the SNMP
limited itself to the User Datagram Protocol (UDP). This gave the
implementor the ability and responsibility to manage lost packets and
perform any necessary retransmissions. As network debugging in the face
of changing routes will certainly mean losing packets, retaining this control
from the transport service (layer 4) was considered essential. Since a
network management protocol will run continuously, it is mandatory that
it consume as minimal a network resource as possible. UDP allows the
necessary control over packet transmissions, packet size and content
(packetization). It is a natural choice.

Using SNMP
SNMP has three control primitives that initiate data flow from the
requester (get, get-next, and set). There are two control primitives the
responder uses to reply. One is used in response to the requester’ s direct
query (get-response) and the other is an asynchronous response to obtain
the requester’ s attention (trap). All five of these primitives are carried by
UDP and are thus limited in size by the amount of data that can fit into a
single UDP packet. The relatively small message size was a goal of the
design but for some reasonable set of network management functions, it
imposes a limitation.
Often in network management, it is necessary to obtain bulk information
without knowing at first what is in that bulk. In one case, there is a set of
problems having to do with packets not going where they are supposed to,
due to device misconfiguration that prevents proper protocol operation
where one needs to view the entire set of data.
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Retrieval of Management Information
SNMP has the get-next primitive which permits the viewing of data
without requiring prior knowledge. If you know what you are looking for,
the get primitive will return it. When you want an entire table of
information, the get-next primitive will obtain it. However, unless
employed with care, the get-next primitive can be extremely
resource-intensive in real time, network bandwidth, and the agent’ s CPU
time. The simplest use of the get-next primitive is to start at the beginning
of a table, await the response and then issue another get-next with the
name returned. As an example, say you wanted the next-hop address,
next-hop interface, and route-type from a routing table containing 1000
entries. Using the simplest form of get-next, this would require 2x3x1000
or 6000 packets (get-next and get-response packets, columns, and rows). A
straight-forward optimization would be to request the three columns in a
single packet. This puts the number of packets at 2x1000 or 2000 packets.
In real time, it is the product of the round trip by the number of request.
In agent CPU time, this is still 6000 lookups in the routing table for both
cases.

An Early Approach to Getting More than One Item at a Time
The ability to retrieve only one piece or object at a time has been a
problem for SNMP. This is particularly an issue with the use of this
protocol in wireless environments where the wireless datapipe is small and
overhead due to network management it is considered overhead. One
approach creates multiple get-next requests running concurrently. A second
algorithm, reduces the packet count by combining the multiple concurrent
get-nexts into a single packet. Neither approach has been implemented
which makes network management in wireless environment, though
essential to the success of the operation, tenuous. The issue has been
resolved in SNMP V2 protocol where a get-bulk primitive has been
defined.

Conclusion
Software development moves forward by evolving the unknown into the
known and wireless environments are moving from vertical only
application to wide spread implementation. At the time of the SNMP
inception, it was not possible to conceive of a reliable transport based
network management protocol. Today’ s problems require more
sophisticated data to analyze a problem. This puts the burden back on the
protocol to send and receive data quickly and efficiently. Work continues
in subcommittees to improve SNMP and resolve the issues that are
developing with new applications and new network architectures.
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SNMP Configuration on the 700 Series Computer
In short, SNMP is an application-layer protocol that facilitates the ex-
change of management information between network devices. The 700
Series Computer is such an SNMP-enabled device. Use SNMP to control
and configure the 700 Series Computer anywhere on an SNMP-enabled
network.

The 700 Series Computer supports four proprietary Management Infor-
mation Bases (MIBs) and Intermec Technologies provides SNMP support
for MIB-II through seven read-only MIB-II (RFC1213-MIB) Object
Identifiers (OIDs).

Note: You can only query these seven OIDs through an SNMP manage-
ment station, these are not available in the Unit Manager applications.

Management Information Base
The Management Information Base is a database that contains information
about the elements to be managed. The information identifies the manage-
ment element and specifies its type and access mode (Read-Only, Read-
Write). MIBs are written in ASN.1 (Abstract Syntax Notation.1) - a ma-
chine independent data definition language. Note: Elements to be managed
are represented by objects. The MIB is a structured collection of such objects.

You will find the following MIB files either on the 700C Tools CD or on
the web via http://www.intermec.com:

S INTERMEC.MIB
Defines the root of the Intermec MIB tree.

S ITCADC.MIB
Defines objects for Automated Data Collection (ADC), such as bar code
symbologies.

S ITCSNMP.MIB
Defines objects for Intermec SNMP parameters and security methods,
such as an SNMP security IP address.

S ITCTERMINAL.MIB
Defines objects for 700 Series parameters, such as key clicks.
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Object Identifiers
Each object has a unique identifier called an OID. OIDs consist of a se-
quence of integer values represented in dot notation. Objects are stored in
a tree structure. OIDs are assigned based on the position of the object in
the tree. Seven MIB OIDs are shown in the followig table.

Example
The internet OID = 1.3.6.1.

MIB Object Identifiers

MIB-II Item OID Group or Table Description

ifNumber 1.3.6.1.2.1.2.1.0 Interfaces Group Indicates the number of adapters
present in the system. For the 700
Series Computer, if one adapter is
present in the system, then ifNum-
ber = 1 and ifIndex = 1.

ifIndex 1.3.6.1.2.1.2.2.1.1.ifIndex Interfaces Table (ifTable) A unique value for each interface.
The value ranges between 1 and the
value of ifNumber.

ifDescr 1.3.6.1.2.1.2.2.1.2.ifIndex Interfaces Table (ifTable) A textual string containing informa-
tion about the interface.

ifType 1.3.6.1.2.1.2.2.1.3.ifIndex Interfaces Table (ifTable) An integer containing information
about the type of the interface. It is
equal to 1 for Other.

ipAdEntAddr 1.3.6.1.2.1.4.20.1.1.IpAddress IP address Table
(ipAddrTable)

The IP address to which this entry’ s
addressing information pertains
(same as 700 IP address), where IP
Address is the valid non-zero IP ad-
dress of the 700 Series Computer.

ipAdEntIfIndex 1.3.6.1.2.1.4.20.1.2.IpAddress IP address Table
(ipAddrTable)

The index value that uniquely iden-
tifies the interface to which this
entry is applicable (same as ifIndex).

ipAdEntNetMask 1.3.6.1.2.1.4.20.1.3.IpAddress IP address Table
(ipAddrTable)

The subnet mask associated with
the IP address of this entry (same as
Subnet Mask).

Configuring with SNMP
The community string allows an SNMP manager to manage the 700 Series
Computer with a specified privilege level. The default read-only communi-
ty string is “public” and “private” is the default read/write community
string. See the specific configuration parameter to find its OID. To config-
ure the 700 Series Computers using SNMP:
1 Configure 700 Series Computers for RF or Ethernet communications.
2 Determine the OID (Object Identifier) for the parameter to be chan-

ged. The Intermec base OID is 1.3.6.1.4.1.1963.
3 Use your SNMP management station to get and set variables that are

defined in the Intermec MIBs. You can set the traps, identification, or
security configuration parameters for SNMP. See Appendix A, “Control
Panel Applets,” to learn more about these parameters.
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Printer Support5

The 700 Series Color Mobile Computer works with the following printers
from Intermec Technologies. Contact an Intermec Representative for in-
formation about these printers.

S 6820
A full-page, 80-column printer.

S 6808
A 4-inch belt-mount printer.

S 781T
A 2-inch belt-mount printer with a Bluetooth compatible module from
Socket Communications.

S 782T
A 2-inch workboard printer.
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Printing ASCII
The following methods for printing using Pocket PC at this time is as fol-
lows:

S Add port drivers to print ASCII directly to the port.

S Use LinePrinter ActiveX Control from the Software Developer’ s Kit
(SDK) - see the SDK User’ s Manual for more information.

S Via wireless printing - see the Wireless Printing Development Guide on the
700C Software Tools CD for more information.

Directly to a Port
Printing directly to the port sends RAW data to the printer. The format of
this data depends upon your application and the printer capabilities.

You must understand the printer commands available for your specific
printer. Generally, applications just send raw ASCII text to the printer.
Since you are sending data to the printer from your application directly to
the port you are in complete control of the printers operations. This allows
you to do line printing (print one line at a time) rather than the page for-
mat printing offered by the GDI approach. It is also much faster since data
does not have to be converted from one graphics format to the other (dis-
play to printer). Most Intermec printers use Epson Escape Sequences to
control print format operations.

These commands are available in documentation you receive with your
printers or from technical support. Win32 APIs are required to print di-
rectly to the port.

Directly to a Generic Serial Port
To print directly to a generic serial port printer (non-Intermec printers):

S Use CreateFile() to open ports - COM1: can be opened on most de-
vices.

S Use WriteFile() to send data directly to the printer.

S Use CloseHandle() when you are finished printing to close the port.

IrDA Printer Driver
IrDA printing is only available on the certain devices and is supported di-
rectly by the Windows CE load via the IrSock API provided by the Micro-
soft Win32 API without need for additional drivers. Intermec 6804, 6805,
6806, 6808 and 6820 and other IrDA printers are supported.
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NPCP Printer Driver
The NPCP printer communications driver (NPCPPORT.DLL) is a
Stream Device Driver built into the operating system. The driver supports
only NPCP communications to and from the 6820 and 4820 printers over
a selected serial port.

All applications use WIN32 API functions to access the drivers. Basic op-
erations are easily implemented by applications through the CreateFile(),
WriteFile(), ReadFile(), DeviceIOControl(), and CloseHandle() Win32
APIs.

Operations to upgrade printer modules, perform printer diagnostics, and
get printer configuration are performed largely via DeviceIOControl()
functions.

About NPCP
NPCP (Norand Portable Communications Protocol) is a proprietary pro-
tocol that provides session, network, and datalink services for Intermec
mobile computers in the Intermec LAN environment used with printers
and data communications.

NPCP Driver Installation and Removal
Use LPT9: for the NPCP printer device and COM1 for the last parameter.
COM1 is the connection available via the 700 Series Computer.

Applications use the RegisterDevice() function to install the driver.
DeregisterDevice() uninstalls the device driver and frees memory space
when the driver is not required. Use the HANDLE returned by
RegisterDevice() as the parameter to DeregisterDevice().

Use the RegisterDevice() function call as demonstrated below. Specify the
full path name to the driver starting at the root for the RegisterDevice()
function to work properly. The last parameter to RegisterDevice() is a
DWORD that represents the name of the port for the NPCP stream driver
to use. Build this parameter on the stack if it is not to be paged out during
the call. The first parameter “LPT” (Device Name) and the second
parameter “9’ (index), indicate the name of the registered device, such as
LPT9. This is used in the CreateFile() function call.

Install()
{

HANDLE hDevice;
TCHAR port[6];
port[0] = TCHAR(‘C’);
port[1] = TCHAR(‘O’);
port[2] = TCHAR(‘M’);
port[3] = TCHAR(‘1’);
port[4] = TCHAR(‘:’);
port[5] = TCHAR(0);
hDevice = RegisterDevice ( (TEXT(”LPT”), 9,
TEXT(“\\STORAGE CARD\\WINDOWS\\NPCPPORT.dll”), (DWORD)port);

}



Printer SupportChapter —5

130 700 Series Color Mobile Computer User’s Manual

Opening the NPCP Driver
The application opens the NPCP driver by using the CreateFile()
function. The call can be implemented as follows. The first parameter
“LPT9:” must reflect the device name and index used in the
RegisterDevice() function call and will fail for any of the following reasons:

hFile = CreateFile(_T(”LPT9:”), GENERIC_WRITE |
GENERIC_READ, 0, NULL, OPEN_ALWAYS, FILE_ATTRIBUTE_NORMAL,
NULL);

S The port associated with the device during RegisterDevice() is in use.

S The NPCP device is already open.

S The share mode is not set to zero. The device cannot be shared.

S Access permissions are not set to GENERIC_WRITE |
GENERIC_READ. Both modes must be specified.

Closing the NPCP Driver
Using the CloseHandle() (hFile) function closes the NPCP driver. Where
hFile is the handle returned by the CreateFile() function call.

S TRUE = the device is successfully closed.

S FALSE = an attempt to close NULL HANDLE or an already closed de-
vice.

Reading from the NPCP Driver
Reading of the NPCP printers is not supported since all responses from the
printer are the result of commands sent to the printer. DeviceIoControl()
functions are provided where data is to be received from the printer.

Writing to the NPCP Driver
All Print data can be sent to the printer using the WriteFile() function.
The print data written to the driver must contain the proper printer
commands for formatting. If the function returns FALSE, the NPCP error
may be retrieved using IOCTL_NPCP_ERROR. See the description on
the next page.
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NPCP Driver I/O Controls
An application uses the DeviceIoControl() function to specify an printer
operation to be performed. Certain I/O controls are required to bind and
close communication sessions with the printer, and must be completed
before any other commands to the driver can execute properly.
The function returns TRUE to indicate the device successfully completed
its specified I/O control operation, otherwise it returns FALSE. The
following I/O control codes are defined:

#define IOCTL_NPCP_CANCEL
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x400,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_BIND
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x401,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_CLOSE
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x402,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_ERROR
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x403,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_FLUSH
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x404,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_IOCTL
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x405,METHOD_BUFFERED,FILE_ANY_ACCESS)
#define IOCTL_NPCP_PRTVER
CTL_CODE(FILE_DEVICE_SERIAL_PORT,0x406,METHOD_BUFFERED,FILE_ANY_ACCESS)

S IOCTL_NPCP_CANCEL
This cancels all printing at the printer. It flushes the printer buffers and
reinitializes the printer to its default state. No parameters are required.

S IOCTL_NPCP_BIND
This command is required before any data is sent or received by the
printer. Once the driver is opened, the application must bind the com-
munications session with the printer before any data can be sent or re-
ceived by the printer. If an error occurs during the bind, the application
may use IOCTL_NPCP_ERROR to get the current extended error
code. No parameters are required.

S IOCTL_NPCP_CLOSE
This command closes the current session with the printer. This function
always returns TRUE. No parameters are required.

S IOCTL_NPCP_ERROR
This command returns the extended NPCP error code in PL/N format.
The word returned will contain the PL/N compatible error code in the
low byte and completion flags in the high byte. If the frame that re-
turned an error was not received correctly by the printer the
FRAME_NOT_ACKED bit will be set in the high byte. This operation
always returns TRUE. An output buffer of at least 2 bytes is required.
See “NPCP Error Codes” on page 133.

S IOCTL_NPCP_FLUSH
This command allows the application to poll the printer for errors while
the report is completing the print process at the printer. If an error oc-
curs during the polling process, the operation will return FALSE and the
application can get the extended error code by using
IOCTL_NPCP_ERROR. No parameters are required.
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NPCP Printer Communications
All NPCP printer communications should be based on the following flow:

1 Use CreateFile(); to open the printer driver.

2 Use IOCTL_NPCP_BIND to bind a session with the printer;
IOCTL_NPCP_ERROR to check for errors on the bind to ensure suc-
cess; and IOCTL_NPCP_CANCEL to cancel any outstanding print
jobs.

3 Use IOCTL_NPCP_FLUSH to poll the printer to free up printer buff-
er resources. Use IOCTL_NPCP_FLUSH to poll the printer’ s status. If
an error is reported by the IOCTL, then use IOCTL_NPCP_ERROR
to get the error and determine the correct recovery procedure.

4 Use WriteFile(); to write your data to the printer. Check for errors and
that all data were written. Use IOCTL_NPCP_ERROR to get the ex-
tended error. If the error is critical in nature, use
IOCTL_NPCP_CLOSE, followed by CloseFile(), to end the commu-
nications session. Start a new session, beginning with step 1 to ensure
proper printing. For noncritical errors display the error and retry the
operation.

5 After all data is sent to the printer, ensure that the printer continues to
print the report properly by polling the printer’ s status. Use
IOCTL_NPCP_FLUSH to poll the printer’ s status. If an error is re-
ported by the IOCTL, then use IOCTL_NPCP_ERROR to get the er-
ror and determine the correct recovery procedure.

Sample Code
See sample code in the “\700 Color Dev Tools\Installable Drivers\Port
Drivers\Npcp\NPCPPrint\” directory for more details on printing, printer
communications and error code handling.



Printer Support—Chapter 5

133700 Series Color Mobile Computer User’s Manual

NPCP Error Codes
Call the IOCTL_NPCP_ERROR I/O control function to receive PL/N
compatible error codes. Applications must decide how to act upon the data
returned.

// Definition of NPCP communications Errors and Printer Errors
#define PNRDY (BYTE)102 // link not ready error
#define RXTMO (BYTE)104 // link no receive error
#define TXTMO (BYTE)106 // link no transmit error
#define BADADR (BYTE)111 // frame address error
#define GAPERR (BYTE)112 // link gap error (timeout) in receive data
#define LSRPE (BYTE)113 // frame parity error on length field
#define IFTS (BYTE)120 // session layer - invalid frame this state
#define NS_NE_VR (BYTE)121 // session layer sequence error
#define NR_NE_VS (BYTE)122 // session layer sequence error
#define MAC_CRCERR (BYTE)124 // MAC CRC error
#define RLENERR (BYTE)123 // MAC too much data received
#define FRMERR (BYTE)200 // Frame Reject
#define FRMERR_IF (BYTE)201 // Frame Reject - Invalid Frame
#define FRMERR_NR (BYTE)202 // Frame Reject - NR Mismatch
#define FRMERR_NS (BYTE)203 // Frame Reject - NS Mismatch
#define NDMERR (BYTE)204 // Normal Disconnect mode error
#define BINDERR (BYTE)210 // bind error
#define IPLDUR (BYTE)221 // invalid presentation layer response
#define HEADJAM (BYTE)222 // printer head jam
#define PAPEROUT (BYTE)223 // printer paper out
#define LOWVOLTS (BYTE)224 // printer low voltage
#define HIVOLTS (BYTE)225 // printer over voltage
#define LOWBAT (BYTE)226 // printer low battery
#define COVEROFF (BYTE)227 // printer cover off error
#define HEADFAULT (BYTE)228 // printer head short or driver short error
#define PFFAULT (BYTE)229 // paper feed motor fault.
#define FRAME_NOT_ACKED 0x8000 // frame was not received by printer and need to
be resent.
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O’ Neil Printer Driver
The DTR printer communications driver is a Stream Device Driver
named ONEIL.DLL.

All applications use WIN32 API functions to access drivers. Basic
operations are easily implemented by applications through the CreateFile(),
WriteFile(), DeviceIOControl() and CloseHandle() Win32 APIs.

The driver supports communications to 6804DM, 6804T, 6805A, 6806,
6808, 681T, and 781 printers over a selected serial port.

DTR Driver Installation and Removal
Your application must install the device driver by using the RegisterDe-
vice() function. The driver name is ONEIL.DLL. We recommend that
you use “DTR” for the Device Name parameter, “1” for the Device Driver
index parameter, and use any of the following strings for the last parame-
ter:

S NULL (==0) Defaults to COM1 @ 9600

S “COM1” only COM port specified defaults to 9600

S “COM1:9600” sets to COM port and specified bit rate

S “COM1:19200” sets to COM port and specified bit rate

Use the HANDLE returned by RegisterDevice() as the parameter to
DeregisterDevice(). The correct usage of the RegisterDevice() function call
is demonstrated below. You may use DeregisterDevice() to uninstall the
driver.

Install()
{

HANDLE hDevice;
TCHAR port[6];
port[0] = TCHAR(‘C’);
port[1] = TCHAR(‘O’);
port[2] = TCHAR(‘M’);
port[3] = TCHAR(‘1’);
port[4] = TCHAR(‘:’);
port[5] = TCHAR(0);
hDevice = RegisterDevice ( (TEXT(”DTR”), 1, TEXT(”\\WINDOWS\\ONEIL.DLL”),
(DWORD)port);

}
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Opening the DTR Driver
The application opens the DTR driver by using the CreateFile() function.
The call can be implemented as follows:

hFile = CreateFile(_T(”DTR1:”), GENERIC_WRITE, 0, NULL,
OPEN_ALWAYS, FILE_ATTRIBUTE_NORMAL, NULL);

The first parameter “DTR1:” must reflect the device name and index used
in the RegisterDevice() function call.

The function call will fail for any of the following reasons:

S The port associated with the device during RegisterDevice() is currently
in use.

S The DTR device is already open.

S The share mode is not set to zero. The device cannot be shared.

S Access permissions are not set to GENERIC_WRITE.

Closing the DTR Driver
Using the CloseHandle() (hFile) function closes the DTR driver. Where
hFile is the handle returned by the CreateFile() function call.

S TRUE indicates the device is successfully closed.

S FALSE indicates an attempt to close a NULL HANDLE or an already
closed device.

Writing to the DTR Driver
You can use the WriteFile() function to send all Print data to the printer.
The print data being written must contain the proper formatting printer
commands.

DTR Printer Communications
All DTR printer communications should be based on the following flow:

1 Use CreateFile(); to open the printer driver.

2 Use WriteFile() to write your data to the printer. Check for errors and
that all data were written.

3 Use CloseHandle() to close the driver.
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Scanner Support6

The 700 Series Color Mobile Computer is available with imaging or laser
scanning technologies, including the following:

S APS linear imager:
Reads 1D symbologies and PDF 417 bar codes. Linear imaging using
Vista Scanning technology reads low-contrast bar codes, laminated bar
codes, and bar codes displayed on CRT or TRT displays. This imaging
uses harmless LEDs for illumination and does not require any warning
labels. Vista Scanning is more reliable than lasers as it is a completely
solid state with no moving parts or oscillating mirrors.

S 2D Imager:
This decodes several stacked 1D and 2D symbologies, including PDF
417 and Data Matrix without “painting.” It can also read 1D codes
from any orientation, for example the scan beam does not need to be
aligned perpendicular to the symbol in order to read it. Photography is a
secondary application; the lens in the device will favor bar code reading.
Photos are 640x480, 256 gray-scale.

S 1D laser scanner:
Traditional laser scanner that decodes 1D bar codes.

S PDF 417 laser scanner:
Higher speed laser scanner that can read PDF 417 labels by “painting”
the label.
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Scanner Control and Data Transfer
Note: To use the methods described below, enable Data Collection func-
tionality on the 700 Computer using the bootloader configuration menu.
See Chapter 3, “Installing Applications” for more information.

The Data Server and associated software provide several ways to manipu-
late scanner control and data transfer between the scanner subsystem and
user applications:

S Automatic Data Collection COM Interfaces:
These COM interfaces allow user applications to receive bar code data,
and configure and control the bar code reader engine.

S ITCAxBarCodeReaderControl functions:
These ActiveX controls allow user applications to collect bar code data
from the scanner, to configure the scanner, and to configure audio and
visual notification when data arrives. For more information, see the
SDK User’ s Manual.

S ITCAxReaderCommand functions:
Use these ActiveX controls to modify and retrieve configuration infor-
mation using the reader interface commands. For more information, see
the SDK User’ s Manual.

S Scanning EasySet bar code labels:
You can use the EasySet bar code creation software from Intermec
Technologies Corporation to print configuration labels. Scan the labels
to change the scanner configuration and data transfer settings.

Automatic Data Collection COM Interfaces
Data collection configuration and functionality cannot be accessed by any
means (including control panel applets or remote management applications)
until after the 700 Series Computer has completed initialization, which
occurs during a warm- or cold-boot or after a firmware upgrade.

When initialization is complete, the green LED on the 700 Series Com-
puter stops flashing. Changes made to configuration settings remain after a
warm boot. After a cold-boot, all configuration settings are reset to their
defaults with the exception of scanner configurations, which remain except
for the Symbology Identifier transmission option or the Preamble and
Postamble strings. To reset all configuration settings to the factory defaults,
the S9C scanner firmware must be reloaded.
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The Automatic Data Collection (ADC) functions are accessed through
custom COM interfaces. These interfaces allow the application to receive
bar code data and configure and control the bar code reader engine. The
COM interfaces include the following functions:

S IADC (starting on page 151)

S IBarCodeReaderControl (starting on page 159)

S IS9CConfig (starting on page 172)

S IS9CConfig2 (starting on page 204)

S IS9CConfig3 (starting on page 216)

S IImage Interface (starting on page 221)

Multiple ADC COM Object Support
A 700 Series Computer may have multiple reader engines to decode differ-
ent types of ADC data. For example, a bar code reader engine decodes raw
bar code data and passes it to a bar code reader COM object. An RFID
reader engine decodes raw RFID tag data and passes it to an RFID tag
reader COM object.

ADC COM interfaces are implemented as in-process COM objects. An
instance of the ADC COM object creates a logical connection to access or
control the reader engine. Specifically, the IBarCodeReadConfig or IBar-
CodeReaderControl COM objects can manage the bar code scanner con-
figuration while the ADC COM object can gather data simultaneously.
These ADC COM objects or connections can be created in a single ap-
plication or multiple applications. Up to seven instances of a COM object
can be created for a reader engine. For more information, see “How to
Create and Use the ADC COM Interfaces” below.

For data collection features, ADC COM objects also provide for read
ahead and non-read ahead data access and grid data editing.
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How to Create and Use the ADC COM Interfaces
You can also use the Input Device Functions (starting on page 149) to
create and use the ADC COM interfaces.

1 Create and initialize the in-process Bar Code Reader object using
ITCDeviceOpen() (see page 149). This function returns a COM
Interface pointer to the Bar Code Reader Object created by the
function.

2 Set the data grid if data filtering is desired (default grid gives the applica-
tion all the data). Below is a sample code of how to set the grid to accept
Code 39 data that starts with the letter “A” and is not a reader com-
mand.

ITC_BARCODEREADER_GRID stBCGrid;
stBCGrid.stDIGrid.szDataMask = TEXT(”A%s”);
stBCGrid.stDDGrid.dwSymbologyMask = BARCODE_SYMBOLOGY_CODE39;
stBCGrid.dwDataSourceTypeMask = ITC_DATASOURCE_USERINPUT;
HRESULT hrStatus = pIBCControl->SetAttribute(
ITC_RDRATTR_GRID,
reinterpret_cast<BYTE *>(&stBCGrid),
sizeof(stBCGrid)
);

3 Issue a read to accept the bar code data. The timestamp, symbology, and
data type are put into the ITC_BARCODE_DATA_DETAILS struc-
ture. Passing in a pointer to this structure is optional. The following
sample code uses an infinite timeout.

ITC_BARCODE_DATA_DETAILS stBCDetails;
BYTE rgbBCData[1024]; // Buffer used to accept the bar code data
DWORD dwBytesReceived; // Number of bytes in the return data.
HRESULT hrStatus = pIBCControl->Read(
rgbBCData,
sizeof(rgbBCData),
&dwBytesReceived,
& stBCDetails,
INFINITE
);

4 Compile and link the application.

Read-Ahead Bar Code Data Access
The Bar Code Reader COM object delivers ADC data to the connection
in read-ahead mode. In this mode, the data is queued until a COM con-
nection is ready to read it. Read-ahead mode decouples reader device per-
formance from the application performance. That is, data is read as fast as
the user can scan it, independent of the connection processing load. No
data will be scanned until the first Read() function is posted.



6 Scanner Support—Chapter

141700 Series Color Mobile Computer User’s Manual

Grid Data Filtering
The virtual wedge retrieves scanned Automatic Data Collection (ADC)
data and sends it to the keypad driver so that the 700 Series Computer can
receive and interpret the data as keypad input. The data can be filtered so
that only data conforming to a certain text pattern or symbology will be
sent to an application. After the data is filtered, it can be edited by adding,
deleting, or rearranging portions of the text or by extracting portions of
text for further editing. To filter and edit data, you need to define the
virtual wedge grid parameters.

S Grid Processing:
Grid processing takes place in two steps:

S Compilation:
In which the user’ s grid expressions are checked for errors and
reduced to a binary form for faster matching. This is done whenever
the virtual wedge grid is set or changed by configuration software.

S Matching:
In which data is tested against the grids set in compilation. Matching
can be performed multiple times after a compilation. The AIM
symbology ID of the data being tested, including the enclosing angle
brackets, must be prepended to the incoming data.

Syntax
The basic syntax of each grid expression is:

<symID> filter-expression= > editing-expression

where:

S symID
Is the AIM symbology ID (see the AIM Symbology ID Defaults table
starting on page 219).

S filterexpression
Is any character string that includes valid filter expression values (see
the “Filter Expression Values” table on the next page).

S editing-expression
Is any character string that includes valid editing expression values (see
the “Editing Expression Values” table on page 144).
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Filter Expression Values
A filter-expression can be any string of text containing the operators listed
below.

Filter Expression Values

Operator Meaning Example

Any character string not containing
the special characters: . ? [ ] { } or \
(period, question mark, left/right
brackets, left/right curly brackets, back-
slash).

Match the string literally. super20 matches super20

\c where c is any of the special char-
acters: . ? [ ] { } or \
(period, question mark, left/right
brackets, left/right curly brackets, back-
slash)

Remove any special meaning of c. \* matches *

. (period) Any character. . matches x

^ (tarot) Anchor the match at the beginning
of the string.

^abc matches abc, but not aabc

$ (dollar sign) Anchor the match at the end of the
string.

abc$ matches abc but not abcc

? (question mark) Repeat the preceding expression zero
or one time.

aa? matches a or aa

* (asterisk) Repeat the preceding expression zero
or more times.

ab*c matches ac, abc, abbc, etc.

+ (plus symbol) Repeat the preceding expression one
or more times.

ab+c matches abc, abbc, etc.

[characterclass] A series of nonrepeating characters
denoting a class.

[abcdefhijklmnopqrstuvwxyz] is the
class of all lowercase alphas.

[rangel`rangeh] A sequential range of nonrepeating
characters denoting a class.

[a-z] is the class of all lowercase al-
phas.

[^characterclass] Any character except those denoted
by a character class.

[^a-z] matches a numeric digit or a
punctuation mark.

[characterclass_tag] [:alnum:] - Alphanumeric characters
[:alpha:] - Alphabetic characters
[:blank:] - Tab and space
[:cntrl:] - Control characters
[:digit:] - Numeric characters
[:graph:] - All printable characters ex-
cept space
[:lower:] - Lowercase letters
[:print:] - All printable characters
[:punct:] - Punctuation
[:space:] - White space characters
[:upper:] - Uppercase letters
[:xdigit:] - Hexadecimal digits

[[:alpha:]]* matches Dynaction,
Selmer, or NewWonder but not Su-
per20

{num} Matches exactly num repetitions. a{3} matches only aaa

{min,} Matches at least num repetitions. a{3,} matches aaaa but not aa
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Filter Expression Values (continued)

ExampleMeaningOperator

{min,max} A repetition operator like + or *, ex-
cept the number of repetitions is spe-
cified by min and max.

[a-z]{1,3} matches a, ab, or aab, but
not aabc

(expr1)|(expr2) Matches expr1 or expr2. a|b matches a or b

(subexpression) Grouping operator to consolidate
terms into a subexpression, which
can override the order of evaluation.

The subexpression is available for lat-
er matching or editing by means of
\index, where \index is between 1-9
and refers to the index-th group in
the string, counting from left to
right. \0 refers to the whole expres-
sion.

Overriding evaluation order: (ab)*c
matches c, abc, ababc, etc.

Back-referencing: (aa)bb\1 matches
aabbaa.
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Editing Expression Values
This table lists the valid operators for editing expressions.

Operator Meaning Example

\index The index-th subexpression (reading left-right)
in the matched string. index must be between
0`9. \0 is the matched expression itself.

M([0-9]{6})= > \1 produces 270494 when
M270494 is scanned, stripping off the first
character.

& or \0 The matched expression itself. M[0-9]{6}= > \0-Conn and
M[0-9]{6}= > &-Conn
both produce
M270494-Conn
when M270494 is scanned.

\xhh A concise representation of the lower 256
characters in the Unicode set. When con-
verted, this is still a 16-bit value.

\x0d inserts a carriage return.

any character string Inserts any character string in the output
string.

See previous examples.

S <symID> is optional. If present, only data in the indicated symbology is
accepted.

S If the entire expression is blank, all data is passed unchanged. If = >
editing-expression is omitted, then all data that passes through the filter is
returned unchanged. If = > editing expression is present, the data is trans-
formed by editing-expression.

S Multiple grid expressions can be compiled and are related in a logical
OR fashion. These are expressed as single grid expressions separated by
semicolons. When matching is attempted, the first grid expression from
left to right that achieves a match will cause the data to be accepted.

S All pattern expressions and parsed data are in Unicode.

Grid Filter Example 1
This accepts a serial number in which the encoded number is a six-charac-
ter string beginning with M followed by six numeric characters.

S Filter
M[0-9]{6}

S Effect
When a bar code, such as M270494, is scanned, all data is passed.

Grid Filter Example 2
This formats a scanned Social Security number and forms it into an XML
element tagged “SSN”.

S Filter
([0-9]{3})([0-9]{2})([0-9]{4})= > <SSN > \1-\2-\3</SSN >

S Effect
A bar code, such as 123456789, is passed and reformatted to
<SSN > 123-45-6789</SSN >
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Grid Filter Example 3
This deletes the first three and last five characters of a 21-character Code
128 label and deletes the first two characters of a 10-character Interleaved
2 of 5 label.

S Filter
<]C > ...(.{13}).....= > \1; <]I > ..(........)= > \1

S Effect
If Code 128, AAA1234567890123BBBBB becomes 1234567890123
If Interleaved 2 of 5, AA12345678 becomes 12345678

Grid Filter Example 4
This inverts data such that the first alphabetic string (like a first name) and
second alphabetic string (like a last name) are reversed and separated by a
comma and a space.

S Filter
([[:alpha:]])+ ([[:alpha:]])+= > \2, \1

S Effect
When a bar code with the data “Dexter Gordon” is scanned, the data is
modified to read “Gordon, Dexter”.

ADC Connection
A 700 Series Computer can have both Bar Code and RFID reader engines
with each engine supporting multiple connections. Each connection allows
an application to access data or manage a configuration. An application
could have multiple connections.

// Get an instance of the ADC COM object that corresponds integrated scanner
IBarCodeReaderControl *pIBCControl;

// Pointer to the Bar Code Reader object
HRESULT hrStatus = ITCDeviceOpen( TEXT(”default”),
IID_IBarCodeReaderControl, ITC_DHDEVFLAG_READAHEAD,
(LPVOID *) &pIBCControl);

// If the ADC object was successfully created and initialized, accept bar
code data.
ITC_BARCODE_DATA_DETAILS stBCDetails;
stBCDetails.wStructSize = sizeof(stBCDetails);
BYTE rgbBCData[1024];

//Buffer used to accept the bar code data
DWORD dwBytesReceived;

// Number of bytes in the return data.
HRESULT hrStatus = pIBCControl->Read(
rgbBCData,
sizeof(rgbBCData),
&dwBytesReceived,
& stBCDetails,
INFINITE
);
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2D Imager Overview
The 700 Color optional integrated 2D Imager captures 640x480
256-grayscale images at 20 frames per second. The imager features can be
categorized into data collection features and image acquisition features as
follows:

Data Collection Features
The imager includes a decode engine capable of decoding 2D matrix
symbologies such as Data Matrix as well as the traditional 1D and stacked
symbologies (see the table on the next page for supported symbologies). The
application programming interfaces used to collect bar code data and con-
figure the imager are the same as those used for the laser scanner. This in-
cludes the keyboard wedge as well as the ADC COM interfaces and in-
cludes functionality such as data editing and data filtering. In addition, the
imager has the following configuration features (see “IS9CConfig3 Func-
tions” starting on page 216 for configuration details):

S Aimer LED:
A small, rectangular-aiming LED is displayed periodically during the
image capture and decoding process. The initial duration (after scan but-
tons are pressed) of the aimer LED can be configured. This helps to select
the specific bar code to be scanned with multiple bar codes in the
image.

S Scaled Illumination LED:
When the ambient light is not sufficient to decode the bar code, the red
illumination LEDs will be turned on to brighten the image. The inten-
sity of the illumination LEDs is scaled to brighten the image just
enough for decode. The reduces power consumption and the effect of
specular reflection.

S Window size and position:
The default window size (640x480) can be reduced in size and posi-
tioned. This is useful in applications where multiple bar codes may be
present in the image and the specific bar code must be selected to be
read. For example, the window can be sized and positioned around the
aimer LED. The entire bar code must reside in the configured window
for a good decode.

Omni-directional scanning is a feature that does not require configuration.
1D and stacked symbologies as well as 2D matrix symbologies can be
scanned with the 700 Series Computer in any orientation. Thus, time is
not needed to orient the 700 horizontal as with laser scanners.
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The following table shows which bar code symbologies are supported ei-
ther by an imager or by a laser scanner.

Bar Code Symbology Imager Laser Scanner

Code 39 X X

Interleaved 2 of 5 X X

Standard 2 of 5 X X

Matrix 2 of 5 X

Code 128 X X

Code 93 X X

Codabar X X

MSI X

Plessey X

UPC X X

EAN/EAN 128 X X

Code 11 X

PDF 417 X X

Micro PDF 417 X

Telepen X

Data Matrix X

QR Code X

Image Acquisition Features
The integrated imager provides the following image acquisition features:

S Real-time and Still Image Acquisition:
This includes functions that start and stop image acquisition and read
acquired images.

S Signature Capture:
This allows the application to retrieve an image of the normalized signa-
ture. This means the image is always oriented as if the picture were tak-
en at right angles to the signature, at the same distance, and in the cen-
ter of the image no matter in what orientation the picture was taken.

Signature capture requires a PDF 417 or Code 128 bar code symbology
to be present in the image and requires the application to identify the
X,Y offsets relative to the center the bar code, the X,Y dimension of
image to be captured, and the aspect ratio of the bar code. Note the
units are in terms of the narrow element width of the bar code.
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See the following example signature capture label and dimensions. These
image acquisition features are provided through the IImage Interface
defined on page 221.

Y-axis

– Y

– X

Intelligent bar code
units

Bar code height
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Create and Delete ADC COM Object Functions
Use these functions to create and release ADC COM interfaces.
ITCDEVMGMT.H is the header file and ITCDEVMGMT.LIB is the
library.

ITCDeviceOpen
This function opens and initializes a communication channel to the de-
vice. In C++, this function returns a pointer to an interface on which the
methods are called. In C, this function returns a handle, which is the first
parameter in each of the interface function calls.

Syntax
HRESULT ITCDeviceOpen( LPCTSTR pszDeviceName, REFIID iid,
ITC_DEVICE_FLAGS eDeviceFlags, void** ppvObject );

Parameters
pszDevice [in] Pointer to a string that contains the device name

on which to initialize the logical connection.
The device name (Merlin 1) identifies a
communications port.
Use “default” for all internal scanners, such as
Imager, SE900, etc. Use “ExtScanner” for
tethered scanners.

iid [in] The identifier of the interface being requested.

eDeviceFlags [in] Enumeration that identifies the read
characteristics as follows:
S ITC_DHDEVFLAG_READAHEAD

Data is buffered on behalf of the calling
applications. Data Buffering starts after the
first call to IADC::Read ().

S ITC_DHDEVFLAG_NODATA
The client application is managing the device
to set its configuration or control its interface
but not to collect data from the device.

ppvObject [out] A pointer to the interface pointer identified by
iid. If the object does not support this interface,
ppvObject is set to NULL.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S ITCDeviceClose
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ITCDeviceClose
This function closes the interface opened with ITCDeviceOpen.

Syntax:
HRESULT ITCDeviceClose( IUnknown** ppvObject );

Parameters
ppvObject [in,out] A pointer to the interface pointer created by

ITCDeviceOpen. If successful on output, this
pointer is set to NULL.

Return Values
None.

Remarks
On Windows, this interface decrements the reference count. So alterna-
tively, IUnknown::Release() could be used and must be used if reference
counting is performed with IUnknown::AddRef(). On DOS, this function
closes all resources associated with the channel.

See Also
None.
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IADC Functions
IADC functions provide ADC data in an input device independent man-
ner. This interface can receive bar code data, RFID data, and other ADC
data from data collection engines, such as a bar code scanner. Use IADC
functions if bar code specifics such as symbology are not important to the
application.

IADC functions are the following. IADC.H is the header file and
ITCUUID.LIB contains the IID_IADC Interface GUID value used to
obtain the interface.

S IADC::CancelReadRequest (page 152)

S IADC::Initialize (page 153)

S IADC::QueryAttribute (page 154)

S IADC::QueryData (page 155)

S IADC::Read (page 156)

S IADC::SetAttribute (page 157)
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IADC::CancelReadRequest
This function cancels a pending Read() request. This call can be made on a
separate thread as a Read() or on the same thread. On a separate thread,
the function is useful in unblocking a blocked Read() so that other opera-
tions can be performed. On the same thread, this function is useful in
stopping data from being collected on behalf of a Read Ahead Client.

Syntax
HRESULT IADC::CancelReadRequest( BOOL FlushBufferedData,WORD
*pwTotalDiscardedMessages, DWORD *pdwTotalDiscardedBytes );

Parameters
FlushBufferedData [in] True Flush and discard all already

buffered data.
False Do not discard data, data will be

returned on the next read call.

pwTotalDiscardedMessages [in/out] Total number of discarded buffered
labels or tags.

pdwTotalDiscardedBytes Total number of discarded bytes.

Return Values
HRESULT that indicates success or failure.

Remarks
The return value indicates whether a read was pending.

See Also
S IADC::Initialize

S IADC::QueryAttribute

S IADC::QueryData

S IADC::Read

S IADC::SetAttribute
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IADC::Initialize
This function initializes a connection by opening a communications chan-
nel with a logical reader engine. The communications port is implicitly
identified. This communication channel is required to collect data or con-
figure the device.

Syntax
HRESULT IADC::Initialize ( LPCTSTR pszDeviceName,
ITC_DEVICE_FLAGS eDeviceFlags ) ;

Parameters
pszDeviceName [in] Pointer to a string that contains the device name

on which to initialize the logical connection.
The device name (Merlin 1) identifies a
communications port.
Use “default” for all internal scanners, such as
Imager, SE900, etc. Use “ExtScanner” for
tethered scanners.

eDeviceFlags [in] Enumeration that identifies the read
characteristic as follows:
S ITC_DHDEVFLAG_READAHEAD

Data is buffered on behalf of the calling
application. Data buffering starts after the
first call to IADC::Read ().

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IADC::CancelReadRequest

S IADC::QueryAttribute

S IADC::QueryData

S IADC::Read

S IADC::SetAttribute
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IADC::QueryAttribute
This function retrieves a specified attribute that is device-independent.
The specified attribute can be a grid or multiclient enable status.

Syntax
HRESULT IADC::QueryAttribute (
ITC_ADC_ATTRIBUTE_ID eAttribID, BYTE rgbBuffer[], DWORD
dwBufferSize, DWORD *pnBufferData );

Parameters
eAttribID [in] Specifies the attribute. Only one attribute can be

queried at a time. See IADC::SetAttribute.

rgbBuffer [out] Contains buffer for the attribute to be queried.
The structure of lpBuffer depends on the
attribute being queried. See IADC::SetAttribute
for a description of these structures.

dwBufferSize [in] The maximum number of bytes rgbBuffer can
store.

pnBufferData [out] Pointer to the DWORD location to put the
number of bytes stored in rgbBuffer.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IADC::CancelReadRequest

S IADC::Initialize

S IADC::QueryData

S IADC::Read

S IADC::SetAttribute
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IADC::QueryData
This function returns the status of user input data that has been buffered.

Syntax
HRESULT IADC::QueryData ( DWORD *dwTotalBufferedBytes, WORD
*wNumberOfMessages, DWORD *dwNextMessageSize );

Parameters
dwTotalBufferedBytes [out] Total bytes buffered for connection.

wNumberOfMessages [out] Total messages buffered. For example,
each buffer contains a single bar code scan.

dwNextMessageSize [out] Size (in bytes) of the next buffered
message.

Return Values
A standard status code that indicates success or failure.

Remarks
None.

See Also
S IADC::CancelReadRequest

S IADC::Initialize

S IADC::QueryAttribute

S IADC::Read

S IADC::SetAttribute
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IADC::Read
This function requests user input data from the reader engine. This is a
blocking function that returns either when there is data or after a timeout.

Syntax
HRESULT IADC::Read ( BYTE rgbDataBuffer[], DWORD
dwDataBufferSize, DWORD pnBytesReturned, SYSTEMTIME
pSystemTime, DWORD dwTimeout );

Parameters
rgbDataBuffer [in] Pointer to the buffer that receives the data

from the device.

dwDataBufferSize [in] Maximum number of bytes that can be
stored in rgbDataBuffer.

pnBytesReturned [out] Pointer to the DWORD location to store
the number of bytes returned in
rgbDataBuffer.

pSystemTime [out] Pointer to a SYSTEMTIME structure that
will hold the time stamp of the received
data. This can be NULL if a timestamp is
not needed.

dwTimeout [in] Number of milliseconds caller waits for
data. This parameter is ignored if the
Read Ahead flag is not set.
S 0

If data is not available, returns quickly.
S INFINITE

Waits until data is available.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IADC::CancelReadRequest

S IADC::Initialize

S IADC::QueryAttribute

S IADC::QueryData

S IADC::SetAttribute
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IADC::SetAttribute
This function changes an attribute such as a grid specification.

Syntax
HRESULT IADC::SetAttribute ( ITC_ADC_ATTRIBUTE_ID eAttribID,
BYTE rgbData[], DWORD nBufferSize );

Parameters
eAttribID [in] Identifies the attribute to set. Only one attribute

can be set at a time. The attribute is:
S ITC_MULTICLIENT_ENABLE

Indicates whether this client can coexist with
other clients.

rgbData [in] Contains data for the attribute to be set.
Depending on the eAttribID, this will be mapped
to the appropriate structure as follows:
S ITC_MULTICLIENT_ENABLE

BOOL is the rgbData Data Structure.
S TRUE, Client can receive data with other

clients (default).
S FALSE, Data stream to this client is turned

off when there are other clients.
S ITC_DHATTR_READFILTER

ITC_READFILTER is the rgbData Data
Structure. The ITC_READFILE structure is
defined in IADCDEVICE.H as follows:

typedef struct
{

#define ITC_MAXFILTER_CHARS 240
WORD nFilterChars;
TCHAR szFilter[ITC_MAXFILTER_CHARS];

} ITC_READFILTER;

where:
S ITC_MAXFILTER_CHARS

Maximum number of characters in a filter
specification. Includes NULL termination.
S nFilterChars Number of characters in

pszDataMask.
S szFilter Data mask specification. See

“Grid Data Filtering.”

nBufferSize [in] Number of bytes in rgbData.

ITC_DHATTR_READFILTER
Regular expression that performs data filtering and data editing. See “Grid
Data Filtering” on page 141 for more information.

Return Values
A standard status code that indicates success or failure.

Remarks
None.
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See Also
S IADC::CancelReadRequest

S IADC::Initialize

S IADC::QueryAttribute

S IADC::QueryData

S IADC::Read



6 Scanner Support—Chapter

159700 Series Color Mobile Computer User’s Manual

IBarCodeReaderControl Functions
IBarCodeReaderControl functions provide functionality for bar code
collection and control only. These functions allow an application to:

S Trigger the bar code laser scanner

S Disable the scanner

S Receive a bar code with details such as symbology scanned, data type
(Unicode, ASCII), and the time the data was received.

These functions include the following. IBARCODEREADER.H is the
header file and ITCUUID.LIB contains the IID_IADC Interface GUID
value used to obtain the interface.

S IBarCodeReaderControl::CancelReadRequest (page 160)

S IBarCodeReaderControl::ControlLED (page 161)

S IBarCodeReaderControl::Initialize (page 162)

S IBarCodeReaderControl::IssueBeep (page 163)

S IBarCodeReaderControl::QueryAttribute (page 164)

S IBarCodeReaderControl::Read (page 165)

S IBarCodeReaderControl::SetAttribute (page 167)

S IBarCodeReaderControl::TriggerScanner (page 171)
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IBarCodeReaderControl::CancelReadRequest
This function cancels a pending IBarCodeReaderControl::Read request. If
the read request is blocked, issue the CancelReadRequest from a separate
thread.

Syntax
HRESULT IBarCodeReaderControl::CancelReadRequest( BOOL
FlushBufferedData, WORD *pwTotalDiscardedMessages,WORD
*pwTotalDiscardedBytes );

Parameters
FlushBufferedData [in] TRUE Flushes and discards all buffered

data.
FALSE Does not discard data; data will

be returned on the next read
call.

pwTotalDiscardedMessages [in/out] Total number of discarded
buffered labels or tags.

pwTotalDiscardedBytes Total number of discarded
bytes.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::ControlLED
This function controls LED illumination on a tethered scanner. The good
read LED and any valid LEDs will be turned on and off based on defined
parameters.

Syntax
HRESULT IBarCodeReaderControl::ControlLED(
ITC_BARCODE_LASER_LED_ID eLED, BOOL fLedOn );

Parameters
eLED [in] The specified LED identifier.

S ITC_BARCODE_LASER_GOOD_READ_LED
Identifies the good read LED.

fLedOn [in] TRUE turns on the LED. FALSE turns off the LED.

Return Values
HRESULT that indicates success or failure.

Remarks
This function does not coordinate LED control with the scanner. If the
scanner LED control is enabled, function results will be unpredictable.

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::Initialize
This function opens and initializes a communications channel with a log-
ical bar code reader engine.

Syntax
HRESULT IBarCodeReaderControl::Initialize ( LPCTSTR
pszDeviceName, ITC_DEVICE_FLAGS eDeviceFlags ) ;

Parameters
pszDeviceName [in] Pointer to a string with device on which to

initialize the logical connection. The device
identifies a communications port. Use “default”
for all internal scanners, such as Imager, SE900,
etc. Use “ExtScanner” for tethered scanners.

eDeviceFlags [in] Enumeration that identifies the read
characteristic as follows:
S ITC_DHDEVFLAG_READAHEAD

Data is buffered on behalf of the calling
applications. Data Buffering starts after the
first call to IADC::Read ().

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::IssueBeep
This function causes the reader engine to generate a high beep, a low beep,
or a custom beep. The high beep and low beep are preconfigured beep
tones and durations. The custom beep allows the client to specify the fre-
quency and duration. The volume is the current volume setting. Note this
is not implemented.

Syntax
HRESULT IBarCodeReaderControl::IssueBeep( ITC_BEEP_SPEC
rgBeepRequests[], DWORD dwNumberOfBeeps );

Parameters
rgBeepRequests [in] Array of ITC_BEEP_SPEC structures that

identifies the beep type. The beep structure
is:

typedef struct tagITCBeepSpec
{
ITC_BEEP_TYPE eBeepType; // Identifies the type of beep
// Following fields used only if the beep type is ITC_CUSTOM_BEEP.
WORD wPitch; // Frequency, in Hz, of the beep.
WORD wOnDuration; // Duration, in milliseconds, of Beep On.
WORD wOffDuration; // Duration, in milliseconds, of Beep Off
// Beep Off is used to separate individual beeps
} ITC_BEEP_SPEC;
typedef enum tagITCBeepType
{
ITC_LOW_BEEP, // Issue the default low beep.
ITC_HIGH_BEEP, // Issue the default high beep.
ITC_CUSTOM_BEEP, // Issue a custom beep.
} ITC_BEEP_TYPE;

dwNumberOfBeeps [in] Identifies the total number of beeps in
rgBeepRequests.

Return Values
E_NOTIMPL as this function is not implemented.

Remarks
None.

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::QueryAttribute
This function retrieves the device-specific grid, the scanner enable status,
and the LED control status for the current bar code reader engine.

Syntax
HRESULT IBarCodeReaderControl::QueryAttribute (
ITC_BARCODEREADER_ATTRIBUTE_ID eAttr, BYTE rgbAttrBuffer[],
DWORD dwAttrBufferSize );

Parameters
eAttr [in] Specifies the attribute. See

IBarCodeReaderControl::SetAttribute on
page 167 for the attributes.

rgbAttrBuffer [out] Contains buffer for the attribute to be
queried. The structure of rgbAttrBuffer
depends on the attribute being queried.
See IBarCodeReaderControl::SetAttritbute
for a description of these structures.

dwAttrBufferSize [in] The maximum number of bytes that
rgbAttrBuffer can store.

Return Values
A standard status code that indicates success or failure.

Remarks
The following attributes are not supported on the imager:

S ITC_RDRATTR_TONE_ENABLE

S ITC_RDRATTR_VOLUME_LEVEL

S ITC_RDRATTR_TONE_FREQUENCY

S ITC_RDRATTR_GOOD_READ_BEEPS_NUMBER

S ITC_RDRATTR_GOOD_READ_BEEP_DURATION

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::Read
This function reads data from the bar code input device. This method per-
forms the same function as IADC::Read () except that it provides addition-
al information about data received such as bar code symbology used, data
type, and time stamp of received data.

Syntax
HRESULT IBarCodeReaderControl::Read ( BYTE
rgbDataBuffer[],DWORD dwDataBufferSize, DWORD
pnBytesReturned,ITC_BARCODE_DATA_DETAILS
pBarCodeDataDetails, DWORD dwTimeout );

Parameters
rgbDataBuffer [in] Pointer to the buffer that receives data

from the device.

dwDataBufferSize [in] Maximum number of bytes that can be
stored in rgbDataBuffer.

pnBytesReturned [out] Pointer to the DWORD location that will
store the bytes returned in rgbDataBuffer.

pBarCodeDataDetails [in] Address of data structure in which to put
the data details. This may be NULL. The
ITC_BARCODE_DATA_DETAILS is:

typedef struct tagITCBarCodeDetails

{

WORD wStructSize,
ITC_BARCODE_SYMBOLOGY_ID eSymbology,
ITC_BARCODE_DATATYPE eDataType,
SYSTEMTIME stTimeStamp,
}ITC_BARCODE_DATA_DETAILS;

typedef enum tagBarCodeDataType

{

BARCODE_DATA_TYPE_UNKNOWN = 1,
BARCODE_DATA_TYPE_ASCII,
BARCODE_DATA_TYPE_UNICODE,
}ITC_BARCODE_DATATYPE;

where:
S wStructSize Size of structure. Used for versioning structure.

S eSymbology Symbology of the returned data.

S eDataType Identifies data types as ASCII, UNICODE, etc.

S stTimeStamp Timestamp of the received data.

S BARCODE_DATA_TYPE_UNKNOWN Data in unknown.

S BARCODE_DATA_TYPE_ASCII Data is ASCII.

S BARCODE_DATA_TYPE_UNICODE Data is UNICODE.
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dwTimeout [in] Number of milliseconds caller waits for
data. If you set a timeout, the call will be
blocked until data is received.
S 0

If data not available, returns quickly.
S INFINITE

Waits until data is available.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::SetAttribute

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::SetAttribute
This function enables and disables the laser scanner, sets the bar code read-
er engine specific grid, and enables or disables the reader engine LED con-
trol.

Syntax
HRESULT IBarCodeReaderControl::SetAttribute (
ITC_BARCODEREADER_ATTRIBUTE_ID eAttr, BYTE rgbAttrBuffer[],
DWORD dwAttrBufferSize );

Parameters
eAttr [in] Identifies the attribute to set. Only one attribute can be set

at a time. The attributes are:
S ITC_RDRATTR_SCANNER_ENABLE

Enable or disable scanner for all connections.
S ITC_RDRATTR_GOOD_READ_LED_ENABLE

Enables and disables the reader engine from controlling
the good read LED.

S ITC_RDRATTR_TONE_ENABLE
Enables and disables the reader engine from issuing
beeps.

S ITC_RDRATTR_VOLUME_LEVEL
Sets beep volume level.

S ITC_RDRATTR_TONE_FREQUENCY
Sets beep frequency.

S ITC_RDRATTR_GOOD_READ_BEEPS_NUMBER
Sets number of beeps for a good read.

S ITC_RDRATTR_GOOD_READ_BEEP_DURATION
Sets duration of beeps for a good read.

S ITC_DHATTR_READFILTER
The ITC_READFILTER is the rgbData Data Structure.
The ITC_READFILE structure is defined in
IADCDEVICE.H as follows:

typedef struct
{

#define ITC_MAXFILTER_CHARS 240
WORD nFilterChars;
TCHAR szFilter[ITC_MAXFILTER_CHARS];

} ITC_READFILTER;

where:
S nFilterChars Number of characters in pszDataMask.
S szFilter Data mask specification. See “Grid Data

Filtering.”
S ITC_MAXFILTER_CHARS

Maximum number of characters in a filter specification.
Includes NULL termination.
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rgbAttrBuffer [in] Contains data for the attribute to be set. Depending
on eAttr, the rgbAttrData will be mapped to the
appropriate structure as shown in the following table .

rgbAttrBuffer Data Structures

eAttr Data Structure contained in rgbAttrBuffer

ITC_RDRATTR_GRID ITC_BARCODEREADER_READER_GRID
Reader Engine specific grid only.

ITC_RDRATTR_SCANNER_ENABLE BOOL
TRUE Enable scanner.
FALSE Disable scanner.

ITC_RDRATTR_GOOD_READ_LED_ENABLE BOOL
TRUE Reader Engine controls good read LED.
FALSE Good read LED is not controlled.

ITC_RDRATTR_DATA_VALID_LED_ENABLE BOOL
TRUE Reader Engine controls data valid LED.
FALSE Data valid LED is not controlled.

ITC_RDRATTR_TONE_ENABLE BOOL
TRUE Reader Engine issues beeps.
FALSE Beeps are not issued.

ITC_RDRATTR_VOLUME_LEVEL ITC_BEEP_VOLUME
An enumerator that identifies the beep volume level con-
trol. Valid range for S9C:

typedef enum tagBeepVolume
{
ITC_BEEP_VOLUME_LOW = 0,
ITC_BEEP_VOLUME_MEDIUM = 2,
ITC_BEEP_VOLUME_HIGH = 1 //Default
}ITC_BEEP_VOLUME

Note: Due to the hardware design on this 700 Series Com-
puter, the volume level can be either
OFF (ITC_BEEP_VOLUME_LOW) or
ON (ITC_BEEP_VOLUME_MEDIUM/HIGH).

ITC_RDRATTR_TONE_FREQUENCY DWORD
A value that identifies the tone frequency in Hz. Valid
range for S9C: 1000`4095 Hz (default: 2090).
Note: Value is divided by 10 for storage. On retrieval, the
scanner rounds off the value to the nearest 10 Hz, then mul-
tiplies the value by 10. For example, the value sent to the
scanner is 2095. On retrieval, the value returned is 2090.
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rgbAttrBuffer Data Structures (continued)

Data Structure contained in rgbAttrBuffereAttr

ITC_RDRATTR_GOOD_READ_BEEPS_NUMBER ITC_GOOD_READ_BEEPS_NUMBER
An enumerator identifying the good read beeps number.
Valid range for S9C:

typedef enum tagGoodReadBeepsNumber
{
ITC_NUM_BEEPS_NONE = 0,
ITC_NUM_BEEPS_ONE = 1, // Default
ITC_NUM_BEEPS_TWO = 2
}ITC_GOOD_READ_BEEPS_NUMBER

ITC_RDRATTR_GOOD_READ_BEEP_DURATION DWORD
Value identifying the good read beep duration in ms.
Valid range for S9C: 0`2550 ms (Default: 80).
Note: Value is divided by 10 for storage. On retrieval, the
scanner rounds the value to the nearest 10 ms, then multi-
plies the value by 10.

dwAttrBufferSize [in] The size of rgbAttrBuffer in bytes.

Return Values
HRESULT that indicates success or failure.

Remarks
Read ahead and non-read ahead clients can change the grid. Since
changing the grid changes the entire reader engine grid, use
IBarCodeReaderControl::QueryAttribute to retrieve the current reader
engine grid and grid changes before sending back using SetAttribute. The
grid structure is typedef struct tagBarCodeReaderGrid.

{
ITC_DI_GRID stDIGrid; // Device independent grid.
ITC_DDBARCODE_GRID stDDGrid; // Reader engine dependent grid
DWORD dwDataSourceTypeMask;
} ITC_BARCODEREADER_GRID;

ITC_DI_GRID

typedef struct tagItcBarCodeGrid
{
DWORD dwSymbologyMask; // Symbologies to be received.
} ITC_DDBARCODE_GRID;

When the scanner is enabled, it scans when the scan button is pressed or
the trigger is pulled. When the scanner is disabled, it does not respond
when the scan button is pressed or the trigger is pulled.



Scanner SupportChapter —6

170 700 Series Color Mobile Computer User’s Manual

The following attributes are not supported on the imager:

S ITC_RDRATTR_TONE_ENABLE

S ITC_RDRATTR_VOLUME_LEVEL

S ITC_RDRATTR_TONE_FREQUENCY

S ITC_RDRATTR_GOOD_READ_BEEPS_NUMBER

S ITC_RDRATTR_GOOD_READ_BEEP_DURATION

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::TriggerScanner
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IBarCodeReaderControl::TriggerScanner
This function turns the scanner on and off. The client application must
coordinate control of the scanner with the user.

Syntax
HRESULT IBarCodeReaderControl::TriggerScanner ( BOOL
fScannerOn );

Parameters
fScannerOn [in] Set TRUE to turn the scanner on. Set FALSE to turn

the scanner off.

Return Values
HRESULT that indicates success or failure.

Remarks
The scanner will be turned on or off independent of the actions of the us-
ers. The client application must coordinate control of the scanner with the
user. When the scanner is turned on, its behavior is controlled by the trig-
ger mode. That is, in one shot mode, the laser turns off when a label is
scanned; in auto-trigger mode, the laser remains on.

See Also
S IBarCodeReaderControl::CancelReadRequest

S IBarCodeReaderControl::ControlLED

S IBarCodeReaderControl::Initialize

S IBarCodeReaderControl::IssueBeep

S IBarCodeReaderControl::QueryAttribute

S IBarCodeReaderControl::Read

S IBarCodeReaderControl::SetAttribute
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IS9CConfig Functions
This interface provides methods to set and retrieve the 700 Series Com-
puter bar code configuration. All supported symbologies are initialized to
their defaults when the S9C firmware is loaded.

GET/SET functions use enumerations as their parameters. In most enu-
merations, there is an enumerator xx_NO_CHANGE (such as
ITC_CODE39_NO_CHANGE), where xx refers to a particular enum-
eration. This enumerator can be used during a call to a SET to indicate
that no change is to be made to that particular parameter. This prevents
the called function from having to format the same S9C command and
send down to the S9C scanner.

For all symbologies, to set a bar code length of “any length,” use a value of
“0” for the bar code length argument.

IS9CConfig functions are the following. IS9CCONFIG.H is the header
file and ITCUUID.LIB contains the IID_IADC Interface GUID value
used to obtain the interface.

S IS9CConfig::GetCodabar (page 173)

S IS9CConfig::SetCodabar (page 174)

S IS9CConfig::GetCode39 (page 176)

S IS9CConfig::SetCode39 (page 177)

S IS9CConfig::GetCode93 (page 179)

S IS9CConfig::SetCode93 (page 179)

S IS9CConfig::GetCode128 (page 180)

S IS9CConfig::SetCode128 (page 181)

S IS9CConfig::GetI2of5 (page 183)

S IS9CConfig::SetI2of5 (page 184)

S IS9CConfig::GetMatrix2of5 (page 185)

S IS9CConfig::SetMatrix2of5 (page 186)

S IS9CConfig::GetMSI (page 187)

S IS9CConfig::SetMSI (page 187)
S IS9CConfig::GetPDF417 (page 188)

S IS9CConfig::SetPDF417 (page 189)

S IS9CConfig::GetPlessey (page 192)

S IS9CConfig::SetPlessey (page 192)

S IS9CConfig::GetStandard2of5 (page 194)

S IS9CConfig::SetStandard2of5 (page 195)

S IS9CConfig::GetTelepen (page 197)

S IS9CConfig::SetTelepen (page 197)

S IS9CConfig::GetUpcEan (page 198)

S IS9CConfig::SetUpcEan (page 200)
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IS9CConfig::GetCodabar
This function retrieves the current settings of Codabar symbology.

Syntax
HRESULT IS9CConfig::GetCodabar( ITC_CODABAR_DECODING*
peDecode, ITC_CODABAR_START_STOP* peSS, ITC_CODABAR_CLSI*
peCLSI, ITC_CODABAR_CHECK_DIGIT* peCheck,
ITC_BARCODE_LENGTH_ID* peLengthId, BYTE rgbLengthBuff[],
DWORD* pdwNumBytes );

Parameters
peDecode [out] Pointer to the ITC_CODABAR_DECODING

location to receive the decoding for Codabar
symbology.

peSS [out] Pointer to the
ITC_CODABAR_START_STOP location to
receive the Start/Stop option.

peCLSI [out] Pointer to the ITC_CODABAR_CLSI location
to receive the CLSI library system.

peCheck [out] Pointer to the
ITC_CODABAR_CHECK_DIGIT location to
receive the check digit.

peLengthId [out] Pointer to the ITC_BARCODE_LENGTH_ID
location to receive an indicator of either
ITC_BARCODE_LENGTH or
ITC_BARCODE_FIXED_LENGTH.

rgbLengthBuff [out,size_is(3)]
An array of bytes to receive 1 byte of data for
ITC_BARCODE_LENGTH, or 3 bytes of data
for ITC_BARCODE_FIXED_LENGTH.

pdwNumBytes [out] Pointer to the DWORD location to receive a
number indicating number of bytes in
rbgLengthBuff[]: 1 byte for
ITC_BARCODE_LENGTH or 3 bytes for
ITC_BARCODE_FIXED_LENGTH.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetCodabar
This function updates the Codabar settings with new values.

Syntax
HRESULT IS9CConfig::SetCodabar( ITC_CODABAR_DECODING
eDecode, ITC_CODABAR_START_STOP eSS, ITC_CODABAR_CLSI
eCLSI,ITC_CODABAR_CHECK_DIGIT eCheck, ITC_BARCODE_LENGTH_ID
eLengthId, BYTE rgbLengthBuff[],DWORD dwNumBytes );

Parameters
eDecode [in] Identifies the decoding for Codabar symbology.

eSS [in] Identifies the Start/Stop option.

eCLSI [in] Identifies the CLSI library system.

eCheck [in] Identifies the check digit.

eLengthId [in] Use
ITC_BARCODE_LENGTH_NO_CHANGE to
indicate no change for bar code length. Use
ITC_BARCODE_LENGTH for any length and
minimum length, and set rgbLengthBuff[0] to a
valid length value.
Use ITC_BARCODE_FIXED_LENGTH to
compose 1 or 2 or 3 fixed lengths, and set 3 bytes:
rgbLengthBuff[0], rgbLengthBuff[1],
rgbLengthBuff[2] with valid values.

rgbLengthBuff [in,size_is(dwNumBytes)]
An array of bytes containing bar code lengths when
eLengthId = ITC_BARCODE_LENGTH or
ITC_BARCODE_FIXED_LENGTH.

dwNumBytes [in] Number of bytes in rbgLengthBuff[]. For S9C, this
value is 1 when
eLengthId = ITC_BARCODE_LENGTH or 3
when eLengthId =
ITC_BARCODE_FIXED_LENGTH

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Codabar Default Settings

Parameter Default Valid Range

Decode Not Active ITC_CODABAR_DECODING

CLSI Library System Not Active ITC_CODABAR_CLSI

Start/Stop Not Transmitted ITC_CODABAR_START_STOP

Check Digit Not Used ITC_CODABAR_CHECK_DIGIT

Bar Code Length Minimum Length = 6 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE

Codabar Enumerations
typedef enum tagCodabarDecoding
{
ITC_CODABAR_NOTACTIVE = 0, // Default
ITC_CODABAR_ACTIVE = 1,
ITC_CODABAR_NO_CHANGE = 255
} ITC_CODABAR_DECODING;

typedef enum tagCodabarStartStop
{
ITC_CODABAR_SS_NOTXMIT, // Default
ITC_CODABAR_SS_LOWERABCD, // a,b,c,d
ITC_CODABAR_SS_UPPERABCD, // A,B,C,D
ITC_CODABAR_SS_LOWERABCDTN, // a,b,c,d / t,n,*,e
ITC_CODABAR_SS_DC1TODC4, // DC1,DC2,DC3,DC4
ITC_CODABAR_SS_NO_CHANGE = 255
} ITC_CODABAR_START_STOP;

typedef enum tagCodabarClsi
{
ITC_CODABAR_CLSI_NOTACTIVE = 0, // Default
ITC_CODABAR_CLSI_ACTIVE = 1,
ITC_CODABAR_CLSI_NO_CHANGE = 255
} ITC_CODABAR_CLSI;

typedef enum tagCodabarCheckDigit
{
ITC_CODABAR_CHECK_NOTUSED, // Default
ITC_CODABAR_CHECK_XMIT,
ITC_CODABAR_CHECK_NOTXMIT,
ITC_CODABAR_CHECK_NO_CHANGE = 255
} ITC_CODABAR_CHECK_DIGIT;

typedef enum tagBarcodeLengthId
{
ITC_BARCODE_LENGTH = 0,
ITC_BARCODE_FIXED_LENGTH,
ITC_BARCODE_LENGTH_NO_CHANGE = 255
} ITC_BARCODE_LENGTH_ID;
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IS9CConfig::GetCode39
This function retrieves the current settings of Code 39.

Syntax
HRESULT IS9Cconfig::GetCode39( ITC_CODE39_DECODING*
peDecode, ITC_CODE39_FORMAT* peFormat,
ITC_CODE39_START_STOP* peSS,ITC_CODE39_SS_CHARS* peSSChars,
ITC_CODE39_CHECK_DIGIT* peCheck, DWORD* pwLength );

Parameters
peDecode [out] Pointer to the ITC_CODE39_DECODING

location to receive the decoding for Code 39.

peFormat [out] Pointer to the ITC_CODE39_FORMAT location
to receive the Code 39 format.

peSS [out] Pointer to the ITC_CODE39_START_STOP
location to receive the Code 39 start/stop.

peSSChars [out] Pointer to the ITC_CODE39_SS_CHARS
location to receive the Start/Stop character.

peCheck [out] Pointer to the ITC_CODE39_CHECK_DIGIT
location to receive the check digit.

pwLength [out] Pointer to the DWORD location to receive the bar
code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetCode39
This function updates the Code 39 settings with new values.

Syntax
HRESULT IS9CConfig::SetCode39( ITC_CODE39_DECODING
eDecode,ITC_CODE39_FORMAT eFormat, ITC_CODE39_START_STOP
eSS,ITC_CODE39_SS_CHARS eSSChars, ITC_CODE39_CHECK_DIGIT
eCheck, DWORD dwLength );

Parameters
eDecode [in] Identifies the decoding for Code 39.

eFormat [in] Identifies the Code 39 Format.

eSS [in] Identifies the Start/Stop option.

eSSChars [in] Identifies the Start/Stop character.

eCheck [in] Identifies the Check digit.

dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Code 39 Default Settings

Parameter Default Valid Range

Decoding Active ITC_CODE39_DECODING

Format Standard 43 Character ITC_CODE39_FORMAT

Start/Stop Not Transmitted ITC_CODE39_START_STOP

Accepted Start/stop Characters * only ITC_CODE39_SS_CHARS

Check Digit Not Used ITC_CODE39_CHECK_DIGIT

Bar Code Length Any Bar Code Length 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE
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Code 39 Enumerations
typedef enum tagCode39Decoding
{
ITC_CODE39_NOTACTIVE = 0,
ITC_CODE39_ACTIVE = 1, // Default
ITC_CODE39_NO_CHANGE = 255
} ITC_CODE39_DECODING;

typedef enum tagCode39Format
{
ITC_CODE39_FORMAT_STANDARD43, // Default
ITC_CODE39_FORMAT_FULLASCII,
ITC_CODE39_FORMAT_NO_CHANGE = 255
} ITC_CODE39_FORMAT;

typedef enum tagCode39StartStop
{
ITC_CODE39_SS_NOTXMIT, // Default
ITC_CODE39_SS_XMIT,
ITC_CODE39_SS_NO_CHANGE = 255
} ITC_CODE39_START_STOP;

typedef enum tagCode39StartStopChars
{
ITC_CODE39_SS_CHARS_DOLLARSIGN,
ITC_CODE39_SS_CHARS_ASTERISK, // Default
ITC_CODE39_SS_CHARS_BOTH,
ITC_CODE39_SS_CHARS_NO_CHANGE = 255
} ITC_CODE39_SS_CHARS;

typedef enum tagCode39CheckDigit
{
ITC_CODE39_CHECK_NOTUSED, // Default
ITC_CODE39_CHECK_MOD43_XMIT,
ITC_CODE39_CHECK_MOD43_NOTXMIT,
ITC_CODE39_CHECK_FRENCH_CIP_XMIT,
ITC_CODE39_CHECK_FRENCH_CIP_NOTXMIT,
ITC_CODE39_CHECK_ITALIAN_CPI_XMIT,
ITC_CODE39_CHECK_ITALIAN_CPI_NOTXMIT,
ITC_CODE39_CHECK_NO_CHANGE = 255
} ITC_CODE39_CHECK_DIGIT;
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IS9CConfig::GetCode93
This function retrieves the current settings of Code 93.

Syntax
HRESULT IS9CConfig::GetCode93( ITC_CODE93_DECODING*
peDecode, DWORD* pdwLength );

Parameters
peDecode [out] Pointer to the ITC_CODE93_DECODING

location to receive the decoding for Code 93
symbology.

pdwLength [out] Pointer to the DWORD location to receive a value
for bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig::SetCode93
This function updates the Code 93 settings with new values.

Syntax
HRESULT IS9CConfig::SetCode93( ITC_CODE93_DECODING
eDecode,DWORD dwLength );

Parameters
eDecode [in] Identifies the decoding for Code93 Symbology.

dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Code 93 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_CODE93_DECODING

Bar Code Length Any Bar Code Length 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE
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Code 93 Enumerations
Use this when the bar code length does not require any change.

typedef enum tagCode93Decoding
{
ITC_CODE93_NOTACTIVE = 0, // Default
ITC_CODE93_ACTIVE = 1,
ITC_CODE93_NO_CHANGE = 255
} ITC_CODE93_DECODING;
#define ITC_BC_LENGTH_NO_CHANGE 255.

IS9CConfig::GetCode128
This function retrieves the current settings of Code 128 symbology.

Syntax
HRESULT IS9Cconfig::GetCode128( ITC_CODE128_DECODING*
peDecode, ITC_EAN128_IDENTIFIER* peEan128Ident,
ITC_CODE128_CIP128 peCip128State, BYTE* pbyFNC1, DWORD*
pdwLength );

Parameters
peDecode [out] Pointer to the ITC_CODE128_DECODING

location to receive the decoding for Code 128
symbology.

peEan128Ident [out] Pointer to the ITC_EAN128_IDENTIFIER
location to receive the EAN 128 identifier.

peCip128State [out] Pointer to the ITC_CODE128_CIP128
location to receive the CIP 128.

pbyFNC1 [out] Pointer to the BYTE location to receive the
FNC1 separator character.

pdwLength [out] Pointer to the DWORD location to receive a
value for bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetCode128
This function updates the Code 128 settings with new values.

Syntax
HRESULT IS9CConfig::SetCode128( ITC_CODE128_DECODING
eDecode, ITC_EAN128_IDENTIFIER eEan128Ident,
ITC_CODE128_CIP128 eCip128State, BYTE byFNC1, DWORD dwLength
);

Parameters
eDecode [in] Identifies the decoding for Code 128 symbology.

eEan128Ident [in] Identifies the EAN 128 identifier.

eCip128State [in] Identifies the CIP 128.

byFNC1 [in] Identifies the FNC1 separator character, usually
any ASCII value.

dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Code 128/EAN 128 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_CODE128_DECODING

EAN 128 Identifier Include ]C1 ITC_EAN128_IDENTIFIER

CIP 128 French Pharmaceutical
Codes

Not Active ITC_CODE128_CIP128

FNC1 Separator Character (EAN
128 norms)

GS function Char
ASCII 29 or 0x1D

0x00`0xFE ITC_CODE128_FNC1_NO_CHANGE

Bar Code Length Any Bar Code Length 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE
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Code 128 Enumerations
typedef enum tagCode128Decoding
{
ITC_CODE128_NOTACTIVE = 0, // Default
ITC_CODE128_ACTIVE = 1,
ITC_CODE128_NO_CHANGE = 255
} ITC_CODE128_DECODING;
typedef enum tagEan128Identifier
{
ITC_EAN128_ID_REMOVE,
ITC_EAN128_ID_INCLUDE, // Default
ITC_EAN128_ID_NO_CHANGE = 255
} ITC_EAN128_IDENTIFIER;
typedef enum tagCode128Cip128
{
ITC_CODE128_CIP128_NOTACTIVE = 0, // Default
ITC_CODE128_CIP128_ACTIVE = 1,
ITC_CODE128_CIP128_NO_CHANGE = 255
} ITC_CODE128_CIP128;

#define ITC_CODE128_FNC1_NO_CHANGE 255.
This definition can be used when the Code128 FNC1 does not require any change.

#define ITC_BC_LENGTH_NO_CHANGE 255. This definition can be used when the bar
code length does not require any change.

The table below shows what to be expected for EAN 128 labels for various
symbology identifier transmit configurations and EAN 128 Identifier op-
tions.

Setup Application’s Expected Result

EAN 128 ]C1 ID Symbology ID option EAN 128 Label Other Labels

1 Include ]C1 Disabled <data> <data>

2 Remove ]C1 Disabled <data> <data>

3 Include ]C1 AIM ID Transmitted ]C1<data> ]XY<data>

4 Remove ]C1 AID ID Transmitted ]C1<data> ]XY<data>

5 Include ]C1 Custom ID Transmitted Z]C1<data> Z<data>

6 Remove ]C1 Custom ID Transmitted Z<data> Z<data>

where “X” is the symbology identifier, “Y” is the modifier character, and “Z” is the 1-byte symbology identifier.
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IS9CConfig::GetI2of5
This function retrieves the current settings of Interleaved 2 of 5.

Syntax
HRESULT IS9CConfig::GetI2of5( ITC_INTERLEAVED2OF5_DECODING*
peDecode, ITC_INTERLEAVED2OF5_CHECK_DIGIT* peCheck,
ITC_BARCODE_LENGTH_ID* peLengthId, BYTE rbgLengthBuff[],
DWORD* pdwNumBytes );

Parameters
peDecode [out] Pointer to the

ITC_INTERLEAVED2OF5_DECODING
location to receive the decoding for Interleaved
2 of 5 symbology.

peCheck [out] Pointer to the
ITC_INTERLEAVED2OF5_CHECK_DIGIT
location to receive the check digit.

peLengthId [out] Pointer to the ITC_BARCODE_LENGTH_ID
location to receive an indicator of either
ITC_BARCODE_LENGTH or
ITC_BARCODE_FIXED_LENGTH.

rgbLengthBuff [out,size_is(3)]
An array of bytes to receives 1 byte of data for
ITC_BARCODE_LENGTH or 3 bytes of data
for ITC_BARCODE_FIXED_LENGTH.

pdwNumBytes [out] Pointer to the DWORD location to receive a
number indicating number of bytes in
rbgLengthBuff[]: 1 byte for
ITC_BARCODE_LENGTH or 3 bytes for
ITC_BARCODE_FIXED_LENGTH.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetI2of5
This function updates the Interleaved 2 of 5 settings with new values.

Syntax
HRESULT IS9CConfig::SetI2of5( ITC_INTERLEAVED2OF5_DECODING
eDecode, ITC_INTERLEAVED2OF5_CHECK_DIGIT eCheck,
ITC_BARCODE_LENGTH_ID eLengthId, BYTE rgbLengthBuff[], DWORD
dwNumBytes );

Parameters
eDecode [in] Identifies the decoding for Interleaved 2 of 5

symbology.

eCheck [in] Identifies the check digit.

eLengthId [in] Use
ITC_BARCODE_LENGTH_NO_CHANGE to
indicate no change for bar code length. Use
ITC_BARCODE_LENGTH for any length and
minimum length, and set rgbLengthBuff[0] to a
valid length value. Use
ITC_BARCODE_FIXED_LENGTH to compose
1 or 2 or 3 fixed lengths, and set 3 bytes:
rgbLengthBuff[0], rgbLengthBuff[1],
rgbLengthBuff[2] with valid values.

rgbLengthBuff [in,size_is(dwNumBytes)]
Contains bar code lengths when eLengthId =
Use ITC_BARCODE_LENGTH or
Use ITC_BARCODE_FIXED_LENGTH.

dwNumBytes [in] Number of bytes in rbgLengthBuff[]. For S9C, this
value is 1 when eLengthId =
ITC_BARCODE_LENGTH or 3 when eLengthId
= ITC_BARCODE_FIXED_LENGTH.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Interleaved 2 of 5 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_INTERLEAVED2OF5_DECODING

Check Digit Not Used ITC_INTERLEAVED2OF5_CHECK_DIGIT

Bar Code Length Minimum Length = 6 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE
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Interleaved 2 of 5 Enumerations
typedef enum tagInterleaved2of5Decoding
{
ITC_INTERLEAVED2OF5_NOTACTIVE = 0, // Default
ITC_INTERLEAVED2OF5_ACTIVE = 1,
ITC_INTERLEAVED2OF5_NO_CHANGE = 255
} ITC_INTERLEAVED2OF5_DECODING;
typedef enum tagInterleaved2of5CheckDigit
{
ITC_INTERLEAVED2OF5_CHECK_NOTUSED, // Default
ITC_INTERLEAVED2OF5_CHECK_MOD10_XMIT,
ITC_INTERLEAVED2OF5_CHECK_MOD10_NOTXMIT,
ITC_INTERLEAVED2OF5_CHECK_FRENCH_CIP_XMIT,
ITC_INTERLEAVED2OF5_CHECK_FRENCH_CIP_NOTXMIT,
ITC_INTERLEAVED2OF5_CHECK_NO_CHANGE = 255
} ITC_INTERLEAVED2OF5_CHECK_DIGIT;
typedef enum tagBarcodeLengthId
{
ITC_BARCODE_LENGTH = 0,
ITC_BARCODE_FIXED_LENGTH,
ITC_BARCODE_LENGTH_NO_CHANGE = 255
} ITC_BARCODE_LENGTH_ID;

IS9CConfig::GetMatrix2of5
This function retrieves the current settings of Matrix 2 of 5.

Syntax
HRESULT IS9CConfig::GetMatrix2of5( ITC_MATRIX2OF5_DECODING*
peDecode, DWORD* pdwLength );

Parameters
peDecode [out] Pointer to the ITC_MATRIX2OF5_DECODING

location to receive the decoding for Matrix 2 of 5
symbology.

pdwLength [out] Pointer to the DWORD location to receive a value
for the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetMatrix2of5
This function updates the Matrix 2 of 5 settings with new values.

Syntax
HRESULT IS9CConfig::SetMatrix2of5( ITC_MATRIX2OF5_DECODING
eDecode, DWORD dwLength );

Parameters
eDecode [in] Identifies the decoding for Matrix 2 of 5 symbology.

dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Matrix 2 of 5 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_MATRIX2OF5_DECODING

Bar Code Length Minimum Length = 6 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE

Matrix 2 of 5 Enumerations
typedef enum tagMatrix2of5Decoding
{
ITC_MATRIX2OF5_NOTACTIVE = 0, // Default
ITC_MATRIX2OF5_ACTIVE = 1,
ITC_MATRIX2OF5_NO_CHANGE = 255
} ITC_MATRIX2OF5_DECODING;
#define ITC_BC_LENGTH_NO_CHANGE 255. This definition can be used when the bar
code length does not require any change.



6 Scanner Support—Chapter

187700 Series Color Mobile Computer User’s Manual

IS9CConfig::GetMSI
This function retrieves the current MSI settings.

Syntax
HRESULT IS9CConfig::GetMSI( ITC_MSI_DECODING* peDecode,
ITC_MSI_CHECK_DIGIT* peCheck, DWORD* pdwLength );

Parameters
peDecode [out] Pointer to the ITC_MSI_DECODING location to

receive the decoding for MSI symbology.
peCheck [out] Pointer to the ITC_MSI_CHECK_DIGIT

location to receive the check digit.

pdwLength [out] Pointer to the DWORD location to receive the bar
code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig::SetMSI
This function updates the MSI settings with new values.

Syntax
HRESULT IS9CConfig::SetMSI( ITC_MSI_DECODING eDecode,
ITC_MSI_CHECK_DIGIT eCheck, DWORD dwLength );

Parameters
eDecode [in] Identifies the decoding for MSI symbology.

eCheck [in] Identifies the check digit.
dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

MSI Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_MSI_DECODING

Check Digit MOD 10 checked and transmitted ITC_MSI_CHECK_DIGIT

Bar Code Length Minimum Length = 6 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE
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MSI Enumerations
typedef enum tagMsiDecoding
{
ITC_MSI_NOTACTIVE = 0, // Default
ITC_MSI_ACTIVE = 1,
ITC_MSI_NO_CHANGE = 255
} ITC_MSI_DECODING;
typedef enum tagMsiCheckDigit
{
ITC_MSI_CHECK_MOD10_XMIT, // Default
ITC_MSI_CHECK_MOD10_NOTXMIT,
ITC_MSI_CHECK_DOUBLEMOD10_XMIT,
ITC_MSI_CHECK_DOUBLEMOD10_NOTXMIT,
ITC_MSI_CHECK_NO_CHANGE = 255
} ITC_MSI_CHECK_DIGIT;
#define ITC_BC_LENGTH_NO_CHANGE 255. This definition can be used when the bar
code length does not require any change.

IS9CConfig::GetPDF417
This function retrieves the current PDF417 settings.

Syntax
HRESULT IS9CConfig::GetPDF417( ITC_PDF417_DECODING*
pePdf417Decode, ITC_PDF417_MACRO_PDF* peMacroPdf,
ITC_PDF417_CTRL_HEADER* pePdfControlHeader,
ITC_PDF417_FILE_NAME* pePdfFileName,
ITC_PDF417_SEGMENT_COUNT* pePdfSegmentCount,
ITC_PDF417_TIME_STAMP* pePdfTimeStamp, ITC_PDF417_SENDER*
pePdfSender, ITC_PDF417_ADDRESSEE* pePdfAddressee,
ITC_PDF417_FILE_SIZE* pePdfFileSize, ITC_PDF417_CHECKSUM*
pePdfChecksum );

Parameters
pePdf417Decode [out] Pointer to the

ITC_PDF417_DECODING location to
receive the decoding for PDF417
symbology.

peMacroPdf [out] Pointer to the
ITC_PDF417_MACRO_PDF location to
receive the Macro PDF.

pePdfControlHeader [out] Pointer to the
ITC_PDF417_CTRL_HEADER location
to receive the control header.

pePdfFileName [out] Pointer to the
ITC_PDF417_FILE_NAME location to
receive the file name.

pePdfSegmentCount [out] Pointer to the
ITC_PDF417_SEGMENT_COUNT
location to receive the segment count.

pePdfTimeStamp [out] Pointer to the
ITC_PDF417_TIME_STAMP location to
receive the time stamp.
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pePdfSender [out] Pointer to the ITC_PDF417_SENDER
location to receive the sender.

pePdfAddressee [out] Pointer to the
ITC_PDF417_ADDRESSEE location to
receive the addressee.

pePdfFileSize [out] Pointer to the ITC_PDF417_FILE_SIZE
location to receive the file size.

pePdfChecksum [out] Pointer to the
ITC_PDF417_CHECKSUM location to
receive the checksum.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig::SetPDF417
This function updates the PDF417 settings with new values.

Syntax
HRESULT IS9CConfig::SetPDF417( ITC_PDF417_DECODING
ePdf417Decode, ITC_PDF417_MACRO_PDF eMacroPdf,
ITC_PDF417_CTRL_HEADER ePdfControlHeader,
ITC_PDF417_FILE_NAME ePdfFileName, ITC_PDF417_SEGMENT_COUNT
ePdfSegmentCount, ITC_PDF417_TIME_STAMP ePdfTimeStamp,
ITC_PDF417_SENDER ePdfSender, ITC_PDF417_ADDRESSEE
ePdfAddressee, ITC_PDF417_FILE_SIZE ePdfFileSize,
ITC_PDF417_CHECKSUM ePdfChecksum );

Parameters
ePdf417Decode [in] Identifies the decoding for PDF417 symbology.

eMacroPdf [in] Identifies the Macro PDF.

ePdfControlHeader [in] Identifies the control header.

ePdfFileName [in] Identifies the file name.

ePdfSegmentCount [in] Identifies the segment count.

ePdfTimeStamp [in] Identifies the time stamp.

ePdfSender [in] Identifies the sender.

ePdfAddressee [in] Identifies the addressee.

ePdfFileSize [in] Identifies the file size.

ePdfChecksum [in] Identifies the checksum.

Return Values
HRESULT that indicates success or failure.
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Remarks
None.

See Also
None.

PDF 417 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_PDF417_DECODING

Macro PDF Macro PDF Buffered ITC_PDF417_MACRO_PDF

Control Header Not Transmitted ITC_PDF417_CTRL_HEADER

*File Name Not Transmitted ITC_PDF417_FILE_NAME

*Segment Count Not Transmitted ITC_PDF417_SEGMENT_COUNT

*Time Stamp Not Transmitted ITC_PDF417_TIME_STAMP

*Sender Not Transmitted ITC_PDF417_SENDER

*Address Not Transmitted ITC_PDF417_ADDRESSEE

*File Size Not Transmitted ITC_PDF417_FILE_SIZE

*Check Sum Not Transmitted ITC_PDF417_CHECKSUM

* These are Macro PDF Optional Fields.

PDF 417 Enumerations
typedef enum tagPdf417Decoding
{
ITC_PDF417_NOTACTIVE = 0,
ITC_PDF417_ACTIVE = 1, // Default
ITC_PDF417_NO_CHANGE = 255
} ITC_PDF417_DECODING;
typedef enum tagPdf417MacroPdf
{
ITC_PDF417_MACRO_UNBUFFERED = 0,
ITC_PDF417_MACRO_BUFFERED = 1, // Default
ITC_PDF417_MACRO_NO_CHANGE = 255
} ITC_PDF417_MACRO_PDF;
typedef enum tagPdf417ControlHeader
{
ITC_PDF417_CTRL_HEADER_NOTXMIT = 0, // Default
ITC_PDF417_CTRL_HEADER_XMIT = 1,
ITC_PDF417_CTRL_HEADER_NO_CHANGE = 255
} ITC_PDF417_CTRL_HEADER;
typedef enum tagPdf417FileName
{
ITC_PDF417_FILE_NAME_NOTXMIT = 0, // Default
ITC_PDF417_FILE_NAME_XMIT = 1,
ITC_PDF417_FILE_NAME_NO_CHANGE = 255
} ITC_PDF417_FILE_NAME;
typedef enum tagPdf417SegmentCount
{
ITC_PDF417_SEGMENT_COUNT_NOTXMIT = 0,// Default
ITC_PDF417_SEGMENT_COUNT_XMIT = 1,
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ITC_PDF417_SEGMENT_COUNT_NO_CHANGE = 255
} ITC_PDF417_SEGMENT_COUNT;

typedef enum tagPdf417TimeStamp
{
ITC_PDF417_TIME_STAMP_NOTXMIT = 0, // Default
ITC_PDF417_TIME_STAMP_XMIT = 1,
ITC_PDF417_TIME_STAMP_NO_CHANGE = 255
} ITC_PDF417_TIME_STAMP;
typedef enum tagPdf417Sender
{
ITC_PDF417_SENDER_NOTXMIT = 0, // Default
ITC_PDF417_SENDER_XMIT = 1,
ITC_PDF417_SENDER_NO_CHANGE = 255
} ITC_PDF417_SENDER;
typedef enum tagPdf417Addressee
{
ITC_PDF417_ADDRESSEE_NOTXMIT = 0, // Default
ITC_PDF417_ADDRESSEE_XMIT = 1,
ITC_PDF417_ADDRESSEE_NO_CHANGE = 255
} ITC_PDF417_ADDRESSEE;
typedef enum tagPdf417FileSize
{
ITC_PDF417_FILE_SIZE_NOTXMIT = 0, // Default
ITC_PDF417_FILE_SIZE_XMIT = 1,
ITC_PDF417_FILE_SIZE_NO_CHANGE = 255
} ITC_PDF417_FILE_SIZE;
typedef enum tagPdf417Checksum
{
ITC_PDF417_CHECKSUM_NOTXMIT = 0, // Default
ITC_PDF417_CHECKSUM_XMIT = 1,
ITC_PDF417_CHECKSUM_NO_CHANGE = 255
} ITC_PDF417_CHECKSUM;
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IS9CConfig::GetPlessey
This function retrieves the current Plessey settings.

Syntax
HRESULT IS9CConfig::GetPlessey( ITC_PLESSEY_DECODING*
peDecode, ITC_PLESSEY_CHECK_DIGIT* peCheck, DWORD* pdwLength
);

Parameters
peDecode [out] Pointer to the ITC_PLESSEY_DECODING

location to receive the decoding for Plessey
symbology.

peCheck [out] Pointer to the ITC_PLESSEY_CHECK_DIGIT
location to receive the check digit.

pdwLength [out] Pointer to the DWORD location to receive the bar
code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig::SetPlessey
This function updates the Plessey settings with new values.

Syntax
HRESULT IS9CConfig::SetPlessey( ITC_PLESSEY_DECODING
eDecode, ITC_PLESSEY_CHECK_DIGIT eCheck, DWORD dwLength );

Parameters
eDecode [in] Identifies the decoding for Plessey symbology.

eCheck [in] Identifies the check digit.

dwLength [in] Identifies the bar code length.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Plessey Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_PLESSEY_DECODING

Check Digit Not Transmitted ITC_PLESSEY_CHECK_DIGIT

Bar Code Length Any Bar Code Length 0x00`0xFE ITC_BC_LENGTH_NO_CHANGE

Plessey Enumerations
typedef enum tagPlesseyDecoding
{
ITC_PLESSEY_NOTACTIVE = 0, // Default
ITC_PLESSEY_ACTIVE = 1,
ITC_PLESSEY_NO_CHANGE = 255
} ITC_PLESSEY_DECODING;
typedef enum tagPlesseyCheckDigit
{
ITC_PLESSEY_CHECK_NOTXMIT = 0, // Default
ITC_PLESSEY_CHECK_XMIT = 1,
ITC_PLESSEY_CHECK_NO_CHANGE = 255
} ITC_PLESSEY_CHECK_DIGIT;
#define ITC_BC_LENGTH_NO_CHANGE 255. This definition can be used when the bar
code length does not require any change.
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IS9CConfig::GetStandard2of5
This function retrieves the current Standard 2 of 5 settings.

Syntax
HRESULT IS9CConfig::GetStandard2of5(
ITC_STANDARD2OF5_DECODING* peDecode,
ITC_STANDARD2OF5_FORMAT* peFormat,
ITC_STANDARD2OF5_CHECK_DIGIT* peCheck,
ITC_BARCODE_LENGTH_ID* peLengthId, BYTE rgbLengthBuff,
DWORD* pdwNumBytes );

Parameters
peDecode [out] Pointer to the

ITC_STANDARD2OF5_DECODING
location to receive the decoding for Standard
2 of 5 symbology.

peFormat [out] Pointer to the
ITC_STANDARD2OF5_FORMAT location
to receive the format.

peCheck [out] Pointer to the
ITC_STANDARD2OF5_CHECK_DIGIT
location to receive Modulo 10 check digit.

peLengthId [out] Pointer to the ITC_BARCODE_LENGTH_ID
location to receive an indicator of either
ITC_BARCODE_LENGTH or
ITC_BARCODE_FIXED_LENGTH.

rgbLengthBuff [out,size_is(3)]
An array of bytes to receives 1 byte of data for
ITC_BARCODE_LENGTH, or 3 bytes of data
for ITC_BARCODE_FIXED_LENGTH.

pdwNumBytes [out] Pointer to the DWORD location to receive a
number indicating number of bytes in
rbgLengthBuff[]: 1 byte for
ITC_BARCODE_LENGTH or 3 bytes for
ITC_BARCODE_FIXED_LENGTH.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetStandard2of5
This function updates the Standard 2 of 5 settings with new values.

Syntax
HRESULT IS9CConfig::SetStandard2of5(
ITC_STANDARD2OF5_DECODING eDecode, ITC_STANDARD2OF5_FORMAT
eFormat, ITC_STANDARD2OF5_CHECK_DIGIT eCheck,
ITC_BARCODE_LENGTH_ID eLengthId, BYTE rgbLengthBuff[], DWORD
dwNumBytes );

Parameters
eDecode [in] Identifies the decoding for Standard 2 of 5

symbology.

eFormat [in] Identifies the format.

eCheck [in] Identifies the Modulo 10 check digit.

eLengthId [in] Use
ITC_BARCODE_LENGTH_NO_CHANGE to
indicate no change for bar code length. Use
ITC_BARCODE_LENGTH for any length and
minimum length, and set rgbLengthBuff[0] to a
valid length value. Use
ITC_BARCODE_FIXED_LENGTH to compose
1 or 2 or 3 fixed lengths, and set 3 bytes:
rgbLengthBuff[0], rgbLengthBuff[1],
rgbLengthBuff[2] with valid values.

rgbLengthBuff [in,size_is(dwNumBytes)]
An array of bytes containing bar code lengths when
eLengthId = ITC_BARCODE_LENGTH or
ITC_BARCODE_FIXED_LENGTH.

dwNumBytes [in] Number of bytes in rbgLengthBuff[]. For S9C, this
value is 1 when eLengthId =
ITC_BARCODE_LENGTH or 3 when eLengthId
= ITC_BARCODE_FIXED_LENGTH.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Standard 2 of 5 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_STANDARD2OF5_DECODING

Format Identicon (6 Start/Stop bars) ITC_STANDARD2OF5_FORMAT

Check Digit Not Used ITC_STANDARD2OF5_CHECK_DIGIT

Bar Code Length Minimum Length = 6 0x00-0xFE ITC_BC_LENGTH_NO_CHANGE

Standard 2 of 5 Enumerations
typedef enum tagStandard2of5Decoding
{
ITC_STANDARD2OF5_NOTACTIVE = 0, // Default
ITC_STANDARD2OF5_ACTIVE = 1,
ITC_STANDARD2OF5_NO_CHANGE = 255
} ITC_STANDARD2OF5_DECODING;
typedef enum tagStandard2of5Format
{
ITC_STANDARD2OF5_FORMAT_IDENTICON, // Default
ITC_STANDARD2OF5_FORMAT_COMPUTER_IDENTICS,
ITC_STANDARD2OF5_FORMAT_NO_CHANGE = 255
} ITC_STANDARD2OF5_FORMAT;
typedef enum tagStandard2of5CheckDigit
{
ITC_STANDARD2OF5_CHECK_NOTUSED, // Default
ITC_STANDARD2OF5_CHECK_XMIT,
ITC_STANDARD2OF5_CHECK_NOTXMIT,
ITC_STANDARD2OF5_CHECK_NO_CHANGE = 255
} ITC_STANDARD2OF5_CHECK_DIGIT;
typedef enum tagBarcodeLengthId
{
ITC_BARCODE_LENGTH = 0,
ITC_BARCODE_FIXED_LENGTH,
ITC_BARCODE_LENGTH_NO_CHANGE = 255
} ITC_BARCODE_LENGTH_ID;
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IS9CConfig::GetTelepen
This function retrieves the current Telepen settings.

Syntax
HRESULT IS9CConfig::GetTelepen( ITC_TELEPEN_DECODING*
peDecode, ITC_TELEPEN_FORMAT* peFormat );

Parameters
peDecode [out] Pointer to the ITC_TELEPEN_DECODING

location to receive the decoding for TELEPEN
symbology.

peFormat [out] Pointer to the ITC_TELEPEN_FORMAT location to
receive the format.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig::SetTelepen
This function updates the Telepen settings with new values.

Syntax
HRESULT IS9CConfig::SetTelepen( ITC_TELEPEN_DECODING*
eDecode, ITC_TELEPEN_FORMAT* eFormat );

Parameters
eDecode [in] Identifies the decoding for Telepen symbology.

eFormat [in] Identifies the format.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Telepen Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_TELEPEN_DECODING

Format ASCII ITC_TELEPEN_FORMAT
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Telepen Enumerations
typedef enum tagTelepenDecoding
{
ITC_TELEPEN_NOTACTIVE = 0, // Default
ITC_TELEPEN_ACTIVE = 1,
ITC_TELEPEN_NO_CHANGE = 255
} ITC_TELEPEN_DECODING;
typedef enum tagTelepenDecoding
{
ITC_TELEPEN_FORMAT_ASCII, // Default
ITC_TELEPEN_FORMAT_NUMERIC,
ITC_TELEPEN_FORMAT_NO_CHANGE = 255
} ITC_TELEPEN_FORMAT;

IS9CConfig::GetUpcEan
This function retrieves the current UPC/EAN settings.

Syntax
HRESULT IS9CConfig::GetUpcEan( ITC_UPCEAN_DECODING*
upceanDecode, ITC_UPCA_SELECT* upcASelect, ITC_UPCE_SELECT*
upcESelect, ITC_EAN8_SELECT* ean8Select, ITC_EAN13_SELECT*
ean13Select, ITC_UPCEAN_ADDON_DIGITS* upcAddOnDigits,
ITC_UPCEAN_ADDON_TWO* upcAddOn2, ITC_UPCEAN_ADDON_FIVE*
upcAddOn5, ITC_UPCA_CHECK_DIGIT* upcACheck,
ITC_UPCE_CHECK_DIGIT* upcECheck, ITC_EAN8_CHECK_DIGIT*
ean8Check, ITC_EAN13_CHECK_DIGIT* ean13Check,
ITC_UPCA_NUMBER_SYSTEM* upcANumSystem,
ITC_UPCE_NUMBER_SYSTEM* upcENumSystem, ITC_UPCA_REENCODE*
upcAReencode, ITC_UPCE_REENCODE* upcEReencode,
ITC_EAN8_REENCODE* ean8Reencode );

Parameters
upceanDecode [out] Pointer to the ITC_UPCEAN_DECODING

location to receive the decoding for UPC/EAN
symbology.

upcASelect [out] Pointer to the ITC_UPCA_SELECT location to
receive the UPC-A selection state.

upcESelect [out] Pointer to the ITC_UPCE_SELECT location to
receive the UPC-E selection state.

ean8Select [out] Pointer to the ITC_EAN8_SELECT location to
receive the EAN-8 selection state.

ean13Select [out] Pointer to the ITC_EAN13_SELECT location
to receive the EAN-13 selection state.

upcAddOnDigits [out] Pointer to the
ITC_UPCEAN_ADDON_DIGITS location to
receive the add-on digits.

upcAddOn2 [out] Pointer to the
ITC_UPCEAN_ADDON_TWO location to
receive the add-on 2 digits.

upcAddOn5 [out] Pointer to the ITC_UPCEAN_ADDON_FIVE
location to receive the add-on 5 digits.
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upcACheck [out] Pointer to the ITC_UPCA_CHECK_DIGIT
location to receive the UPC-A check digit.

upcECheck [out] Pointer to the ITC_UPCE_CHECK_DIGIT
location to receive the UPC-E check digit.

ean8Check [out] Pointer to the ITC_EAN8_CHECK_DIGIT
location to receive the EAN-8 check digit.

ean13Check [out] Pointer to the ITC_EAN13_CHECK_DIGIT
location to receive the EAN-13 check digit.

upcANumSystem [out] Pointer to the
ITC_UPCA_NUMBER_SYSTEM location to
receive the UPC-A number system.

upcENumSystem [out] Pointer to the
ITC_UPCE_NUMBER_SYSTEM location to
receive the UPC-E number system.

upcAReencode [out] Pointer to the ITC_UPCA_REENCODE
location to receive the UPC-A reencoding.

upcEReencode [out] Pointer to the ITC_UPCE_REENCODE
location to receive the UPC-E reencoding.

ean8Reencode [out] Pointer to the ITC_EAN8_REENCODE
location to receive the EAN-8 reencoding.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig::SetUpcEan
This function updates the UPC/EAN settings with new values.

Syntax
HRESULT IS9CConfig::SetUpcEan( ITC_UPCEAN_DECODING
upceanDecode, ITC_UPCA_SELECT upcASelect, ITC_UPCE_SELECT
upcESelect, ITC_EAN8_SELECT ean8Select, ITC_EAN13_SELECT
ean13Select, ITC_UPCEAN_ADDON_DIGITS upcAddOnDigits,
ITC_UPCEAN_ADDON_TWO upcAddOn2, ITC_UPCEAN_ADDON_FIVE
upcAddOn5, ITC_UPCA_CHECK_DIGIT upcACheck,
ITC_UPCE_CHECK_DIGIT upcECheck, ITC_EAN8_CHECK_DIGIT
ean8Check, ITC_EAN13_CHECK_DIGIT ean13Check,
ITC_UPCA_NUMBER_SYSTEM upcANumSystem, ITC_UPCE_NUMBER_SYSTEM
upcENumSystem, ITC_UPCA_REENCODE upcAReencode,
ITC_UPCE_REENCODE upcEReencode, ITC_EAN8_REENCODE
ean8Reencode );

Parameters
upceanDecode [in] Identifies the decoding for UPC/EAN symbology.

upcASelect [in] Identifies the UPC-A selection state.

upcESelect [in] Identifies the UPC-E selection state.

ean8Select [in] Identifies the EAN-8 selection state.

ean13Select [in] Identifies the EAN-13 selection state.

upcAddOnDigits [in] Identifies the Add-on digits.

upcAddOn2 [in] Identifies the Add-on 2 digits.

upcAddOn5 [in] Identifies the Add-on 5 digits.

upcACheck [in] Identifies the UPC-A check digit.

upcECheck [in] Identifies the UPC-E check digit.

ean8Check [in] Identifies the EAN-8 check digit.

ean13Check [in] Identifies the EAN-13 check digit.

upcANumSystem [in] Identifies the UPC-A number system.

upcENumSystem [in] Identifies the UPC-E number system.

upcAReencode [in] Identifies the UPC-A reencoding.

upcEReencode [in] Identifies the UPC-E reencoding.

ean8Reencode [in] Identifies the EAN-8 reencoding.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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UPC/EAN Default Settings

Parameter Default Valid Range

Decoding ITC_UPCEAN_NO_CHANGE This parameter is no longer used, set it to this value.

UPC-A Active ITC_UPCA_SELECT

UPC-E Active ITC_UPCE_SELECT

EAN-8 Active ITC_EAN8_SELECT

EAN-13 Active ITC_EAN13_SELECT

Add On Digits Not Required ITC_UPCEAN_ADDON_DIGITS

Add On 2 Digits Not Active ITC_UPCEAN_ADDON_TWO

Add On 5 Digits Not Active ITC_UPCEAN_ADDON_FIVE

UPC-A Check Digit Transmitted ITC_UPCA_CHECK_DIGIT

UPC-E Check Digit Transmitted ITC_UPCE_CHECK_DIGIT

EAN-8 Check Digit Transmitted ITC_EAN8_CHECK_DIGIT

EAN-13 Check Digit Transmitted ITC_EAN13_CHECK_DIGIT

UPC-A Number System Transmitted ITC_UPCA_NUMBER_SYSTEM

UPC-E Number System Transmitted ITC_UPCE_NUMBER_SYSTEM

Reencode UPC-A UPC-A transmitted as EAN-13 ITC_UPCA_REENCODE

Reencode UPC-E UPC-E transmitted as UPC-E ITC_UPCE_REENCODE

Reencode EAN-8 EAN-8 transmitted as EAN-8 ITC_EAN8_REENCODE

UPC/EAN Enumerations
typedef enum tagUpcEanDecoding
{
ITC_UPCEAN_NOTACTIVE = 0,
ITC_UPCEAN_ACTIVE = 1, // Default
ITC_UPCEAN_NO_CHANGE = 255
} ITC_UPCEAN_DECODING;
typedef enum tagUpcASelect
{
ITC_UPCA_DEACTIVATE,
ITC_UPCA_ACTIVATE, // Default
ITC_UPCA_NO_CHANGE = 255
} ITC_UPCA_SELECT;
typedef enum tagUpcESelect
{
ITC_UPCE_DEACTIVATE,
ITC_UPCE_ACTIVATE, // Default
ITC_UPCE_NO_CHANGE = 255
} ITC_UPCE_SELECT;
typedef enum tagEan8Select
{
ITC_EAN8_DEACTIVATE,
ITC_EAN8_ACTIVATE, // Default
ITC_EAN8_NO_CHANGE = 255
} ITC_EAN8_SELECT;
typedef enum tagEan13Select
{
ITC_EAN13_DEACTIVATE,
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ITC_EAN13_ACTIVATE, // Default
ITC_EAN13_NO_CHANGE = 255
} ITC_EAN13_SELECT;
typedef enum tagUpcEanAddonDigits
{
ITC_UPCEAN_ADDON_NOT_REQUIRED, // Default
ITC_UPCEAN_ADDON_REQUIRED,
ITC_UPCEAN_ADDON_NO_CHANGE = 255
} ITC_UPCEAN_ADDON_DIGITS;
typedef enum tagUpcEanAddonTwo
{
ITC_UPCEAN_ADDON_TWO_NOTACTIVE = 0, // Default
ITC_UPCEAN_ADDON_TWO_ACTIVE = 1,
ITC_UPCEAN_ADDON_TWO_NO_CHANGE = 255
} ITC_UPCEAN_ADDON_TWO;
typedef enum tagUpcEanAddonFive
{
ITC_UPCEAN_ADDON_FIVE_NOTACTIVE = 0, // Default
ITC_UPCEAN_ADDON_FIVE_ACTIVE = 1,
ITC_UPCEAN_ADDON_FIVE_NO_CHANGE = 255
} ITC_UPCEAN_ADDON_FIVE;
typedef enum tagUpcACheckDigit
{
ITC_UPCA_CHECK_NOTXMIT = 0,
ITC_UPCA_CHECK_XMIT = 1, // Default
ITC_UPCA_CHECK_NO_CHANGE = 255
} ITC_UPCA_CHECK_DIGIT;
typedef enum tagUpcECheckDigit
{
ITC_UPCE_CHECK_NOTXMIT = 0,
ITC_UPCE_CHECK_XMIT = 1, // Default
ITC_UPCE_CHECK_NO_CHANGE = 255
} ITC_UPCE_CHECK_DIGIT;
typedef enum tagEan8CheckDigit
{
ITC_EAN8_CHECK_NOTXMIT = 0,
ITC_EAN8_CHECK_XMIT = 1, // Default
ITC_EAN8_CHECK_NO_CHANGE = 255
} ITC_EAN8_CHECK_DIGIT;
typedef enum tagEan13CheckDigit
{
ITC_EAN13_CHECK_NOTXMIT = 0,
ITC_EAN13_CHECK_XMIT = 1, // Default
ITC_EAN13_CHECK_NO_CHANGE = 255
} ITC_EAN13_CHECK_DIGIT;
typedef enum tagUpcANumberSystem
{
ITC_UPCA_NUM_SYS_NOTXMIT = 0,
ITC_UPCA_NUM_SYS_XMIT = 1, // Default
ITC_UPCA_NUM_SYS_NO_CHANGE = 255
} ITC_UPCA_NUMBER_SYSTEM;
typedef enum tagUpcENumberSystem
{
ITC_UPCE_NUM_SYS_NOTXMIT = 0,
ITC_UPCE_NUM_SYS_XMIT = 1, // Default
ITC_UPCE_NUM_SYS_NO_CHANGE = 255
} ITC_UPCE_NUMBER_SYSTEM;
typedef enum tagUpcAReencode
{
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ITC_UPCA_XMIT_AS_EAN13, // Default
ITC_UPCA_XMIT_AS_UPCA,
ITC_UPCA_XMIT_NO_CHANGE = 255
} ITC_UPCA_REENCODE;
typedef enum tagUpcEReencode
{
ITC_UPCE_XMIT_AS_UPCE, // Default
ITC_UPCE_XMIT_AS_UPCA,
ITC_UPCE_XMIT_NO_CHANGE = 255
} ITC_UPCE_REENCODE;
typedef enum tagEan8Reencode
{
ITC_EAN8_XMIT_AS_EAN8, //Default
ITC_EAN8_XMIT_AS_EAN13,
ITC_EAN8_XMIT_NO_CHANGE = 255
} ITC_EAN8_REENCODE;
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IS9CConfig2 Functions
This interface is derived from the IS9CConfig interface and provides addi-
tional methods that can be used to set and retrieve the 700 Series Comput-
er’ s bar code configuration. All supported symbologies are initialized to
their defaults when the S9C firmware is loaded.

GET/SET functions use enumerations as their parameters. In most enu-
merations, there is an enumerator xx_NO_CHANGE (such as
ITC_CODE39_NO_CHANGE), where xx refers to a particular enum-
eration. This enumerator can be used during a call to a SET to indicate
that no change is to be made to that particular parameter. This prevents
the called function from having to format the same S9C command and
send it down to the scanner.

To specify a bar code length of “any length,” use a value of “0” for the bar
code length argument.

IS9CConfig2 functions are the following. IS9CCONFIG.H is the header
file and ITCUUID.LIB contains the IID_IADC Interface GUID value
used to obtain the interface.

S IS9CConfig2::GetCode11 (page 205)

S IS9CConfig2::SetCode11 (page 205)

S IS9CConfig2::GetCustomSymIds (page 207)

S IS9CConfig2::SetCustomSymIds (page 208)

S IS9CConfig2::GetGlobalAmble (page 211)

S IS9CConfig2::SetGlobalAmble (page 212)

S IS9CConfig2::GetPDF417Ext (page 213)

S IS9CConfig2::SetPDF417Ext (page 213)

S IS9CConfig2::GetSymIdXmit (page 214)

S IS9CConfig2::SetSymIdXmit (page 214)
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IS9CConfig2::GetCode11
This function retrieves the current settings for Code 11.

Syntax
HRESULT GetCode11( ITC_CODE11_DECODING* peDecode,
ITC_CODE11_CHECK_DIGIT* peCheck,
ITC_CODE11_CHECK_VERIFICATION* peVer );

Parameters
peDecode [out] Pointer to ITC_CODE11_DECODING location to

receive Code 11 decoding.

peCheck [out] Pointer to ITC_CODE11_CHECK_DIGIT location
to receive the check digit option.

peVer [out] Pointer to
ITC_CODE11_CHECK_VERIFICATION location
to receive the check verification option.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig2::SetCode11
This function updates the current setting of Code 11 symbology.

Syntax
HRESULT SetCode11( ITC_CODE11_DECODING eDecode,
ITC_CODE11_CHECK_DIGIT eCheck, ITC_CODE11_CHECK_VERIFICATION
eVer );

Parameters
eDecode [in] An enumeration that identifies decoding option for

Code 11.

eCheck [in] An enumeration that identifies the check digit option.

eVer [in] An enumeration that identifies check verification option.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Code 11 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_CODE11_DECODING

Check Verification 1 Digit ITC_CODE11_CHECK_VERIFICATION

Check Digit Enable ITC_CODE11_CHECK_DIGIT

Code 11 Enumerations
typedef enum tagCode11Decoding
{
ITC_CODE11_NOTACTIVE = 0,
ITC_CODE11_ACTIVE = 1, // Default
ITC_CODE11_NO_CHANGE = 255
} ITC_CODE11_DECODING;
typedef enum tagCode11CheckVerification
{
ITC_CODE11_CHK_VERIFY_ONEDIGIT = 1,
ITC_CODE11_CHK_VERIFY_TWODIGIT = 2, // Default
ITC_CODE11_CHK_VERIFY_NO_CHANGE = 255
} ITC_CODE11_CHECK_VERIFICATION;
typedef enum tagCode11CheckDigit
{
ITC_CODE11_CHECK_NOTXMIT = 0, // Default
ITC_CODE11_CHECK_XMIT = 1,
ITC_CODE11_CHECK_NO_CHANGE = 255
} ITC_CODE11_CHECK_DIGIT;
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IS9CConfig2::GetCustomSymIds
This function retrieves all the custom symbology identifiers defined for the
currently supported symbologies. This is not supported when using an imag-
er on the 700 Series Computer.

Syntax
HRESULT GetCustomSymIds( ITC_CUST_SYM_ID_PAIR*
pStructSymIdPair,DWORD dwMaxNumElement, DWORD* pdwNumElement
);

Parameters
pStructSymIdPair [out] Pointer to ITC_CUST_SYM_ID_PAIR

location to receive the current defined
symbology identifiers for the supported
symbologies. The caller must preallocate
this buffer with dwMaxNumElement
elements.

dwMaxNumElement [in] Maximum number of elements allocated
for the pStructSymIdPair buffer which
should always be equal to the last defined
enumeration constant + 1 of the
enumeration ITC_CUSTOM_ID. In this
case, it is
ITC_CUSTOMID_LAST_ELEMENT.

pdwNumElement [out] Pointer to DWORD location to receive
the actual number of elements returned in
the pStructSymIdPair buffer, which should
be the same as dwMaxNumElement.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
S Custom Identifier Assignments (page 209)

S Custom Identifier Example (page 210)

S Custom Identifier Default Settings (page 210)
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IS9CConfig2::SetCustomSymIds
This function updates the symbology identifiers (any ASCII values) for the
currently supported symbologies. This is not supported when using an imag-
er on the 700 Series Computer.

Syntax
HRESULT SetCustomSymIds( ITC_CUST_SYM_ID_PAIR*
pStructSymIdPair, DWORD dwNumElement );

Parameters
pStructSymIdPair [in] Pointer to ITC_CUST_SYM_ID_PAIR

location, containing the new symbology
identifiers for any supported symbologies to
update.

dwNumElement [in] Identifies the number of symbology identifiers
to update in the pStructSymIdPair buffer.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Custom Identifier Assignments
Each custom identifier is a one byte ASCII value within the range from
0x00 to 0xff. The enumerations in the ITC_CUSTOM_ID enumerator
can be used as symbology identifications in the GetCustomSymIds() and
SetCustomSymIds() functions.

typedef enum tagCustomId
{
ITC_CUSTOMID_CODABAR = 0 Identifies the Codabar symbology
ITC_CUSTOMID_CODE39 Identifies the Code 39 symbology
ITC_CUSTOMID_CODE93 Identifies the Code 93 symbology
ITC_CUSTOMID_CODE128_EAN_128 Identifies the Code 128 symbology
ITC_CUSTOMID_EAN8 Identifies the EAN-8 symbology
ITC_CUSTOMID_EAN13 Identifies the EAN-13 symbology
ITC_CUSTOMID_I2OF5 Identifies the Interleaved 2 of 5 symbology
ITC_CUSTOMID_MATRIX2OF5 Identifies the Matrix 2 of 5 symbology
ITC_CUSTOMID_MSI Identifies the MSI symbology
ITC_CUSTOMID_PDF417 Identifies the PDF 417 symbology
ITC_CUSTOMID_PLESSEY Identifies the Plessey symbology
ITC_CUSTOMID_CODE2OF5 Identifies the Standard 2 of 5 symbology
ITC_CUSTOMID_TELEPEN Identifies the Telepen symbology
ITC_CUSTOMID_UPCA Identifies the UPC-A symbology
ITC_CUSTOMID_UPCE Identifies the UPC-E symbology
ITC_CUSTOMID_CODE11 Identifies the Code 11 symbology
ITC_CUSTOMID_LAST_ELEMENT Identifies the last element. Use to preallocate
the buffer on GetCustomSymIds
}ITC_CUSTOM_ID;
typedef struct tagCustSymbIdPair
{

ITC_CUSTOM_ID eSymbology; Identifies the symbology of interest

BYTE byteId;
ASCII value (1 byte within the range0x00 – 0xf)

}ITC_CUST_SYM_ID_PAIR;
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Custom Identifier Default Settings

Symbology Default Valid Range

Codabar D 0x00-0xFF

Code 11 * 0x00-0xFF

Code 39 * 0x00-0xFF

Code 93 D 0x00-0xFF

Code128/EAN 128 D 0x00-0xFF

EAN-8 0xFF 0x00-0xFF

EAN-13 F 0x00-0xFF

Interleaved 2 of 5 I 0x00-0xFF

Matrix 2 of 5 D 0x00-0xFF

MSI D 0x00-0xFF

PDF 417 * 0x00-0xFF

Plessey D 0x00-0xFF

Standard 2 of 5 D 0x00-0xFF

Telepen * 0x00-0xFF

UPC-A A 0x00-0xFF

UPC-E E 0x00-0xFF

Custom Identifier Example
The following code segment is an example of updating the UPC-E and
UPC-A symbology identifiers with new values, and then retrieving the
currently defined symbology identifiers for all the supported symbologies:

ITC_CUST_SYM_ID_PAIR oStructSymIdPair [ITC_CUSTOMID_LAST_ELEMENT];
oStructSymIdPair[0].eSymbology = ITC_CUSTOMID_UPCE;
oStructSymIdPair[0].byteId = 0x41; // ASCII char A
oStructSymIdPair[1].eSymbology = ITC_CUSTOMID_UPCA;
oStructSymIdPair[1].byteId = 0x42; // ASCII char B
HRESULT hr = pIS9CConfig2->SetCustomSymIds(&oStructSymIdPair[0], 2];
DWORD dwNum = 0;
HRESULT hr = pIS9CConfig2->GetCustomSymIds(&oStructSymIdPair[0],
ITC_CUSTOMID_LAST_ELEMENT, &dwNum);
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IS9CConfig2::GetGlobalAmble
This retrieves the scanner’ s current preamble or postamble setting.

Syntax
HRESULT GetGlobalAmble( ITC_GLOBAL_AMBLE_ID eAmbleId, BYTE
rgbBuffer[], DWORD dwBufferSize, DWORD* pdwBufferSize );

Parameters
eAmbleId [in] An enumeration of type

ITC_GLOBAL_AMBLE_ID identifies whether
the preamble or postamble setting is to be
retrieved. Only one setting can be queried at a
time.

rgbBuffer [in] Contains the buffer for the postamble or
preamble setting to be queried.

dwBufferSize [in] The maximum number of bytes that rgbBuffer
can store. Must be at least
ITC_GLOBAL_AMBLE_MAX_CHARS bytes.

pdwBufferSize [out] A pointer to DWORD location to store the
actual number of returned bytes in rgbBuffer.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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IS9CConfig2::SetGlobalAmble
This function updates the scanner’ s current preamble or postamble setting
depending on the input parameters.

Syntax
HRESULT SetGlobalAmble( ITC_GLOBAL_AMBLE_ID eAmbleId, BYTE
rgbBuffer[], DWORD dwBufferSize );

Parameters
eAmbleId [in] An enumeration of type

ITC_GLOBAL_AMBLE_ID identifies whether
the preamble or postamble setting is to be updated.
Only one setting can be updated at a time.

rgbBuffer [in] Contains the buffer for the postamble or preamble
setting to be updated.

dwBufferSize [in] Identifies number of bytes in rgbBuffer.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

Postamble and Preamble Defaults

Parameter Default Valid Range

Preamble Null 0 to 20 ASCII characters

Postamble Null 0 to 20 ASCII characters
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IS9CConfig2::GetPDF417Ext
This function is an extended function for retrieving the PDF 417 settings
not included in the IS9CConfig::GetPDF417.

Syntax
HRESULT GetPDF417Ext( ITC_MICRO_PDF417_DECODING* peDecode,
ITC_MICRO_PDF417_CODE128_EMULATION* peCode128 );

Parameters
peDecode [out] Pointer to ITC_MICRO_PDF417_DECODING

location to receive the Micro PDF 417 decoding.

peCode128 [out] Pointer to
ITC_MICRO_PDF417_CODE128_EMULATION*

location to receive the Micro PDF 417 Code 128
emulation option.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig2::SetPDF417Ext
This function is an extended function for updating the additional PDF
417 settings not included in IS9CConfig::SetPDF417.

Syntax
HRESULT SetPDF417Ext( ITC_MICRO_PDF417_DECODING eDecode,
ITC_MICRO_PDF417_CODE128_EMULATION eCode128 );

Parameters
eDecode [in] An enumeration that identifies decoding option for the

Micro PDF 417.

eCode128 [in] An enumeration that identifies the Code 128 emulation
option for the Micro PDF 417.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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PDF 417 Extended: Micro PDF 417 Default Settings

Parameter Default Valid Range

Decoding Not Active ITC_MICRO_PDF417_DECODING

Code 128 Emulation Not Active ITC_MICRO_PDF417_CODE128_EMULATION

* These are Micro PDF 417 parameters.

IS9CConfig2::GetSymIdXmit
This function retrieves the current symbology ID transmission option as
described on the next page.

Syntax
HRESULT GetSymIdXmit( ITC_SYMBOLOGY_ID_XMIT* peSymIdXmit );

Parameters
peSymIdXmit [out] Pointer to ITC_SYMBOLOGY_ID_XMIT

location to receive the current symbology
identifier transmission option.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.

IS9CConfig2::SetSymIdXmit
This updates the symbology ID transmission option shown next page.

Syntax
HRESULT SetSymIdXmit( ITC_SYMBOLOGY_ID_XMIT eSymIdXmit );

Parameters
eSymIdXmit [in] Identifies the symbology identifier transmission

option to update.

Return Values
HRESULT that indicates success or failure.

Remarks
None.

See Also
None.
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Symbology ID Transmission Option
The symbology identifier (or code mark) concept provides a standardized
way for a device receiving data from a bar code reader to differentiate be-
tween the symbologies.

The following symbology ID transmission option specifies whether or not
the symbology ID should be transmitted as part of the scanned bar code
label to all the connected data collection applications. Options for trans-
mission are: do not transmit, transmit the standard AIM identifiers, or
transmit the one byte custom defined identifiers. AIM and custom identi-
fiers cannot be selected to be transmitted at the same time; only the last
selected option will be active.

typedef enum tagSymbologyIdXmit

{

ITC_ID_XMIT_DISABLE = 0 Symbology identifier will not be transmitted as part of the
label. This is the default setting.

ITC_ID_XMIT_CUSTOM = 1 Activate custom symbology identifier transmission for all
symbologies. Example of the transmitted label:
[preamble] [Custom ID] <data> [postamble]

ITC_ID_XMIT_AIM = 2 Activate AIM symbology identifier transmission for all
symbologies. Example of the transmitted label:
[preamble] [AIM symbology ID] <data> [postamble]

}ITC_SYMBOLOGY_ID_XMIT;
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IS9CConfig3 Functions
The IS9CConfig3 interface provides generic methods for retrieving and
setting configuration using ISCP commands.

ISCP Commands
An ISCP Command is composed of three or more bytes formatted as
<SG><FID><parameters> where:

S SG Setup group.

S FID Function ID.

S parameters One or more configuration value bytes depending on the
configuration.

ISCP commands include the following:

Imager Settings
This dictates the start and end column positions for the image dimension.

SG FID Parameter Description
0x7B 80 Value [0..639] Start column position.
0x7B 81 Value [0..639] End column position.

Trigger Settings
This sets the duration of the aiming beam before acquiring images to be
decoded.

SG FID Parameter Description
0x70 81 Value [0..65535] Number of milliseconds.

QRCode Symbology
This enables or disables the QRCode symbology.

SG FID Parameter Description
0x55 40 0 Disable this symbology.
0x55 40 1 Enable this symbology.

Data Matrix Symbology
This enables or disables the Data Matrix symbology.

SG FID Parameter Description
0x54 40 0 Disable this symbology.
0x54 40 1 Enable this symbology.



6 Scanner Support—Chapter

217700 Series Color Mobile Computer User’s Manual

ISCP::GetConfig
This retrieves configurations using the ISCP commands format.

Syntax
HRESULT ISCPGetConfig( BYTE rgbCommandBuff[], DWORD
dwCommandBuffSize, BYTE rgbReplyBuff[], DWORD
dwReplyBuffMaxSize, DWORD *pdwReplyBuffSize );

Parameters
rgbCommandBuff [in, size_is] Contains ISCP commands in

array of bytes.

dwCommandBuffSize [in] Number of bytes in
rgbCommandBuff.

rgbReplyBuff [in, out, size_is] Results of query in array of
bytes.

dwReplyBuffMaxSize [in] Maximum size of rgdReplyBuff.

pdwReplyBuffSize [in, out] Number of bytes placed in
rbfReplyBuff.

Return Values
None.

Remarks
None.

See Also
None.
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ISCP::SetConfig
This updates configurations using the ISCP commands format.

Syntax
HRESULT ISCPSetConfig( BYTE rgbCommandBuff[], DWORD
dwCommandBuffSize, BYTE rgbReplyBuff[], DWORD
dwReplyBuffMaxSize, DWORD *pdwReplyBuffSize );

Parameters
rgbCommandBuff [in, size_is] Contains ISCP commands in

array of bytes.

dwCommandBuffSize [in] Number of bytes in
rgbCommandBuff.

rgbReplyBuff [in, out, size_is] Results of request in array of
bytes.

dwReplyBuffMaxSize [in] Maximum size of rgbReplyBuff.

pdwReplyBuffSize [in, out] Number of bytes placed in
rgbReplyBuff.

Return Values
None.

Remarks
None.

See Also
None.
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AIM Symbology ID Defaults
Refer to the official AIM documentation on symbology identifiers for full
information on the different processing options supported.

Symbology ID Character Modifier Characters

Codabar F 0 Standard Codabar symbol. No special processing.
1 ABC Codabar (American Blood commission)

concatenate/message append performed.
2 Reader has validated the check character.
4 Reader has stripped the check character before transmission.

Code 11 H 0 Single modulo 11 check character validated and transmitted.
1 Two modulo 11 check characters validated and transmitted.
3 Check characters validated but not transmitted.

Code 39 A 0 No check character validation nor full ASCII processing. All data
transmitted as decoded.

1 Modulo 43 check character validated and transmitted.
3 Modulo 43 check character validated but not transmitted.
4 Full ASCII character conversion performed. No check character

validation.
5 Full ASCII character conversion performed. Modulo 43 check

character validated and transmitted.
7 Full ASCII character conversion performed. Modulo 43 check

character validated but not transmitted.

Code 93 G 0 No options specified. Always transmit 0.

Code128 C 0 Standard data packet. No FNC1 in first or second symbol
character position after start character.

1 EAN/UCC-128 data packet. FNC1 in first symbol character
position after start character.

2 FNC1 in second symbol character position after start character.
4 Concatenation according to International Society for Blood

Transfusion specifications was performed. Concatenated data
follows.

Interleaved 2 of 5 I 0 No check character validation.
1 Modulo 10 symbol check character validated and transmitted
3 Modulo 10 symbol check character validated but not transmitted.

Matrix 2 of 5 X 0`F
For symbologies or symbology options not listed, a code character
with the value 0-F may be assigned by the decoder manufacturer
to identify those symbologies and options implemented in the
reader.

MSI M 0 Modulo 10 symbol check character validated and transmitted.
1 Modulo 10 symbol check character validated but not transmitted.
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Modifier CharactersID CharacterSymbology (continued)

PDF 417/
Micro PDF 417

L 0 Reader set to conform with protocol defined in 1994 PDF 417
specifications.

1 Reader set to follow protocol of ENV 12925 for Extended
Channel Interpretation (all data characters 92 doubled).

2 Reader set to follow protocol of ENV 12925 for Basic Channel
Interpretation (data characters 92 are not doubled).

3 Code 128 emulation: implied FNC1 in first position.
4 Code 128 emulation: implied FNC1 after initial letter or pair of

digits.
5 Code 128 emulation: no implied FNC1.

Plessey P 0 No options specified. Always transmit 0.

Standard 2 of 5
(2-bar start/stop)

R 0 No check character validation.
1 Modulo 7 check character validated and transmitted.
3 Modulo 7 check character validated but not transmitted.

Standard 2 of 5
(3-bar start/stop)

S 0 No options specified. Always transmit 0.

Telepen B 0 Full ASCII mode
1 Double density numeric only mode
2 Double density numeric followed by full ASCII
4 Full ASCII followed by double density numeric

UPC/EAN E Consider UPC/EAN symbols with supplements as two separate sym-
bols. The first symbol is the main data packet, and the second symbol
is the 2 or 5 digit supplement. Transmit these two symbols separately,
each with its own symbology identifier. Provision is made for the op-
tion of transmitting both symbols as a single data packet.
0 Standard data packet in full EAN format (13 digits for EAN-13,

UPC-A, and UPC-E; does not include add-on data).
1 Two digit add-on data only.
2 Five digit add-on data only.
3 Combined data packet comprising 13 digits from EAN-13,

UPC-A, or UPC-E symbol and 2 or 5 digits from add-on symbol.
4 EAN-8 data packet

IMPORTANT: The “symbology_id” character letter must be uppercase for the above definitions.
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IImage Interface
The IImage interface gives the application the capability to acquire images.
The image acquired can be either a raw image as captured by the digital
camera or it can be normalized. A normalized image is presented the same
as if the picture were taken at right angles to the image and at the same
distance. The normalized image is commonly used for signature capture
applications.

S IImage::ReadSigCapBuffer (page 221)

S IImage::ReadSigCapFile (page 224)

S IImage::ReadImage (page 225)

S IImage::CancelReadImage (page 226)

S IImage::Start (page 226)

S IImage::Stop (page 227)

S IImage::Open (page 227)

S IImage::Close (page 228)

IImage::ReadSigCapBuffer

Syntax
HRESULT IImage::ReadSigCapBuffer( ITC_SIGCAP_SPEC
*pSigCapSpec, ITC_IMAGE_SPEC *pImgBuffer, DWORD nMaxBuffSize
);

Parameters
Parameters:
pSigCapSpec [in] Pointer to the structure that identifies the signature

capture region. This structure is defined as follows:
typedef struct tagITCSigCapSpec
{
DWORD dwStructSize;
INT iAspectRatio;
INT iOffsetX;
INT iOffsetY;
UINT uiWidth;
UINT uiHeight;
INT iResolution;
ITCFileFormat eFormat;
DWORD eDepth;
} ITC_SIGCAP_SPEC;

where:

S dwStructSize Size, in bytes, of this struct. This is for version control.

S iAspectRatio Ratio of the bar code height (linear bar codes) or row
height (2D bar codes) to the narrow element width.

S iOffsetX Offset in X direction, relative to barcode center.
Positive values are right of the bar code, negative
values to the left.
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S iOffsetY Offset in Y direction, relative to barcode center.
Positive values are higher than the bar code, negative
values lower.

S uiWidth Width of signature capture image region in intelligent
bar code units.

S uiHeight Height of the signature capture image region in
intelligent bar code units.

S iResolution Number of pixels per intelligent bar code unit.
S eFormat Format of the image buffer returned as follows.

Currently, only ITC_FILE_RAW is supported.
ITC_FILE_KIM = 0, // Returns data a KIM file
ITC_FILE_TIFF_BIN = 1, // TIFF Binary file
ITC_FILE_TIFF_BIN_GROUP4 = 2, // TIFF Binary Group 4 compressed
ITC_FILE_TIFF_GRAY_SCALE = 3, // TIFF Gray Scale
ITC_FILE_RAW = 4, // Raw image
ITC_FILE_JPEG = 5, // JPEG image

S eDepth Number of bits per pixel. Currently, only one
(monochrome) or eight (gray-scale) are supported.

pImgBuffer [out] Pointer to the buffer in which the signature capture
image will be put.

typedef struct tagITCImageSpec
{

DWORD dwStructSize;
LONG biWidth;
LONG biHeight;
WORD biBitCount;
ITC_FILE_FORMAT eFormat;
DWORD biActualImageSize;
DWORD biMaxImageBytes;
BYTE rgbImageData[1];

} ITC_IMAGE_SPEC;

where:
S dwStructSize Size, in bytes, of this struct. This is for version

control.
S biWidth The width of each row in pixels.
S biHeight The number of rows in the image data.
S biBitCount The number of bits per pixel.
S eFormat Identifies the image format.
S biActualImageSize Total bytes of image data returned.
S biMaxImageBytes Maximum bytes that can be stored in

rgbImageData[].
S rgbImageData Buffer containing the actual data, for example a

640x480 uses a 307200-byte buffer. The array size
of this buffer is arbitrary so do not use this
structure directly to reserve memory. The actual
dimension of the buffer is identified by
biMaxImageBytes.
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Return Values
HRESULT identifying success or error. On error, the following codes will
be returned:

S S_OK
Image successfully returned.

S ITC_RESULT_ERR_BADREGION_E
The specified region is not in the image.

S ITC_RESULT_NO_BC_DECODED_E
A bar code has not yet been decoded or the last bar code decoded was
not a signature capture symbology.

S ITC_IMGBUFF_TOO_SMALL_E
pImgBuffer is too small to contain the signature captured image.

S ITC_INV_PARAMETER_E
One of the parameters is invalid.

S S_DEVICE_NOT_OPENED_E
The device had not been opened.

Remarks
ReadSigCapBuffer() will return the image from the last decoded label with
dimensions identified by the calling parameter. This signature capture
region must include the signature capture bar code. The supported bar
codes for signature capture are: PDF 417, Code 128, and Code 39. The
caller specifies the width, height, and center of the image to be retrieved.
This image is independent of any rotation of the bar code relative to the
imager. Thus, if the bar code is decoded with the code itself upside down
to the imager, the retrieved image will still be right side up. However, if
the specified image is outside the field of view a result code of
ITC_RESULT_ERR_BADREGION_E will be returned.

This function uses the dimensions of the last decoded bar code as its coor-
dinate system. Thus, all the parameters describing the image size and posi-
tion are in units called “Intelligent Bar Code Units.” An Intelligent Bar
Code Unit is equivalent to the narrow element width of the bar code.

The dimensions of the resulting image can be calculated with this formula:

Resulting Width = Specified Width * Specified Resolution
Resulting Height = Specified Height * Specified Resolution

See Also
None.
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IImage::ReadSigCapFile
Note: This has not been implemented as of this publication.

Syntax
HRESULT IImage::ReadSigCapFile( ITC_SIGCAP_SPEC
*pSigCapSpec, LPCTSTR pszFileName );

Parameters
pSigCapSpec [in] Pointer to the structure that identifies the signature

capture region. See ReadSigCapFile (page 221) for
a description of this structure.

pszFileName [in] Name of the file in which to copy the image.

Return Values
HRESULT identifying success or error. On error, the following codes will
be returned:

S S_OK
Image successfully returned.

S ITC_RESULT_ERR_BADREGION_E
The specified region is not in the image.

S ITC_RESULT_NO_BC_DECODED_E
A bar code has not yet been decoded or the last bar code decoded was
not a signature capture symbology.

S ITC_FILE_OPEN_E
The file could not be opened.

S ITC_INV_PARAMETER_E
One of the parameters is invalid.

S S_DEVICE_NOT_OPENED_E
The device had not been opened.

Remarks
ReadSigCapFile() will write the image from the last decoded label with di-
mensions identified by the calling parameter. If the file already exists, its
contents will be overwritten.

This signature capture region must include the signature capture bar code.
The supported bar codes for signature capture are: PDF 417, Code 128,
and Code 39. The caller specifies the width, height, and center of the
image to be retrieved. This image is independent of any rotation of the bar
code relative to the imager. Thus, if the bar code is decoded with the code
itself upside down to the imager, the retrieved image will still be right side
up. However, if the specified image is outside the field of view a result
code of ITC_RESULT_ERR_BADREGION_E will be returned.

This function uses the dimensions of the last decoded bar code as its coor-
dinate system. Thus, all the parameters describing the image size and posi-
tion are in units called “Intelligent Bar Code Units”. An Intelligent Bar
Code Unit is equivalent to the narrow element width of the bar code.
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The dimensions of the resulting image can be calculated with this formula:

Resulting Width = Specified Width * Specified Resolution
Resulting Height = Specified Height * Specified Resolution

See Also
None.

IImage::ReadImage

Syntax
HRESULT IImage::Read( ITCFileFormat eFormat, DWORD nDepth,
ITC_IMAGE_SPEC *pImgBuffer, DWORD dwTimeout );

Parameters
eFormat [in] Format of the image buffer returned as follows.

Currently, only ITC_FILE_RAW is supported.

ITC_FILE_KIM = 0, // Returns data a KIM file
ITC_FILE_TIFF_BIN = 1, // TIFF Binary file
ITC_FILE_TIFF_BIN_GROUP4 = 2, // TIFF Binary Group 4 compressed
ITC_FILE_TIFF_GRAY_SCALE = 3, // TIFF Gray Scale
ITC_FILE_RAW = 4, // Raw image
ITC_FILE_JPEG = 5, // JPEG image

nDepth [in] Number of bits per pixel. Currently, only eight
(gray-scale) are supported.

pImgBuffer [in/out] Pointer to the buffer containing the image.

dwTimeout [in] Milliseconds to wait for the image to be returned.

Return Values
HRESULT identifying success or error. On error, these will be returned:

S S_OK Image successfully returned.

S ITC_IMGBUFF_TOO_SMALL_E pImgBuffer is too small to contain
the signature captured image.

S ITC_TIMEOUT_E Timeout.

S ITC_INV_PARAMETER_E One of the parameters is invalid.

S S_DEVICE_NOT_OPENED_E The device had not been opened.

Remarks
The image is returned in pImgBuffer in the caller specified format.

See Also
None.
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IImage::CancelReadImage

Syntax
HRESULT IImage::CancelReadImage( );

Parameters
None.

Return Values
Status code indicating success or failure as follows:

S S_OK Imager closed.

S S_DEVICE_NOT_OPENED_E The device had not been opened.

Remarks
This function causes a pending image read of IImage::ReadImage() to re-
turn immediately with an error status. The purpose of this function is to
allow the application to release a thread blocked on the ReadImage() call.

See Also
None.

IImage::Start

Syntax
HRESULT IImage::Start( );

Parameters
None.

Return Values
Status code indicating success or failure as follows:

S S_OK Imager started.

S S_DEVICE_NOT_OPENED_E The device had not been opened.

Remarks
This function starts the image continuously capturing images.

See Also
None.
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IImage::Stop

Syntax
HRESULT IImage::Stop( );

Parameters
None.

Return Values
Status code indicating success or failure as follows:

S S_OK Imager started.

S S_IMG_NOT_PRESENT_E Unit does not contain an imager.

S S_DEVICE_NOT_OPENED_E Device had not been opened.

Remarks
This function stops the image continuously capturing images.

See Also
None.

IImage::Open

Syntax
HRESULT IImage::Open( BOOL fSigCapEnable );

Parameters
fSigCapEnable [in] When TRUE, signature capture is enabled. When

FALSE, it is disabled. Bar code labels are decoded
and images (via IImage::ReadImage) the same.

Return Values
Status code indicating success or failure as follows:

S S_OK Imager opened.

S S_IMG_NOT_PRESENT_E Unit does not contain an imager.

S S_DEVICE_CONTENTION_E Device has already been opened.

Remarks
This function exclusively allocates the imager device so that the other IIm-
age methods can be safely called.

See Also
None.
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IImage::Close

Syntax
HRESULT IImage::Close( );

Parameters
None.

Return Values
Status code indicating success or failure as follows:

S S_OK Imager closed.

S S_DEVICE_NOT_OPENED_E The device had not been opened.

Remarks
This function releases the imager device so that other applications can
open it. An IImage::Release() will also close the imager device.

See Also
None.
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Data Collection Configuration
Scanner settings for the 700 Series Computer can be configured via the
Data Collection control panel applet. From the 700 Series Computer, tap
Start → Settings → the System tab → the Data Collection icon. See Ap-
pendix A, “Control Panel Applets” for more information about the following
parameters. Note that these are in alphabetical order.

S Codabar (page 292)

S Code 11 (page 306)

S Code 128 (page 295)

S Code 128 Options (page 296)

S Code 128 FNC1 Character (page 297)

S Code 39 (page 290)

S Code 93 (page 294)

S Code 93 Length (page 294)

S Data Matrix (page 308)

S Interleaved 2 of 5 (page 303)

S Matrix 2 of 5 (page 304)

S MSI (page 299)

S PDF 417 (page 300)

S Macro PDF (page 300)

S Micro PDF 417 (page 302)

S Plessey (page 298)

S QR Code (page 307)

S Standard 2 of 5 (page 291)

S Telepen (page 305)

S UPC/EAN (page 293)
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Tethered Scanner

The Intermec Tethered Scanner feature accepts data from the COM1 port
wedges it to the keyboard interface, and allows some ADC. This feature
can be enabled or disabled from the Today Screen on the 700 Series Com-
puter.

Enabling and Disabling

On the 700 Series Computer, tap Start → Today. Tap the bar code scan-
ner icon in the System Tray (circled in the following illustration). Initially,
the bar code scanner icon indicates that this feature is disabled (shown to
the left).

S Select Comm Port Wedge to send any data, coming into the 700 Series
Computer through the COM1 port from an external input device, as
keyboard data to an application on the desktop.

For example, if you have Pocket Word running on your 700 Series
Computer desktop, information scanned with a scanner connected to
the COM1 port will appear in the Word document. If another data
collection application is running and is active on the 700 Series Com-
puter, the scanned information will appear in that application.

Note: When Comm Port Wedge is selected, regardless of the data sent by
the external input device, you cannot control the device or the data format
using any of the Intermec scanner control or data transfer APIs from the
SDK or the internal Data Collection software. The external input device is
governed by what software it has onboard to tell it how to scan, take pic-
tures, or send the data elsewhere.
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S Select 1551/1553 to enable the Sabre 1551E or 1553 Tethered Scanner
to scan, then send data as keyboard data. The 1551/1553 Tethered
Scanner has software onboard that translates scanned data into charac-
ters, so the running/active application does not need to know how to do
that. All the scanner control and data transfer APIs will work with the
1551/1553 Tethered Scanner, so you can control the device.

S Select Disable All to disable this feature and use the COM1 port for
another application, such as ActiveSync. An error message will result if
this option were not selected, but this action was attempted. Similarly, if
ActiveSync is using the COM1 port, and you select Comm Port Wedge
or 1551/1553, an error message will result. See “Error Message” on page
232 for more information.

Changing Comm Settings
Tap Change Comm Settings to configure the settings for the COM1 port.
Current settings are restored after a warm-boot, but are lost after a cold-
boot. When these settings have not been changed, the OK button is dis-
abled (grayed out). When changes are made, tap OK after it is enabled to
accept these changes.

S Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600,
115200

S Data Bits: 7 or 8

S Parity: None, Odd, Even, Mark, Space

S Stop Bits: 1 or 2

S Flow Control: None or Hardware

Tethered Scanner
The default settings for the Tethered Scanner are shown in the following
illustration:
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Sabre 1551E or 1553 Tethered Scanner
The default communication configuration for the Sabre 1551E or 1553
Tethered Scanner is shown in the following illustration. Scan the EasySet
Reset Factory Defaults label to set the Sabre 1551E or 1553 tethered scan-
ner communications settings to this configuration. The COM1 port con-
figuration settings must also match those of the scanner to scan labels.

Welch Allyn 1470 Imager Settings
The Welch Allyn 1470 Imager can be set to this configuration by scanning
the Factory Default Settings label.

Error Message
If the COM1 port is used by another application, such as ActiveSync, nei-
ther the Comm Port Wedge nor the 1551/1553 Tethered Scanner can be
enabled. As a result, the following message may appear. Note that this mes-
sage is for the Comm Port Wedge. You must disable that application to free
up the COM1 port before you can enable either the wedge or the scanner.

Scanner Cabling
A null modem cable is required for the Welch Allyn 1470 Imager to com-
municate with the 700 Series Computer when using the 700 Series Serial
Cable (P/N: 226-999-001).

The Sabre 1551E / 1553 Cable connects directly to the Model 700 Comm
Port.
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Limitations and Capabilities
The Tethered Scanner has the following limitations:

S No auto detection of a scanner’ s physical connection to COM1 port.
User needs to ensure the communication settings of COM1 port
matched the settings of the device.

S The Pocket PC Pocket Office applications misbehave when control
characters such as carriage return are wedged. This is a known Pocket
PC problem, which is being worked with Microsoft and for which a
work around is being developed.

S Communications port is COM1 and cannot be changed.

S A complete bar code label is detected when the time between bytes (the
inter-byte gap) exceeds 100 ms. This allows that data could be concate-
nated if two labels were received while the Comm Port Wedge or the
1551/1553 Tethered Scanner was not performing a read. That is, it
could be wedging data just read or the read thread could be preempted.
Also, the labels could appear concatenated if the scanner itself were to
buffer the labels before transmitting them.

When enabled, the Comm Port Wedge menu option has the following
limitation:

S There is no bar code API to get bar code data from the bar code scan-
ner. The Comm Port Wedge transmits the data through the keyboard
interface only.

When enabled, the 1551/1553 menu option has the following capabilities:

S Grid Data Editing is available.

S The source of the symbology configurations is only available via the
Easy Set command labels. Only the Virtual Wedge configurations can be
configured via the Data Collection Control Panel Applet Virtual Wedge
page. See Appendix A, “Control Panel Applets,” for more information.

S May transmit the data through the keyboard interface (via the Virtual
Wedge).
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S The bar code APIs, defined in the IADC interface, are available to get
bar code data from the bar code scanner. The following example shows
how to programmatically collects bar code data:

#include “IADC.h” // Linked with ITCUUID.LIB
#include “ITCAdcMgmt.h” // Linked with ITCAdcDevMgmt.lib

IADC* pIADC;
HRESULT hrStatus = S_OK;

// Create a ADC COM interface to collect bar code data from the 1551E/1553
// when the 1551/1553 menu option is enabled.

hrStatus =
ITCDeviceOpen(TEXT(“ExtScanner”), // Name of the ADC device.

IID_IADC, // COM interface to return
ITC_DHDEVFLAG_READAHEAD, // Device’s Flags
(LPVOID *) &pIADC); // the returned interface

if( SUCCEEDED(hrStatus) )
{

BYTE byteBuffer[MAX_LABEL_SIZE];
DWORD dwLength = 0;

HRESULT hr = pIDC->Read(
byteBuffer, // Buffer to put the ADC data.
MAX_LABEL_SIZE, // Size of pDataBuffer in bytes.
&dwLength, // Number bytes returned.
NULL, // Time stamp of the received data. NULL.
INFINITE // Number of milliseconds to wait.

);

}
when done using this COM interface, delete it:

ITCDeviceClose( (IUnknown **) pIADC);
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Programming7

The following programming information pertains to the 700 Series Color
Mobile Computer:

S Creating CAB Files (page 236)

S FTP Server (page 251)

S Full Screen (page 262)

S Kernel I/O control functions (page 264)

S Reboot Functions (page 280)

S Remapping the Keypad (page 281)
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Creating CAB Files

The Windows CE operating system uses a .CAB file to install an applica-
tion on a Windows CE-based device. A .CAB file is composed of multiple
files that are compressed into one file. Compressing multiple files into one
file provides the following benefits:

S All application files are present.

S A partial installation is prevented.

S The application can be installed from several sources, such as a desktop
computer or a Web site.

Use the CAB Wizard application (CABWIZ.EXE) to generate a .CAB file
for your application.

Creating Device-Specific CAB Files
Do the following to create a device-specific .CAB file for an application, in
the order provided:

1 Create an .INF file with Windows CE-specific modifications (page 236).

2 Optional Create a SETUP.DLL file to provide custom control of the
installation process (page 248).

3 Use the CAB Wizard to create the .CAB file, using the .INF file, the
optional SETUP.DLL file, and the device-specific application files as
parameters (page 249).

Creating an .INF File
An .INF file specifies information about an application for the CAB Wi-
zard. Below are the sections of an .INF file:

[Version]
This specifies the creator of the file, version, and other relevant informa-
tion.

Required? Yes

S Signature: “signature_name”
Must be “$Windows NT$” as Windows CE is not available on Win-
dows 95.

S Provider: “INF_creator”
The company name of the application, such as “Microsoft.”

S CESignature: “$Windows CE$”

EXAMPLE:
[Version]
Signature = “$Windows NT$”
Provider = “Microsoft”
CESignature = “$Windows CE$”
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[CEStrings]
This specifies string substitutions for the application name and the default
installation directory.

Required? Yes

S AppName: app_name
Name of the application. Other instances of %AppName% in the .INF
file will be replaced with this string value, such as RP32.

S InstallDir: default_install_dir
Default installation directory on the device. Other instances of %Install-
Dir% in the .INF file will be replaced with this string value. Example:
\storage_card\%AppName%

EXAMPLE:
[CEStrings]
AppName=“Game Pack”
InstallDir=%CE1%\%AppName%

[Strings]
This section is optional and defines one or more string keys. A string key
represents a string of printable characters.

Required? No

S string_key: value
String consisting of letters, digits, or other printable characters. Enclose
value in double quotation marks ““”” if the corresponding string key is
used in an item that requires double quotation marks. No string_keys is
okay.

EXAMPLE:
[Strings]
reg_path = Software\Microsoft\My Test App
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[CEDevice]
Describes the platform for the targeted application. All keys in this section
are optional. If a key is nonexistent or has no data, Windows CE does not
perform any checking with the exception being UnsupportedPlatforms. If
the UnsupportedPlatforms key exists but no data, the previous value is not
overridden.

Required? Yes

S ProcessorType : processor_type
The value that is returned by SYSTEMINFO.dwProcessorType. For
example, the value for the SH3 CPU is 10003 and the MIPS CPU is
4000.

S UnsupportedPlatforms: platform_family_name
This lists known unsupported platform family names. If the name
specified in the [CEDevice.xxx] section is different from that in the
[CEDevice] section, both platform_family_name values are unsupported
for the microprocessor specified by xxx. That is, the list of unsupported
platform family names is appended to the previous list of unsupported
names. Application Manager will not display the application for an
unsupported platform. Also, a user will be warned during the setup
process if the .CAB file is copied to an unsupported device.

EXAMPLE:
[CEDevice]
UnsupportedPlatforms = pltfrm1 ; pltfrm1 is unsupported
[CEDevice.SH3]
UnsupportedPlatforms = ; pltfrm1 is still unsupported

S VersionMin: minor_version
Numeric value returned by OSVERSIONINFO.dwVersionMinor. The
.CAB file is valid for the currently connected device if the version of this
device is greater than or equal to VersionMin. For Windows CE Japa-
nese language devices, set this to 2.01

S VersionMax: major_version
Numeric value returned by OSVERSIONINFO.dwVersionMajor. The
.CAB file is valid for the currently connected device if the version of this
device is less than or equal to VersionMax. For Windows CE Japanese
language devices, set this to 2.01

Note: Supported Windows CE operating system versions include 1.0,
1.01, 2.0, 2.01, and 2.10. When using these numbers, be sure to include
all significant digits.

S BuildMin: build_number
Numeric value returned by OSVERSIONINFO.dwBuildNumber. The
.CAB file is valid for the currently connected device if the version of this
device is greater than or equal to BuildMin.

S BuildMax: build_number
Numeric value returned by OSVERSIONINFO.dwBuildNumber. The
.CAB file is valid for the currently connected device if the version of this
device is less than or equal to BuildMax.
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EXAMPLE:
The following code example shows three [CEDevice] sections: one that
gives basic information for any CPU and two that are specific to the SH3
and the MIPS microprocessors.

[CEDevice] ; A “template” for all platforms
UnsupportedPlatforms = pltfrm1 ; Does not support pltfrm1

; The following specifies version 1.0 devices only.
VersionMin = 1.0
VersionMax = 1.0

[CEDevice.SH3] ; Inherits all [CEDevice] settings
; This will create a .CAB file specific to SH3 devices.
ProcessorType = 10003 ; SH3 .cab file is valid for SH3 microprocessors.
UnsupportedPlatforms = ; pltfrm1 is still unsupported

; The following overrides the version settings so that no version checking is
performed.
VersionMin =
VersionMax =

[CEDevice.MIPS] ; Inherits all [CEDevice] settings
; This will create a .CAB file specific to “MIPS” devices.
ProcessorType = 4000 ; MIPS .CAB file is valid for MIPS microprocessor.
UnsupportedPlatforms =pltfrm2 ; pltfrm1, pltfrm2 unsupported for MIPs .CAB file.

Note: To create the two CPU-specific .CAB files for the SETUP.INF file
in the previous example, run the CAB Wizard with the “/cpu sh3 mips”
parameter.
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[DefaultInstall]
This describes the default installation of your application. Note that under
this section, you will list items expanded upon later in this description.

Required? Yes

S Copyfiles: copyfile_list_section
Maps to files defined later in the .INF file, such as Files.App, Files.Font,
and Files.Bitmaps.

S AddReg: add_registry_section
Example: RegSettings.All

S CEShortcuts: shortcut_list_section
String that identifies one more section that defines shortcuts to a file, as
defined in the [CEShortcuts] section.

S CESetupDLL: setup_DLL
Optimal string that specifies a SETUP.DLL file. It is written by the In-
dependent Software Vendor (ISV) and contains customized functions
for operations during installation and removal of the application. The
file must be specified in the [SourceDisksFiles] section.

S CESelfRegister: self_reg_DLL_filename
String that identifies files that self-register by exporting the DllRegister-
Server and DllUnregisterServer Component Object Model (COM)
functions. Specify these files in the [SourceDiskFiles] section. During
installation, if installation on the device fails to call the file’ s exported
DllRegisterServer function, the file’ s exported DllUnregisterServer
function will not be called during removal.

EXAMPLE:
[DefaultInstall]
AddReg = RegSettings.All
CEShortcuts = Shortcuts.All

[SourceDiskNames]
This section describes the name and path of the disk on which your ap-
plication resides.

Required? Yes

S disk_ordinal: disk_label,,path
1=,“App files” , C:\Appsoft\RP32\...
2=,“Font files”,,C:\RpTools\...
3=,“CE Tools” ,,C:\windows ce tools...

S CESignature: “$Windows CE$”

Example
[SourceDisksNames] ; Required section
1 = ,“Common files”,,C:\app\common ; Using an absolute path
[SourceDisksNames.SH3]
2 = ,“SH3 files”,,sh3 ; Using a relative path
[SourceDisksNames.MIPS]
2 = ,“MIPS files”,,mips ; Using a relative path
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[SourceDiskFiles]
This describes the name and path of the files in which your application
resides.

Required? Yes

S filename: disk_number[,subdir]
RPM.EXE = 1,c:\appsoft\...
WCESTART.INI = 1
RPMCE212.INI = 1
TAHOMA.TTF = 2

Note: [,subdir] is relative to the location of the INF file.

Example
[SourceDisksFiles] ; Required section
begin.wav = 1
end.wav = 1
sample.hlp = 1
[SourceDisksFiles.SH3]
sample.exe = 2 ; Uses the SourceDisksNames.SH3 identification of 2.
[SourceDisksFiles.MIPS]
sample.exe = 2 ; Uses the SourceDisksNames.MIPS identification of 2.
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[DestinationDirs]
This describes the names and paths of the destination directories for the
application on the target device. Note Windows CE does not support directory
identifiers.

Required? Yes

S file_list_section: 0,subdir
String that identifies the destination directory. The following list shows
the string substitutions supported by Windows CE. These can be used
only for the beginning of the path. \
%CE1% \Program Files
%CE2% \Windows
%CE3% \My Documents
%CE4% \Windows\Startup
%CE5% \My Documents
%CE6% \Program Files\Accessories
%CE7% \Program Files\Communication
%CE8% \Program Files\Games
%CE9% \Program Files\Pocket Outlook
%CE10% \Program Files\Office
%CE11% \Windows\Start Menu\Programs
%CE12% \Windows\Start Menu\Programs\Accessories
%CE13% \Windows\Start Menu\Programs\Communications
%CE14% \Windows\Start Menu\Programs\Games
%CE15% \Windows\Fonts
%CE16% \Windows\Recent
%CE17% \Windows\Start Menu
%InstallDir%
Contains the path to the target directory selected during installation. It
is declared in the [CEStrings] section
%AppName%
Contains the application name defined in the [CEStrings] section.

Example
[DestinationDirs]
Files.Common = 0,%CE1%\My Subdir ; \Program Files\My Subdir
Files.Shared = 0,%CE2% ; \Windows
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[CopyFiles]
This section, under the [DefaultInstall] section, describes the default files
to copy to the target device. Within the [DefaultInstall] section, files were
listed that must be defined elsewhere in the INF file. This section identi-
fies that mapping and may contain flags.

Required? Yes

S copyfile_list_section : destination_filename,[source_filename]
The source_filename parameter is optional if it is the same as destina-
tion_filename.

S copyfile_list_section : flags
The numeric value that specifies an action to be done while copying fi-
les. The following table shows values supported by Windows CE.

Flag Value Description

COPYFLG_WARN_IF_SKIP 0x00000001 Warn user if skipping a file is attempted after error.

COPYFLG_NOSKIP 0x00000002 Do not allow a user to skip copying a file.

COPYFLG_NO_OVERWRITE 0x00000010 Do not overwrite files in destination directory.

COPYFLG_REPLACEONLY 0x00000400 Copy the source file to the destination directory only if the
file is already in the destination directory.

CE_COPYFLG_NO_DATE_DIALOG 0x20000000 Do not copy files if the target file is newer.

CE_COPYFLG_NODATECHECK 0x40000000 Ignore date while overwriting the target file.

CE_COPYFLG_SHARED 0x80000000 Create a reference when a shared DLL is counted.

Example
[DefaultInstall.SH3]
CopyFiles = Files.Common, Files.SH3
[DefaultInstall.MIPS]
CopyFiles = Files.Common, Files.MIPS
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[AddReg]
This section, under the [DefaultInstall] section, is optional and describes
the keys and values that the .CAB file adds to the device registry. Within
the [DefaultInstall] section, a reference may have been made to this
section, such as “AddReg=RegSettings.All”. This section defines the
options for that setting.

Required? No

S add_registry_section : registry_root_string
String that specifies the registry root location. The following list shows
the values supported by Windows CE.

S HKCR Same as HKEY_CLASSES_ROOT

S HKCU Same as HKEY_CURRENT_USER

S HKLM Same as HKEY_LOCAL_MACHINE

S add_registry_section : value_name
Registry value name. If empty, the “default” registry value name is used.

S add_registry_section : flags
Numeric value that specifies information about the registry key. The
following table shows the values that are supported by Window CE.

Flag Value Description

FLG_ADDREG_NOCLOBBER 0x00000002 If the registry key exists, do not overwrite it. Can be used
with any of the other flags in this table.

FLG_ADDREG_TYPE_SZ 0x00000000 REG_SZ registry data type.

FLG_ADDREG_TYPE_MULTI_SZ 0x00010000 REG_MULTI_SZ registry data type. Value field that follows
can be a list of strings separated by commas.

FLG_ADDREG_TYPE_BINARY 0x00000001 REG_BINARY registry data type. Value field that follows
must be a list of numeric values separated by commas, one
byte per field, and must not use the 0x hexadecimal prefix.

FLG_ADDREG_TYPE_DWORD 0x00010001 REG_DWORD data type. The noncompatible format in the
Win32 Setup .INF documentation is supported.

Example
AddReg = RegSettings.All

[RegSettings.All]
HKLM,%reg_path%,,0x00000000,alpha ; <default> = “alpha”
HKLM,%reg_path%,test,0x00010001,3 ; Test = 3
HKLM,%reg_path%\new,another,0x00010001,6 ; New\another = 6



Programming—Chapter 7

245700 Series Color Mobile Computer User’s Manual

[CEShortCuts]
This section, a Windows CE-specific section under the [DefaultInstall]
section, is optional and describes the shortcuts that the installation applica-
tion creates on the device. Within the [DefaultInstall] section, a reference
may have been made to this section, such as “ShortCuts.All”. This section
defines the options for that setting.

Required? No

S shortcut_list_section: shortcut_filename
String that identifies the shortcut name. It does not require the .LNK
extension.

S shortcut_list_section: shortcut_type_flag
Numeric value. Zero or empty represents a shortcut to a file; any non-
zero numeric value represents a shortcut to a folder.

S shortcut_list_section: target_file_path
String value that specifies the destination location. Use the target file
name for a file, such as MyApp.exe, that must be defined in a file copy
list. For a path, use a file_list_section name defined in the [Destination-
Dirs] section, such as DefaultDestDir, or the %InstallDir% string.

S shortcut_list_section: standard_destination_path
Optional string value. A standard %CEx% path or %InstallDir%. If no
value is specified, the shortcut_list_section name of the current section or
the DefaultDestDir value from the [DestinationDirs] section is used.

Example
CEShortcuts = Shortcuts.All
[Shortcuts.All]
Sample App,0,sample.exe ; Uses the path in DestinationDirs. Sample
App,0,sample.exe,%InstallDir% ; The path is explicitly specified.

Sample .INF File
[Version] ; Required section
Signature = “$Windows NT$”
Provider = “Intermec Technologies Corporation”
CESignature = “$Windows CE$”

;[CEDevice]
;ProcessorType =

[DefaultInstall] ; Required section
CopyFiles = Files.App, Files.Fonts, Files.BitMaps, Files.Intl,
Files.TelecomNcsCE, Files.Windows, Files.Import, Files.Export, Files.Work,
Files.Database, Files.WinCE AddReg = RegSettings.All ;CEShortcuts =
Shortcuts.All

[SourceDisksNames] ; Required section
1 = ,“App files” ,,c:\appsoft\...
2 = ,”Font files” ,,c:\WinNT\Fonts
3 = ,”CE Tools” ,,c:\windows ce tools\wce212\6110ie\mfc\lib\x86

[SourceDisksFiles] ; Required section
rpm.exe = 1,C:\Appsoft\program\wce212\WCEX86Rel6110
wcestart.ini = 1
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rpmce212.ini = 1
intermec.bmp = 1
rpmlogo.bmp = 1
rpmname.bmp = 1
import.bmp = 1
export.bmp = 1
clock.bmp = 1
printer.bmp = 1
filecopy.bmp = 1
readme.txt = 1
lang_eng.bin = 1
rpmdata.dbd = 1,database\wce1
tahoma.ttf = 2
mfcce212.dll = 3
olece212.dll = 3
olece211.dll = 1,c:\windows ce tools\wce211\NMSD61102.11\mfc\lib\x86
rdm45wce.dll = 1,c:\rptools\rdm45wce\4_50\lib\wce212\wcex86rel
picfmt.dll = 1,c:\rptools\picfmt\1_00\wce212\wcex86rel6110
fmtctrl.dll = 1,c:\rptools\fmtctrl\1_00\wce212\wcex86rel6110
ugrid.dll = 1,c:\rptools\ugrid\1_00\wce212\wcex86rel6110
simple.dll = 1,c:\rptools\pspbm0c\1_00\wce211\wcex86rel
psink.dll = 1,c:\rptools\psink\1_00\wce211\WCEX86RelMinDependency
pslpwce.dll =1,c:\rptools\pslpm0c\1_00\wce211\WCEX86RelMinDependency
npcpport.dll = 1,c:\rptools\cedk\212_03\installable drivers\printer\npcp
;dexcom.dll = 1,c:\rptools\psdxm0c\1_00\x86
ncsce.exe = 1,c:\rptools\ncsce\1_04
nrinet.dll = 1,c:\rptools\ncsce\1_04

[DestinationDirs] ; Required section
;Shortcuts.All = 0,%CE3% ; \Windows\Desktop
Files.App = 0,%InstallDir%
Files.DataBase = 0,%InstallDir%\DataBase
Files.BitMaps = 0,%InstallDir%\Bitmaps
Files.Fonts = 0,%InstallDir%\Fonts
Files.Intl = 0,%InstallDir%\Intl
Files.TelecomNcsCE = 0,%InstallDir%\Telecom\NcsCE
Files.Windows = 0,%InstallDir%\Windows
Files.Import = 0,%InstallDir%\Import
Files.Export = 0,%InstallDir%\Export
Files.Work = 0,%InstallDir%\Work
Files.WinCE = 0,\storage_card\wince

[CEStrings] ; Required section
AppName = Rp32
InstallDir = \storage_card\%AppName%

[Strings] ; Optional section
;[Shortcuts.All]
;Sample App,0,sample.exe ; Uses the path in DestinationDirs.
;Sample App,0,sample.exe,%InstallDir% ; The path is explicitly specified.

[Files.App]
rpm.exe,,,0
rpm.ini,rpmce212.ini,,0
mfcce212.dll,,,0
olece212.dll,,,0
olece211.dll,,,0
rdm45wce.dll,,,0
picfmt.dll,,,0
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fmtctrl.dll,,,0
ugrid.dll,,,0
simple.dll,,,0
psink.dll,,,0
pslpwce.dll,,,0
npcpport.dll,,,0
;dexcom.dll,,,0

[Files.DataBase]
rpmdata.dbd,,,0

[Files.Fonts]
tahoma.ttf,,,0

[Files.BitMaps]
intermec.bmp,,,0
rpmlogo.bmp,,,0
rpmname.bmp,,,0
import.bmp,,,0
export.bmp,,,0
clock.bmp,,,0
printer.bmp,,,0
filecopy.bmp,,,0

[Files.Intl]
lang_eng.bin,,,0

[Files.TelecomNcsCE]
ncsce.exe,,,0
nrinet.dll,,,0

[Files.Windows]
readme.txt,,,0

[Files.Import]
readme.txt,,,0

[Files.Export]
readme.txt,,,0

[Files.Work]
readme.txt,,,0

[Files.WinCE]
wcestart.ini,,,0

[RegSettings.All]
HKLM,”SOFTWARE\Microsoft\Shell\AutoHide”,,0x00010001,1
; Autohide the taskbar HKLM,”SOFTWARE\Microsoft\Shell\OnTop”,,0x00010001,0

; Shell is not on top HKLM,”SOFTWARE\Microsoft\Clock”,SHOW_CLOCK,0x00010001,0
; Clock is not on taskbar
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Using Installation Functions in SETUP.DLL
SETUP.DLL is an optional file that enables you to perform custom opera-
tions during installation and removal of your application. The following
list shows the functions that are exported by SETUP.DLL.

S Install_Init
Called before installation begins. Use this function to check the applica-
tion version when reinstalling an application and to determine if a de-
pendent application is present.

S Install_Exit
Called after installation is complete. Use this function to handle errors
that occur during application installation.

S Uninstall_Init
Called before the removal process begins. Use this function to close the
application, if the application is running.

S Uninstall_Exit
Called after the removal process is complete. Use this function to save
database information to a file and delete the database and to tell the user
where the user data files are stored and how to reinstall the application.

Note; Use [DefaultInstall] → CESelfRegister (page 240) in the .INF file
to point to SETUP.DLL.

After the CAB File Extraction
Cab files that need to cause a warm reset after cab extraction will need to
create the __RESETMEPLEASE__.TXT file in the “\Windows” directory.
The preferred method to create this file is within the DllMain portion of
the SETUP.DLL file. It looks like this:

BOOL APIENTRY DllMain( HANDLE hModule, DWORD ul_reason_for_call, LPVOID
lpReserved )
{

switch (ul_reason_for_call)
{

case DLL_PROCESS_ATTACH:
break;

case DLL_THREAD_ATTACH:
break;

case DLL_THREAD_DETACH:
break;

case DLL_PROCESS_DETACH:
if (bInstallSuccessful) {

HANDLE h;
h = CreateFile(L”\\Windows\\__resetmeplease__.txt”,

GENERIC_READ|GENERIC_WRITE, 0, NULL, CREATE_ALWAYS,
FILE_ATTRIBUTE_HIDDEN, NULL);

if (h != INVALID_HANDLE_VALUE)
CloseHandle(h);

}
break;

}
return TRUE;

}
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The system software looks for the following directory structure and files on
the installed media card whether it be an SD card or CF card or embedded
flash file system. No other folders need exist.

\2577\autorun.exe
\2577\autorun.dat
\2577\autocab.exe
\2577\autocab.dat
\cabfiles\*.cab

Creating CAB Files with CAB Wizard
After you create the .INF file and the optional SETUP.DLL file, use the
CAB Wizard to create the .CAB file. The command-line syntax for the
CAB Wizard is as follows:

cabwiz.exe “inf_file” [/dest dest_directory] [/err error_file] [/cpu cpu_type
[cpu_type]]

A batch file, located in <program> directory, with the following com-
mands, works well:

cd\“Windows CE Tools”\WCE211\”MS HPC Pro”\support\appinst\bin
cabwiz.exe c:\appsoft\<program>\<inf_file_name>
cd \appsoft\<program>

S “inf_file”
The SETUP.INF file path.

S dest_directory
The destination directory for the .CAB files. If no directory is specified,
the .CAB files are created in the “inf_file” directory.

S error_file
The file name for a log file that contains all warnings and errors that are
encountered when the .CAB files are compiled. If no file name is speci-
fied, errors are displayed in message boxes. If a file name is used, the
CAB Wizard runs without the user interface (UI); this is useful for au-
tomated builds.

S cpu_type
Creates a .CAB file for each specified microprocessor tag. A micropro-
cessor tag is a label used in the Win32 SETUP.INF file to differentiate
between different microprocessor types. The /cpu parameter, followed by
multiple cpu_type values, must be the last qualifier in the command line.

Example
This example creates .CAB files for the SH3 and MIPS microprocessors,
assuming that the Win32 SETUP.INF file contains the SH3 and MIPS
tags:

cabwiz.exe “c:\myfile.inf” /err myfile.err /cpu sh3 mips

Note: CABWIZ.EXE, MAKECAB.EXE, and CABWIZ.DDF (Windows
CE files available on the Windows CE Toolkit) must be installed in the
same directory on the desktop computer. Call CABWIZ.EXE using its full
path for the CAB Wizard application to run correctly.
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Troubleshooting the CAB Wizard
To identify and avoid problems that might occur when using the CAB
Wizard, follow these guidelines:

S Use %% for a percent sign (%) character when using this character in
an .INF file string, as specified in Win32 documentation. This will not
work under the [Strings] section.

S Do not use .INF or .CAB files created for Windows CE to install ap-
plications on Windows-based desktop platforms.

S Ensure the MAKECAB.EXE and CABWIZ.DDF files, included with
Windows CE, are in the same directory as CABWIZ.EXE.

S Use the full path to call CABWIZ.EXE.

S Do not create a .CAB file with the MAKECAB.EXE file included with
Windows CE. You must use CABWIZ.EXE, which uses MAKE-
CAB.EXE to generate the .CAB files for Windows CE.

S Do not set the read-only attribute for .CAB files.
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FTP Server
FTP support is provided through the FTP Server application
FTPDCE.EXE (MS Windows CE Versions) which is provided as part the
base system.

FTPDCE is the Internet File Transfer Protocol (FTP) server process. The
server can be invoked from an application or command line. Besides ser-
vicing FTP client requests the FTP Server also send a “network announce-
ment” to notify prospective clients of server availability.

Synopsis
ftpdce [ options ]

Options
S -Aaddr

Sets the single target address to which to send the network announce-
ment. Default is broadcast.

S -Bbyte
Sets the FTP data block size. Smaller sizes may be useful over slower
links. Default is 65536.

S -Cname
Sets the device name. Used by Intermec management software.

S -Fvalue
Disables the default Intermec account. A value of “0” disables the ac-
count. Default is “1”.

Note: Disabling the default account without providing a working access
control list on the server will result in a device that will not accept any
FTP connections.

S -Hsec
Sets the interval between network announcements in seconds.A value of
“0” turns the network announcement off. Default is 30 seconds.

S -Iip
Sets the preferred 6920 Communications Server (optional).

S -Llog
Sets the state of logging. Default is 0 (disabled).

S -Nsec
Specifies the number of seconds to wait before starting FTP server ser-
vices.

S -Pport
Sets the UDP port on which the network announcement will be sent.
Default port is 52401.

S -Qport
Sets the port on which the FTP Server will listen for connections.
Default port is 21.
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S -Rdir
Sets the FTP mount point to this directory. Default is the rootdirectory
of the drive from which the FTP Server program was executed.

S -Tscript
Sets the script name for the 6920 Communications Server to process.

S -Uurl
Sets the default URL for this device.

S -Z“parms”
Sets extended parameters to be included in the network announcement.

Configurable Parameters Via the Registry Editor
The following parameters receive default values during the installation of
the Intermec FTP Server components. A few of the parameters are visible
in the registry by default, but most must be created in order to modify the
default behavior of the FTP server.

BlockSize
Setting this parameter forces the Intermec FTP Server to transmit and re-
ceive Ethernet packets using the specified data block size. By default, the
FTP server transmits and receives data using a 64K data block size. Adjust-
ing this value may be useful in certain wireless TCP/IP installations.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_DWORD - data block size, in bytes.

Valid Range
0x100-0x10000 (256-65536 decimal).

Default
65536
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DeviceName
This parameter forces the Intermec FTP Server to include the specified
device name in the Intermec Device Network Announcement (IDNA).
Adjusting this value may be useful in assigning a symbolic name to this
device for asset tracking.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_SZ

Valid Range
None.

Default
None.

DeviceURL
This parameter forces the Intermec FTP Server to transmit the specified
URL in the IDNA. This can be used by Intermec management software
for asset management.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_SZ

Valid Range
None.

Default
None.
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IDNATarget
This parameter forces the Intermec FTP Server to transmit the IDNA to a
specific destination instead of a general UDP broadcast. This parameter is
useful on networks that do not allow UDP broadcasts to be routed be-
tween subnets. The use of this parameter will restrict the reception of the
IDNA to the target destination only.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_SZ

Valid Range
None.

Default
None.

ManifestName
This parameter forces the Intermec FTP Server to transmit the specified
manifest name in the IDNA. This parameter is used by the Intermec 6920
Communications Server for communication transactions. See the 6920
Communications Server documentation for proper use of this parameter.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_SZ

Valid Range
None.

Default
iftp.ini



Programming—Chapter 7

255700 Series Color Mobile Computer User’s Manual

PauseAtStartup
This parameter forces the Intermec FTP Server to sleep for the specified
number of seconds before making the FTP service available on the device.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_DWORD - stored in seconds.

Valid Range
None.

Default
0

Root
This parameter forces the Intermec FTP Server to set the root of the FTP
mount point to the specified value. Note that this must map to an existing
directory or you will not be able to log into the FTP Server.

Key
HKLM\Software\Intermec\IFTP

Value Type
REG_SZ

Valid Range
None.

Default
\
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Transferring Files Over TCP/IP Networks
The File Transfer Protocol (FTP) server transfers files over TCP/IP net-
works. The FTPDCE.EXE program is a version that does not display a
window, but can run in the background.

FTPDCE is the Internet File Transfer Protocol (FTP) server process. The
server can be invoked from an application or command line. Besides ser-
vicing FTP client requests, the FTP Server also sends a “network an-
nouncement” to notify prospective clients of server availability.

Remarks
The FTP Server currently supports the following FTP requests:

S CDUP
Changes to the parent directory of the current working directory.

S CWD
Changes working directory.

S DELE
Deletes a file.

S HELP
Gives help information.

S LIST (This FTP request is the same as the ls -lgA command).
Gives list files in a directory.

S MKD
Makes a directory.

S MODE (Always Uses Binary).
Specifies data transfer mode.

S NLST
Gives a name list of files in directory (this FTP request is the same as
the ls command).

S NOOP
Does nothing.

S PASS
Specifies a password.

S PWD
Prints the current working directory.

S QUIT
Terminates session.

S RETR
Retrieves a file.

S RMD
Removes a directory.

S RNFR
Specifies rename-from file name.
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S RNTO
Specifies rename-to file name.

S STOR
Stores a file.

S SYST
Shows the operating system type of server system.

S TYPE (Binary transfers only.)
Specifies the data transfer type with the Type parameter.

S USER
Specifies user name.

S XCUP (Not Normally Used)
Changes the parent directory of the current working directory.

S XCWD (Not Normally Used)
Changes the current directory.

S XMKD (Not Normally Used)
Creates a directory.

S XPWD (Not Normally Used)
Prints the current working directory.

S XRMD (Not Normally Used)
Removes a directory.

S SITE
The following nonstandard or operating system (OS)-specific com-
mands are supported by the SITE request. For Microsoft FTP clients,
you can send site commands by preceding the command with “quote”
such as “quote site status.”

S ATTRIB
Gets or sets the attributes of a given file. (SITE ATTRIB)

Usage: QUOTE SITE ATTRIB [+R | -R] [+A | -A ] [+S | -S]
[+H | -H] [[path] filename]

+ Sets an attribute.
` Clears an attribute.
R Read-only file attribute.
A Archive file attribute.
S System file attribute.
H Hidden file attribute.

To retrieve the attributes of a file, only specify the file. The server re-
sponse will be: 200-AD SHRCEIX filename

If the flag exists in its position shown above, it is set. Also, in addition
to the values defined above, there is also defined:

C Compressed file attribute.
E Encrypted file attribute.
I INROM file attribute.
X XIP file attribute (execute in ROM, not shadowed in RAM).
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S BOOT
Reboots the server OS. This will cause the system on which the serv-
er is executing to reboot. The FTP Server will shut down cleanly be-
fore reboot. All client connections will be terminated. Cold boot is
default except for the PocketPC build in which the default is warm
boot.
(SITE BOOT)

Usage: QUOTE SITE BOOT [WARM | COLD]

S COPY
Copies a file from one location to another. (SITE COPY)

Usage: QUOTE SITE COPY [source] [destination]

Example
QUOTE SITE COPY ‘\Storage Card\one.dat’ ‘\Storage
Card\two.dat’

S EXIT
Exits the FTP Server. This command will shut down the FTP Server
thus terminating all client connections. (SITE EXIT)

Usage: QUOTE SITE EXIT

S HELP
Gives site command help information. (SITE HELP)

Usage: QUOTE SITE HELP [command]

S KILL
Terminates a running program. (SITE KILL)

Usage: QUOTE SITE KILL [program | pid]

S LOG
Opens or closes the program log. (SITE LOG)

Usage: QUOTE SITE LOG [open [filename]| close]

S PLIST
Lists the running processes (not supported on all platforms).
(SITE PLIST)

Usage: QUOTE SITE PLIST

S RUN
Starts a program running. If the program to run has spaces in path or
filename, wrapping the name with single quotes is required.

Usage: QUOTE SITE RUN [program]

Example
QUOTE SITE RUN ‘\Storage Card\app.exe’
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S STATUS
Returns the current settings of the FTP Server. MAC, serial number,
model, IP address, network announcement information as well as OS
memory usage are returned. (SITE STATUS)

Usage: QUOTE SITE STATUS

S TIMEOUT
Toggles idle timeout between 120 to 1200 seconds (2 to 20 minutes).
If this timer expires with no activity between the client and the server,
the client connection will be disconnected. If the optional seconds
argument is supplied, the server will set the connection timeout to
the number of seconds specified. Default is 120 seconds or 2 minutes.
(SITE TIMEOUT)

Usage: QUOTE SITE TIMEOUT [seconds]

The remaining FTP requests specified in RFC 959 are recognized, but not
implemented.

The banner returned in the parenthetical portion of its greeting shows the
version number of the FTP Server as well as the MAC address, serial num-
ber and OS of the machine hosting the server.

The FTP Server supports browsing from the latest Netscape and Microsoft
web browsers. Drag-and-drop capability is available using this environ-
ment.

The FTPDCMDS subdirectory contains commands that can be used from
the web browser.

S Click EXITME.BIN to execute a SITE EXIT command.

S Click REBOOTME.BIN to execute SITE BOOT command.

S Use the GET command on these files to have the FTP Server execute
these commands.

S Security:
A customer configurable access control list may be installed on the
700 Series Computer. This list will allow customers to restrict access
via the FTP Server to the users they wish. This is in addition to the
default Intermec account which can be disabled using the -F0 option
at runtime.

The access control list is named FTPDCE.TXT and is placed in the
same directory on the 700 Series Computer as the FTPDCE.EXE
server. The FTP Server will encrypt this file to keep the information
safe from unauthorized users. This file is encrypted when the FTP
Server is started so a file that is placed onto the 700 Series Computer
after the FTP Server starts will require a restart of the FTP Server to
take effect.

The format of the FTPDCE.TXT is as follows:

FTPDCE:user1!passwd1<cr><lf>user2!passwd2<cr><lf>user3!passw
d3<cr><lf>...
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Note: The user accounts and passwords are case sensitive.
Once the access control list is encrypted on the 700 Series Computer, the
FTP Server will hide this file from users. Once an access control list has
been installed on the 700 Series Computer, a new one will not be accepted
by the FTP Server until the previous one is removed.
Encrypted access control lists are not portable between 700 Series Com-
puters.

Stopping the FTP Server from Your Application
To allow application programmers the ability to programmatically shut
down the FTP Server, the FTP Server periodically tests to see if a named
event is signaled. The name for this event is “ITC_IFTP_STOP” (no
quotes).

For examples on how to use this event, consult the Microsoft Developer
Network Library at http://www.msdn.com. The MSDN Library is an essen-
tial resource for developers using Microsoft tools, products, and technolo-
gies. It contains a bounty of technical programming information, includ-
ing sample code, documentation, technical articles, and reference guides.

Autostart FTP
This automatically starts the FTP Server (FTPDCE.EXE) when the 700
Series Computer is powered on. This is provided with the NDISTRAY
program, which displays the popup menu that currently allows you to load
and unload the network drivers. Tap the antenna icon in the System Tray
of the Today screen (a sample antenna icon is circled below) to get this pop-
up menu.
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The default is to start the FTP Server at boot time, unless the following
registry entry is defined and set to “0” which disables AutoFTP. “1” enables
the AutoFTP. The entry can be set from the NDISTRAY pop-up menu by
selecting either AutoFTP On or AutoFTP Off.

HKEY_LOCAL_MACHINE\Software\Intermec\Ndistray\StartupIFTP

These new entries are located below the selections to load the network
drivers. If the StartupIFTP registry key is not defined, the FTP Server is
loaded by default, to provide “out-of-the-box” capability for customers
who want to begin loading files to the 700 Series Computer without any
prior configuration.

Note: If a network driver is unloaded using the NDISTRAY popup menu,
and the FTP Server is running, the FTP Server is stopped.

On a resume, if AutoFTP is enabled and the FTP Server is running, it is
stopped and restarted. NDISTRAY uses a helper application named RESE-
TIFTP to implement the restart on resume feature. To do an AutoFTP
Installation Check:

1 Ensure the FTP Server is running “out-of-the-box” the first time.

2 Tap Start → Today to access the Today screen, then tap the antenna
icon in the System Tray to bring up the NDISTRAY pop-up menu.
Select AutoFTP Off to disable AutoFTP. Do a warm boot and confirm
the FTP Server is not running.

3 Tap Start → Today to access the Today screen, then tap the antenna
icon in the System Tray to bring up the NDISTRAY pop-up menu.
Select AutoFTP On to enable AutoFTP, reboot and confirm it is
running.

4 Unload the network driver when the FTP Server is running and confirm
that it is not running any more.

5 Load the FTP Server, establish a connection, then suspend and resume.
The server should still be running, but the FTP connection to the client
should be dropped.
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Full Screen
Pocket PC is a hardware specification created by Microsoft Corporation.
Devices that wish to carry the Pocket PC logo must meet the minimum
hardware requirements set in the Pocket PC specification. Manufacturers
are free to add extra hardware functionality.

Pocket PC 2002 devices also use a specialized version of the CE operating
system. This OS is built from Windows CE 3.0 but contains customiza-
tions, most notably the lack of a desktop and the addition of the Today
Screen.

To carry the Pocket PC logo, all devices must be tested at an Independent
Test Laboratory. The ITL testing is done based on Microsoft requirements.
The test lab then reports the findings back to Microsoft Corporation and
Intermec Technologies. If the 700 Series Computer passed all tests, Inter-
mec is allowed to ship the device with the Pocket PC logo. Each time the
operating system is modified, Intermec must resubmit to ITL testing.

This means we cannot change the operating system much and still be a
Pocket PC device. For example, if we remove Word from the Start menu,
the device would fail ITL testing and we would not be able to ship devices
with the Pocket PC logo.

Although many customers want a Pocket PC device, some customers
would prefer that their users not have access to all of the Pocket PC featu-
res. Intermec cannot customize the operating system in any way but a cus-
tom application can:

S Delete items from the Start menu, and Programs folder. These items are
just shortcuts in the file system so the application is not really being
deleted. Cold booting the device will bring these items back so the ap-
plication will need to be run on every cold boot.

S Use the RegFlushKey() API to save a copy of the registry to a storage
device. See the Recovery CD Help for more information on how to do
this. Saving a copy of the registry will allow most system settings to be
restored in a cold boot situation.

S Use the SHFullScreen() API in conjunction with other APIs to make the
application take up the entire display and prevent the start menu from
being available.

S Remap keys and disable keys on the keypad.

S Create a custom SIP.

S Make changes to the registry to configure the device.
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Should you want your 700 Series Computer to display a full screen, keep
in mind that your computer is Pocket-PC certified by Microsoft Corpora-
tion. Check out resources on programming for the Pocket PC, using the
following links. These instructions give full instructions on how to display
full screen.

S Instructions on how to create a full screen application for eVC++ ap-
plications using an SHFullScreen() API:
http://support.microsoft.com/support/kb/articles/Q266/2/44.ASP

S Instructions on how to create a full screen application for eVB applica-
tions also using the SHFullScreen() API:
http://support.microsoft.com/support/kb/articles/Q265/4/51.ASP
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Kernel I/O Controls
This describes the KernelIoControl() functions available to application
programmers. Most C++ applications will need to prototype the function
as the following to avoid link and compile errors.

extern “C” BOOL KernelIoControl(DWORD dwIoControlCode, LPVOID lpInBuf, DWORD
nInBufSize, LPVOID lpOutBuf, DWORD nOutBufSize, LPDWORD lpBytesReturned);

IOCTL_HAL_GET_DEVICE_INFO
This IOCTL returns either the platform type or the OEMPLATFORM
name based on an input value.

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_DEVICE_INFO, LPVOID
lpInBuf, DWORD nInBufSize, LPVOID lpOutBuf, DWORD
nOutBufSize, LPDWORD lpBytesReturned );

Parameters
lpInBuf Points to a DWORD containing either the

SPI_GETPLATFORMTYPE or SPI_GETOEMINFO
value.

lpInBufSize Must be set to sizeof(DWORD).

lpOutBuf Must point to a buffer large enough to hold the return
data of the function. If SPI_GETPLATFORMTYPE is
specified in lpInBuf, then the “PocketPC\0” Unicode
string is returned. If SPI_GETOEMINFO is specified in
lpInBuf, then the “Intermec 700\0” Unicode string is
returned.

nOutBufSize The size of lpOutBuf in bytes. Must be large enough to
hold the string returned.

lpBytesReturned The actual number of bytes returned by the function for
the data requested.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_ITC_READ_PARM

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_ITC_READ_PARM,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Points to this structure. See “ID Field Values” below.

struct PARMS {
BYTE id;
BYTE ClassId;

};

nInBufSize Must be set to the size of the PARMS structure.

lpOutBuf Must point to a buffer large enough to hold the return
data of the function. If this field is set to NULL and
nOutBufSize is set to zero when the function is called the
function will return the number bytes required by the
buffer.

nOutBufSize The size of lpOutBuf in bytes.

lpBytesReturned The number of bytes returned by the function for the
data requested.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the error value. Either
ERROR_INVALID_PARAMETER or
ERROR_INSUFFICIENT_BUFFER may be returned when this function
is used to get the error.

ID Field Values
The id field of the PARMS structure may be one of the following values:

S ITC_NVPARM_ETHERNET_ID
This IOCTL returns the Ethernet 802.11 MAC Address. Six bytes are
returned in the buffer pointed to by the lpOutBuffer parameter.

S ITC_NVPARM_SERIAL_NUM
This IOCTL returns the serial number of the device in BCD format.
Six bytes are returned in the buffer pointed to by the lpOutBuffer pa-
rameter.

S ITC_NVPARM_MANF_DATE
This IOCTL returns the device date of manufacture in the
BCD YYYY/MM/DD format. Four bytes are returned in the buffer
pointed to by the lpOutBuffer parameter.
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S ITC_NVPARM_SERVICE_DATE
This IOCTL returns the device’ s date of last service in BCD YYYY/
MM/DD format. Four bytes are returned in the buffer pointed to by
the lpOutBuffer parameter.

S ITC_NVPARM_DISPLAY_TYPE
This IOCTL returns the device’ s display type. One byte is returned in
the buffer pointed to by the lpOutBuffer parameter.

S ITC_NVPARM_EDG_IP
This IOCTL returns the device Ethernet debug IP address. Four bytes
are returned in the buffer pointed to by the lpOutBuffer parameter.

S ITC_NVPARM_EDBG_SUBNET
This IOCTL returns the device Ethernet debug subnet mask. Four by-
tes are returned in the buffer pointed to by the lpOutBuffer parameter.

S ITC_NVPARM_ECN
This IOCTL returns ECNs applied to the device in a bit array format.
Four bytes are returned in the buffer pointed to by the lpOutBuffer pa-
rameter.

S ITC_NVPARM_CONTRAST
This IOCTL returns the device default contrast setting. Two bytes are
returned in the buffer pointed to by the lpOutBuffer parameter.

S ITC_NVPARM_MCODE
This IOCTL returns the manufacturing configuration code for the de-
vice. Sixteen bytes are returned in the buffer pointed to by the lpOut-
Buffer parameter.

S ITC_NVPARM_VERSION_NUMBER
This IOCTL returns the firmware version for various system compo-
nents. These values for the ClassId field of the PARMS structure are al-
lowed when ITC_NVPARM_VERSION_NUMBER is used in the id
field:

S VN_CLASS_KBD
Returns a five-byte string, including null terminator, that contains an
ASCII value which represents the keyboard microprocessor version in
the system. The format of the string is x.xx with a terminating null
character.

S VN_CLASS_ASIC
Returns a five-byte string, including null terminator, that contains an
ASCII value which represents the version of the FPGA firmware in
the system. The format of the string is x.xx with a terminating null
character.

S VN_CLASS_BOOTSTRAP
Returns a five-byte string, including null terminator, that contains an
ASCII value which represents the version of the Bootstrap Loader
firmware in the system. The format of the string is x.xx with a termi-
nating null character.
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S ITC_NVPARM_INTERMEC_SOFTWARE_CONTENT
This IOCTL reads the manufacturing flag bits from the non-volatile
data store that dictates certain software parameters. A BOOLEAN
DWORD is returned in the buffer pointed to by lpOutBuffer that indi-
cates if Intermec Content is enabled in the XIP regions. TRUE indicates
that it is enabled. FALSE indicates that it is not enabled.

S ITC_NVPARM_ANTENNA_DIVERSITY
This IOCTL reads the state of the antenna diversity flag. A BOOLEAN
DWORD is returned in the buffer pointed to by lpOutBuffer that indi-
cates if there is a diversity antenna installed. TRUE indicates that it is
installed. FALSE indicates that it is not installed.

S ITC_NVPARM_WAN_RI
This IOCTL reads the state of the WAN ring indicator flag. A BOOL-
EAN DWORD is returned in the buffer pointed to by lpOutBuffer that
indicates the polarity of the WAN RI signal. TRUE indicates active
high. FALSE indicates active low.

S ITC_NVPARM_RTC_RESTORE
This IOCTL reads the state of the real-time clock restore flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the RTC will be restored upon a cold boot.
FALSE indicates that the RTC will not be restored.

S ITC_NVPARM_INTERMEC_DATACOLLECTION_SW
This IOCTL reads the state of the data collection software enabled flag.
A BOOLEAN DWORD is returned in the buffer pointer to by lpOut-
Buffer that indicates the data collection software is to be installed at boot
time. FALSE indicates the data collection software should not be
installed.

S ITC_NVPARM_INTERMEC_DATACOLLECTION_HW
This IOCTL reads the data collection hardware flags. A BYTE is re-
turned in the buffer pointer to by lpOutBuffer that indicates the type of
data collection hardware installed. The maximum possible value re-
turned is ITC_DEVID_SCANHW_MAX.

S ITC_DEVID_SCANHW_NONE
No scanner hardware is installed.

S ITC_DEVID_OEM2D_IMAGER
OEM 2D imager is installed.

S ITC_DEVID_INTERMEC2D_IMAGER
Intermec 2D imager is installed.

S ITC_DEVID_SE900_LASER
SE900 laser is installed.

S ITC_DEVID_SE900HS_LASER
SE900HS laser is installed.

The high bit indicates whether the S6 scanning engine is installed. The
bit mask for this is ITC_DEVID_S6ENGINE_MASK. A non-zero val-
ue indicates that the S6 scanning engine is installed.
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S ITC_NVPARM_WAN_INSTALLED
This IOCTL reads the state of the WAN radio installed flag. A BOOL-
EAN DWORD is returned in the buffer pointed to by lpOutBuffer.
TRUE indicates that the WAN radio is installed. FALSE indicates that
no WAN radio is installed.

S ITC_NVPARM_WAN_FREQUENCY
This IOCTL reads the state of the WAN radio frequency flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the WAN radio frequency is United States.
FALSE indicates that the WAN radio frequency is European.

S ITC_NVPARM_WAN_RADIOTYPE
This IOCTL reads the WAN radio ID installed by manufacturing. A
BYTE is returned in the buffer pointer to by lpOutBuffer which indi-
cates the type of WAN radio hardware installed. The maximum possible
value returned is ITC_DEVID_WANRADIO_MAX. The current defi-
nitions are:

S ITC_DEVID_WANRADIO_NONE
No WAN radio installed.

S ITC_DEVID_WANRADIO_SIERRA_SB555
CDMA Sierra Wireless radio.

S ITC_DEVID_WANRADIO_XIRCOM_GEM3503
GSM/GPRS Intel (Xircom) radio.

S ITC_DEVID_WANRADIO_SIEMENS_MC45
GSM/GPRS Siemens radio.

S ITC_NVPARM_80211_INSTALLED
This IOCTL reads the state of the 802.11b radio installed flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the 802.11b radio is installed. FALSE indicates
that no 802.11b radio is installed.

S ITC_NVPARM_80211_RADIOTYPE
This IOCTL reads the 802.11b radio ID installed by manufacturing. A
BYTE is returned in the buffer pointer to by lpOutBuffer that indicates
the type of 802.11b radio hardware installed. The maximum possible
value returned is ITC_DEVID_80211RADIO_MAX. The current defi-
nitions are:

S ITC_DEVID_80211RADIO_NONE
No 802.11b radio installed.

S ITC_DEVID_80211RADIO_INTEL_2011B
Intel 2011B radio installed.

S ITC_NVPARM_BLUETOOTH_INSTALLED
This IOCTL reads the state of the Bluetooth radio installed flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the Bluetooth radio is installed. FALSE indi-
cates that no Bluetooth radio is installed.
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S ITC_NVPARM_SERIAL2_INSTALLED
This IOCTL reads the state of the serial 2 (COM2) device installed
flag. A BOOLEAN DWORD is returned in the buffer pointed to by
lpOutBuffer. TRUE indicates that the serial 2 device is installed. FALSE
indicates that no serial 2 device is installed.

S ITC_NVPARM_VIBRATE_INSTALLED
This IOCTL reads the state of the vibrate device installed flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the vibrate device is installed. FALSE indicates
that no vibrate device is installed.

S ITC_NVPARM_LAN9000_INSTALLED
This IOCTL reads the state of the Ethernet device installed flag. A
BOOLEAN DWORD is returned in the buffer pointed to by lpOutBuf-
fer. TRUE indicates that the Ethernet device is installed. FALSE indi-
cates that no Ethernet device is installed.

S ITC_NVPARM_SIM_PROTECT_HW_INSTALLED
This IOCTL reads the state of the SIM card protection hardware
installed flag. A BOOLEAN DWORD is returned in the buffer pointed
to by lpOutBuffer. TRUE indicates that the SIM card protection hard-
ware is installed. FALSE indicates that no SIM card protection hardware
is installed.

S ITC_NVPARM_SIM_PROTECT_SW_INSTALLED
This IOCTL reads the state of the SIM card protection software
installed flag. A BOOLEAN DWORD is returned in the buffer pointed
to by lpOutBuffer. TRUE indicates that the SIM card protection soft-
ware is installed. FALSE indicates that no SIM card protection software
is installed.
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IOCTL_HAL_ITC_WRITE_SYSPARM
Describes and enables the registry save location.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_ITC_WRITE_SYSPARM,LPVOID
lpInBuf,DWORD nInBufSize, LPVOID lpOutBuf, DWORD
nOutBufSize, LPDWORD lpBytesReturned );

Parameters
lpInBuf A single byte that may be one of the id values.

See “ID Field Values” below.

nInBufSize Must be set to the size of the lpInBuf in bytes.

lpOutBuf Must point to a buffer large enough to hold the data to
be written to the non-volatile data store.

nOutBufSize The size of lpOutBuf in bytes.

lpBytesReturned The number of bytes returned by the function.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the error value. Either
ERROR_INVALID_PARAMETER or
ERROR_INSUFFICIENT_BUFFER may be returned when this function
is used to get the error.

ID Field Values
The id field of lpInBuf may be one of the following values:

S ITC_REGISTRY_LOCATION
This IOCTL sets the default location for where to write the registry
when RegFlushKey() is called by an application. The registry may be
saved to Flash, a CompactFlash storage card or a SecureDigital storage
card. lpOutBuf must point to a buffer that contains a byte value of “1”
for the CompactFlash card or “2” for the SecureDigital card to specify
the location.

S ITC_REGISTRY_SAVE_ENABLE
This function enables or disables the save registry to non-volatile media
feature of the RegFlushKey() function. lpOutBuf must be set to zero
(FALSE) if the feature is to be disabled or one (TRUE) if the feature is
to be enabled.

S ITC_ DOCK_SWITCH
This IOCTL sets a position of the dock switch. The dock switch may
be set to either “modem” or “serial” positions. lpOutBuf must point to a
buffer that contains a byte value of either DOCK_MODEM or
DOCK_SERIAL as defined in OEMIOCTL.H; the value specifies the
position the switch is to be set.
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S ITC_ WAKEUP_MASK
This IOCTL sets a bit mask that represents the mask for the five pro-
grammable wakeup keys. The I/O key is not a programmable wakeup
key. By default it is always the system resume key and all other keys are
set to disable key wakeup. A zero in a bit position masks the wakeup for
that key. A one in a bit position enables wakeup for that key. lpOutBuf
must point to a buffer that contains a byte value of a wakeup mask con-
sisting of the OR’ ed constants as defined in OEMIOCTL.H. Only the
following keys are programmable as wakeup events.

#define SCANNER_TRIGGER1
#define SCANNER_LEFT 2
#define SCANNER_RIGHT 4
#define GOLD_A1 8
#define GOLD_A2 0x10

S ITC_AMBIENT_KEYBOARD
This IOCTL sets the threshold for the keyboard ambient sensor. This
can be a value from 0 (always off ) to 255 (always on). lpOutBuf must
point to a buffer that contains a byte value of the desired setting.

S ITC_AMBIENT_FRONTLIGHT
This IOCTL sets the threshold for the frontlight ambient sensor. This
can be a value from 0 (always off ) to 255. lpOutBuf must point to a
buffer that contains a byte value of the desired setting.
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IOCTL_HAL_GET_DEVICEID
This IOCTL returns the device ID. There are two types of device IDs sup-
ported, which are differentiated based on the size of the output buffer. The
UUID is returned if the buffer size is set to sizeof(UNIQUE_DEVICEID),
otherwise the oldstyle device ID is returned.

Usage
#include “pkfuncs.h”
#include “deviceid.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_DEVICEID,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL. STRICT_ID settings are not

supported.

lpInBufSize Should be set to zero.

lpOutBuf Must point to a UNIQUE_DEVICEID structure as
defined by DEVICEID.H if the UUID is to be returned.

nOutBufSize The size of the UNIQUE_DEVICEID in bytes if the
UUID is to be returned. A DEVICE_ID as defined by
PKFUNCS.H is returned if the size in bytes is greater
than or equal to sizeof(DEVICE_ID).

lpBytesReturned The number of bytes returned by the function.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_GET_OAL_VERINFO
Returns the HAL version information of the Pocket PC image.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_OAL_VERINFO,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Must point to a VERSIONINFO structure as defined by
OEMIOCTL.H. The fields should have these values:
S cboemverinfo sizeof (tagOemVerInfo);
S verinfover 1
S sig; “ITC\0”
S id; ‘ N’
S tgtcustomer “”
S tgtplat SeaRay
S tgtplatversion Current build version number
S tgtcputype[8]; “Intel\0”
S tgtcpu “PXA250\0”;
S tgtcoreversion “”
S date Build time
S time Build date

nOutBufSize The size of VERSIONINFO in bytes.

lpBytesReturned Returns sizeof(PVERSIONINFO).

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_GET_BOOTLOADER_VERINFO
Returns the HAL version information of the Pocket PC image.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_OAL_VERINFO,LPVOID
lpInBuf, DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Must point to a VERSIONINFO structure as defined by
OEMIOCTL.H. The fields should have these values:
S cboemverinfo Sizeof (tagOemVerInfo);
S verinfover 1
S sig; “ITC\0”
S id; ‘ B’
S tgtcustomer “”
S tgtplat SeaRay
S tgtplatversion Current build version number of

the bootstrap loader
S tgtcputype[8]; “Intel\0”;
S tgtcpu “PXA250\0”
S tgtcoreversion “”
S date Build time
S time Build date

nOutBufSize The size of VERSIONINFO in bytes.

lpBytesReturned The number of bytes returned to lpOutBuf.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_WARMBOOT
Causes the system to perform a warm-boot. The object store is retained.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_WARMBOOT,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Should be NULL.

nOutBufSize Should be zero.

Return Values
None.

IOCTL_HAL_COLDBOOT
Causes the system to perform a cold-boot. The object store is cleared.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_COLDBOOT,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Should be NULL.

nOutBufSize Should be zero.

Return Values
None.
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IOCTL_HAL_GET_RESET_INFO
This IOCTL code allows software to check the type of the most recent re-
set.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_RESET_INFO,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Must point to a HAL_RESET_INFO structure:

typedef struct {
DWORD ResetReason; // most recent reset type
DWORD ObjectStoreState; // state of object store

} HAL_RESET_INFO, * PHAL_RESET_INFO;

// Reset reason types
#define HAL_RESET_TYPE_UNKNOWN 0
#define HAL_RESET_REASON_HARDWARE 1 // cold
#define HAL_RESET_REASON_SOFTWARE 2 // suspend
#define HAL_RESET_REASON_WATCHDOG 4
#define HAL_RESET_BATT_FAULT 8 // power fail
#define HAL_RESET_VDD_FAULT 16 // warm boot

// Object store state flags
#define HAL_OBJECT_STORE_STATE_UNKNOWN 0
#define HAL_OBJECT_STORE_STATE_CLEAR 1

nOutBufSize The size of HAL_RESET_INFO in bytes.

lpBytesReturned The number of bytes returned by the function.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_GET_BOOT_DEVICE
This IOCTL code allows software to check which device CE booted from.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_GET_BOOT_DEVICE,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Must point to a buffer large enough to hold a DWORD
(4 bytes) that contains the boot device. The following
boot devices are supported:

#define HAL_BOOT_DEVICE_UNKNOWN 0
#define HAL_BOOT_DEVICE_ROM_XIP 1
#define HAL_BOOT_DEVICE_ROM 2
#define HAL_BOOT_DEVICE_PCMCIA_ATA 3
#define HAL_BOOT_DEVICE_PCMCIA_LINEAR 4
#define HAL_BOOT_DEVICE_IDE_ATA 5
#define HAL_BOOT_DEVICE_IDE_ATAPI 6

nOutBufSize The size of lpOutBuf in bytes (4).

lpBytesReturned The number of bytes returned by the function.

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_HAL_REBOOT
Causes the system to perform a warm-boot. The object store is retained.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_HAL_REBOOT,LPVOID lpInBuf,DWORD
nInBufSize,LPVOID lpOutBuf,DWORD nOutBufSize,LPDWORD
lpBytesReturned );

Parameters
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Should be NULL.

nOutBufSize Should be zero.

Return Values
None.
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IOCTL_PROCESSOR_INFORMATION
Returns processor information.

Usage
#include “pkfuncs.h”

Syntax
BOOL KernelIoControl( IOCTL_PROCESSOR_INFORMATION,LPVOID
lpInBuf,DWORD nInBufSize,LPVOID lpOutBuf,DWORD
nOutBufSize,LPDWORD lpBytesReturned );

Parameters
Parameters:
lpInBuf Should be set to NULL.

lpInBufSize Should be set to zero.

lpOutBuf Should be a pointer to the PROCESSOR_INFO
structure. The PROCESSOR_INFO structure stores
information that describes the CPU more descriptively.

typedef __PROCESSOR_INFO {
WORD wVersion; // Set to value 1
WCHAR szProcessorCore[40]; // “ARM\0”
WORD wCoreRevision; // 4
WCHAR szProcessorName[40]; // “PXA250\0”
WORD wProcessorRevision; // 0
WCAHR szCatalogNumber[100]; // 0
WCHAR szVendor[100]; // “Intel Corporation\0”
DWORD dwInstructionSet; // 0
DWORD dwClockSpeed; // 400
}

nOutBufSize Should be set to sizeof(PROCESSOR_INFO) in bytes.

lpBytesReturned Returns sizeof(PROCESSOR_INFO);

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.
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IOCTL_GET_CPU_ID
Returns Xscale processor ID.

Usage
#include “oemioctl.h”

Syntax
BOOL KernelIoControl( IOCTL_GET_CPU_ID,LPVOID lpInBuf, DWORD
nInBufSize,LPVOID lpOutBuf,DWORD nOutBufSize,LPDWORD
lpBytesReturned );

Parameters
lpInBuf Should point to a CPUIdInfo structure defined in

OEMIOCTL.H.

lpInBufSize Should be sizeof(CPUIdInfo).

lpOutBuf Should be NULL.

nOutBufSize Should be set to 0.

lpBytesReturned Returns sizeof(PROCESSOR_INFO);

Return Values
Returns TRUE if function succeeds. Returns FALSE if the function fails.
GetLastError() may be used to get the extended error value.

Reboot Functions
There are several methods, via Kernel I/O Control functions, that an ap-
plication program can use to force the 700 Series Computer to reboot.

IOCTL_HAL_REBOOT
IOCTL_HAL_REBOOT performs a warm-boot. See page 278.

IOCTL_HAL_COLDBOOT
Invoking the KernelIOControl function with
IOCTL_HAL_COLDBOOT forces a cold reboot. This resets the 700
Series Computer and reloads Windows CE as if a power-up had been
performed. The contents of the Windows CE RAM-based object store are
discarded. See page 275.

IOCTL_HAL_WARMBOOT
This function is supported on the 700 Series Computers. It performs a
warm boot of the system, preserving the object store. See page 275.
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Remapping the Keypad
Note; Use caution when remapping the keypad. Improper remapping may
render the keypad unusable. Data within the 700 Series Computer could
also be lost, should any problems occur.

Applications have the ability to remap keys on the 700 Color Keypad. This
will allow applications to enable keys that would otherwise not be availa-
ble, such as the [F1] function key. Also, to disable keys that should not be
available, such as the alpha key because no alpha entry is required. Care
should be exercised when attempting to remap the keypad because im-
proper remapping may cause the keypad to become unusable. This can be
corrected by cold booting the device which will cause the default keymap
to be loaded again.

Note that remapping the keys in this way affects the key mapping for the
entire system, not just for the application that does the remapping.

There are three “planes” supported for the 740 Keypad. Keys that are to be
used in more than one shift plane must be described in each plane.

Unshifted Plane
The unshifted plane contains values from the keypad when not pressed
with other keys, such as the following:

S [1] 1

S [5] 5

S [9] 9

Gold Plane
The gold plane contains values from the keypad when a key is simulta-
neously pressed with the [Gold] key, such as the following:

S [Gold] + [1] Send

S [Gold] + [5] A3

S [Gold] + [9] PageDown

Alpha Plane
The alpha plane contains values from the keypad when the keypad has
been placed in alpha mode by pressing the blue alpha key, such as the fol-
lowing:

S [Alpha] + [1] Caps

S [Alpha] + [5] JKL

S [Alpha] + [9] WXYZ
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Key Values
Key values for each plane are stored in the registry. All units ship with a
default key mapping already loaded in the registry. Applications that wish
to change the default mapping need to read the appropriate key from the
registry into an array of Words, modify the values required and then write
the updated values back into the registry. The registry access can be done
with standard Microsoft API calls, such as RegOpenKeyEx(), RegQuery-
ValueEx(), and RegSetValueEx().

S The unshifted plane mapping can be found in the registry at:
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\Vkey

S The gold plane mapping can be found in the registry at:
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\VkeyGold

S The alpha plane mapping can be found in the registry at:
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\VkeyAlpha

How Key Values Are Stored in Registry
To know which fields to update in the registry, you must know what Scan
Codes are assigned to each physical key (see the table below). The Scan
Code is used at the lowest level of the system to let the keypad driver know
which physical key has been pressed. The keypad driver takes that scan
code and looks it up in a table (a copy of the one stored in the registry) to
determine which values to pass on to the operating system.

Each registry key is just an array that describes to the keypad driver what
value needs to be passed for each physical key. The key values are indexed
by the scan code, this is a zero-based index. For example in the unshifted
plane, the [4] key has a scan code of 0x06. This means that the seventh
word under the “Vkey” registry key will have the value for the [4] key.
Taking a sample of the “Vkey” registry key shows the following values:

00,00,0B,05,02,03,C1,07,04,03,BE,00,34,00,00,00,. . .

The value is 34,00. The values are in reverse byte order because that is the
way the processor handles data. When writing an application, nothing
needs to be done to swap the bytes, as this will happen automatically when
the data is read into a byte value. This is something you just need to be
aware of this when looking at the registry. Knowing this, we can see that
the value that the keypad driver will pass to the system is a hex 34. Look-
ing that up on an UNICODE character chart, we see that it maps to a “4”.
If you wanted the key, labeled “4”, to output the letter “A” instead, you
would need to change the seventh word to “41” (the hexadecimal represen-
tation of “A” from the UNICODE chart), then put the key back into the
registry.

Note: Do not remap scan codes 0x01, 0x41, 0x42, 0x43, 0x44. Remap-
ping these scan codes could render your 700 Series Computer unusable
until a cold-boot is performed.

If you wish to disable a certain key, remap its scan code to 0x00.
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Change Notification
Just changing the registry keys will not immediately change the key
mappings. To notify the keypad driver that the registry has been updated,
signal the “ITC_KEYBOARD_CHANGE” named event using the
CreateEvent() API.

Advanced Keypad Remapping
It is also possible to map multiple key presses to one button and to map
named system events to a button. The multiple key press option could be
useful to cut down on the number of keys needed to press in a given situa-
tion or to remap which key behaves like the action key. Mapping events to
a button could be useful to change which buttons will fire the scanner,
control volume, and allow for suspending and resuming the device. If you
need help performing one of these advanced topics please contact Intermec
Technical Support.

Scan Codes
At the lowest driver level, the 740 Keypad identifies keys as scan codes.
These scan codes are sent via the keypad microcontroller, and cannot be
changed without modifying the keypad firmware.

Key/Meaning Scancode
Reserved 0x00
I/O Button 0x01
Scanner Trigger 0x02
Scanner Left 0x03
Scanner Right 0x04
. 0x05
4 0x06
None 0x07
Left Arrow 0x08
None 0x09
Backspace 0x0A
Gold Key 0x0B
None 0x0C
ESC 0x0D
Down Arrow 0x0E
1 0x0F
7 0x10
Alpha Key 0x11
None 0x12
Up Arrow 0x13
Right Arrow 0x14
2 0x15
8 0x16
0 0x17
5 0x18
None 0x19
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Key/Meaning Scancode
Action Key 0x1A
3 0x1B
9 0x1C
ENTER 0x1D
6 0x1E
None 0x1F-0x40
Charge Detect 0x41

LCD Frontlight 0x42
Ambient Light 0x42
Threshold Crossed 0x42

Headset Detected 0x43

Keypad Backlight 0x44
Ambient Light 0x44
Threshold Crossed 0x44

Sample View of Registry Keys

The following is a sample view of the current default key mapping. See the
registry on your device for the latest key mappings.

[HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD]
”ResumeMask”=dword:7
”Vkey”=hex: 00,00,0B,05,02,03,C1,07,04,03,BE,00,34,00,00,00,\

25,00,00,00,08,00,03,02,00,00,1B,00,28,00,31,00,\
37,00,01,02,00,00,26,00,27,00,32,00,38,00,30,00,\
35,00,00,00,01,03,33,00,39,00,0D,00,36,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,07,05,01,05,03,05,02,05

”VkeyGold”=hex: 00,00,0B,05,02,03,C1,07,04,03,BE,00,34,00,00,00,\
09,01,00,00,BF,00,03,02,00,00,BD,00,75,00,72,00,\
21,00,01,02,00,00,76,00,09,00,73,00,38,01,5B,00,\
35,00,00,00,BB,01,09,05,22,00,32,01,36,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,07,05,01,05,03,05,02,05

”VkeyAlpha”=hex: 00,00,0B,05,02,03,C1,07,04,03,BE,00,47,00,00,00,\
25,00,00,00,08,00,03,02,00,00,1B,00,28,00,02,02,\
50,00,01,02,00,00,26,00,27,00,41,00,54,00,20,00,\
4A,00,00,00,01,03,44,00,57,00,0D,00,4D,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,\
00,00,07,05,01,05,03,05,02,05
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Control Panel AppletsA

This appendix contains information about the Data Collection, SNMP,
and User Information Control Panel applets that may be on your 700 Se-
ries Color Mobile Computer.

SNMP and Data Collection settings that can appear under Settings are
dependent on what hardware configuration is done for each 700 Series
Computer at the time of shipment. These settings will currently only ap-
pear if a scanner or an imager option is present.

Likewise, other control panel applets that are specifically related to the
802.11b radio module will appear when a 802.11b radio module is
installed in a 700 Series Computer. Control panel applets that are specific
for Wireless Printing, CDMA/1xRTT, and GSM/GPRS radio modules
will only appear when each respective hardware configuration is done on
the 700 Series Computer. See Chapter 4, “Network Support,” for more infor-
mation about the radio modules or the wireless printing.
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Configuration Parameters
A configuration parameter changes the way the 700 Series Color (700C)
Mobile Computer operates, such as configuring a parameter to have the
700 Series Computer emit a very loud beep in a noisy environment. Use
any of the following methods to execute configuration parameters:

S Change Data Collection and SNMP parameters via control panel ap-
plets later in this appendix.

S Access the 700 Series Computer via the Unit Manager through a web
browser on your desktop PC via the SRDEVMGMT.CAB file. To use
the Unit Manager, install this CAB file from the 700 Color Software
Tools CD-ROM. Unit Manager applications are available on the 700
Series Color Unit Manager CD-ROM. For more information, consult
your Intermec sales representative.

S Send parameters from an SNMP management station. See “SNMP Con-
figuration” starting on page 123.

S Scan EasySet bar codes. You can use the EasySet bar code creation soft-
ware from Intermec Technologies Corporation to print configuration
labels. Scan the labels to change the scanner configuration and data
transfer settings.

Changing a Parameter Setting
Menus of available parameters for each group are listed. Use the scroll bars
to go through the list. Expand each menu (+) to view its parameter set-
tings. Tap a parameter to select, or expand a parameter (+) to view its sub-
parameters.

Note that each parameter or subparameter is shown with its default setting
or current setting in (< >) brackets. Tap a parameter or subparameter to
select that parameter, then do any of the following to change its setting:
Tap Apply to apply any changes. Note that these illustrations are from a
Symbologies parameter.

S Typing a new value in an entry field.

S Choosing a new value from the drop-down list.

S Selecting a different option. The selected option contains a bullet.

S Tap Defaults, then Apply to restore factory-default settings. Tap Yes
when you are prompted to verify this action.
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S Tap Refresh to discard changes and start again. Tap Yes when you are
prompted to verify this action.

About Configuration Parameters
You can find the following information about each configuration parame-
ter:

S Name and Purpose:
Describes the parameter and its function.

S Action:
Describes what to do with a parameter once that parameter is selected.

S SNMP OID:
Lists the SNMP OID for the parameter.

S Syntax or Options:
Syntax lists the two-character code for the parameter, if the parameter is
configurable by scanning a bar code or by sending parameters through a
network. Both Syntax and Options list acceptable values for the para-
meter. Default settings are noted in italic.
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Data Collection Control Panel Applet
See “Scanner Control and Data Transfer” in the Intermec Windows CE/Pocket
PC Software Developer’ s Kit (SDK) User’ s Manual shipped with the Soft-
ware Developer’ s Kit (SDK) for information about data collection func-
tions.

Note: Icons are shown to the left.

To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Data Collection icon to access its control panel
applet.

Use the left and right arrows to scroll through the tabs along the bottom of
the control panel applet, then tap a tab to access its menus. These tabs rep-
resent the following groups of settings or parameters:

S Symbologies

S Symbology Options (starting on page 309)

S Beeper/LED (starting on page 317)

S Imager (starting on page 323)

S Virtual Wedge (starting on page 325)
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Symbologies
You can change bar code symbology parameter settings in your 700 Series
Computer via the Data Collection control panel applet. The following
parameters are for bar code symbologies. Additional information about the
more common bar code symbologies are in Appendix C, “Bar Code
Symbologies.” Note that these parameters are listed in the order of their
appearance within this tab.

Most of these symbologies apply to both the imager and the laser scanner
tools. However, when using an imager, the Macro PDF (page 300), Micro
PDF 417 (page 302), Matrix 2 of 5 (page 304), Telepen (page 305), and
Code 11 (page 306) symbologies are not supported. Likewise, when using
a laser scanner, the QR Code (page 307) and Data Matrix (page 308)
symbologies are not supported.

The following table shows which bar code symbologies are supported ei-
ther by an imager or by a laser scanner.

Bar Code Symbology Imager Laser Scanner

Code 39 X X

Interleaved 2 of 5 X X

Standard 2 of 5 X X

Matrix 2 of 5 X

Code 128 X X

Code 93 X X

Codabar X X

MSI X

Plessey X

UPC X X

EAN/EAN 128 X X

Code 11 X

PDF 417 X X

Micro PDF 417 X

Telepen X

Data Matrix X

QR Code X
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Code 39
Code 39 is a discrete, self-checking, variable length symbology. The char-
acter set is uppercase A-Z, 0-9, dollar sign ($), period (.), slash (/), percent
(%), space ( ), plus (+), and minus (-).

Action
Tap (+) to expand the Code 39 parameter, select the setting to be changed,
then tap an option to change this setting or select an option from the
drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.3.1

Options
Decoding 0 Not active

1 Active (default)
Format 0 Standard 43 characters (default)

1 Full ASCII
Start/Stop 0 Not transmitted (default)

1 Transmitted
Start/Stop characters (Not supported when using an imager):

0 $ (dollar sign) only
1 * (asterisk) only (default)
2 & and * (dollar sign and asterisk)

Check digit 0 Not used (default)
1 Mod 43 transmitted
2 Mod 43 not transmitted
3 French CIP transmitted
4 French CIP not transmitted
5 Italian CPI transmitted
6 Italian CPI not transmitted

Bar code length 0 Any length (default)
1 Minimum length

Minimum length 000-254 Minimum length 1-254 (6)

Note: If Bar code length = “1” then Minimum length is entered.
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Standard 2 of 5
Standard 2 of 5 is a discrete and self-checking symbology that uses the bars
to encode information and the spaces to separate the individual bars.

Action
Tap (+) to expand the Standard 2 of 5 parameter, select the setting to be
changed, then tap an option to change this setting or select an option from
the drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.4.1

Options
Decoding 0 Not active (default)

1 Active
Format 0 Identicon, 6 start/stop bars (default)

1 Computer Identics, 4 start/stop
Check digit 0 Not used (default)

1 Mod 10 transmitted
2 Mod 10 not transmitted

Bar code length 0 Any length
1 Minimum length (default)
2 Fixed lengths

Minimum length 001-254 Minimum length 1-254 (6)
Fixed length 1 000-254 Fixed bar code length 0-254 (0)
Fixed length 2 000-254 Fixed bar code length 0-254 (0)
Fixed length 3 000-254 Fixed bar code length 0-254 (0)

Note: If Bar code length = “1” then Minimum length is entered. If Bar
code length = “2” then Fixed length 1, Fixed length 2, or Fixed length 3
is entered.
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Codabar
Codabar is a self-checking, discrete symbology.

Action
Tap (+) to expand the Codabar parameter, select a setting to be changed,
then select an option from the drop-down list to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.5.1

Options
Decoding 0 Not active (default)

1 Active
Start/Stop 0 Not transmitted (default)

1 abcd transmitted
2 ABCD transmitted
3 abcd/tn*e transmitted
4 DC1`DC4 transmitted

CLSI library system (Not supported when using an imager):
0 Not active (default)
1 Active

Check digit 0 Not used (default)
1 Transmitted
2 Not transmitted

Bar code length 0 Any length
1 Minimum length (default)
2 Fixed lengths

Minimum length 003-254 Minimum length 3-254 (6)
Fixed length 1 000-254 Fixed length 0-254 (0)
Fixed length 2 000-254 Fixed length 0-254 (0)
Fixed length 3 000-254 Fixed length 0-254 (0)

Note: If Bar code length = “1” then Minimum length is entered. If Bar
code length = “2” then Fixed length 1, Fixed length 2, or Fixed length 3
is entered.
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UPC/EAN
UPC/EAN are fixed-length, numeric, continuous symbologies that use
four element widths.

Action
Tap (+) to expand the UPC/EAN parameter, select the setting to be
changed, then select an option to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.6.1

Options
UPC A 0 Not active

1 Active (default)
UPC E 0 Not active

1 Active (default)
EAN 8 0 Not active

1 Active (default)
EAN 13 0 Not active

1 Active (default)
Add-on digits 0 Not required (default)

1 Required
Add-on 2 digits 0 Not active (default)

1 Active
Add-on 5 digits (Not supported when using an imager):

0 Not active (default)
1 Active

UPC A check digit 0 Not transmitted
1 Transmitted (default)

UPC E check digit 0 Not transmitted
1 Transmitted (default)

EAN 8 check digit 0 Not transmitted
1 Transmitted (default)

EAN 13 check digit 0 Not transmitted
1 Transmitted (default)

UPC A number system 0 Not transmitted
1 Transmitted (default)

UPC E number system 0 Not transmitted
1 Transmitted (default)

UPC A re-encoding 0 UPC A transmitted as EAN 13 (default)
1 UPC A transmitted as UPC A

UPC E re-encoding 0 UPC E transmitted as UPC E (default)
1 UPC E transmitted as UPC A

EAN 8 re-encoding 0 EAN 8 transmitted as EAN 8 (default)
1 EAN 8 transmitted as EAN 13
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Code 93
Code 93 is a variable length, continuous symbology that uses four element
widths.

Action
Tap the Code 93 parameter, then select an option to change this parameter
setting. Tap (+) to access the Code 93 Lengths parameter.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.7.1

Options
0 Not active (default)
1 Active

Code 93 Length
Sets the Code 93 bar code length.

Action
Tap (+) to expand the Code 93 parameter, then tap (+) to expand the
Code 93 Lengths parameter. Tap the setting to be changed, then tap an
option to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.19.1

Options
Bar code length 0 Any length (default)

1 Minimum length
Minimum length 001-254 Minimum length 1-254 (6)

Note: If Bar code length = “1” then Minimum length is entered.
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Code 128
Code 128 is a variable-length, continuous, high-density, alphanumeric
symbology that uses multiple element widths and supports the extended
ASCII character set.

Action
Tap the Code 128 parameter, then select an option to change this parame-
ter setting. The following illustration is for a 700 Series Computer using a la-
ser scanner.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.9.1

Options
0 Not active (default)
1 Active
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Code 128 Options
Set the following for the Code 128 parameter. Note that the EAN 128 ]C1
and CIP 128 French Pharmaceutical options are not available when you use
an imager with your 700 Series Computer.

Action
Tap (+) to expand the Code 128 Options parameter, select a setting, then
select an option to change this setting.

SNMP OID
None.

Options
EAN 128 ]C1 Identifier (disabled when using an imager)

0 Remove
1 Include (default)

CIP 128 French Pharmaceutical (disabled when using an imager)
0 Not active (default)
1 Active

Bar code length 0 Any length (default)
1 Minimum length

Minimum length 001-254 Minimum length 1-254 (6)
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Code 128 FNC1 Character
The Code 128 FNC1 character (EAN 128 norms) can be any ASCII char-
acter and is used as a separator when multiple identifiers and their fields
are concatenated. Note that this is not available when you use an imager with
your 700 Series Computer.

Non-printable ASCII characters can be entered using the following syntax
where HH is the hexadecimal value of the character.

\xHH
For example, the GS character, whose hexadecimal value is 1D, would be
entered as \x1D. In addition,the following characters have their own iden-
tifiers:

S BEL \a

S BS \b

S FF \f

S LF \n

S CR \r

S HT \t

S VT \v

Action
Tap (+) to expand the Code 128 parameter, then type the ASCII charac-
ters to be set for the Code 128 FNC1 character parameter.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.21.1

Options
Any ASCII character (default is the GS function character - ID hex)
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Plessey
Plessey is a pulse-width modulated symbology like most other bar codes. It
includes a start character, data characters, an eight-bit cyclic check digit,
and a termination bar. The code is continuous and not self-checking. You
need to configure two parameters for Plessey code: Start Code and Check
Digit. Note that this is not available when you use an imager with your 700
Series Computer.

Action
Tap (+) to expand the Plessey parameter, select the setting to be changed,
then select an option to change this setting or select an option from the
drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.10.1

Options
Decoding 0 Not active (default)

1 Active
Check digit 0 Not transmitted (default)

1 Transmitted
Bar code length 0 Any length (default)

1 Minimum length
Minimum length 001-254 Minimum bar code length 1-254 (6)

Note: If Bar code length = “1” then Minimum length is entered.
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MSI
MSI is a symbology similar to Plessey code (page 298) that includes a start
pattern, data characters, one or two check digits, and a stop pattern. Note
that this is not available when you use an imager with your 700 Series Com-
puter.

Action
Tap (+) to expand the MSI parameter, select the setting to be changed,
then select an option to change this setting or select an option from the
drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.15.1

Options
Decoding 0 Not active (default)

1 Active
Check digit 0 Mod 10 transmitted (default)

1 Mod 10 Not transmitted
2 Double Mod 10 transmitted
3 Double Mod 10 not transmitted

Bar code length 0 Any length
1 Minimum length (default)

Minimum length 001-254 Minimum length 1-254 (6)

Note: If Bar code length = “1” then Minimum length is entered.
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PDF 417
PDF 417 is a stacked two-dimensional symbology that provides the ability
to scan across rows of code. Each row consists of start/stop characters, row
identifiers, and symbol characters, which consist of four bars and four
spaces each and contain the actual data. This symbology uses error correc-
tion symbol characters appended at the end to recover loss of data.

Because the virtual wedge translates incoming data into keypad input, the
size of the keypad buffer limits the effective length of the label to 128
characters. Longer labels may be truncated. For PDF 417 labels of more
than 128 characters, you can develop an application that bypasses the key-
pad buffer.

Action
Tap the PDF 417 parameter, then select an option to change this parame-
ter setting. Tap (+) to access either the Macro PDF options parameter or
the Micro PDF 417 parameter.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.17.1

Options
0 Not active
1 Active (default)

Macro PDF options
Macro PDF is used when a long message requires more than one PDF 417
label. Note that this is not available when you use an imager with your 700
Series Computer.

S Select Buffered to store a multi-label PDF 417 message in the Sabre
buffer, thus transmitting the entire message when all labels have been
read.
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S Select Unbuffered for multi-label PDF 417 messages that are too long
for the Sabre buffer (memory overflow). Each part of the PDF 417 label
is transmitted separately, and the host application must then assemble
the message using the macro PDF control header transmitted with each
label. Control Header is only present in macro PDF codes and is always
transmitted with unbuffered option.

Action
Tap (+) to expand the PDF 417 parameter, tap (+) to expand the Macro
PDF parameter, select a setting to be changed, then select an option to
change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.22.1

Options
Macro PDF 0 Unbuffered

1 Buffered (default)
Control header 0 Not transmitted (default)

1 Transmitted
File name 0 Not transmitted (default)

1 Transmitted
Segment count 0 Not transmitted (default)

1 Transmitted
Time stamp 0 Not transmitted (default)

1 Transmitted
Sender 0 Not transmitted (default)

1 Transmitted
Addressee 0 Not transmitted (default)

1 Transmitted
File size 0 Not transmitted (default)

1 Transmitted
Checksum 0 Not transmitted (default)

1 Transmitted
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Micro PDF 417
Micro PDF 417 is a multi-row symbology derived from and closely based
on PDF 417 (page 300). A limited set of symbology sizes is available, to-
gether with a fixed level of error correction for each symbology size. Note
that this is not available when you use an imager with your 700 Series Com-
puter.

Action
Tap (+) to expand the PDF 417 parameter, tap (+) to expand the Micro
PDF 417 parameter, select a setting to be changed, then select an option
to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.27.1

Options
Decoding 0 Not active (default)

1 Active
Code 128 Emulation 0 Not active (default)

1 Active
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Interleaved 2 of 5
Interleaved 2 of 5 (I 2 of 5) is a high-density, self-checking, continuous,
numeric symbology used mainly in inventory distribution and the auto-
mobile industry.

Note: An Interleaved 2 of 5 bar code label must be at least three characters
long for the 700 Series Computer to scan and decode correctly.

Action
Tap (+) to expand the Interleaved 2 of 5 parameter, select the setting to be
changed, then tap an option to change this setting or select an option from
the drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.23.1

Options
Decoding 0 Not active (default)

1 Active
Check digit 0 Not used (default)

1 Mod 10 transmitted
2 Mod 10 not transmitted
3 French CIP transmitted
4 French CIP not transmitted

Bar code length 0 Any length
1 Minimum length (default)
2 Fixed lengths

Minimum length 003-254 Minimum length 3-254 (6)
Fixed length 1 003-254 Fixed length 3-254 (0)
Fixed length 2 003-254 Fixed length 3-254 (0)
Fixed length 3 003-254 Fixed length 3-254 (0)

Note: If Bar code length = “1” then Minimum length is entered. If Bar
code length =“2” then Fixed length 1, Fixed length 2, or Fixed length 3 is
entered.
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Matrix 2 of 5
Matrix 2 of 5 is a numerical symbology. Note that this is not available when
you use an imager with your 700 Series Computer.

Action
Tap (+) to expand the Matrix 2 of 5 parameter, select the setting to be
changed, then tap an option to change this setting or select an option from
the drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.24.1

Options
Decoding 0 Not active (default)

1 Active
Bar code length 0 Any length

1 Minimum length (default)
Minimum length 001-254 Minimum length 1-254 (6)

Note: If Bar code length = “1” then Minimum length is entered.
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Telepen
Telepen is an alphanumeric, case-sensitive, full ASCII symbology. Note that
this is not available when you use an imager with your 700 Series Computer.

Action
Tap (+) to expand the Telepen parameter, select the setting to be changed,
then tap an option to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.25.1

Options
Decoding 0 Not active (default)

1 Active
Format 0 ASCII (default)

1 Numeric
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Code 11
Code 11 is a high density, discrete numeric symbology that is extensively
used in labeling telecommunications components and equipment. Note
that this is not available when you use an imager with your 700 Series Com-
puter.

Action
Tap (+) to expand the Code 11 parameter, select the setting to be changed,
then tap an option to change this setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.26.1

Options
Decoding 0 Not active (default)

1 Active
Check digit verification 1 1 digit (default)

2 2 digits
Check digit transmit 0 Disable (default)

1 Enable
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QR Code
QR Code (Quick Response Code) is a two-dimensional matrix symbology
containing dark and light square data modules. It has position detection
patterns on three of its four corners and features direct encodation of the
Japanese Kana-Kanji character set. It can encode up to 2509 numeric or
1520 alphanumeric characters and offers three levels of error detection.
Note that this is not available when you use a laser scanner with your 700 Se-
ries Computer.

Action
Tap (+) to expand the QR Code parameter, select the setting to be
changed, then tap an option to change this setting or select an option from
the drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.35.1

Options
Decoding 0 Not active

1 Active (default)
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Data Matrix
A two-dimensional matrix symbology, which is made of square modules
arranged within a perimeter finder pattern. The symbology utilizes Error
Checking and Correcting (ECC) algorithm with selectable levels for data
error recovery and Cyclic Redundancy Check algorithm to validate the da-
ta. The character set includes either 128 characters conforming to ISO
646 (ANSI X3.4 - 1986) or 256 extended character set. Maximum capac-
ity of a symbol is 2335 alphanumeric characters, 1556 8-bit byte charac-
ters or 3116 numeric digits. Note that this is not available when you use a
laser scanner with your 700 Series Computer.

Action
Tap (+) to expand the Data Matrix parameter, select the setting to be
changed, then tap an option to change this setting or select an option from
the drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.1.1.34.1

Options
Decoding 0 Not active

1 Active (default)
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Symbology Options
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Data Collection icon to access its control panel
applet.

Use the right and left arrows to scroll to the Symbology Options tab, then
tap this tab to access its parameters. The following are parameters for bar
code symbology options. Note that these are listed in the order of their
appearance within the Symbology Options tab.

Symbology ID
Identifies the bar code symbology in which data has been encoded by pre-
pending a user-specified symbology identifier to the data. You can prepend
one of these types of character strings to identify the symbology:

S User-defined ASCII Character (Option 1):
A user-defined symbology identifier is a single ASCII character. You can
assign a custom identifier character to each bar code symbology. Note
that this is not available when you use an imager with your 700 Series
Computer.

S AIM ISO/IEC Standard (Option 2 - Required to define symbology IDs):
The AIM Standard has a three-character structure which indicates the
symbology and optional features. See the AIM ISO/IEC Standard for
more information.

Action
Select Symbology ID, then select an option to change this parameter set-
ting. Tap (+) to expand the Symbology ID parameter, then select any of
the user ID parameters listed. See the top of the next page for a sample screen
of the Code 39 user ID.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.4.1.22.1

Options
0 Disable (default)
1 User defined (disabled when using an imager)
2 ISO/IEC Standard
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Code 39 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Code 39 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Code 39 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.3.1

Options: x where x is a single ASCII character. Default is asterisk (*).

Code 128 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Code 128 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Code 128 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.5.1

Options: x where x is a single ASCII character. Default is asterisk (*).

Codabar User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Codabar bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Codabar user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.2.1

Options: x where x is a single ASCII character. Default is D.
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Code 93 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Code 93 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Code 93 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.4.1

Options: x where x is a single ASCII character. Default is asterisk (*).

Interleaved 2 of 5 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Interleaved 2 of 5 bar code data. Note that this
is not available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Interleaved 2
of 5 user ID parameter, then enter a user ID value to change this parame-
ter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.10.1

Options: x where x is a single ASCII character. Default is I (not lowercase L).

PDF-417 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify PDF 417 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the PDF 417 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.12.1

Options: x where x is a single ASCII character. Default is an asterisk (*).

MSI User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify MSI bar code data. Note that this is not avail-
able when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the MSI user ID
parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.11.1

Options: x where x is a single ASCII character. Default is D.
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Plessey User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Plessey bar code data. Note that this is not avail-
able when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Plessey user ID
parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.13.1

Options: x where x is a single ASCII character. Default is D.

Standard 2 of 5 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Standard 2 of 5 bar code data. Note that this is
not available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Standard 2 of
5 user ID parameter, then enter a user ID value to change this parameter
setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.23.1

Options: x where x is a single ASCII character. Default is D.

UPC A User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify UPC-A (Universal Product Code) bar code
data. Note that this is not available when you use an imager with your 700
Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the UPC A user ID
parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.6.1

Options: x where x is a single ASCII character. Default is A.

UPC E User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify UPC-E bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the UPC E user ID
parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.7.1

Options: x where x is a single ASCII character. Default is E.



Control Panel AppletsAppendix —A

313700 Series Color Mobile Computer User’s Manual

EAN 8 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify EAN-8 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the EAN 8 user ID
parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.8.1

Options: x where x is a single ASCII character. Default is \xFF.

EAN 13 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify EAN-13 (European Article Numbering) bar
code data. Note that this is not available when you use an imager with your
700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the EAN 13 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.9.1

Options: x where x is a single ASCII character. Default is F.

Matrix 2 of 5 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Matrix 2 of 5 bar code data. Note that this is
not available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Matrix 2 of 5
user ID parameter, then enter a user ID value to change this parameter
setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.24.1

Options: x where x is a single ASCII character. Default is D.

Telepen User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Telepen bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Telepen user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.25.1

Options: x where x is a single ASCII character. Default is an asterisk (*).
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Code 11 User ID
If “1” was selected in the Symbology ID parameter, you can set your own
ASCII character to identify Code 11 bar code data. Note that this is not
available when you use an imager with your 700 Series Computer.

Action: Tap (+) to expand the Symbology ID parameter, select the Code 11 user
ID parameter, then enter a user ID value to change this parameter setting.

SNMP OID: 1.3.6.1.4.1.1963.15.3.3.4.1.16.1

Options: x where x is a single ASCII character. Default is asterisk (*).
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Prefix
Prepends a string of up to 20 ASCII characters to all scanned data.

Action
Tap the Prefix parameter, then enter a prefix value to change this parame-
ter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.4.1.29.1

Options
Acceptable values are up to 20 ASCII characters.
Embedded null (<NUL >) characters are not allowed.
Default is no characters (disabled).
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Suffix
Appends a string of up to 20 ASCII characters to all scanned data.

Action
Tap the Suffix parameter, then enter a suffix value to change this parame-
ter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.4.1.30.1

Options
Acceptable values are up to 20 ASCII characters. Embedded null (<NUL
>) characters are not allowed. Default is no characters (disabled).
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Beeper/LED
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Data Collection icon to access its control panel
applet.

Use the right and left arrows to scroll to the Beeper/LED tab, then tap this
tab to access its parameters.

Most of these functions are not available when using an imager. The following
table shows which functions are supported either by an imager or by a laser
scanner.

Beeper Function Imager Laser Scanner

Beeper Volume X X

Beeper Frequency X

Good Read Beeps X

Good Read Beep Duration X

The following are parameters for features on the 700 Series Computer.
Note that these are listed in the order of their appearance.
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Beeper Volume
Sets the volume for the good read beep.

Action
Tap the Beeper volume parameter, then select an option to change this pa-
rameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.1.4.1.6.1

Laser Scanner Options
0 Low
1 High (default)
2 Medium
3 Off
4 Vibrate
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Imager Options
1 Beeper (default)
4 Vibrate

Silencing the Beeper Volume
To turn the beeper off, tap Start → Settings → the Personal tab →
Sounds and Notifications → the Volume tab, drag the System volume
slider bar to the left “Silent” position, then tap ok to exit this applet.



Control Panel AppletsAppendix —A

320 700 Series Color Mobile Computer User’s Manual

Beeper Frequency
Sets the frequency for the good read beep. Note that this is not available
when you use an imager with your 700 Series Computer.

Action
Tap the Beeper frequency parameter, then enter a frequency value to
change this parameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.1.4.1.7.1

Options
1000-4095 (default is 2090)
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Good Read Beeps
Sets the number of good read beeps. Note that this is not available when you
use an imager with your 700 Series Computer.

Action
Tap the Good read beeps parameter, then select an option to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.1.4.1.8.1

Options
0 No beeps
1 One beep (default)
2 Two beeps
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Good Read Beep Duration
Sets the duration of the good read beep. Note that this is not available when
you use an imager with your 700 Series Computer.

Action
Tap the Good read beep duration parameter, then enter a duration value
to change this parameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.1.4.1.9.1

Options
0`2550 Beep duration in milliseconds. (default is 80)
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Imager
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Data Collection icon to access its control panel
applet.

Use the right and left arrows to scroll to the Imager tab, then tap this tab
to access its parameters.

The following are parameters for the imager. Note that these are listed in
the order of their appearance within the Imager tab.

Aimer LED duration
The Aimer LED duration controls the time the Aimer LED is turned on
when the scan button is pressed. After this time, images are captured for
decoding. The purpose is to position the Aimer LED on the bar code sym-
bol before attempting to decode the bar code. Note that this is not available
when you use a laser scanner with your 700 Series Computer.

Action
Tap the Aimer LED duration parameter, then enter a value to change this
setting. Note that values must be in 50 ms increments, such as 500, 650,
or 32500. Values not entered in 50 ms increments will be rounded down.
For example, 2489 ms would be rounded down to 2450 ms, 149 ms
would be rounded down to 100 ms, etc..

SNMP OID
1.3.6.1.4.1.1963.15.3.3.3.1.1.21.1

Options
0-65500 ms (Default is 0)
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Image Dimension
The image dimensions control the horizontal size of the image for decod-
ing. This can restrict the image to one bar code when otherwise, there
might be more than one bar code in the image to be decoded. Note that
this is not available when you use a laser scanner with your 700 Series Com-
puter.

Action
Tap the Image dimension parameter, select the position to be changed,
then tap an option or enter a value to change this position.

SNMP OID
1.3.6.1.4.1.1963.15.3.3.3.1.1.22.1

Options
Left position 0 Not supported
Right position 0 Not supported
Top position 0-478 Position in pixels (0)
Bottom position 0-479 Position in pixels (479)
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Virtual Wedge
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Data Collection icon to access its control panel
applet.

Use the right and left arrows to scroll to the Virtual Wedge tab, then tap
this tab to access its parameters.

The following are parameters for the virtual wedge scanner. Note that these
are listed in the order of their appearance within the Virtual Wedge tab.

Virtual Wedge
Enables or disables the virtual wedge for the internal scanner. The virtual
wedge retrieves scanned Automatic Data Collection (ADC) data and sends
it to the keypad driver so that the 700 Series Computer can receive and
interpret the data as keypad input.

Because the virtual wedge translates incoming data into keypad input, the
size of the keypad buffer limits the effective length of the label to 128
characters. Longer labels may be truncated. For labels of more than 128
characters, you need to develop an application that bypasses the keypad
buffer.

Action
Tap the Virtual Wedge parameter, then tap an option to change this pa-
rameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.2.1.1.2.1

Options
0 Disable
1 Enable (default)
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Preamble
Sets the preamble that precedes any data you scan with the 700 Series
Computer. Common preambles include a data location number or an op-
erator number.

Action
Tap the Preamble parameter, then enter a preamble value to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.2.1.1.3.1

Syntax
ADdata
where data is acceptable values up to 31 ASCII characters. Embedded null
(<NUL >) characters are not allowed. Default is no characters (disabled).

Note: When you enter the AD command without data, the preamble is
disabled. If you want to use quotation marks or the following combina-
tions of characters as part of the appended data, separate those characters
from the AD command with quotes. If you do not use quotes as described
here, the 700 Series Computer will interpret the characters as another con-
figuration command:
AD
AE
AF
KC
BV
EX
DF

EXAMPLE:
To use the two-character string BV as a preamble, scan this command (as a
Code 39 label) or send this command through the network: $+AD“BV”
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Postamble
Sets the postamble that is appended to any data you scan with the 700 Se-
ries Computer. Common postambles include cursor controls, such as tabs
or carriage return line feeds.

Action
Tap the Postamble parameter, then enter a postamble value to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.2.1.1.4.1

Syntax
AEdata
where data is any acceptable values up to 31 ASCII characters. Embedded
null (<NUL >) characters are not allowed. Default is the tab character (\t).

Note: When you enter the AE command without data, the postamble is
disabled. If you want to use quotation marks or the following combina-
tions of characters as part of the appended data, separate those characters
from the AE command with quotes. If you do not use quotes as described
here, the 700 Series Computer will interpret the characters as another con-
figuration command.
AD
AE
AF
KC
BV
EX
DF

EXAMPLE:
To use the two-character string BV as a postamble, scan this command (as
a Code 39 label) or send this command through the network: $+AE“BV”
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Grid
Sets the virtual wedge grid, which filters the data coming from this 700
Series Computer. The data server supports data filtering, which allows you
to selectively send scanned data. The virtual wedge grid is similar to the
“format” argument of the C Runtime Library scan function.

Action
Tap the Grid parameter, then enter a grid value to change this parameter
setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.2.1.1.5.1

Syntax
AF<symID> filter-expression= > editing-expression
where:

S <symID>
The AIM symbology ID.

S filter-expression
Any character string that includes valid filter expression values, and edit-
ing-expression is any character string that includes valid editing expres-
sion values.

S <width>
Any positive integer or NULL. A NULL width means that the field type
(defined next) applies all the way to the end of the data string. A non-
NULL width means that the field applies to that many characters of da-
ta. The grid can be up to 240 characters in length. Default is NULL.
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Code Page
Sets the virtual wedge code page. The code page controls the translation
from the character set of the raw collected data to Unicode, which is the
character set expected by Windows CE applications. The default code page
is 1252, which is the Windows Latin 1 (ANSI) character set.

Action
Tap the Code Page parameter, then select an option to change this param-
eter setting.

SNMP OID
1.3.6.1.4.1.1963.15.3.2.1.1.6.1

Options
The only acceptable value for the code page parameter is “1252,” which is
the default.
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SNMP Control Panel Applet
Simple Network Management Protocol (SNMP) parameters include iden-
tification information, security encryption, security community strings,
and traps.

To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the SNMP icon to access its control panel applet.

Tap a tab to access its menus. These tabs represent three groups of settings
or parameters:

S Security (starting on the next page)

S Traps (starting on page 336)

S Identification (starting on page 338)
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Security
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the SNMP icon → the Security tab to access its
parameters.

The following are parameters that affect encryption and community
strings. Note that these are listed in the order of their appearance within the
Security tab.

Read Only Community
Sets the read-only community string for this 700 Series Computer, which
is required for processing of SNMP get and get next requests.

Action
Tap the Read Only Community parameter, then enter a community string
to change this parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.1.2.0

Options
The read-only community string can be up to 128 ASCII characters. De-
fault is Public.
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Read/Write Community
Sets the read/write community string, which is required for processing of
SNMP set requests by this 700 Series Computer. An SNMP packet with
this name as the community string will also process SNMP get and next
requests.

Action
Tap the Read/Write Community parameter, then enter a community
string to change this parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.1.3.0

Options
The read/write community string can be up to 128 ASCII characters. De-
fault is Private.
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Read Encryption
Sets the packet-level mode of security for SNMP read-only requests. If you
enable read encryption, all received SNMP get and get next packets have
to be encrypted or the packet will not be authorized. If encryption is en-
abled, you can only use software provided by Intermec Technologies.

Note: To enable security encryption, you also need to set the Security En-
cryption Key (page 335).

Action
Tap the Read Encryption parameter, then select an option to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.1.4.0

Options
1 On SNMP get and get next packets must be encrypted
2 Off SNMP packets do not have to be encrypted (default)
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Write Encryption
Sets the packet-level mode of security for SNMP read/write requests. If
you enable write encryption, all SNMP packets that are received with the
read/write community string have to be encrypted or the packet will not
be authorized. You need to use software from Intermec Technologies that
supports encryption.

Note: To enable security encryption, you also need to set the Security En-
cryption Key (page 335).

Action
Tap the Write Encryption parameter, then select an option to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.1.5.0

Options
1 On SNMP packets must be encrypted
2 Off SNMP packets do not have to be encrypted (default)
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Encryption Key
Identifies the key that this 700 Series Computer uses to encrypt or deci-
pher SNMP packets. Encryption is used only by software provided by In-
termec Technologies. If encryption is enabled, SNMP management plat-
forms will not be able to communicate with the 700 Series Computer. The
encryption key is returned encrypted.

Action
Tap the Encryption Key parameter, then enter a security encryption key
value to change this parameter setting.

Note: You also need to set either Read Encryption (page 333) or Write
Encryption (page 334) or both.

SNMP OID
1.3.6.1.4.1.1963.10.5.1.6.0

Options
The encryption key can be from 4 to 20 ASCII characters. Default is
NULL.
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Traps
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the SNMP icon → the Traps tab to access its
parameters.

The following are authentication and threshold parameters for traps. Note
that these are listed in the order of their appearance within the Traps tab.

Authentication
Determines whether to send authentication traps. When trap authentica-
tion is enabled, an authentication trap is sent if an SNMP packet is re-
ceived by the master agent with an invalid community string.

Action
Tap the Authentication parameter, then select an option to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.2.2.0

Options
1 On (default)
2 Off
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Threshold
Determines the maximum number of traps per second that the master
agent generates. If the threshold is reached, the trap will not be sent.

Action
Tap the Threshold parameter, then enter a threshold value to change this
parameter setting.

SNMP OID
1.3.6.1.4.1.1963.10.5.2.3.0

Options
Any positive integer value. Default is 10.
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Identification
To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the SNMP icon → the Identification tab to access
its parameters.

The following are parameters for contact, location, and name information
for support purposes. Note that these are listed in the order of their appear-
ance within the Identification tab.

Contact
Sets the contact information for the person responsible for this 700 Series
Computer.

Action
Tap the Contact parameter, then enter the name of your contact represen-
tative to change this parameter setting.

SNMP OID
1.3.6.1.2.1.1.4.0

Options
The identification contact may be up to 255 ASCII characters. Default is
no characters or blank.
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Name
Sets the assigned name for this 700 Series Computer.

Action
Tap the Name parameter, then enter the name of your 700 Series Com-
puter to change this parameter setting.

SNMP OID
1.3.6.1.2.1.1.5.0

Options
The identification name may be up to 255 ASCII characters. Default is no
characters or blank.
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Location
Sets the identification location for this 700 Series Computer, such as
“Shipping.”

Action
Tap the Location parameter, then enter the location of where your 700
Series Computer to change this parameter setting.

SNMP OID
1.3.6.1.2.1.1.6.0

Options
The identification location may be up to 255 ASCII characters. Default is
no characters or blank.
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Unit Information Control Panel Applet
Unit Information is a read-only control panel applet that provides informa-
tion about your 700 Series Computer, such as software version builds,
available CAB files, and the internal battery status.

This control panel applet is only available in the 700 Series Computer if
Intermec Content is enabled, the Plus region is enabled and installed, and
a laser scanner is installed.

To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Unit Information icon to access its control panel
applet.

Tap a tab to access its menus. These tabs represent three groups of settings
or parameters:

S Versions (starting on the next page)

S Battery Status (starting on page 343)

S CAB Files (starting on page 344)
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Versions
You can view the latest software build version on your 700 Series
Computer by accessing the Unit Information control panel applet.

To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Unit Information icon → the Versions tab to
view the latest software build version. Tap ok to exit this information.

Below are some of the software applications you may find on this screen:

S 700 Platform Build:
Shows the latest development or released version of the software build
for the 700 Series Computer.

S S9C:
Provides the name and version of the scanner file built into this 700 Se-
ries Computer, along with the current CPU version.

S DataCollection Build:
Shows the latest development or released version of the software build
for the Data Collection control panel applet.
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Battery Status
You can view the battery status for your 700 Series Computer by accessing
the Unit Information control panel applet. Unit Manager applications are
available on the 700 Series Color Unit Manager CD-ROM. For more
information, consult your Intermec sales representative.

To access the settings from the 700 Series Computer, tap Start → Settings
→ the System tab → the Unit Information icon → the Battery Status tab
to view the current status. Tap ok to exit this information.
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CAB Files
You can view the latest developer or released version of each CAB file from
Intermec Technologies Corporation that are installed in your 700 Series
Computer via the Unit Information control panel applet. Custom CAB
files are not displayed in this applet. See the Software Tools User’ s Manual for
more information about these files.

To access the information from the 700 Series Computer, tap Start →
Settings → the System tab → the Unit Information icon → the CAB
Files tab to view the current CAB file versions. Tap ok to exit this
information.

When a CAB file is built, a registry entry is created with a build number
for that file. This CAB Files control panel applet looks for a registry key
for each CAB file installed. When the registry entry is found, the CAB file
name and version number information are displayed. If a CAB file has not
been installed, then its information is not displayed.

Below is a list of CAB files from Intermec Technologies that are available
for your 700 Series Computer with their latest developer or released ver-
sion of the software build. Should you need to add any of these to your
700 Series Computer, contact an Intermec representative.

S BtMainStack:
Installation of the Main Bluetooth Stack is handled automatically as part
of the operating system boot-up procedure. See Chapter 4, “Network
Support,” for more information about Bluetooth wireless printing.

S Comm Port Wedge:
The software build for the Comm Port Wedge. Note that the Comm Port
Wedge CAB file is available on the 700C Tools CD.

S NPCPTest:
This installs a Norand Portable Communications Protocol (NPCP)
Printing test application which will print to an Intermec 4815, 4820,
or 6820 Printer. See Chapter 5, “Printer Support,” for more information.
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S PDWPM0C:
This is the installer for the Wireless Printing Demo application. To run
this demonstration, tap Start → Programs → the Wireless Printing
Demo icon. Press Help in the demo application for more information.

S S9C Upgrade:
Installs the files needed to upgrade the S9C scanner firmware. See the
Recovery CD Help for more information about upgrading the firmware.

S SDK:
Installs the Intermec Software Developer’ s Kit (SDK). See the SDK
User’ s Manual for more information.

S Unit Manager:
Installs the Unit Manager application which provides tools for remotely
managing the 700 Series Computer. Unit Manager applications are
available on the 700 Series Color Unit Manager CD-ROM. For more in-
formation, consult your Intermec sales representative.

S Unit Manager Help:
Installs the online help for the Unit Manager application.

S WinCfg:
Configures the NRINET.INI file, launches the NRINet client, and
loads and unloads the LAN and WLAN device drivers. See the Windows
95 and Windows CE Configuration Utilities Reference Manual (P/N:
978-054-010) for more information.

S Wireless Printing Sample:
Installs a sample application that developers can use for reference when
they are developing their own Wireless Printing applications. The source
code for this application is included as part of the Wireless Printing
SDK on the 700C Tools CD. See the SDK User’ s Manual for more infor-
mation.

S ActiveX Control Tools:
This lists some of the CAB files that may be available with which to
install ActiveX Control Tools. See the SDK Online Help for more informa-
tion.

S AXCommunication:
Communication controls that transmit or receive messages from in-
put connections.

S AXFileTransfer:
File transfer controls that transmit and receive files using the Trivial
File Transfer Protocol (TFTP).

S AXReaderCommand:
Reader command functions that modify and retrieve configuration
information from your 700 Series Computer.

S AXVWedge:
The virtual wedge control that retrieves scanned ADC data and sends
it to the keyboard driver to interpret data as keyboard input.
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Unit ManagerB

Configuration parameters are also configurable using a Unit Manager ap-
plication which accesses the 700 Series Computer through a web browser
on your desktop PC via the SRDEVMGMT.CAB file.

Unit Manager applications are available on the 700 Series Color Unit
Manager CD-ROM. For more information, consult your Intermec sales
representative.

Note: Parameter information, such as SNMP OID and options, is detailed
in Appendix A, “Control Panel Applets.”
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Data Collection
Within the Unit Manager, click Configuration from the left navigation
bar, then click the Data Collection icon to access any of these tabs:
Symbologies, Symbology ID, Beeper/LED, or Virtual Wedge.

Symbologies
Within the Unit Manager, select Configuration Management → Data
Collection, then click the Symbologies tab to access the following parame-
ters. Options for these parameters are listed on the page provided. These
are listed in alphabetical order.

S Codabar (page 292)

S Code 11 (page 306)

S Code 128 (page 295)

S Code 128 Options (page 296)

S Code 128 FNC1 Character (page 297)

S Code 39 (page 290)

S Code 93 (page 294)

S Code 93 Length (page 294)

S Data Matrix (page 308)

S Interleaved 2 of 5 (page 303)

S Matrix 2 of 5 (page 304)

S MSI (page 299)

S PDF 417 (page 300)

S Macro PDF (page 300)

S Micro PDF 417 (page 302)

S Plessey (page 298)

S QR Code (page 307)

S Standard 2 of 5 (page 291)

S Telepen (page 305)

S UPC/EAN (page 293)
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Symbology ID
Within the Unit Manager, select Configuration Management → Data
Collection, then click the Symbology ID tab to access the following
parameters. Options for these parameters are listed on the page provided.
These are listed in alphabetical order.

S Prefix (page 315)

S Suffix (page 316)

S Symbology ID (page 309)

S Codabar user ID (page 310)

S Code 11 user ID (page 314)

S Code 128 user ID (page 310)

S Code 39 user ID (page 310)

S Code 93 user ID (page 311)

S EAN-13 user ID (page 313)

S EAN-8 user ID (page 313)

S Interleaved 2 of 5 user ID (page 311)

S Matrix 2 of 5 user ID (page 313)

S MSI user ID (page 311)

S PDF 417 user ID (page 311)

S Plessey user ID (page 312)

S Standard 2 of 5 user ID (page 312)

S Telepen user ID (page 313)

S UPC-A user ID (page 312)

S UPC-E user ID (page 312)

Beeper/LED
Within the Unit Manager, select Configuration Management → Data
Collection, then click the Beeper/LED tab to access the following
parameters. Options for these parameters are listed on the page provided.
These are listed in alphabetical order.

S Beeper Frequency (page 320)

S Beeper Volume (page 318)

S Good Read Beep Duration (page 322)

S Good Read Beeps (page 321)
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Imager
Within the Unit Manager, select Configuration Management → Data
Collection, then click the Imager tab to access the following parameters.
Options for these parameters are listed on the page provided. These are
listed in alphabetical order.

S Aimer LED Duration (page 323)

S Image Dimension (page 324)

Virtual Wedge
Within the Unit Manager, select Configuration Management → Data
Collection, then click the Virtual Wedge tab to access the following
parameters. Options for these parameters are listed on the page provided.
These are listed in alphabetical order.

S Code Page (page 329)

S Grid (page 328)

S Postamble (page 327)

S Preamble (page 326)

S Virtual Wedge (page 325)

SNMP
Within the Unit Manager, click Configuration from the left navigation
bar, then click the SNMP icon to access any of these tabs: Security, Traps,
or Identification.

Security
Within the Unit Manager, select Configuration Management → SNMP,
then click the Security tab to access the following parameters. Options for
these parameters are listed on the page provided. These are listed in alpha-
betical order.

S Encryption Key (page 335)

S Read Encryption (page 333)

S Read Only Community (page 331)

S Read/Write Community (page 332)

S Write Encryption (page 334)
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Traps
Within the Unit Manager, select Configuration Management → SNMP,
then click the Traps tab to access the following parameters. Options for
these parameters are listed on the page provided. These are listed in alpha-
betical order.

S Authentication (page 336)

S Threshold (page 337)

Identification
Within the Unit Manager, select Configuration Management → SNMP,
then click the Identification tab to access the following parameters. Op-
tions for these parameters are listed on the page provided. These are listed
in alphabetical order.

S Contact (page 338)

S Location (page 340)

S Name (page 339)
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Unit

Within the Unit Manager, click Configuration from the left navigation
bar, then click the Unit icon to access any of these tabs: Date/Time, Dis-
play, Keypad, Power Management, or Speaker.

Date/Time
Sets the current date and time.

Action
Click the Date/Time tab, then select Date or Time and make changes in
the entry field, or tap (+) to expand either the Date or Time parameter,
select the setting to be changed, then select a value from the drop-down
list or enter a new value to change this setting.

SNMP OID
Date: 1.3.6.1.4.1.1963.15.501.2.1.0
Time: 1.3.6.1.4.1.1963.15.501.2.2.0

Options
Date Year 0000`999 (1999)

Month 1-12 (6)
Day 1-31 (1)

Time Hour 0-23 (0)
Minute 0-59 (00)
Second 0-59 (00)
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Backlight Timeout
Sets the length of time that the display backlight remains on. If you set a
longer timeout value, you use the battery power at a faster rate.

Action
Click the Display tab, then select an option from the Backlight timeout
drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.13.1.0

Syntax
DFdata
where data is any of the following:

10 10 seconds
30 30 seconds
60 1 minute (default)
120 2 minutes
180 3 minutes
240 4 minutes
300 5 minutes
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Key Clicks
Enables or disables the keypad clicks. The 700 Series Computer emits a
click each time you press a key or decode a row of a two-dimensional
symbology.

Action
Click the Keypad tab, then select an option from the Key clicks drop-
down list.

SNMP OID
1.3.6.1.4.1.1963.15.12.1.0

Syntax
KCdata
where data is any of the following:

0 Disable clicks
1 Enable soft key clicks
2 Enable loud key clicks (default)
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Automatic Shutoff
Sets the length of time the 700 Series Computer remains on when there is
no activity. When you turn on the 700 Computer, it either resumes exactly
where it was when you turned it off or boots and restarts your application.

Action
Click the Power Management tab, then select an option from the Auto-
matic shutoff drop-down list.

SNMP OID
1.3.6.1.4.1.1963.15.11.3.0

Syntax
EZdata
where data is any of the following:

1 1 minute
2 2 minutes
3 3 minutes (default)
4 4 minutes
5 5 minutes
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Volume
Changes the volume of all audio signals.

Action
Click the Speaker tab, then select an option from the Volume drop-down
list.

SNMP OID
1.3.6.1.4.1.1963.15.3.1.3.0

Syntax
BVdata
where data is any of the following:

0 Off
1 Very quiet
2 Quiet
3 Normal (default)
4 Loud
5 Very loud
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Using Reader Commands
After the 700 Series Computer is connected to your network, you can send
the 700 Series Computer a reader command from an application to per-
form a task, such as changing the time and date. Some reader commands
temporarily override the configuration settings and some change the con-
figuration settings.

Change Configuration
The Change Configuration command must precede any configuration
command. If you enter a valid string, the 700 Series Computer configura-
tion is modified and the computer emits a high beep. To send the Change
Configuration command through the network, use the $+ [command]
syntax where command is the two-letter command syntax for the configu-
ration command followed by the value to be set for that command.

You can also make changes to several different commands by using the
$+ [command]...[command n] syntax. There are seven configuration
command settings that can be changed in this way. See each command for
information on respective acceptable “data” values.

Command Syntax

Audio Volume BVdata

Automatic Shutoff EZdata

Backlight Timeout DFdata

Key Clicks KCdata

Virtual Wedge Grid AFdata

Virtual Wedge Postamble AEdata

Virtual Wedge Preamble ADdata

Note: See Appendix A, “Control Panel Applets” for more information about
the Virtual Wedge Postamble and Virtual Wedge Preamble commands.

Example 1
To change the Beep Volume to Off, you can send this string to the 700
Series Computer through the network: $+BV0
where:

$+ Indicates Change Configuration.
BV Specifies the Audio Volume parameter.
0 Specifies a value of Off.

Example 2
To change the Beep Volume to Very Quiet and the Virtual Wedge Grid to
123: $+BV1AF123
where:

$+ Indicates Change Configuration
BV1 Specifies Audio Volume, set to Very Quiet (1)
AF123 Specifies Virtual Wedge Grid, set to a value of 123.
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Set Time and Date
This command sets the date and time on the 700 Series Computer. The
default date and time is June 1, 1999 at 12:00 AM.

From the network, send the following:

/+ yyyymmddhhmmss

where acceptable values for the date are:

yyyy 0000-9999 Year
mm 01-12 Month of the year
dd 01-31 Day of the month
hh 00-23 Hour
mm 00-59 Minutes
ss 00-59 Seconds

You can also set the time and date by using Configuration Management in
Unit Manager, or by using the Clock control panel applet in the Settings
menu. To access this control panel applet, tap Start → Settings → the
System tab → the Clock icon to access its control panel applet.



359700 Series Color Mobile Computer User’s Manual

Bar CodesC

This appendix contains a brief explanation of some of the bar code
symbologies that the 700 Series Color (700C) Mobile Computer decodes
and explains some of the general characteristics and uses of these bar code
types. It also includes several bar code labels that can be scanned into your
700 Series Computer.
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Bar Code Symbologies
Specific bar code algorithms can be enabled using the setup menus or the
host computer. Once the computer correctly decodes a bar code, the com-
puter encodes data with descriptive information about the symbol. Re-
sponse time is improved by limiting the computer to the bar codes being
used.

Bar Code Data String Formats

Data Bar Code Type Data Format Data Length

UPC short (UPC-E) nddddddc 8

EAN short (EAN-8) fndddddc 8

UPC long (UPC-A) nddddddddddc 12

EAN long (EAN-13) fnddddddddddc 13

UPC short add-on 2 nddddddcaa 10

EAN short add-on 2 fndddddcaa 10

UPC long add-on 2 nddddddddddcaa 14

EAN long add-on 2 fnddddddddddcaa 15

UPC short add-on 5 nddddddcaaaaa 13

EAN short add-on 5 fndddddcaaaaa 13

UPC long add-on 5 nddddddddddcaaaaa 17

EAN long add-on 5 fnddddddddddcaaaaa 18

Interleaved 2 of 5 d......d Scan device dependent

Standard 2 of 5 d......d Scan device dependent

Plessey d......dc Scan device dependent

Codabar sd....ds Scan device dependent

Code 11 d......d Scan device dependent

Code 39 d......d Scan device dependent

Extended Code 39 d......d Scan device dependent

Code 93 d......d Scan device dependent

Code 128 d......d Scan device dependent

Note: These bar code data definitions apply to the Data Format column in
the previous table

a Add-on code digits
c Check digits
d Bar code digits
f EAN flag 1 characters
n Number system digits
s Start and stop digits

If MOD 10 or MOD 11 check digits are enabled, the digit falls at the end
of a bar code data string. Each check digit enabled extends the bar code
data string length by one character.
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The 700 Series Computer recognizes eleven of the most widely used bar
code symbologies. With bar code symbologies, like languages, there are
many different types. A bar code symbology provides the required flexibil-
ity for a particular inventory tracking system.

A symbology may be for particular industries, such as food and beverage,
automotive, railroad, or aircraft. Some of these industries have established
their own bar code symbology because other symbologies did not meet
their needs.

Without going into great detail on the bar code structure, note that no two
products use the same bar code. Each product gets a unique bar code.

Industries that use a particular type of bar code symbology have formed
regulating committees or are members of national institutes that issue and
keep track of bar codes. This ensures that each organization that contrib-
utes to a particular industry conforms to its standard. Without some form
of governing body, bar coding would not work.

S UPC (Universal Product Code) with/without add-ons

S EAN (European Article Numbering Code) with/without add-ons

S Codabar

S C11 (Code 11)

S C39 (Code 39)

S C93 (Code 93)

S C128 (Code 128)

S I 2 of 5 (Interleaved 2 of 5 Code)

S S 2 of 5 (Standard 2 of 5)

S Plessey

S MSI (a variant of Plessey)
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UPC
The UPC (Universal Product Code) is the symbology used throughout the
grocery and retail industries. This bar code symbology contains two pieces
of numerical information encoded on the bar code, producer identifica-
tion, and product identification information.

The UPC symbol is 12 characters long. The first character of the UPC
symbol is a number system character, such as “0” for grocery items and “3”
for drug- and health-related items.

The UPC symbology is for retail environments such as grocery stores, con-
venience stores, and general merchandise stores.

Some retail items are so small that a standard UPC bar code cannot fit on
the packaging. When this occurs there is a permitted shorter version of the
UPC symbology, referred to as UPC-E. UPC-E is six characters long (eight
including number system and check digit), approximately half the size of a
standard UPC bar code.

EAN
EAN (European Article Numbering) symbology is similar to UPC symbol-
ogy, except that it contains 13 characters and uses the first two to identify
countries.

The EAN symbology is used in the retail environment throughout most of
Europe. Though similar to UPC symbology, these are not interchangeable.

Codabar
Codabar was for retail price-labeling systems. Today it is widely accepted
by libraries, medical industries, and photo finishing services.

Codabar is a discrete, self-checking code with each character represented
by a stand-alone group of four bars and three intervening spaces.

Four different start or stop characters get defined and designated “a”, “b”,
“c”, and “d”. These start and stop characters are constructed using one
wide bar and two wide spaces. A complete Codabar symbol begins with
one of the start or stop characters followed by some number of data char-
acters and ending in one of the start or stop characters.

Any of the start or stop characters may be used on either end of the sym-
bol. It is possible to use the 16 unique start or stop combinations to identi-
fy label type or other information.

Since Codabar is variable-length, discrete, and self-checking, it is a versatile
symbology. The width of space between characters is not critical and may
vary significantly within the same symbol. The character set consists of “0”
through “9”, “-”, “$”, “:”, “/”, “.”, and “+”.

The specific dimensions for bars and spaces in Codabar optimize perfor-
mance of certain early printing and reading equipment. Codabar has 18
different dimensions for bar and space widths. So many different dimen-
sions often result in labels printed out of specification and cause Codabar
printing equipment to be more expensive.
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Code 11
Code 11 satisfies the requirements for a very high density, discrete numeric
bar code. The name Code 11 derives from 11 different data characters that
can be represented, in addition to a start or stop character.

The character set includes the 10 digits and the dash symbol. Each charac-
ter is represented by a stand-alone group of three bars and two intervening
spaces. Although Code 11 is discrete, it is not self-checking. A single print-
ing defect can transpose one character into another valid character. One or
two check digits obtain data security.

The specifications for Code 11 suggest that this code should have a narrow
element width of 7.5 mils. This results in an information density of 15
characters per inch.

Code 39
Code 39 (C39) is the most widely used symbology among the industrial
bar codes. Most major companies, trade associations, and the federal gov-
ernment find this code to fit their needs. The main feature of this symbol-
ogy is the ability to encode messages using the full alphanumeric character
set, seven special characters, and ASCII characters.

Programming for this symbology can be for any length that the application
requires. The application program for the 700 Series Computer handles
symbology at least one character but no more than 32 characters in length.

When programming the computer for Code 39, it is important to set the
symbology limit as close as possible (minimum and maximum bar code
lengths being scanned). Doing so keeps the computer bar code processing
time to a minimum and conserves battery power.

Bar code readers can respond to Uniform Symbology Specification symbols
in non-standard ways for particular applications. These methods are not
for general applications, because of the extra programming required. Code
39 Full ASCII is one example of non-standard code.

Note: See page 368 to scan several Code 39 bar code labels available to
change settings on your 700 Series Computer.

Encoded Code 39 (Concatenation)
If the first data character of a symbol is a space, the reader may be pro-
grammed to append the information contained in the remainder of the
symbol to a storage buffer. This operation continues for all successive sym-
bols that contain a leading space, with messages being added to the end of
previously stored ones. When a message is read which does not contain a
leading space, the contents are appended to the buffer, the entire buffer is
transmitted, and the buffer is cleared.

Encoded Code 39 (Full ASCII)
If the bar code reader is programmed for the task, the entire ASCII charac-
ter set (128 characters) could be coded using two character sequences: a
symbol (“$”,“.”,“%”,“/”) followed by a letter of the alphabet.
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Code 93
The introduction of Code 93 provided a higher density alphanumeric
symbology designed to supplement Code 39. The set of data characters in
Code 93 is identical with that offered with Code 39. Each character con-
sists of nine modules arranged into three bars and three spaces.

Code 93 uses 48 of the 56 possible combinations. One of these characters,
represented by a square, is reserved for a start or stop character, four are
used for control characters, and the remaining 43 data characters coincide
with the Code 39 character set. An additional single module termination
bar after the stop character concludes the final space.

Code 93 is a variable length, continuous code that is not self-checking. Bar
and spaces widths may be one, two, three, or four modules wide. Its struc-
ture uses edge-to-similar-edge decoding. This makes the bar code immune
to uniform ink spread, which allows liberal bar width tolerances.

Code 93 uses two check characters. Its supporters believes this makes it the
highest density alphanumeric bar code. The dual check digit scheme pro-
vides for high data integrity. All substitution errors in a single character are
detected for any message length.

Code 128
Code 128 (C128) is one of the newest symbologies used by the retail and
manufacturing industries. It responds to the need for a compact alphanu-
meric bar code symbol that could encode complex product identification.

The fundamental requirement called for a symbology capable of being
printed by existing data processing printers (primarily dot-matrix printers)
that produce daily, work-in-progress, job, and product traceability docu-
ments. The ability to print identification messages between 10 and 32
characters long, on existing forms and labels deemed an important require-
ment.

Code 128 uniquely addresses this need as the most compact, complete,
alphanumeric symbology available.

Additionally, the Code 128 design with geometric features, improves scan-
ner read performance, does self-checking, and provides data message man-
agement function codes.

Code 128 encodes the complete set of 128 ASCII characters without ad-
ding extra symbol elements. Code 128 contains a variable-length symbolo-
gy and the ability to link one message to another for composite message
transmission. Code 128, being a double-density field, provides two numer-
ic values in a single character.

Code 128 follows the general bar code format of start zone, data, check
digit, stop code, and quiet zone. An absolute minimum bar or space di-
mension of nine mils (0.010 inch minimum nominal± 0.001 inch toler-
ance) must be maintained.

Characters in Code 128 consist of three bars and three spaces so that the
total character set includes three different start characters and a stop char-
acter.
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UCC/EAN-128 Shipping Container Labeling is a versatile tool that can
ease movement of products and information. The Shipping Container La-
beling bar code can take any form and usually has meaning only within the
company or facility where applied.

Because this random data can get mistaken later for an industry standard
code format, the UCC and EAN chose a symbology uniquely identified
from these other bar codes. This standard is for maximum flexibility, to
handle the diversity of distribution in global markets by cost efficiency.

The UCC/EAN-128 Container Labeling specification calls for a FUNC1
to immediately follow the bar code’ s start character. FUNC1 also follows
any variable-length application field. The specification also calls for the
computer to send “]C1” for the first FUNC1. The specification requires
that the computer send a “<GS>” (hex 1D) for subsequent FUNC1 codes
in the bar code.

Because “<GS>” is not compatible with computer emulation data streams,
the Uniform Code Council has been asked to change the specification.
This change is made to send the same three character sequence “]C1” to
identify the embedded FUNC1 codes.

This implementation should provide for clean application coding by iden-
tifying the same sequences for the same scanned codes. If the communica-
tion of Norand bar code types is enabled, the Shipping Container Label
codes precede with a “J”. These strings will appear on the computer dis-
play. The application may have to allow for strings longer than 48 charac-
ters (maximum length indicated in the specification). Actual length vari-
ance depends on the number of variable-length data fields. Allowing for 60
characters should be sufficient. Within the Code 128 specification, the
computer can link bar codes together. If this is to happen, allow for more
characters (computer limit is 100 characters).

The Application Identifier Standard, that is part of the UCC/EAN Ship-
ping Label concept, complements, rather than replaces, other UCC/EAN
standards. Most UCC/EAN standards primarily identify products.

Several industries expressed the need to standardize more than product
identification. The UCC/EAN Code 128 Application Identifier Standard
supplies this tool. The standard adds versatility for inter-enterprise ex-
changes of perishability dating, lot and batch identification, units of use
measure, location codes, and several other information attributes.

For more detailed information on Code 128 UCC/EAN Shipping Label
bar code and Application Identifier Standard, refer to the UCC/EAN-128
Application Identifier Standard specification.
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I 2 of 5 (Interleaved)
I 2 of 5 (Interleaved 2 of 5 Code) is an all-numeric symbology, widely used
for warehouse and heavy industrial applications. Its use has been particu-
larly prevalent in the automobile industry. The I 2 of 5 symbology can be
placed on smaller labels than what the standard UPC symbology requires.

I 2 of 5 also provides a little more flexibility on the type of material it can
print on. Interleaved 2 of 5 Code has its name because of the way the bar
code is configured.

I 2 of 5 bars and spaces both carry information. The bars represent the
odd number position digits, while spaces represent the even number posi-
tion digits. The two characters are interleaved as one. Messages encoded
with this symbology have to use an even number of characters since two
numeric characters always get interleaved together.

S 2 of 5 (Standard 2 of 5)
The code S 2 of 5 (Standard 2 of 5 Code) is designed primarily for:

S Warehouse inventory handling

S Identification of photo finishing envelopes

S Airline tickets

S Baggage and cargo handling

The code S 2 of 5 is simple and straightforward. All information is con-
tained in the widths of the bars, with the spaces serving only to separate
the individual bars.

Bars can either be wide or narrow, and the wide bars are usually three
times the widths of the narrow bars. Spaces may be any reasonable width
but are typically equal to the narrow bars. Narrow bars are identified as
zero bits and wide bars as one bits.

Remember the code structure by associating the bar positions from left to
right with weighting factors 1, 2, 4, 7, and parity. Exceptions to this rule
are zero, start, and stop. This code is a discrete code, since the white spaces
between the characters are not part of the code. Because the white spaces
carry no information, their dimensions are not critical.

The S 2 of 5 code is self-checking, meaning a scanner passing through a
printing void would detect the proper ratio of wide bars to total bars.
When the scanner spots an error, a non-read will occur.
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Plessey
Plessey finds its origin in the pulse width modulated (PWM) code devel-
oped in England. It is widely used for shelf markings in grocery stores.
Pulse width modulated codes represent each bit of information by a bar
and space pair. A zero bit consists of a narrow bar followed by a wide
space, while a one bit consists of a wide bar followed by a narrow space. It
is mainly a numeric symbology (0-9) with six extra characters available for
assigning any symbol or letter desired.

Plessey codes are not self-checking and employ a variety of check charac-
ters. Plessey employs a polynomial-based Cyclic Redundancy Check
(CRC). For start and stop characters, Plessey employs a 1101 and previous-
ly used a 0101.

This symbology is very limited about what information can be encoded. It
is not considered for new applications.

MSI Code (Variant of Plessey)
In addition to Plessey characteristics, the MSI Code employs a Modulus
10 Check. For start and stop checks, MSI employs a single bit pair of 1 as
a start symbol and a single bit pair of 0 as a stop symbol. MSI reverses the
1-2-4-8 BCD pattern for bit pair weighting to 8-6-2-1.
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Bar Code Labels
You can change some settings on your 700 Series Computer by scanning
the following Code 39 bar code labels.

S You can use the Unit Manager application to set the Automatic Shutoff,
Volume, Backlight Timer, or Key Clicks parameters (starting on page
352).

S You can use the Unit Manager application or the Data Collection con-
trol panel to set the three Virtual Wedge parameters (starting on page
325).

Note: When you use a bar code creation utility to make a scannable bar
code label, the utility probably adds opening and closing asterisks automat-
ically. Asterisks are included here for translation purposes.

Audio Volume
Note: The Audio Volume parameter information is on page 356.

Turn Audio Off

*$+BV0*
*$+BV0*

Set Audio Volume to very quiet

*$+BV1*
*$+VB1*

Set Audio Volume to quiet

*$+BV2*
*$+BV2*

Set Audio Volume to normal (default)

*$+BV3*
*$+BV3*

Set Audio Volume to loud

*$+BV4*
*$+BV4*

Set Audio Volume to very loud

*$+BV5*
*$+BV5*
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Automatic Shutoff
Note: The Automatic Shutoff parameter information is on page 355.

Set Automatic Shutoff to 1 minute

*$+EZ1*
*$+EZ1*

Set Automatic Shutoff to 2 minutes

*$+EZ2*
*$+EZ2*

Set Automatic Shutoff to 3 minutes (default)

*$+EZ3*
*$+EZ3*

Set Automatic Shutoff to 4 minutes

*$+EZ4*
*$+EZ4*

Set Automatic Shutoff to 5 minutes

*$+EZ5*
*$+EZ5*

Backlight Timeout
Note: The Backlight Timeout parameter information is on page 353.

Backlight Timeout 10 seconds

*$+DF10*
*$+DF10*

Backlight Timeout 30 seconds

*$+DF30*
*$+DF30*

Backlight Timeout 1 minute (default)

*$+DF60*
*$+DF60*
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Backlight Timeout 2 minutes

*$+DF120*
*$+DF120*

Backlight Timeout 3 minutes

*$+DF180*
*$+DF180*

Backlight Timeout 4 minutes

*$+DF240*
*$+DF240*

Backlight Timeout 5 minutes

*$+DF300*
*$+DF300*

Key Clicks
Note: The Key Clicks parameter information is on page 354.

Disable key clicks

*$+KC0*
*$+KC0*

Enable soft key clicks

*$+KC1*
*$+KC1*

Enable loud key clicks (default)

*$+KC2*
*$+KC2*
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Virtual Wedge Grid, Preamble, Postamble
The following parameters are user-configurable strings. Refer to a full
ASCII chart for more information.

Grid
For Virtual Wedge Grid, the first part of the bar code would be the follow-
ing, which can include a string of up to 240 characters. Parameter informa-
tion starts on page 328.

*$+AF
*$+AF

Preamble
For Virtual Wedge Preamble, the first part of the bar code would be below,
followed by a string of up to 31 characters (no <NUL>) and an asterisk.
Default is no characters. Parameter information is on page 326.

*$+AD
*$+AD

Postamble
For Virtual Wedge Postamble, the first part of the bar code would be be-
low, followed by a string of up to 31 characters (no <NUL>) and an aster-
isk. Default is no characters. Parameter information is on page 327.

*$+AE
*$+AE
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IndexI

The Classes and Functions Index covers classes and functions for the 700 Series
Color Mobile Computer.

The General Index covers all topics. Those in italics are figures, those in bold are
tables.

The Files Index is to assist you in locating descriptions for device drivers, applica-
tions, utilities, batch files, or other files within this publication.
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Classes and Functions

A
add_registry_section, [AddReg]

flags, 244
registry_root_string, 244
value_name, 244

AddReg, [DefaultInstall], 240
[AddReg], add_registry_section

flags, 244
registry_root_string, 244
value_name, 244

AddWep(), 103
AppName, [CEStrings], 237

B
BuildMax, [CEDevice], 238
BuildMin, [CEDevice], 238

C
CancelReadImage, IImage, 226
CancelReadRequest

IADC, 152
IBarCodeReaderControl, 160

[CEDevice]
BuildMax, 238
BuildMin, 238
ProcessorType, 238
UnsupportedPlatforms, 238
VersionMax, 238
VersionMin, 238

CESelfRegister, [DefaultInstall], 240
CESetupDLL, [DefaultInstall], 240
CEShortcuts, [DefaultInstall], 240
[CEShortcuts], shortcut_list_section

shortcut_filename, 245
shortcut_type_flag, 245
target_file/path, 245
target_file_path, 245

CESignature
[SourceDiskNames], 240
[Version], 236

[CEStrings]
AppName, 237
InstallDir, 237

Close, IImage, 228
CloseHandle()

DTR printing, 134, 135
IrDA printing, 128
NPCP printing, 129, 130

ConfigureProfile(), 106
ControlLED, IBarCodeReaderControl, 161
Copyfiles, [DefaultInstall], 240
[CopyFiles], file_list_section

destination_filename, 243
flags, 243
source_filename, 243

create/delete ADC COM objects, 149
CreateEvent(), 283

CreateFile()
DTR printing, 134, 135
IrDA printing, 128
NPCP printing, 129, 130

D
[DefaultInstall]

AddReg, 240
CESelfRegister, 240
CESetupDLL, 240
CEShortcuts, 240
Copyfiles, 240

DeregisterDevice(), 129
DTR printing, 134

[DestinationDirs], file_list_section, 242
DeviceIOControl(), 98

DTR printing, 134
NPCP printing, 129

DeviceIoControl(), NPCP printing, 130, 131
disk_ordinal, [SourceDiskNames], 240
DllRegisterServer, 240
DllUnregisterServer, 240

E
EnableWep(), 105
EncryptWepKeyForRegistry(), 106

F
file_list_section

[CopyFiles]
destination_filename, 243
flags, 243
source_filename, 243

[DestinationDirs], 242
filename, [SourceDiskFiles], 241

G
GetAssociationStatus(), 104
GetAuthenticationMode(), 104
GetBSSID(), 101
GetCodabar, IS9CConfig, 173
GetCode11, IS9CConfig2, 205
GetCode128, IS9CConfig, 180
GetCode39, IS9CConfig, 176, 200
GetCode93, IS9CConfig, 179
GetConfig, ISCP, 217
GetCustomSymIds, IS9CConfig2, 207
GetGlobalAmble, IS9CConfig2, 211
GetI2of5, IS9CConfig, 183
GetLinkSpeed(), 102
GetMac(), 101
GetMatrix2of5, IS9CConfig, 185
GetMSI, IS9CConfig, 187
GetNetworkMode(), 103
GetNetworkType(), 102
GetPDF417, IS9CConfig, 188
GetPDF417Ext, IS9CConfig2, 213
GetPlessey, IS9CConfig, 192
GetPowerMode(), 105
GetRSSI(), 103
GetRTSThreshold(), 106
GetSSID(), 101
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GetStandard2of5, IS9CConfig, 194
GetSymIdXmit, IS9CConfig2, 214
GetTelepen, IS9CConfig, 197
GetTXPower(), 102
GetUpcEan, IS9CConfig, 198
GetWepStatus(), 104

I

IADC, 151
CancelReadRequest, 152
Initialize, 153
QueryAttribute, 154
QueryData, 155
Read, 156
SetAttribute, 157

IBARCODEREADER.H, IBarCodeReaderControl func-
tions, 159

IBarCodeReaderControl, 159
CancelReadRequest, 160
ControlLED, 161
Initialize, 162
IssueBeep, 163
QueryAttribute, 164
Read, 165
SetAttribute, 167
TriggerScanner, 171

IImage
CancelReadImage, 226
Close, 228
Open, 227
ReadImage, 225
ReadSigCapBuffer, 221
ReadSigCapFile, 224
Start, 226
Stop, 227

Imager, settings, IS9CConfig3, 216
Initialize

IADC, 153
IBarCodeReaderControl, 162

InstallDir, [CEStrings], 237
IS9CConfig, 172

GetCodabar, 173
GetCode128, 180
GetCode39, 176, 200
GetCode93, 179
GetI2of5, 183
GetMatrix2of5, 185
GetMSI, 187
GetPDF417, 188
GetPlessey, 192
GetStandard2of5, 194
GetTelepen, 197
GetUpcEan, 198
SetCodabar, 174
SetCode128, 181
SetCode39, 177
SetCode93, 179
SetI2of5, 184
SetMatrix2of5, 186

SetMSI, 187
SetPDF417, 189
SetPlessey, 192
SetStandard2of5, 195
SetTelepen, 197

IS9CConfig2, 204
GetCode11, 205
GetCustomSymIds, 207
GetGlobalAmble, 211
GetPDF417Ext, 213
GetSymIdXmit, 214
SetCode11, 205
SetCustomSymIds, 208
SetGlobalAmble, 212
SetPDF417Ext, 213
SetSymIdXmit, 214

IS9CConfig3, 216
ISCP

GetConfig, 217
SetConfig, 218

isOrinoco(), 106
IssueBeep, IBarCodeReaderControl, 163
ITCDeviceClose, 150
ITCDeviceOpen, 140, 149
ITCUUID.LIB, IBarCodeReaderControl functions, 159

K
KernelIoControl(), 264

O
Open, IImage, 227
OSVERSIONINFO.dwBuildNumber, 238
OSVERSIONINFO.dwVersionMajor, 238
OSVERSIONINFO.dwVersionMinor, 238

P
ProcessorType, [CEDevice], 238
Provider, [Version], 236

Q
QueryAttribute

IADC, 154
IBarCodeReaderControl, 164

QueryData, IADC, 155

R
RadioConnect(), 101
RadioDisconnect(), 101
Read, 140

IADC, 156
IBarCodeReaderControl, 165

ReadFile(), NPCP printing, 129
ReadImage, IImage, 225
ReadSigCapBuffer, IImage, 221
ReadSigCapFile, IImage, 224
RegFlushKey(), 81, 262, 270
RegisterDevice(), 129

DTR printing, 134
RegOpenKeyEx(), 282
RegQueryValueEx(), 282
RegSetValueEx(), 282
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S

SetAttribute
IADC, 157
IBarCodeReaderControl, 167

SetAuthenticationMode(), 104
SetChannel(), 105
SetCodabar, IS9CConfig, 174
SetCode11, IS9CConfig2, 205
SetCode128, IS9CConfig, 181
SetCode39, IS9CConfig, 177
SetCode93, IS9CConfig, 179
SetConfig, ISCP, 218
SetCustomSymIds, IS9CConfig2, 208
SetGlobalAmble, IS9CConfig2, 212
SetI2of5, IS9CConfig, 184
SetMatrix2of5, IS9CConfig, 186
SetMSI, IS9CConfig, 187
SetNetworkMode(), 103
SetPDF417, IS9CConfig, 189
SetPDF417Ext, IS9CConfig2, 213
SetPlessey, IS9CConfig, 192
SetRTSThreshold(), 106
SetSSID(), 105
SetStandard2of5, IS9CConfig, 195
SetSymIdXmit, IS9CConfig2, 214
SetTelepen, IS9CConfig, 197
SHFullScreen(), 262, 263
shortcut_list_section, [CEShortcuts]

shortcut_filename, 245
shortcut_type_flag, 245
target_file/path, 245
target_file_path, 245

Signature, [Version], 236
[SourceDiskFiles], filename, 241
[SourceDiskNames]

CESignature, 240
disk_ordinal, 240

SourceDisksNames.MIPS, 241
SourceDisksNames.SH3, 241
Start, IImage, 226
StartScanList(), 107
Stop, IImage, 227
string_key, [Strings], 237
[Strings], string_key, 237
SYSTEMINFO.dwProcessorType, 238

T
Trigger settings, IS9CConfig3, 216
TriggerScanner, IBarCodeReaderControl, 171

U
UnsupportedPlatforms, [CEDevice], 238

V
[Version]

CESignature, 236
Provider, 236
Signature, 236

VersionMax, [CEDevice], 238
VersionMin, [CEDevice], 238

W
WriteFile()

DTR printing, 134, 135
IrDA printing, 128
NPCP printing, 129, 130
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General Index

Numbers

1470 Imager. See Imager
1551/1553 Tethered Scanner. See Tethered scanner
1D laser scanner, about, 137
2D Imager

about, 137
data collection features, 146

aimer LED, 146
scaled illumination LED, 146
window size and position, 146

image acquisition features, 147
overview, 146

4820 printer, NPCP driver, 129
6804DM printer

DTR driver, 134
IrDA driver, 128

6804T printer
DTR driver, 134
IrDA driver, 128

6805A printer
DTR driver, 134
IrDA driver, 128

6806 printer
DTR driver, 134
IrDA driver, 128

6808 printer
DTR driver, 134
IrDA driver, 128
printer support, 127

681T printer, DTR driver, 134
6820 printer

IrDA driver, 128
NPCP driver, 129
printer support, 127

6920 Communications Server, ManifestName parameter,
254

700 Platform Build, version number, 342
740 Color Computer, 281
781 printers

DTR driver, 134
printer support, 127

782T printer, printer support, 127
802.11 CR radio CORE module, 107
802.11 WEP Encryption, profile security information, 91
802.11b

antenna color code, 85
API, 100
channel, 89
communications setup, 87
configuration profiles, 100
CORE module, 107
network type, 89
profiles, 87

basic information, 89
certificates, 95
exporting, 96

import/export, 96
importing, 97
read-only, 94
scan list, 97, 98
security information, 90
selected, 97

SSID (network name), 89
WEP encryption, 91

802.1x TLS, profile security information, 92
802.1x TTLS, profile security information, 93

A

Abstract Syntax Notation.1. See ASN.1
ActiveSync

ActiveSync Help, 30
adding programs, 26
adding programs to Start menu, 28
Folder behavior connected to e-mail server, 46
installing applications, 77
Microsoft Reader, 58
Pocket Internet Explorer

favorite links, 62
Mobile Favorites folder, 62

Pocket PC, 29
Pocket PC icon, 13
Pocket PC status icons, 12
URL, 29

ActiveX control tools, unit information control panel, CAB
files, 345

AD command, with/without data, 326
ADC COM interfaces, 138

functions
create/delete objects, 149
IADC, 151
IBarCodeReaderControl, 159
IS9CConfig, 172
IS9CConfig2, 204
IS9CConfig3, 216

Adding a profile, 88
Adding bookmarks, Microsoft Reader, 61
Adding drawings to text, Microsoft Reader, 61
Adding programs

ActiveSync, 26
Pocket Internet Explorer, 27
Pocket PC, 26
to the Start menu, 28

via ActiveSync, 28
via File Explorer, 28

Adjusting settings, Pocket PC, 26
Adobe Acrobat Reader, URL, 116
AE command, with/without data, 327
Aimer LED duration, configuration parameter, 323
Alpha plane on keypad, 281
Annotations index, Microsoft Reader, 61
Antenna, radio type, 85
APIs

802.11b, 100
AT command interface, 115
IrSock, 128

Appointments, via Calendar, 31
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APS linear imager, about, 137
ASCII

printing, 128
printing to a port, port print method, 128
raw text to printer, 128

ASN.1, 125
Asset management, DeviceURL parameter, 253
AT command interface, 115

terminal application, 114
testing, 117

Attaching notes to text, Microsoft Reader, 61
Audio files, Windows Media Player, 57
Audio system

external headset jack, 2
internal microphone, 2
speaker, 2

AutoCab, command line syntax, 82
AutoFTP, 260
AutoIP, 122
Automatic Data Collection. See ADC COM interfaces
Automatic Private IP. See AutoIP
Automatic shutoff

bar code configuration, 369
configuration parameter, 355

Autostart FTP, 260
AvantGo channels, Pocket Internet Explorer, 64
AXCommunication, 345
AXFileTransfer, 345
AXReaderCommand, 345
AXVWedge, 345

B
Backlight timeout

bar code configuration, 369
configuration parameter, 353

Bar Code
scanning labels, 368
supported symbologies, 147, 289
symbologies, 360

Codabar, 362
Code 11, 363
Code 128, 364
Code 39, 363
Code 39 concatenation, 363
Code 39 full ASCII, 363
Code 93, 364
data string formats, 360
EAN, 362
I 2 of 5, 366
MSI code, 367
Plessey, 367
S 2 of 5, 366
UPC, 362

Bar code configuration
audio volume, 368
automatic shutoff, 369

backlight timeout, 369
Code 39, 368
key clicks, 370

BARCODE_DATA_TYPE_ASCII, IBarCodeReaderCon-
trol::Read, 165

BARCODE_DATA_TYPE_UNICODE, IBarCodeReader-
Control::Read, 165

BARCODE_DATA_TYPE_UNKNOWN, IBarCodeRead-
erControl::Read, 165

Battery
low battery conditions, 3
Pocket PC status icons, 12
status, 2

Battery status, unit information control panel applet, 343
Beeper

configuration parameter
frequency, 320
volume, 318

silencing the volume, 319
supported functions, 317
Unit Manager, 349
when not available

beeper frequency, 320
good read beep duration, 322
good read beeps, 321

biActualImageSize, pImgBuffer, IImage::ReadSigCapBuffer,
222

biBitCount, pImgBuffer, IImage::ReadSigCapBuffer, 222
biHeight, pImgBuffer, IImage::ReadSigCapBuffer, 222
biMaxImageBytes, pImgBuffer, IImage::ReadSigCapBuffer,

222
biWidth, pImgBuffer, IImage::ReadSigCapBuffer, 222
Block recognizer, Pocket PC input panel, 17
BlockSize, FTP Server, 252
Bluealps CORE module, 120
Bluetooth

CORE module, 120
unit information control panel, main stack CAB file,

344
Bluetooth compatibility, network support, 120
Bluetooth Device Manager, documentation, 120
Books, Microsoft Reader

adding bookmarks, 61
adding drawings, 61
annotations index, 61
attaching notes, 61
copying, 61
downloading, 58
highlighting, 61
reading, 60
removing, 61
searching, 61

Browing the Internet, Pocket Internet Explorer, 66
BTctrl program, documentation, 120
Build information, 5
byFNC1, IS9CConfig::SetCode128, 181
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C
CAB files

after the extraction, 248
creating, 236

INF files, 236
with CAB Wizard, 249

information regarding, 4
installation functions, SETUP.DLL, 248
placing files onto storage card, 80
unit information control panel applet, 344

Cabinet Wizard
creating CAB files, 249
troubleshooting, 250
using the application, 236

Cabling, scanner, 232
Calendar

creating
an appointment, 32
meeting requests, 33

Pocket Outlook, 31
Pocket PC icon, 13
scheduling a meeting, 33
using the summary screen, 33

Capacitor, internal super, 3
Capturing thoughts and ideas, via Notes, 40
Card support

CompactFlash cards, 5
modems, 4
MultiMediaCards, 5
radios, 4
SecureDigital cards, 5

CDMA/1xRTT, 110
antenna color code, 85
AT command set, 116
CORE module, 111

CEImager
location of the executable file, 80
migrating AUTORUN.DAT files, 80

Channel, 802.11 radio module, 89
ClassID field values

VN_CLASS_ASIC, 266
VN_CLASS_BOOTSTRAP, 266
VN_CLASS_KBD, 266

Clock
Pocket PC settings, 26
setting date and time, 358

Closing drivers, NPCP, 130
CMIP, 123
Codabar, 362

configuration parameter, 292
user ID, 310

default S9C settings, 175
enumerations, 175
IS9CConfig::GetCodabar, 173
IS9CConfig::SetCodabar, 174
modifier characters, 219

Code 11, 363
configuration parameter, 306

user ID, 314

default S9C settings, 206
enumerations, 206
IS9CConfig2::GetCode11, 205
IS9CConfig2::SetCode11, 205
modifier characters, 219

Code 128, 364
configuration parameter, 295

FNC1 character, 297
user ID, 310

default S9C settings, 181
enumerations, 182
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224
IS9CConfig::GetCode128, 180
IS9CConfig::SetCode128, 181
modifier characters, 219

Code 39, 363
configuration parameter, 290

user ID, 310
default S9C settings, 177
enumerations, 178
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224
IS9CConfig::GetCode39, 176
IS9CConfig::SetCode39, 177
modifier characters, 219

Code 93, 364
configuration parameter, 294

length, 294
user ID, 311

default S9C settings, 179
enumerations, 180
IS9CConfig::GetCode93, 179
IS9CConfig::SetCode93, 179
modifier characters, 219

Code Division Multiple Access. See CDMA/1xRTT
Codes

11, 363
128, 364
39, 363
39 concatenation, 363
39 full ASCII, 363
93, 364

Cold boot, IOCTL_HAL_COLDBOOT, 275
COM port

configuration, 231
wedge settings, 231

COM1, NPCP parameter, 129
COM1 port, 128
Comm port wedge

disabling, 231
enabling, 230
error messages, 232
limitations, 233
settings, 231
unit information control panel, 344

Command line syntax, AutoCab, 82
Common Object Resource Environment. See CORE
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Communications
DTR, 135
NPCP, 132

Communications options, 83
CompactFlash cards

card support, 5
installing applications, 78

Composing Messages, via Inbox, 45
Computer shutdown, 3
Concatenation, 363
Configuration Management. See Unit Manager
Configuration parameters

aimer LED duration, 323
automatic shutoff, 355
backlight timeout, 353
beeper

frequency, 320
volume, 318

codabar, 292
user ID, 310

code 11, 306
user ID, 314

code 128, 295
FNC1 character, 297
user ID, 310

code 39, 290
user ID, 310

code 93, 294
length, 294
user ID, 311

data matrix, 308
date/time, 352
EAN

13 user ID, 313
8 user ID, 313

good read
beep duration, 322
beeps, 321

identification
contact, 338
location, 340
name, 339

image dimension, 324
interleaved 2 of 5, 303

user ID, 311
key clicks, 354
macro PDF, 300
matrix 2 of 5, 304

user ID, 313
micro PDF 417, 302
MSI, 299

user ID, 311
PDF 417, 300

user ID, 311
plessey, 298

user ID, 312
prefix, 315
QR code, 307

security
encryption key, 335
read encryption, 333
read-only community string, 331
read/write community string, 332
write encryption, 334

SNMP, security subnet mask, 309
standard 2 of 5, 291

user ID, 312
suffix, 316
telepen, 305

user ID, 313
trap

authentication, 336
threshold, 337

UPC
A user ID, 312
E user ID, 312

UPC/EAN, 293
virtual wedge, 325

code page, 329
grid, 328
postamble, 327
preamble, 326

volume, 356
Connecting directly to e-mail server, via Inbox, 42
Connecting to

an ISP, 68
e-mail server, 72
work, 70

Connections
See also Getting connected
directly to e-mail server, 72
ending, 72
setting up an e-mail service, 73
status icon, 12
to an ISP, 68

via Ethernet, 69
via modem, 68

to work, 70
via Ethernet, 71
via modem, 70

via Ethernet
to an ISP, 69
to work, 71

via modem
to an ISP, 68
to work, 70

Contacts
creating a contact, 34
finding a contact, 35
MSN Messenger

chatting with, 55
working with, 54

Pocket Outlook, 34
Pocket PC icon, 13
using the summary screen, 36
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Control panel applets
clock, 358
data collection, 288

beeper/LED, 317
imager, 323
symbologies, 289
symbology options, 309
virtual wedge, 325

power, battery status, 2
SNMP, 330

identification, 338
security, 331
traps, 336

system, wireless network, 87
unit information, 341

battery status, 3, 343
CAB files, 344
versions, 6, 342

utilities, 81
Converting writing to text, 20
Copying text, Microsoft Reader, 61
CORE, 84

802.11b radio module, 107
details, 109
general, 107

accessing from
Programs panel, 84
Today screen, 84

Bluealps module, 120
Bluetooth, 120
module for 802.11b NIC, 100
WAN radio module, 111

details, 113
general, 111

Creating
a modem connection

to an ISP, 68
to work, 70

an Ethernet connection
to an ISP, 69
to work, 71

appointment via Calendar, 32
CAB files, 236

with CAB Wizard, 249
contact via Contacts, 34
document via Pocket Word, 47
drawing via Notes, 22
INF files, 236
meeting requests, 33
note via Notes, 41
recording via Notes, 23
task via Tasks, 38
workbook via Pocket Excel, 52

Customer Support, xviii
D
Data collection

2D imager features, 146
ADC COM interfaces, 138
build version number, 342

configuration parameters
aimer LED duration, 323
beeper frequency, 320
beeper volume, 318
codabar, 292
codabar user ID, 310
code 11, 306
code 11 user ID, 314
code 128, 295
code 128 FNC1 character, 297
code 128 user ID, 310
code 39, 290
code 39 user ID, 310
code 93, 294
code 93 length, 294
code 93 user ID, 311
data matrix, 308
EAN-13 user ID, 313
EAN-8 user ID, 313
good read beep duration, 322
good read beeps, 321
image dimension, 324
interleaved 2 of 5, 303
interleaved 2 of 5 user ID, 311
macro PDF, 300
matrix 2 of 5, 304
matrix 2 of 5 user ID, 313
micro PDF 417, 302
MSI, 299
MSI user ID, 311
PDF 417, 300
PDF 417 user ID, 311
plessey, 298
plessey user ID, 312
prefix, 315
QR code, 307
standard 2 of 5, 291
standard 2 of 5 user ID, 312
suffix, 316
telepen, 305
telepen user ID, 313
UPC-E user ID, 312
UPC-A user ID, 312
UPC/EAN, 293
virtual wedge, 325
virtual wedge code page, 329
virtual wedge grid, 328
virtual wedge postamble, 327
virtual wedge preamble, 326

functions
create/delete ADC COM objects, 149
IADC, 151
IBarCodeReaderControl, 159
IS9CConfig, 172
IS9CConfig2, 204
IS9CConfig3, 216

initialization, 138
Unit Manager, 348

Data filtering, virtual wedge grid, 141
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Data Matrix
configuration parameter, 308
IS9CConfig3 function, 216

Date, setting, 358
Date/Time, configuration parameter, 352
Deleting a profile, 88
DeviceName, FTP Server, 253
DeviceURL, FTP Server, 253
DHCP, 122
Display full screen, 263
Docks, modem support, 4
DRAM, low battery shutdown, 3
Drawing mode, Pocket Word, 51
Drawing on the screen

See also Notes
Pocket Word, 51

Drivers
DTR

communications, 135
installing, 134
opening, 135
removing, 134
writing to, 135

NPCP
closing, 130
communications, 132
I/O controls, 131
installing, 129
opening, 130
reading from, 130
removing, 129
writing to, 130

O’ Neil. See DTR printing
DTR printing, 134

closing driver, 135
communications, 135
opening driver, 135
removing driver, 134
writing to driver, 135

dwAttrBufferSize
IBarCodeReaderControl::QueryAttribute, 164
IBarCodeReaderControl::SetAttribute, 169

dwBufferSize
IADC::QueryAttribute, 154
IS9CConfig2::GetGlobalAmble, 211
IS9CConfig2::SetGlobalAmble, 212

dwCommandBuffSize
ISCP::GetConfig, 217
ISCP::SetConfig, 218

dwDataBufferSize
IADC::Read, 156
IBarCodeReaderControl::Read, 165

dwLength
IS9CConfig::SetCode128, 181
IS9CConfig::SetCode39, 177
IS9CConfig::SetCode93, 179
IS9CConfig::SetMatrix2of5, 186
IS9CConfig::SetMSI, 187
IS9CConfig::SetPlessey, 192

dwMaxNumElement, IS9CConfig2::GetCustomSymIds,
207

dwNextMessageSize, IADC::QueryData, 155
dwNumberOfBeeps, IBarCodeReaderControl::IssueBeep,

163
dwNumBytes

IS9CConfig::SetCodabar, 174
IS9CConfig::SetI2of5, 184
IS9CConfig::SetStandard2of5, 195

dwNumElement, IS9CConfig2::SetCustomSymIds, 208
dwReplyBuffMaxSize

ISCP::GetConfig, 217
ISCP::SetConfig, 218

dwStructSize
pImgBuffer, IImage::ReadSigCapBuffer, 222
pSigCapSpec, IImage::ReadSigCapBuffer, 221

dwTimeout
IADC::Read, 156
IBarCodeReaderControl::Read, 166
IImage::ReadImage, 225

dwTotalBufferedBytes, IADC::QueryData, 155

E
E-mail server

getting connected, 72
setting up a service, 73

eAmbleId
IS9CConfig2::GetGlobalAmble, 211
IS9CConfig2::SetGlobalAmble, 212

EAN, 362
configuration parameter, 293

13 user ID, 313
8 user ID, 313

default S9C settings, 181, 201
enumerations, 201
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200
modifier characters, 220

ean13Check
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

ean13Select
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

ean8Check
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

ean8Reencode
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

ean8Select
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

eAttr
IBarCodeReaderControl::QueryAttribute, 164
IBarCodeReaderControl::SetAttribute, 167

eAttribID
IADC::QueryAttribute, 154
IADC::SetAttribute, 157
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eCheck
IS9CConfig::SetCodabar, 174
IS9CConfig::SetI2of5, 184
IS9CConfig::SetMSI, 187
IS9CConfig::SetPlessey, 192
IS9CConfig::SetStandard2of5, 195
IS9CConfig2::SetCode11, 205

eCip128State, IS9CConfig::SetCode128, 181
eCLSI, IS9CConfig::SetCodabar, 174
eCode128, IS9CConfig2::SetPDF417Ext, 213
eDataType, IBarCodeReaderControl::Read, 165
eDecode

IS9CConfig::SetCodabar, 174
IS9CConfig::SetCode128, 181
IS9CConfig::SetCode39, 177
IS9CConfig::SetCode93, 179
IS9CConfig::SetI2of5, 184
IS9CConfig::SetMatrix2of5, 186
IS9CConfig::SetMSI, 187
IS9CConfig::SetPlessey, 192
IS9CConfig::SetStandard2of5, 195
IS9CConfig::SetTelepen, 197
IS9CConfig2::SetCode11, 205
IS9CConfig2::SetPDF417Ext, 213

eDepth, pSigCapSpec, IImage::ReadSigCapBuffer, 222
eDeviceFlags

IADC::Initialize, 153
IBarCodeReaderControl::Initialize, 162
ITCDeviceOpen, 149

Editing a profile, 88
Edition information, 8
eEan128Ident, IS9CConfig::SetCode128, 181
eFormat

IImage::ReadImage, 225
IS9CConfig::SetCode39, 177
IS9CConfig::SetStandard2of5, 195
IS9CConfig::SetTelepen, 197
pImgBuffer, IImage::ReadSigCapBuffer, 222
pSigCapSpec, IImage::ReadSigCapBuffer, 222

eLED, IBarCodeReaderControl::ControlLED, 161
eLengthId

IS9CConfig::SetCodabar, 174
IS9CConfig::SetI2of5, 184
IS9CConfig::SetStandard2of5, 195

eMacroPdf, IS9CConfig::SetPDF417, 189
Embedded modules, SB555, 110
Encoded Code 39

concatenation, 363
full ASCII, 363

Ending a connection, 72
Enumerations

Codabar, 175
Code 11, 206
Code 128, 182
Code 39, 178
Code 93, 180
Interleaved 2 of 5, 185
Matrix 2 of 5, 186
MSI, 188
PDF 417, 190

Plessey, 193
Standard 2 of 5, 196
Telepen, 198
UPC/EAN, 201

ePdf417Decode, IS9CConfig::SetPDF417, 189
ePdfAddressee, IS9CConfig::SetPDF417, 189
ePdfChecksum, IS9CConfig::SetPDF417, 189
ePdfControlHeader, IS9CConfig::SetPDF417, 189
ePdfFileName, IS9CConfig::SetPDF417, 189
ePdfFileSize, IS9CConfig::SetPDF417, 189
ePdfSegmentCount, IS9CConfig::SetPDF417, 189
ePdfSender, IS9CConfig::SetPDF417, 189
ePdfTimeStamp, IS9CConfig::SetPDF417, 189
Epson Escape Sequences, 128
Error messages

comm port wedge, 232
tethered scanner, 232

ERROR_INSUFFICIENT_BUFFER
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270

ERROR_INVALID_PARAMETER
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270

eSS
IS9CConfig::SetCodabar, 174
IS9CConfig::SetCode39, 177

eSSChars, IS9CConfig::SetCode39, 177
eSymbology, IBarCodeReaderControl::Read, 165
eSymIdXmit, IS9CConfig2::SetSymIdXmit, 214
Ethernet

communications setup, 86
creating a connection

to an ISP, 69
to work, 71

ETSI GSM 07.05 interface specifications, 115
ETSI GSM 07.07 interface specifications, 115
European Article Numbering code. See EAN
eVer, IS9CConfig2::SetCode11, 205
Excel. See Pocket Excel
Exporting a profile, 802.11 radio module, 96

F
Factory repair, xviii
Favorite links, Pocket Internet Explorer, 62
File Explorer

adding programs to Start menu, 28
Pocket PC, 25
removing programs, 28

File Transfer Protocol. See FTP
Filter expression values, virtual wedge grid, 142
Find feature, Pocket PC, 25
fLedOn, IBarCodeReaderControl::ControlLED, 161
FlushBufferedData

IADC::CancelReadRequest, 152
IBarCodeReaderControl::CancelReadRequest, 160

Folder behavior connected to e-mail server
ActiveSync, 46
IMAP4, 46
POP3, 46
SMS, 46
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FRAME_NOT_ACKED, 131
fScannerOn, IBarCodeReaderControl::TriggerScanner, 171
fSigCapEnable, IImage::Open, 227
FTP

client, 256
configurable parameters, 252

BlockSize, 252
DeviceName, 253
DeviceURL, 253
IDNATarget, 254
ManifestName, 254
PauseAtStartup, 255
Root, 255

FTPDCMDS subdirectory, 259
heartbeat, 256
RTC 959, 259
server, 256

installing applications, 78
server requests

CDUP, 256
CWD, 256
DELE, 256
HELP, 256
LIST, 256
MKD, 256
MODE, 256
NLST, 256
NOOP, 256
PASS, 256
PWD, 256
QUIT, 256
RETR, 256
RMD, 256
RNFR, 256
RNTO, 257
SITE, 257
SITE ATTRIB, 257
SITE BOOT, 258
SITE COPY, 258
SITE EXIT, 258
SITE HELP, 258
SITE KILL, 258
SITE LOG, 258
SITE PLIST, 258
SITE RUN, 258
SITE STATUS, 259
SITE TIMEOUT, 259
STOR, 257
SYST, 257
TYPE, 257
USER, 257
XCUP, 257
XCWD, 257
XMKD, 257
XPWD, 257
XRMD, 257

stopping server from application, 260

support, 256
web browsers, 259

FTPDCMDS subdirectory, FTP support, 259
Full screen display, 263

G
GDI approach, 128
General Packet Radio Service. See GSM/GPRS
Getting connected

directly to an e-mail server, 72
infrared (IR) port, 67
ISP, 67
Pocket PC, 67
setting up an e-mail service, 73
to an ISP, 68

creating a modem connection, 68
creating an Ethernet connection, 69

to work, 70
creating a modem connection, 70
creating an Ethernet connection, 71

transfer items using infrared, 67
Global services and support center, xviii
Gold plane on keypad, 281
Good read, configuration parameter

beep duration, 322
beeps, 321

Grid data
configuration parameter, 328
filtering, 141

GSM/GPRS, 110
antenna color code, 85
AT command set

GEM350X, 116
MC45, 116

CORE module, 111

H
HAL, verion of Pocket PC

IOCTL_HAL_GET_BOOTLOADER_VERINFO,
274

IOCTL_HAL_GET_OAL_VERINFO, 273
Header files

IADC.H, IADC functions, 151
IBARCODEREADER.H, IBarCodeReaderControl

functions, 159
IS9CCONFIG.H

IS9CConfig functions, 172
IS9CConfig2 functions, 204

ITCDEVMGMT.H, 149
Headset jack, external, 2
Highlighting text, Microsoft Reader, 61
Hotmail account, 53

I
I 2 of 5. See Interleaved 2 of 5
I/O controls, NPCP driver, 131
iAspectRatio, pSigCapSpec, IImage::ReadSigCapBuffer,

221
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ID field values
IOCTL_HAL_ITC_READ_PARM

ITC_NVPARM_80211_INSTALLED, 268
ITC_NVPARM_80211_RADIOTYPE, 268
ITC_NVPARM_ANTENNA_DIVERSITY, 267
ITC_NVPARM_BLUETOOTH_INSTALLED, 268
ITC_NVPARM_CONTRAST, 266
ITC_NVPARM_DISPLAY_TYPE, 266
ITC_NVPARM_ECN, 266
ITC_NVPARM_EDBG_SUBNET, 266
ITC_NVPARM_EDG_IP, 266
ITC_NVPARM_ETHERNET_ID, 265
ITC_NVPARM_INTERMEC_DATACOLLEC-

TION_HW, 267
ITC_NVPARM_INTERMEC_DATACOLLEC-

TION_SW, 267
ITC_NVPARM_INTERMEC_SOFTWARE_CON-

TENT, 267
ITC_NVPARM_LAN9000_INSTALLED, 269
ITC_NVPARM_MANF_DATE, 265
ITC_NVPARM_MCODE, 266
ITC_NVPARM_RTC_RESTORE, 267
ITC_NVPARM_SERIAL_NUM, 265
ITC_NVPARM_SERIAL2_INSTALLED, 269
ITC_NVPARM_SERVICE_DATE, 266
ITC_NVPARM_SIM_PRO-

TECT_HW_INSTALLED, 269
ITC_NVPARM_SIM_PRO-

TECT_SW_INSTALLED, 269
ITC_NVPARM_VERSION_NUMBER, 266
ITC_NVPARM_VIBRATE_INSTALLED, 269
ITC_NVPARM_WAN_FREQUENCY, 268
ITC_NVPARM_WAN_INSTALLED, 268
ITC_NVPARM_WAN_RADIOTYPE, 268
ITC_NVPARM_WAN_RI, 267

IOCTL_HAL_ITC_WRITE_SYSPARM
ITC_ DOCK_SWITCH, 270
ITC_ WAKEUP_MASK, 271
ITC_AMBIENT_FRONTLIGHT, 271
ITC_AMBIENT_KEYBOARD, 271
ITC_REGISTRY_LOCATION, 270
ITC_REGISTRY_SAVE_ENABLE, 270

Identification
configuration parameter

contact, 338
location, 340
name, 339

Unit Manager, 351
IDNA

DeviceName, 253
DeviceURL, 253
IDNATarget, 254
ManifestName, 254

IDNATarget, FTP Server, 254
iid, ITCDeviceOpen, 149
IImage interface, 221

Image, acquisition features, 147
Image dimension, configuration parameter, 324
Imager

beeper functions not available
beeper frequency, 320
good read beep duration, 322
good read beeps, 321

control panel appet, data collection, 323
data collection parameters

aimer LED duration, 323
data matrix, 308
image dimension, 324
QR code, 307

settings, 232
supported

beeper functions, 317
functions, 323
symbologies, 289

supported symbologies, 147
symbologies not available

CIP 128 French Pharmaceutical, 296
Code 11, 306
Code 128 FNC1 character, 297
EAN 128 ]C1, 296
Macro PDF, 300
Matrix 2 of 5, 304
Micro PDF 417, 302
Telepen, 305

symbology user IDs not available
Codabar, 310
Code 11, 314
Code 128, 310
Code 39, 310
Code 93, 311
EAN 13, 313
EAN 8, 313
Interleaved 2 of 5, 311
Matrix 2 of 5, 313
MSI, 311
PDF 417, 311
Plessey, 312
Standard 2 of 5, 312
Telepen, 313
UPC A, 312
UPC E, 312

Unit Manager, 350
IMAP4, Folder behavior connected to e-mail server, 46
Import libraries

ITCDEVMGMT.LIB, 149
ITCUUID.LIB

IADC functions, 151
IBarCodeReaderControl functions, 159
IS9CConfig functions, 172
IS9CConfig2 functions, 204

Importing a profile, 802.11 radio module, 97
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Inbox
composing messages, 45
connecting directly to e-mail server, 42
Folder behavior connected to e-mail server, 46
getting connected, 67
managing e-mail messages and folders, 46
Pocket Outlook, 42
Pocket PC icon, 13
synchronizing e-mail messages, 42
using a message list, 43
using My Text, 24

INF files, creating, 236
Infrared (IR) port

Pocket PC, 67
transfer items using, 67

receiving information, 67
sending information, 67

Input panel
block recognizer, 17
keyboard, 17
letter recognizer, 18
methods available, 16
Pocket PC, 14
Pocket Word, 49
selecting typed text, 18
transcriber, 18
word suggestions, 17

Installation, site, xviii
Installation functions, SETUP.DLL, 248
Installing applications

using a storage card, 78
using CompactFlash cards, 78
using SecureDigital cards, 79
with ActiveSync, 77
with Application Manager, 78
with FTP Server, 78

Installing drivers
DTR, 134
NPCP, 129

Instant messaging, 53
Pocket PC icon, 12

Intelliget Bar Code Unit
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224

Interface specifications, ETSI GSM 07.0x, 115
Interleaved 2 of 5, 366

configuration parameter, 303
user ID, 311

default S9C settings, 184
enumerations, 185
IS9CConfig::GetI2of5, 183
IS9CConfig::SetI2of5, 184
modifier characters, 219

Intermec Device Network Announcement. See IDNA
Internet Explorer. See Pocket Internet Explorer
Internet explorer

Pocket PC 2002 edition, 8
software build version, 5

Internet Service Provider. See ISP
IOCTL_GET_CPU_ID, 280

IOCTL_HAL_COLDBOOT, 275, 280
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO, 274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278, 280
IOCTL_HAL_WARMBOOT, 275, 280
IOCTL_LOAD_NDIS_MINIPORT, 98
IOCTL_NPCP_BIND, 131
IOCTL_NPCP_CANCEL, 131
IOCTL_NPCP_CLOSE, 131
IOCTL_NPCP_ERROR, 131
IOCTL_NPCP_FLUSH, 131
IOCTL_PROCESSOR_INFORMATION, 279
IOCTL_UNLOAD_NDIS_MINIPORT, 98
iOffsetX, pSigCapSpec, IImage::ReadSigCapBuffer, 221
iOffsetY, pSigCapSpec, IImage::ReadSigCapBuffer, 222
IrDA printing, 128
iResolution, pSigCapSpec, IImage::ReadSigCapBuffer, 222
IS9CConfig3

Data Matrix symbology, 216
imager settings, 216
QRCode symbology, 216
trigger settings, 216

ISP
connecting to via Pocket PC, 68
creating

a modem connection, 68
an Ethernet connection, 69

Pocket Internet Explorer, 62
Pocket PC, 67

ITC_ DOCK_SWITCH, 270
ITC_ WAKEUP_MASK, 271
ITC_AMBIENT_FRONTLIGHT, 271
ITC_AMBIENT_KEYBOARD, 271
ITC_BARCODE_LASER_GOOD_READ_LED, IBar-

CodeReaderControl::ControlLED, 161
ITC_DEVID_80211RADIO_INTEL_2011B, 268
ITC_DEVID_80211RADIO_MAX values

ITC_DEVID_80211RADIO_INTEL_2011B, 268
ITC_DEVID_80211RADIO_NONE, 268

ITC_DEVID_80211RADIO_NONE, 268
ITC_DEVID_INTERMEC2D_IMAGER, 267
ITC_DEVID_OEM2D_IMAGER, 267
ITC_DEVID_SCANHW_MAX values

ITC_DEVID_INTERMEC2D_IMAGER, 267
ITC_DEVID_OEM2D_IMAGER, 267
ITC_DEVID_SCANHW_NONE, 267
ITC_DEVID_SE900_LASER, 267
ITC_DEVID_SE900HS_LASER, 267

ITC_DEVID_SCANHW_NONE, 267
ITC_DEVID_SE900_LASER, 267
ITC_DEVID_SE900HS_LASER, 267
ITC_DEVID_WANRADIO_NONE, 268
ITC_DEVID_WANRADIO_SIEMENS_MC45, 268
ITC_DEVID_WANRADIO_SIERRA_SB555, 268
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ITC_DEVID_WANRADIO_XIRCOM_GEM3503, 268
ITC_DHATTR_READFILTER

IADC::SetAttribute, rgbData, 157
IBarCodeReaderControl::SetAttribute, 167

ITC_DHDEVFLAG_NODATA, ITCDeviceOpen, 149
ITC_DHDEVFLAG_READAHEAD

IADC::Initialize, 153
IBarCodeReaderControl::Initialize, 162
ITCDeviceOpen, 149

ITC_FILE_OPEN_E, IImage::ReadSigCapFile, 224
ITC_IFTP_STOP, 260
ITC_IMGBUFF_TOO_SMALL_E

IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 223

ITC_INV_PARAMETER_E
IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224

ITC_KEYBOARD_CHANGE, CreateEvent(), 283
ITC_MAXFILTER_CHARS, IBarCodeReaderControl::Se-

tAttribute, 167
ITC_MULTICLIENT_ENABLE, IADC::SetAttribute

eAttribID, 157
rgbData, 157

ITC_NVPARM_80211_INSTALLED, 268
ITC_NVPARM_80211_RADIOTYPE, 268
ITC_NVPARM_ANTENNA_DIVERSITY, 267
ITC_NVPARM_BLUETOOTH_INSTALLED, 268
ITC_NVPARM_CONTRAST, 266
ITC_NVPARM_DISPLAY_TYPE, 266
ITC_NVPARM_ECN, 266
ITC_NVPARM_EDBG_SUBNET, 266
ITC_NVPARM_EDG_IP, 266
ITC_NVPARM_ETHERNET_ID, 265
ITC_NVPARM_INTERMEC_DATACOLLEC-

TION_HW, 267
ITC_NVPARM_INTERMEC_DATACOLLEC-

TION_SW, 267
ITC_NVPARM_INTERMEC_SOFTWARE_CON-

TENT, 267
ITC_NVPARM_LAN9000_INSTALLED, 269
ITC_NVPARM_MANF_DATE, 265
ITC_NVPARM_MCODE, 266
ITC_NVPARM_RTC_RESTORE, 267
ITC_NVPARM_SERIAL_NUM, 265
ITC_NVPARM_SERIAL2_INSTALLED, 269
ITC_NVPARM_SERVICE_DATE, 266
ITC_NVPARM_SIM_PROTECT_HW_INSTALLED,

269
ITC_NVPARM_SIM_PROTECT_SW_INSTALLED,

269
ITC_NVPARM_VERSION_NUMBER, 266
ITC_NVPARM_VIBRATE_INSTALLED, 269
ITC_NVPARM_WAN_FREQUENCY, 268
ITC_NVPARM_WAN_INSTALLED, 268
ITC_NVPARM_WAN_RADIOTYPE, 268

ITC_NVPARM_WAN_RI, 267
ITC_RDRATTR_GOOD_READ_BEEP_DURATION,

IBarCodeReaderControl::SetAttribute, 167
ITC_RDRATTR_GOOD_READ_BEEPS_NUMBER,

IBarCodeReaderControl::SetAttribute, 167
ITC_RDRATTR_GOOD_READ_LED_ENABLE, IBar-

CodeReaderControl::SetAttribute, 167
ITC_RDRATTR_SCANNER_ENABLE, IBarCodeRead-

erControl::SetAttribute, 167
ITC_RDRATTR_TONE_ENABLE, IBarCodeReader-

Control::SetAttribute, 167
ITC_RDRATTR_TONE_FREQUENCY, IBarCodeRead-

erControl::SetAttribute, 167
ITC_RDRATTR_VOLUME_LEVEL, IBarCodeReader-

Control::SetAttribute, 167
ITC_REGISTRY_LOCATION, 270
ITC_REGISTRY_SAVE_ENABLE, 270
ITC_RESULT_ERR_BADREGION_E

IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224

ITC_RESULT_NO_BC_DECODED_E
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224

ITC_TIMEOUT_E, IImage::ReadImage, 225
ITU-T interface specifications, 115

K
Keeping a to-do list, via Tasks, 37
KernelIoControl

IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275, 280
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278, 280
IOCTL_HAL_WARMBOOT, 275, 280
IOCTL_PROCESSOR_INFORMATION, 279

Key clicks
bar code configuration, 370
configuration parameter, 354

Keyboard, Pocket PC input panel, 17
Keypad

advanced remapping, 283
change notification, 283
driver registry settings, 282
planes, 281
remapping, 281
sample registry keys, 284

Knowledge Central, xviii
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L
Laser scanner

configuration parameters, 286
data collection parameters

beeper frequency, 320
beeper volume, 318
codabar, 292
codabar user ID, 310
code 11, 306
code 11 user ID, 314
code 128, 295
code 128 FNC1 character, 297
code 128 user ID, 310
code 39, 290
code 39 user ID, 310
code 93, 294
code 93 length, 294
code 93 user ID, 311
EAN-13 user ID, 313
EAN-8 user ID, 313
good read beep duration, 322
good read beeps, 321
interleaved 2 of 5, 303
interleaved 2 of 5 user ID, 311
macro PDF, 300
matrix 2 of 5, 304
matrix 2 of 5 user ID, 313
micro PDF 417, 302
MSI, 299
MSI user ID, 311
PDF 417, 300
PDF 417 user ID, 311
plessey, 298
plessey user ID, 312
prefix, 315
standard 2 of 5, 291
standard 2 of 5 user ID, 312
suffix, 316
telepen, 305
telepen user ID, 313
UPC-E user ID, 312
UPC-A user ID, 312
UPC/EAN, 293
virtual wedge, 325
virtual wedge code page, 329
virtual wedge grid, 328
virtual wedge postamble, 327
virtual wedge preamble, 326

SNMP configuration parameters
identification contact, 338
identification location, 340
identification name, 339
security encryption key, 335
security read encryption, 333
security read-only community string, 331
security read/write community string, 332

security subnet mask, 309
security write encryption, 334
trap authentication, 336
trap threshold, 337

supported
beeper functions, 317
symbologies, 289

supported symbologies, 147
symbologies not available

data matrix, 308
Datamatrix, 307

LEAP, 802.1x profile, security information, 93
Letter recognizer, Pocket PC input panel, 18
Library, Microsoft Reader, 59
Line printing, 128
lpBytesReturned

IOCTL_GET_CPU_ID, 280
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_PROCESSOR_INFORMATION, 279

lpInBuf
IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275
IOCTL_PROCESSOR_INFORMATION, 279

lpInBufSize
IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275
IOCTL_PROCESSOR_INFORMATION, 279
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lpOutBuf
IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275
IOCTL_PROCESSOR_INFORMATION, 279

LPT9 printer device, 129

M
Macro PDF, configuration parameter, 300
Managing e-mail messages and folders, via Inbox, 46
ManifestName, FTP Server, 254
Matrix 2 of 5

configuration parameter, 304
user ID, 313

default S9C settings, 186
enumerations, 186
IS9CConfig::GetMatrix2of5, 185
IS9CConfig::SetMatrix2of5, 186
modifier characters, 219

Meetings, via Calendar, 31
Menus, Pocket PC settings, 26
MIBs

ASN.1, 125
files, 125
object identifier, 126
OIDs, 126

Micro PDF 417, configuration parameter, 302
Microphone, internal, 2
Microsoft Developer Network Library. See MSDN library
Microsoft Exchange e-mail account, 53
Microsoft Passport account, 53
Microsoft Reader

books
downloading, 58
reading, 60
removing, 61

features, 61
adding bookmarks, 61
adding drawings, 61
annotations index, 61
attaching notes, 61
copying text, 61
highlighting text, 61
searching for text, 61

Pocket PC, 58
using the library, 59

Microsoft Word. See Pocket Word
Migrating applications, 80
Mini-Landline modems, 4
Mobile Favorites folder, Pocket Internet Explorer, 62

Modems
card support, 4
creating a connection

to an ISP, 68
to work, 70

MP3 files, Windows Media Player, 57
MSDN library, 260
MSI, 367

configuration parameter, 299
user ID, 311

default S9C settings, 187
enumerations, 188
IS9CConfig::GetMSI, 187
IS9CConfig::SetMSI, 187
modifier characters, 219

MSN account, 53
MSN Messenger

about, 53
accounts

Hotmail, 53
Microsoft Exchange e-mail, 53
Microsoft Passport, 53
MSN, 53

contacts
chatting with, 55
working with, 54

Pocket PC icon, 13
setting up, 54
using My Text, 24

MultiMediaCards, card support, 5

N

nBufferSize, IADC::SetAttribute, 157
nDepth, IImage::ReadImage, 225
NDIS_NET_AUTO_UNKNOWN, GetNetworkMode(),

103
NDIS_NET_MODE_ESS, GetNetworkMode(), 103
NDIS_NET_MODE_IBSS, GetNetworkMode(), 103
NDIS_NET_MODE_UNKNOWN, GetNetworkMode(),

103
NDIS_NET_TYPE_DS, GetNetworkType(), 102
NDIS_NET_TYPE_FH, GetNetworkType(), 102
NDIS_NET_TYPE_UNDEFINED, GetNetworkType(),

102
NDIS_POWER_LEVEL_1, GetTXPower(), 102
NDIS_POWER_LEVEL_15, GetTXPower(), 102
NDIS_POWER_LEVEL_30, GetTXPower(), 102
NDIS_POWER_LEVEL_5, GetTXPower(), 102
NDIS_POWER_LEVEL_63, GetTXPower(), 102
NDIS_POWER_LEVEL_UNKNOWN, GetTXPower(),

102
NDIS_RADIO_ASSOCIATED, GetAssocationStatus(),

104
NDIS_RADIO_AUTH_MODE_AUTO, GetAuthentica-

tionMode(), 104
NDIS_RADIO_AUTH_MODE_ERROR, GetAuthentic-

ationMode(), 104
NDIS_RADIO_AUTH_MODE_OPEN, GetAuthentica-

tionMode(), 104
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NDIS_RADIO_AUTH_MODE_SHARED, GetAuthen-
ticationMode(), 104

NDIS_RADIO_POWER_MODE_CAM, GetPower-
Mode(), 105

NDIS_RADIO_POWER_MODE_MAX, GetPower-
Mode(), 105

NDIS_RADIO_POWER_MODE_PSP, GetPowerMode(),
105

NDIS_RADIO_POWER_UNKNOWN, GetPower-
Mode(), 105

NDIS_RADIO_SCANNING, GetAssociationStatus(), 104
NDIS_RADIO_WEP_ABSENT, GetWepStatus, 104
NDIS_RADIO_WEP_DISABLED, GetWepStatus(), 104
NDIS_RADIO_WEP_ENABLED, GetWepStatus(), 104
NDIS_RADIO_WEP_NOT_SUPPORTED, GetWepSta-

tus(), 104
Network adapters

802.11b, 87
antenna color code, 85
Ethernet communications, 86
wireless printing, 120
WWAN radio options, 110

Network management. See SNMP
Network type, 802.11 radio module, 89
nFilterChars

IADC::SetAttribute, 157
IBarCodeReaderControl::SetAttribute, 167

nInBufSize
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270

Notes
creating a note, 41
drawing on the screen, 22

creating a drawing, 22
selecting a drawing, 22

Pocket Outlook, 40
Pocket PC icon, 13
recording a message, 23

creating a recording, 23
writing on the screen, 19

alternate writing, 21
converting writing to text, 20
selecting the writing, 19
tips for good recognition, 21

nOutBufSize
IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_DEVICE_INFO, 264
IOCTL_HAL_GET_DEVICEID, 272
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278

IOCTL_HAL_WARMBOOT, 275
IOCTL_PROCESSOR_INFORMATION, 279

NPCP printing, 129
about, 129
closing driver, 130
COM1 parameters, 129
communications, 132
driver I/O controls, 131
installation, 129
LPT9, 129
opening driver, 130
reading from driver, 130
removal, 129
sample code, 132
unit information control panel, NPCPTEST CAB file,

344
writing to driver, 130

O
O’ Neil printing

See also DTR printer
installing driver, 134

Object store
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275

Oldstyle device ID, 272
Onsite repair, xviii
Opening drivers

DTR, 135
NPCP, 130

Operators, virtual wedge grid, 144
Other publications, xviii
Owner information, Pocket PC settings, 26

P
Page format printing, 128
Password

Pocket Excel, 53
Pocket PC settings, 26

PauseAtStartup, FTP Server, 255
pBarCodeDataDetails, IBarCodeReaderControl::Read, 165
pbyFNC1, IS9CConfig::GetCode128, 180
PDF 417

about the laser scanner, 137
configuration parameter, 300

user ID, 311
default S9C settings, 190
enumerations, 190
extensions

IS9CConfig2::GetPDF417ext, 213
IS9CConfig2::SetPDF417ext, 213

IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224
IS9CConfig::GetPDF417, 188
IS9CConfig::SetPDF417, 189
modifier characters, 220

pdwBufferSize, IS9CConfig2::GetGlobalAmble, 211
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pdwLength
IS9CConfig::GetCode128, 180
IS9CConfig::GetCode93, 179
IS9CConfig::GetMatrix2of5, 185
IS9CConfig::GetMSI, 187
IS9CConfig::GetPlessey, 192

pdwNumBytes
IS9CConfig::GetCodabar, 173
IS9CConfig::GetI2of5, 183
IS9CConfig::GetStandard2of5, 194

pdwNumElement, IS9CConfig2::GetCustomSymIds, 207
pdwReplyBuffSize

ISCP::GetConfig, 217
ISCP::SetConfig, 218

pdwTotalDiscardedBytes, IADC::CancelReadRequest, 152
peCheck

IS9CConfig::GetCodabar, 173
IS9CConfig::GetCode39, 176
IS9CConfig::GetI2of5, 183
IS9CConfig::GetMSI, 187
IS9CConfig::GetPlessey, 192
IS9CConfig::GetStandard2of5, 194
IS9CConfig2::GetCode11, 205

peCip128State, IS9CConfig::GetCode128, 180
peCLSI, IS9CConfig::GetCodabar, 173
peCode128, IS9CConfig2::GetPDF417Ext, 213
peDecode

IS9CConfig::GetCodabar, 173
IS9CConfig::GetCode128, 180
IS9CConfig::GetCode39, 176
IS9CConfig::GetCode93, 179
IS9CConfig::GetI2of5, 183
IS9CConfig::GetMatrix2of5, 185
IS9CConfig::GetMSI, 187
IS9CConfig::GetPlessey, 192
IS9CConfig::GetStandard2of5, 194
IS9CConfig::GetTelepen, 197
IS9CConfig2::GetCode11, 205
IS9CConfig2::GetPDF417Ext, 213

peEan128Ident, IS9CConfig::GetCode128, 180
peFormat

IS9CConfig::GetCode39, 176
IS9CConfig::GetStandard2of5, 194
IS9CConfig::GetTelepen, 197

peLengthId
IS9CConfig::GetCodabar, 173
IS9CConfig::GetI2of5, 183
IS9CConfig::GetStandard2of5, 194

peMacroPdf, IS9CConfig::GetPDF417, 188

pePdf417Decode, IS9CConfig::GetPDF417, 188
pePdfAddressee, IS9CConfig::GetPDF417, 189
pePdfChecksum, IS9CConfig::GetPDF417, 189
pePdfControlHeader, IS9CConfig::GetPDF417, 188
pePdfFileName, IS9CConfig::GetPDF417, 188
pePdfFileSize, IS9CConfig::GetPDF417, 189
pePdfSegmentCount, IS9CConfig::GetPDF417, 188
pePdfSender, IS9CConfig::GetPDF417, 189
pePdfTimeStamp, IS9CConfig::GetPDF417, 188
peSS

IS9CConfig::GetCodabar, 173
IS9CConfig::GetCode39, 176

peSSChars, IS9CConfig::GetCode39, 176
peSymIdXmit, IS9CConfig2::GetSymIdXmit, 214
peVer, IS9CConfig2::GetCode11, 205
pImgBuffer

IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 222

Planes, keypad, 281
Plessey, 367

configuration parameter, 298
user ID, 312

default S9C settings, 193
enumerations, 193
IS9CConfig::GetPlessey, 192
IS9CConfig::SetPlessey, 192
modifier characters, 220

pnBufferData, IADC::QueryAttribute, 154
pnBytesReturned

IADC::Read, 156
IBarCodeReaderControl::Read, 165

Pocket Excel
about, 52
creating a workbook, 52
Pocket PC icon, 13

Pocket Internet Explorer
about, 62
adding programs, 27
AvantGo channels, 64
browing the Internet, 66
favorite links, 62
getting connected, 67
Mobile Favorites folder, 62
Pocket PC icon, 13
software build, 5
viewing mobile favorites and channels, 66

Pocket Outlook, 31
Calendar, 31



Index

392 700 Series Color Mobile Computer User’s Manual

Pocket PC
about, 8
ActiveSync, 29
basic skills, 11
Calendar, 31
command bar, 14
Contacts, 34
edition information, 8
getting connected, 67
Inbox, 42
input panel. See Input panel
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_OAL_VERINFO, 273
MSN Messenger, 53
navigation bar, 14
Notes, 40
notifications, 15

status icon, 12
Pocket Excel, 52
Pocket Word, 47
pop-up menus, 15
programs, 13
status icons, 12
support URLs, 10
Tasks, 37
Today screen, 11
where to find information, 10
Windows Media Player, 57
writing on the screen, 19

Pocket Word
about, 47
creating a document, 47
drawing mode, 51
Pocket PC icon, 13
recording mode, 51
tips, 53
typing mode, 49
writing mode, 50

POP3, Folder behavior connected to e-mail server, 46
Postamble

configuration parameter, 327
with/without data, 327

Power
control panel, battery status, 2
Pocket PC settings, 26

ppvObject
ITCDeviceClose, 150
ITCDeviceOpen, 149

Preamble
configuration parameter, 326
with/without data, 326

Prefix, configuration parameter, user ID, 315
Printer support, 128

IrDA printer driver, 128
NPCP printer driver, 129

O’ Neil printer driver, 134
Processor information, IOCTL_PROCESSOR_IN-

FORMATION, 279
Profiles

802.11 radio module, 87
basic information, 89
certificates, 95
import/export, 96
read-only, 94
scan list, 97
security information, 90

adding to unit, 88
deleting, 88
editing, 88

Programs, adding or removing, Pocket PC, 26
pSigCapSpec

IImage::ReadSigCapBuffer, 221
IImage::ReadSigCapFile, 224

pStructSymIdPair
IS9CConfig2::GetCustomSymIds, 207
IS9CConfig2::SetCustomSymIds, 208

pSystemTime, IADC::Read, 156
pszDevice, ITCDeviceOpen, 149
pszDeviceName

IADC::Initialize, 153
IBarCodeReaderControl::Initialize, 162

pszFileName, IImage::ReadSigCapFile, 224
pwLength, IS9CConfig::GetCode39, 176
pwTotalDiscardedBytes, IBarCodeReaderControl::Cancel-

ReadRequest, 160
pwTotalDiscardedMessages

IADC::CancelReadRequest, 152
IBarCodeReaderControl::CancelReadRequest, 160

Q
QR code

configuration parameter, 307
IS9CConfig3 function, 216

Quick Response code. See QR code

R
Radios

See also Network adapters
card support, 4

Reader commands, 357
configuration change, 357
date and time settings, 358

Reading from drivers, NPCP, 130
Reboot methods

IOCTL_HAL_COLDBOOT, 280
IOCTL_HAL_REBOOT, 280
IOCTL_HAL_WARMBOOT, 280

Record button, recording a message, 23
Recording a message

See also Notes
Pocket Word, 51

Recording mode, Pocket Word, 51
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Recovery CD
AutoCab method, 82
AutoRun system, 76
AUTOUSER.DAT file, 81
part numbers, xviii
RegFlushKey() API, 262
S9C upgrade, 345
updating the system software, 79

RegFlush utility, 81
Registry

FTP Server parameters, 252
keypad remapping, 282
sample view of key mapping, 284
save location, IOCTL_HAL_ITC_WRITE_SYSPARM,

270
writing to a storage card, 81

Registry settings
AutoCfg, 122
AutoFTP, 261
AutoInterval, 122
AutoIP/DHCP, 122
DhcpMaxRetry, 122
DhcpRetryDialogue, 122
EnableDHCP, 122
keypad driver, 282
keypad planes

alpha, 282
gold, 282
unshifted, 282

Related publications, xviii
Removeable card support, 5
Removing drivers

DTR, 134
NPCP, 129

Removing programs, Pocket PC, 26, 28
RFC 959, 259
rgbAttrBuffer

IBarCodeReaderControl::QueryAttribute, 164
IBarCodeReaderControl::SetAttribute, 168

rgbBuffer
IADC::QueryAttribute, 154
IS9CConfig2::GetGlobalAmble, 211
IS9CConfig2::SetGlobalAmble, 212

rgbCommandBuff
ISCP::GetConfig, 217
ISCP::SetConfig, 218

rgbData, IADC::SetAttribute, 157
rgbDataBuffer

IADC::Read, 156
IBarCodeReaderControl::Read, 165

rgBeepRequests, IBarCodeReaderControl::IssueBeep, 163
rgbImageData, pImgBuffer, IImage::ReadSigCapBuffer,

222
rgbLengthBuff

IS9CConfig::GetCodabar, 173
IS9CConfig::GetI2of5, 183
IS9CConfig::GetStandard2of5, 194
IS9CConfig::SetCodabar, 174

IS9CConfig::SetI2of5, 184
IS9CConfig::SetStandard2of5, 195

rgbReplyBuff
ISCP::GetConfig, 217
ISCP::SetConfig, 218

Root, FTP Server, 255

S
S 2 of 5. See Standard 2 of 5
S_DEVICE_CONTENTION_E, IImage::Open, 227
S_DEVICE_NOT_OPENED_E

IImage::CancelReadImage, 226
IImage::Close, 228
IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224
IImage::Start, 226
IImage::Stop, 227

S_IMG_NOT_PRESENT_E
IImage::Open, 227
IImage::Stop, 227

S_OK
IImage::CancelReadImage, 226
IImage::Close, 228
IImage::Open, 227
IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 223
IImage::ReadSigCapFile, 224
IImage::Start, 226
IImage::Stop, 227

S9C
initialization, 138
IS9CConfig functions, 172
IS9CConfig2 functions, 204
IS9CConfig3 functions, 216
unit information control panel, upgrade files, 345
version number, 342

Sabre 1551E or 1553
See also Tethered scanner
cabling, 232
settings, 232

Sample code, NPCP printing, 132
SB555 radio, 110
Scan list of profiles, 802.11 radio module, 98
Scanner, unit configuration parameters

automatic shutoff, 355
backlight timeout, 353
date/time, 352
key clicks, 354
volume, 356

Scanner cabling, 232
Scheduling appointments and meetings, via Calendar, 31
SDK, unit information control panel, 345
SDMMC Disk, 80
Searching for text, Microsoft Reader, 61
SecureDigital cards

card support, 5
installing applications, 78, 79
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Security
configuration parameter

encryption key, 335
read encryption, 333
read-only community string, 331
read/write community string, 332
subnet mask, 309
write encryption, 334

Unit Manager, 350
Selected profile, 802.11 radio module, 97
Selecting, drawing via Notes, 22
Sending and receiving messages, via Inbox, 42
Serial port, modem support, 4
Service contract status, xviii
Setting date and time, 358
Setting up an e-mail service, 73
SETUP.DLL, installation functions, 248
Signature capture

IImage interface, 221
IImage::CancelReadImage, 226
IImage::Close, 228
IImage::Open, 227
IImage::ReadImage, 225
IImage::ReadSigCapBuffer, 221
IImage::ReadSigCapFile, 224
IImage::Start, 226
IImage::Stop, 227

Simple Network Management Protocol. See SNMP
Site installations, xviii
Site surveys, xviii
SMS, Folder behavior connected to e-mail server, 46
SNMP, 125

about SNMP, 123
CMIP, 123
configuration parameters

identification contact, 338
identification location, 340
identification name, 339
security encryption key, 335
security read encryption, 333
security read-only community string, 331
security read/write community string, 332
security subnet mask, 309
security write encryption, 334
trap authentication, 336
trap threshold, 337

control primitives, 123
multiple retrievals, 124
retrieval, 124
Unit Manager, 350
using the protocol, 123

SNMP OIDs
aimer LED duration, 323
automatic shutoff, 355
backlight timeout, 353
beeper

frequency, 320
volume, 318

codabar, 292
user ID, 310

code 11, 306
user ID, 314

code 128, 295
FNC1 character, 297
user ID, 310

code 39, 290
user ID, 310

code 93, 294
length, 294
user ID, 311

data matrix, 308
date/time, 352
default S9C settings, 210
EAN

13 user ID, 313
8 user ID, 313

good read
beep duration, 322
beeps, 321

identification
contact, 338
location, 340
name, 339

image dimension, 324
interleaved 2 of 5, 303

user ID, 311
IS9CConfig2::GetCustomSymIds, 207
IS9CConfig2::GetSymIdXmit, 214
IS9CConfig2::SetCustomSymIds, 208
IS9CConfig2::SetSymIdXmit, 214
key clicks, 354
macro PDF, 300
matrix 2 of 5, 304

user ID, 313
micro PDF 417, 302
MSI, 299

user ID, 311
PDF 417, 300

user ID, 311
plessey, 298

user ID, 312
prefix, 315
QR code, 307
security

encryption key, 335
read encryption, 333
read-only community string, 331
read/write community string, 332
write encryption, 334

security subnet mask, 309
standard 2 of 5, 291

user ID, 312
suffix, 316
telepen, 305

user ID, 313
transmission option, 215
trap

authentication, 336
threshold, 337
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UPC
A user ID, 312
E user ID, 312

UPC/EAN, 293
virtual wedge, 325

code page, 329
grid, 328
postamble, 327
preamble, 326

volume, 356
Symbology ID defaults, 219
Software Developer’ s Kit. See SDK
Software Tools CD. See Tools CD
Software versions, 6, 342

700 Series Computer, 5
unit information control panel applet, 342, 344

Speaker, 2
SSID (network name), 802.11 radio module, 89
Standard 2 of 5, 366

configuration parameter, 291
user ID, 312

default S9C settings, 196
enumerations, 196
IS9CConfig::GetStandard2of5, 194
IS9CConfig::SetStandard2of5, 195
modifier characters, 220

Start Menu, adding programs, 28
via ActiveSync, 28
via File Explorer, 28

Status icons, Pocket PC, 12
Stream device driver

NPCPPORT.DLL, 129
ONEIL.DLL, 134

stTimeStamp, IBarCodeReaderControl::Read, 165
Suffix, configuration parameter, 316
Summary screen

Calendar, 33
Contacts, 36
Tasks, 39

Support
global services and support center, xviii
web, xviii

Symbologies, 360
scanning labels, 368
Unit Manager, 348
user IDs

Codabar, 310
Code 11, 314
Code 128, 310
Code 39, 310
Code 93, 311
EAN 13, 313
EAN 8, 313
Interleaved 2 of 5, 311
Matrix 2 of 5, 313
MSI, 311
PDF 417, 311
Plessey, 312
Standard 2 of 5, 312
Telepen, 313

UPC A, 312
UPC E, 312

when not available
imager, 298, 299, 300, 302, 304, 305, 306
laser scanner, 307, 308

Symbology ID, Unit Manager, 349
Synchronizing e-mail messages, via Inbox, 42
System status maintained, 4
szDest, EncryptWepKeyForRegistry(), 106
szFilter

IADC::SetAttribute, 157
IBarCodeReaderControl::SetAttribute, 167

szSource, EncrypWepKeyForRegistry(), 106

T

Tasks
creating a task, 38
Pocket Outlook, 37
Pocket PC icon, 13
using the summary screen, 39

TCP/IP client, DHCP server, 122
Technical support, xviii
Telepen

configuration parameter, 305
user ID, 313

default S9C settings, 197
enumerations, 198
IS9CConfig::GetTelepen, 197
IS9CConfig::SetTelepen, 197
modifier characters, 220

Telephone numbers, xviii
Testing AT commands, 117
Tethered scanner

capabilities, 233
disabling, 231
enabling, 231
error messages, 232
limitations, 233
settings, 231

Text messages, Pocket PC, 24
Time, setting, 358
Tips for working, Pocket Excel, 53
TLS, 802.1x profile, 92
Today, Pocket PC settings, 26
Today screen, Pocket PC, 11
Tools CD

base operating system files, 78
Bluetooth documentation, 120
CAB files, 4, 78, 344
CE Imager, 80
Comm Port Wedge CAB file, 344
management tools installed on desktop, 77
MIB files, 125
part number, xviii
sample NPCP code, 132
SRDEVMGMT.CAB file, 286
Unit Manager CAB file, 347
Wireless Printing Development Guide, 120
wireless printing sample, 345
wireless printing SDK, 120
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Tracking people, via Contacts, 34
Transcriber, Pocket PC input panel, 18
Transfer items using infrared

getting connected, 67
receiving information, 67
sending information, 67

Trap configuration parameters
authentication, 336
threshold, 337

Traps
control panel appet, SNMP, 336
Unit Manager, 351

Troubleshooting, CAB Wizard, 250
TTLS, 802.1x profile, 93
Typing mode, Pocket Word, 49
Typing on the screen, Pocket Word, 49

U

UDP
FTPDCE, 256
within SNMP, 123

UDP broadcasts, IDNATarget parameter, 254
uiHeight, pSigCapSpec, IImage::ReadSigCapBuffer, 222
uiWidth, pSigCapSpec, IImage::ReadSigCapBuffer, 222
Unit, configuration parameters

automatic shutoff, 355
backlight timeout, 353
date/time, 352
key clicks, 354
volume, 356

Unit information
battery status, 343
CAB files, 344

ActiveX control tools, 345
Bluetooth stack, 344
Comm Port Wedge, 344
NPCP printer, 344
S9C Upgrade, 345
SDK, 345
Unit Manager, 345
Unit Manager help, 345
Windows configuration, 345
wireless printing demo, 345
wireless printing sample, 345

versions, 6, 342
700 Platform Build, 342
DataCollection Build, 342
S9C, 342

Unit Manager
automatic shutoff, 355
backlight timeout, 353
data collection, 348

beeper/LED, 349
imager, 350
symbologies, 348
symbology ID, 349
virtual wedge, 350

date/time, 352
documentation, 347
key clicks, 354

reader commands, 357
changing configuration, 357
setting time and date, 358

SNMP, 350
identification, 351
security, 350
traps, 351

volume, 356
Unit manager

installing applications, 78
unit information control panel, 345

help files, 345
Universal Product Code. See UPC
Unshifted plane on keypad, 281
UPC, 362

configuration parameter, 293
A user ID, 312
E user ID, 312

default S9C settings, 201
enumerations, 201
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200
modifier characters, 220

upcACheck
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcAddOn2
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

upcAddOn5
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

upcAddOnDigits
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

upcANumSystem
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcAReencode
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcASelect
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

upceanDecode
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

upcECheck
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcENumSystem
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcEReencode
IS9CConfig::GetUpcEan, 199
IS9CConfig::SetUpcEan, 200

upcESelect
IS9CConfig::GetUpcEan, 198
IS9CConfig::SetUpcEan, 200

Updating, bootloader, 77
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URLs
ActiveSync, 29
Adobe Acrobat Reader, 116
AT command interface

CDMA/1xRTT SB555, 116
GPRS/GSM GEM350X, 116
GPRS/GSM MC45, 116

customer support, xviii
full screen display, 263
Knowledge Central, xviii
MIBs, 125
Microsoft Exchange e-mail account, 53
Microsoft Passport account, 53
Microsoft support, 10
MSDN library, 260
Pocket PC, 10
Pocket PC support, 10
web support, xviii

User Datagram Protocol. See UDP
Using a message list, via Inbox, 43
UUID, 272
V
Video files, Windows Media Player, 57
Viewing mobile favorites and channels, Pocket Internet

Explorer, 66
Virtual wedge

bar code configuration
grid, 371
postamble, 371
preamble, 371

configuration parameter, 325
code page, 329
grid, 328
postamble, 327
preamble, 326

data filtering, 141
filter expression values, 142
global amble

IS9CConfig2::GetGlobalAmble, 211
IS9CConfig2::SetGlobalAmble, 212

operators, 144
Unit Manager, 350

VN_CLASS_ASIC, 266
VN_CLASS_BOOTSTRAP, 266
VN_CLASS_KBD, 266
Volume

bar code configuration, 368
configuration parameter, 356

W
WAN radio CORE module, 111
WAN radio IDs

ITC_DEVID_WANRADIO_NONE, 268
ITC_DEVID_WANRADIO_SIEMENS_MC45, 268
ITC_DEVID_WANRADIO_SIERRA_SB555, 268

WAN rado CORE module
phone application, 115

terminal application, 114
WAP pages, 62

connecting to an ISP, 68
Warm boot

IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275

Web addresses. See URLs
Web browsers, FTP support, 259
Web pages, 62

connecting to an ISP, 68
Web support, xviii
Welch Allyn 1470 Imager

cabling, 232
settings, 232

WEP encryption, 802.11 radio module, 91
Windows configuration, unit information control panel,

WinCfg CAB file, 345
Windows Media files, Windows Media Player, 57
Windows Media Player, Pocket PC, 57
Wireless Application Protocol. See WAP pages
Wireless network, 87
Wireless printing

Bluetooth compatible module, 120
unit information control panel

PDWPM0C CAB file, 345
WP_SAMPLE.CAB file, 345

Wireless TCP/IP installations, BlockSize parameter, 252
Wireless WAN

AT command interface
CDMA/1xRTT SB555, 116
GPRS/GSM GEM350X, 116
GPRS/GSM MC45, 116

CDMA/1xRTT, 110
GEM350x, 110
GSM/GPRS, 110
SB555, 110
testing AT commands, 117

wNumberOfMessages, IADC::QueryData, 155
Word documents. See Pocket Word
Work

creating
a modem connection, 70
an Ethernet connection, 71

getting connected, 70
Writing mode, Pocket Word, 50
Writing on the screen

See also Notes
Pocket Word, 50

Writing to drivers
DTR, 135
NPCP, 130

wStructSize, IBarCodeReaderControl::Read, 165
WWAN. See Wireless WAN

X
Xscale processor ID, IOCTL_GET_CPU_ID, 280
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Files Index
Numbers
80211API.DLL, 100
80211CONF.EXE, 100
80211SCAN.EXE, 100

A
AUTOUSER.DAT, 79

C
CABWIZ.DDF, 249
CABWIZ.EXE, 236, 249
CEIMAGER.EXE, 80
CPL802.CPL, 100

D
DEVICEID.H, 272

E
EXITME.BIN, 259

F
FTPDCE.EXE, 256, 259

AutoFTP, 261
FTP Server, 251

FTPDCE.TXT, 259

I
IADC.H, IADC functions, 151
IADCDEVICE.H

IADC::SetAttribute, 157
IBarCodeReaderControl::SetAttribute, 167

INTERMEC.MIB, 125
IS9CCONFIG.H

IS9CConfig functions, 172
IS9CConfig2 functions, 204

ITCADC.MIB, 125
ITCDEVMGMT.H, 149
ITCDEVMGMT.LIB, 149
ITCSNMP.MIB, 125
ITCTERMINAL.MIB, 125
ITCUUID.LIB

IADC functions, 151
IS9CConfig functions, 172

IS9CConfig2 functions, 204

M
MAKECAB.EXE, 249
MOD80211.DLL, 100

N
NETWLAN.DLL, 100
NPCPPORT.DLL, 129
NRINET.INI, 345

O
OEMIOCTL.H

IOCTL_GET_CPU_ID, 280
IOCTL_HAL_COLDBOOT, 275
IOCTL_HAL_GET_BOOT_DEVICE, 277
IOCTL_HAL_GET_BOOTLOADER_VERINFO,

274
IOCTL_HAL_GET_OAL_VERINFO, 273
IOCTL_HAL_GET_RESET_INFO, 276
IOCTL_HAL_ITC_READ_PARM, 265
IOCTL_HAL_ITC_WRITE_SYSPARM, 270
IOCTL_HAL_REBOOT, 278
IOCTL_HAL_WARMBOOT, 275

ONEIL.DLL, 134

P
PKFUNCS.H

IOCTL_HAL_GET_DEVICEID, 272
IOCTL_PROCESSOR_INFORMATION, 279

R
REBOOTME.BIN, 259
__RESETMEPLEASE__.T XT, 248
RPM.EXE, 241
RPMCE212.INI, 241

S
SETUP.DLL, 240, 248

DllMain, 248
SRDEVMGMT.CAB, 286

T
TAHOMA.TTF, 241

W
WCESTART.INI, 241
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